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Introduction  
 

Welcome to the beta release of MPC 3 desktop software—a major evolution in the MPC platform. MPC 3 delivers a 
significant upgrade in both workflow efficiency and feature depth, introducing a streamlined approach to music 
production through an all-new unified track architecture. 

By merging tracks and programs into a single 1:1 track model, MPC 3 simplifies complex workflows and accelerates 
creative momentum. Whether you're composing, editing, or mixing, MPC 3 is designed to help you move faster and 
stay inspired. 

 

Highlights of the MPC 3 Beta: 

• 1:1 Track Model — Tracks and programs are now unified, streamlining routing and editing. 

• VST3 Plugin Support — Expanded plugin compatibility for modern production environments. 

• Improved drum tracks. 

• Advanced Keygroup Synthesis engine. 

• More time stretch options. 

• Time Signature Support per Sequence and Clip 

• Beta Arrange Mode 

 

Please note: This is an early beta build. 

This beta version includes core elements of the MPC 3 architecture, but does not represent the final feature set. It is 
designed to give users early access to the new workflow and provide feedback as we move toward a full release. 

 

Planned Features Not Yet Included in This Beta: 

• Q-Link Setup UI 

• Various GUI Enhancements 

 

We’re excited to bring you into the future of MPC, and we can’t wait to hear what you create with MPC 3. 

 

Akai Professional 
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Updates in Beta v3.9 
 

MPC One G2 and MPC Key 37 G2 Compatibility 
 
MPC Software v3.9 adds support for MPC One G2 and MPC Key 37 G2 hardware in controller mode.  

 

 

Plugin Formats 
 
MPC Software now includes plugin versions in VST3 and Audio Unit (AU) formats for use in other DAWs.  

 

 

Arrange Mode Beta 
 
MPC software now includes a beta implementation of Arrange Mode, providing a linear, track-based view of your 
arrangement and enabling basic arrangement-level editing directly from the software.  

 
To access Arrange Mode, do either of the following:   

• Click the Arrange Mode icon in the Toolbar. 

• Click the menu icon (≡) in the upper-left corner of the window and navigate to View > Mode > Arrange. 

 

See Modes > Arrange Mode to learn more.  

 

 

MPC Oscillators 
 
Drum and Keygroup tracks can now use oscillators as a sound generator per layer instead of samples. An optional 
Expansion library of presets is available to download from the inMusic Software Center. These presets provide an 
introduction to the creative possibilities of the new MPC Oscillators.  

 
To use MPC Oscillators: 

1. Select a Drum or Keygroup track. 

2. Open Track Edit Mode. 

3. In the Track Editor Panel, navigate to the Sample/Osc Layers section. 

4. For any layer, switch the sound source from a Sample by clicking the OSC button. 

Some Oscillator types may require additional content. After switching a layer to an Oscillator, click the Get 
Oscillator Content button to open the Activations tab of the Preferences, where you can download the 
required MPC Oscillator Content.  

5. Additional parameters will be available depending on the type of oscillator selected.  

Oscillator parameters can be modulated using the Mod Matrix in the same way as other parameters.  
 
For more information on using MPC Oscillators, see Operation > Modes > Track Edit Mode and General Features 
> Editors > Wave Editor.  
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Time Signatures per Sequence and Clip 
 
You can now set time signatures per sequence and clip. 
 
To adjust the sequence time signature: 

1. Open the Inspector.  

2. In the Sequence section, set the Time Signature to the desired value. The numerator (top/first number) 
indicates the number of beats per bar (1–16). The denominator (bottom/second number) indicates the note 
value of each beat (4, 8, 16, 32). Time signatures can be set individually per sequence. 

 
To adjust the clip time signature: 

1. Open the Inspector. 

2. In the Arrangement/Clip section,  

 
To create a new clip with a custom time signature: 

1. Open the Inspector. 

2. In the Arrangement/Clip section, click the Arrangement/Clip field or down arrow () and select an unused 
clip slot. 

 
 
Other Enhancements 
 
You can now save MPC programs directly from the software. Click the menu icon (≡) in the upper-left corner of the 
window to open the menu, and then navigate to File > Save Current Program.  
 
MPC program files are now saved in the MPC3 file format (.JSON). This aligns program data with the rest of the MPC 
file ecosystem.  
 
Drum and Keygroup tracks now include two new classic analog low-pass filter models, Jura LP and Iona LP, 
derived from the AIR Jura and AIR Iona instruments.  
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MPC 2 vs. MPC 3 
 

MPC 3 installs alongside MPC 2, allowing you to use both versions independently. 

 

The transition from MPC 2 to MPC 3 introduces significant architectural changes, most notably the unification of 
tracks and programs into a single track container. This redesign aims to streamline and accelerate workflow, but also 
means that MPC 2 projects are not loadable into MPC 3 with identical behavior, and projects created in MPC 3 are 
not backwards-compatible with MPC 2. Because of this, we strongly recommend saving a new copy of all MPC 2 
projects before importing them to preserve editing capabilities and ensure you can still reopen the existing MPC 2 
projects in the previous software. 

 

Upon loading an MPC 2 project, MPC 3 will display a Project Import dialog. By default, the Import field is set to All 
Sequences. Using this method: 

• MPC 3 will attempt to import all sequences and tracks from the MPC 2 project. 

• If a single track was assigned to a single program in MPC 2, MPC 3 will create a corresponding track of the 
same type as the original program.  

• If multiple tracks were assigned to the same program in MPC 2, MPC 3 will create one primary track of the 
same type as the program, and subsequent tracks will be converted to MIDI tracks with their Send To field 
pointing to the primary track. 

Alternatively, you can set the Import field to Selected Sequences Import. Using this method: 

• A list of sequences from the source MPC 2 project will be displayed, and you can tick the sequences you 
wish to import into MPC 3. 

• The selected sequences will load into their original locations within the sequence list. 

 

MPC 3 also introduces a refreshed, darker visual design across the interface, including updated mixer and channel 
strip views. The overall look and feel have been enhanced to improve visual clarity and user experience, offering a 
more modern and refined workflow environment. 

 

When starting MPC 3, or when selecting File > New Project, it will automatically load a small factory project by 
default, including: The configuration of this project varies depending on the type of MPC device in use. 

• Drum Track Preset: A single drum track with samples loaded on Pad Bank A. 

• Q-Link Track Layout: Configured to control the sound of the drum track. 

• Effects: AIR Reverb and AIR Delay are preloaded on Returns 1 and 2.  

You can change the default behavior of the new project to load an Empty Project or use an Autoload Project from 
the Preferences > Project Load/Save menu. 

 

Your inMusic Profile is now visible in the top-right corner of the MPC 3 interface. Clicking on your profile provides 
quick access to the Preferences > Activations menu, where you can easily activate and install newly purchased 
plugin instruments and effects, including the MPC 3 beta activation. 
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About This User Guide 
 

This user guide will get you up to speed on the latest changes in the MPC 3 software. For details on any features or 
functions not covered in this manual, refer to the MPC 2 User Guide or the MPC Standalone OS User Guide. 

 

For consistency, the terminology throughout is based on the MPC parameter names. We also used specific 
formatting to indicate particular topics of significance: 

 

Important/Note/Tip: Important or helpful information on a given topic. 

 

Names of buttons, controls, parameters, settings, and other options are written in bold characters throughout the manual. 

Examples: Click the Play Start button. 

Turn Q-Link Knob 4. 

Click the Mute button. 

The Velocity ranges from 0 to 127. 

Set the Sample Play selector to One Shot. 

Click BPM, and then use the numeric keypad to enter 120 as the tempo. 

 

Some parts of this manual refer to other relevant chapters or sections, which are cited in bold, italic blue characters.  

Examples: Read the Important Notes section before proceeding. 

See Operation > General Features > Menu > MIDI/Sync for more information. 

To learn more about using send effects, see General Features > Effects > Send/Return Effects. 

 
 
Important Notes 
 

Before installing the MPC 3 software, make sure your computer meets the system requirements.  

Before connecting your MPC hardware to your computer, make sure you have installed the latest drivers and 
software. Visit akaipro.com to download the latest versions.  

 

http://akaipro.com
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Setup 
 
1. Connection 
 

Here is just an example of how to use MPC hardware in your setup (MPC Live, in this case). Items not listed in your 
included Quickstart Guide are sold separately. 

 
 

 
 
 
 

 
2. Registration and Installation 
 

1. Go to profile.inmusicbrands.com and log into your inMusic Brands Profile. 

2. Click Register New Product and use the unlock code provided by the beta team to register the MPC 3 software 
to your account. 

3. Once MPC 3 is registered, download the MPC 3 software package.  

4. Open the file and double-click the installer application. 

5. Follow the on-screen instructions to complete the installation. MPC 3 will be installed alongside any previous 
MPC 2 installation, ensuring you can use both versions as needed. 

Note: By default, the MPC 3 software will be installed in [your hard drive]\Program Files\Akai Pro\MPC3 
(Windows®) or Applications (macOS®). You can also create a shortcut on your Desktop. 

 

Computer Turntable Powered Monitors Power (optional) 

SD Card USB 
drive 

http://profile.inmusicbrands.com
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3. Getting Started 
 

1. Power on your MPC hardware. 

2. On your computer, open the MPC 3 software. 

3. Click Sign In to sign into your inMusic Brands Profile account. Follow the on-screen instructions to activate your 
MPC 3 software. 

4. MPC XL, MPC X, MPC X SE, MPC Live, MPC Live II, MPC Live III, MPC One, MPC One+, MPC One G2, 
MPC Key 61, & MPC Key 37, MPC Key 37 G2 users: Check the upper-right corner of the window: 

• If you see a computer icon, then your MPC hardware is already in Controller Mode. Continue to Step 5. 

• If you see a chip icon (shown right), then your MPC hardware is in Standalone Mode. Follow 
these steps: 

i. Press Menu to enter the Menu. 

ii. Tap the chip icon in the upper-right corner. 

iii. In the Enter Controller Mode window that appears, tap Controller Mode. “Looking 
for computer” may appear briefly in the window before your MPC hardware 
recognizes the USB connection as a controller. 

5. In the MPC 3 software, open the Preferences: 

Windows: Click the menu icon (≡), select Edit, and click Preferences. 

macOS: Click the MPC menu, and click Preferences. 

6. In the Preferences window, click the Audio Device tab and select the sound card you want to use. Click OK 
when you are done. 

Important: We highly recommend using your MPC hardware’s sound card (Akai Pro [your MPC model] ASIO). 

Windows users only: If you need to use your computer’s internal sound card, we recommend downloading the 
latest ASIO4ALL driver at asio4all.com. 

 

 

http://asio4all.com
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Operation 
 

This chapter explains the complete features and functions of the MPC 3 software.  

 
 
General Features 
 
Tracks 
 

About Tracks 

 

Each sequence you create within a project is made up of tracks. There are six main types of tracks, each of which 
determines how the track sounds or for what it is used. A single project can hold up to 128 tracks. 

This chapter covers how to create each track type. 

To learn about editing your tracks to your preference, see the Modes > Track Edit Mode chapter. 

 

A drum track uses one or more samples as its sound source. It contains (1) a list of samples and (2) the 
settings for each sample (i.e., pad assignments, loop points, pitch tuning, effects, etc.). Drum tracks are 
used mostly for creating drum parts and quickly and easily assigning samples to pads. See Drum Tracks 
for more information. 

 

A keygroup track uses one or more samples as its sound source. It contains (1) a list of samples and (2) the 
settings for each sample (i.e., pitch tuning, effects, etc.). Keygroup tracks are used to play samples 
chromatically with a MIDI keyboard or the MPC pads. See Keygroup Tracks for more information. 

 

A plugin track contains an instance of a plugin through which you can send your track’s MIDI data. See 
Plugin Tracks for more information. 

 

A MIDI track lets you send your track’s MIDI data to an external MIDI device like a synth or drum machine, 
or to another MPC track. See MIDI Tracks for more information. 

 

A CV track lets you send your track’s MIDI data to an external MIDI device that uses control voltage (CV), 
like a synth. Although this option is selectable, it is usable only with MPC hardware that has CV outputs 
(e.g., MPC X). See CV Tracks for more information. 

 

An Audio track lets you record audio from an external source or by resampling another track to create a 
sample. See Audio Tracks for more information. 
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Drum Tracks 
 

A drum track uses one or more samples as its sound source. It contains (1) a list of samples and (2) the settings for 
each sample (i.e., pad assignments, loop points, pitch tuning, effects, etc.). Drum tracks are used mostly for creating 
drum parts and quickly and easily assigning samples to pads. 

 

To create a drum track, do either of the following in the Inspector (Click the i icon to show or hide the Inspector): 

• Click the four-squares icon below the Track Name field, which indicates a 
drum track.  

• Click the + icon next to the record arm button in the Track section, or right-click 
the Track Name and select New Track, to open the New Track window. Then, 
select Drum as the track Type. Use the Tracks field to create multiple drum 
tracks at the same time.  

A new drum track will be created and appended with a number (e.g., Drum 002). 

 

To rename the track, double-click the Track Name field, type a name, and press 
Enter. 

 

To edit drum track settings, click the cog wheel icon to open the Track Settings window. 

Use the track name field to rename the track. Press Enter or select another field to apply the change.  

Use the Position field to change the location of the track, moving the other tracks in relation. You can also use 
the -/+ buttons at the bottom of the window. 

Use the Rec Arm field to arm (On) or disarm (Off) the track for recording.  

Use the MIDI Routing fields to edit the MIDI routing for the track: 

MIDI Input Port: Select the MIDI port from which to receive MIDI data. When set to All Ports, the track will 
receive all incoming MIDI data from any connected port. To view and edit the available ports, go to Preferences 
> MIDI / Sync. 

MIDI Input Channel: Sets the MIDI Channel from which to receive MIDI data. Select Any to receive from any 
MIDI channel, or select 1–16. 

MIDI Send: Sets where the MIDI data is sent. You can use this to send the MIDI data from one track to another 
track. 

Use the MIDI Monitor field to set the monitoring behavior of the track: 

Off: The track's MIDI input is not monitored, and playback of recorded events will be heard. This setting is 
useful when using keyboards with Local Control active. 

In: The track's MIDI input is always monitored regardless of the track's Record Arm state, and playback from 
recorded events will not be heard. 

Auto: The track's MIDI input is monitored when the track is record armed, and playback of recorded events will 
be heard. 

Merge: The track's MIDI input is always monitored, and playback of recorded events will be heard. 

Use the Color field to change the track color. 

Click Delete Track at the bottom of the window to remove the track. 

Click Reset Strip at the bottom of the window to reset all mixer settings for the track. 

Click Close to close the Track Settings window.  
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To load a sample into a drum track: 

1. In the File Browser, find a sample you want to use. 
(Click the hard-drive icon in the lower-right corner to 
show or hide the File Browser. See Browser to learn 
more.) 

2. Click and drag the sample from the Browser onto the 
desired pad. Alternatively, double-click the sample to 
load it to the sample pool without loading it to a 
specific pad. 

 

To assign samples to additional pads, repeat Steps 1–2. 

Tip: Remember that a drum track has 128 pads total—16 
pads across eight banks. 

 

 

Alternatively, assign samples in a drum track this way: 

1. Click the four-pads icon in the toolbar to enter Track Edit Mode. 

2. In the bottom half of the window, scroll to the right to find the Sample Layers section. This lets you view the 
samples assigned to all eight layers of the drum track as well as tuning and level parameters for each layer. 

3. Click a pad to select it (and play its assigned samples, if any). The pad will be lit green. 

4. Click the menu for a layer, and select a sample. 

Tip: Remember that a drum track has 128 pads total—16 pads across eight banks. 
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Keygroup Tracks 

 

A keygroup track uses one or more samples as its sound source. It contains (1) a list of samples and (2) the settings 
for each sample (i.e., pitch tuning, effects, etc.). Keygroup tracks are used to play samples chromatically with a MIDI 
keyboard or the MPC pads. 

 

To create a keygroup track, do either of the following in the Inspector (Click the i icon to show or hide the 
Inspector):  

• Click the piano-keys icon below the Track Name field, which indicates a 
keygroup track.  

• Click the + icon next to the record arm button in the Track section, or right-click 
the Track Name and select New Track, to open the New Track window. Then, 
select Keygroup as the track Type. Use the Tracks field to create multiple 
keygroup tracks at the same time. 

A new keygroup track will be created and appended with a number (e.g., Keygroup 
002). 

 

To rename the track, double-click the Track Name field, type a name, and press Enter. 

 

To edit keygroup track settings, click the cog wheel icon to open the Track Settings window. 

Use the track name field to rename the track. Press Enter or select another field to apply the change.  

Use the Position field to change the location of the track, moving the other tracks in relation. You can also use 
the -/+ buttons at the bottom of the window. 

Use the Rec Arm field to arm (On) or disarm (Off) the track for recording.  

Use the MIDI Routing fields to edit the MIDI routing for the track: 

MIDI Input Port: Select the MIDI port from which to receive MIDI data. When set to All Ports, the track will 
receive all incoming MIDI data from any connected port. To view and edit the available ports, go to Preferences 
> MIDI / Sync. 

MIDI Input Channel: Sets the MIDI Channel from which to receive MIDI data. Select Any to receive from any 
MIDI channel, or select 1–16. 

MIDI Send: Sets where the MIDI data is sent. You can use this to send the MIDI data from one track to another 
track. 

Use the MIDI Monitor field to set the monitoring behavior of the track: 

Off: The track's MIDI input is not monitored, and playback of recorded events will be heard. This setting is 
useful when using keyboards with Local Control active. 

In: The track's MIDI input is always monitored regardless of the track's Record Arm state, and playback from 
recorded events will not be heard. 

Auto: The track's MIDI input is monitored when the track is record armed, and playback of recorded events will 
be heard. 

Merge: The track's MIDI input is always monitored, and playback of recorded events will be heard. 

Use the Color field to change the track color. 

Use the Transpose field to adjust the transposition amount of the track.  

Click Delete Track at the bottom of the window to remove the track. 

Click Reset Strip at the bottom of the window to reset all mixer settings for the track. 

Click Close to close the Track Settings window.  
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To load a sample for your keygroup track into the project:  

1. In the File Browser, find a sample you want to use. (Click the hard-drive icon in the lower-right corner to show 
or hide the File Browser. See Browser to learn more.) 

2. Click and drag the sample from the Browser onto any space outside of the Browser. Alternatively, double-click 
the sample to load it to the sample pool. 

To load additional samples, repeat Steps 1–2. 

 

 

 

To assign samples in a keygroup track: 

1. Click the four-pads icon in the toolbar to enter Track Edit Mode. 

2. In the bottom half of the window, scroll to the right to find the Sample Layers section. This lets you view the 
samples assigned to all eight layers of the current keygroup as well as tuning and level parameters for each layer. 

3. Click a pad to select it (and play its assigned samples, if any). The pad will be lit green. 

Tip: In the Pads panel, click the Pad Bank D button and click Pad 13. You should hear the sample played back 
with its original pitch. You can use the other pads to play your sample chromatically.  

4. Click the menu for a layer, and select a sample. 

 

 

 

To create complex keygroup tracks, you can add more keygroups (up to 128). This is useful when working with multi-
samples (e.g., when programming a real piano). 

Tip: Remember that a keygroup track offers up to 128 keygroups, and each keygroup can hold up to eight samples 
(Layers 1–8). This is a total of 1,024 samples. 
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Plugin Tracks 

 

A plugin track contains an instance of a plugin through which you can send your track’s MIDI data. This lets you use 
the same instance of a plugin with multiple tracks (rather than load an instance of a plugin on every track, which can 
be cumbersome and CPU-intensive). See the Plugins chapter to learn about scanning and selecting plugins. 

 

To create a plugin track, do either of the following in the Inspector (Click the i 
icon to show or hide the Inspector):  

• Click the plug icon below the Track Name field, which indicates a plugin 
track.  

• Click the + icon next to the record arm button in the Track section, or right-
click the Track Name and select New Track, to open the New Track window. 
Then, select Plugin as the track Type. Use the Tracks field to create multiple 
plugin tracks at the same time. 

A new plugin track will be created and appended with a number (e.g., Plugin 002). 

 

To rename the track, double-click the Track Name field, type a name, and press 
Enter. 

 

To edit plugin track settings, click the cog wheel icon to open the Track Settings window. 

Use the track name field to rename the track. Press Enter or select another field to apply the change.  

Use the Position field to change the location of the track, moving the other tracks in relation. You can also use 
the -/+ buttons at the bottom of the window. 

Use the Rec Arm field to arm (On) or disarm (Off) the track for recording.  

Use the Plugin field to select a plugin for the track.  

Use the Preset field to select a preset from the loaded plugin.  

Use the MIDI Routing fields to edit the MIDI routing for the track: 

MIDI Input Port: Select the MIDI port from which to receive MIDI data. When set to All Ports, the track will 
receive all incoming MIDI data from any connected port. To view and edit the available ports, go to Preferences 
> MIDI / Sync. 

MIDI Input Channel: Sets the MIDI Channel from which to receive MIDI data. Select Any to receive from any 
MIDI channel, or select 1–16. 

MIDI Send: Sets where the MIDI data is sent. You can use this to send the MIDI data from one track to another 
track. 

Use the MIDI Monitor field to set the monitoring behavior of the track: 

Off: The track's MIDI input is not monitored, and playback of recorded events will be heard. This setting is 
useful when using keyboards with Local Control active. 

In: The track's MIDI input is always monitored regardless of the track's Record Arm state, and playback from 
recorded events will not be heard. 

Auto: The track's MIDI input is monitored when the track is record armed, and playback of recorded events will 
be heard. 

Merge: The track's MIDI input is always monitored, and playback of recorded events will be heard. 

Use the Color field to change the track color. 

Use the Transpose field to adjust the transposition amount of the track.  

Click Delete Track at the bottom of the window to remove the track. 

Click Reset Strip at the bottom of the window to reset all mixer settings for the track. 

Click Close to close the Track Settings window.  
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To select a plugin: 

1. In the Program section, click the Plugin menu to 
open the Plugin window. 

2. Use the Search bar to search for a plugin by name. 

Check the Sort By boxes for Type and/or Manufacturer 
to sort your plugins. 

Click the + or – icons to expand or contract the 
selected Plugin list. 

3. Click the desired plugin, and then click Select to load 
it, or click Close to cancel. 

Note: You have to specify the disk directory where 
your plugins are located. This can be done in the 
software’s Preferences.  
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MIDI Tracks 
 

A MIDI program lets you send your track’s MIDI data to an external MIDI device like a synth or drum machine, or to 
another MPC track.  

Note: Configure your MIDI ports in the software’s Preferences.  

 

To create a MIDI track, do either of the following in the Inspector (Click the i 
icon to show or hide the Inspector):  

• Click the MIDI-jack icon below the Track Name field, which indicates a MIDI 
track.  

• Click the + icon next to the record arm button in the Track section, or right-click 
the Track Name and select New Track, to open the New Track window. Then, 
select MIDI as the track Type. Use the Tracks field to create multiple MIDI tracks 
at the same time. 

A new MIDI track will be created and appended with a number (e.g., MIDI 002). 

 

To rename the track, double-click the Track Name field, type a name, and press 
Enter. 

 
To edit MIDI track settings, click the cog wheel icon to open the Track 
Settings window. 

Use the track name field to rename the track. Press Enter or select another field to apply the change.  

Use the Position field to change the location of the track, moving the other tracks in relation. You can also use 
the -/+ buttons at the bottom of the window. 

Use the Rec Arm field to arm (On) or disarm (Off) the track for recording.  

Use the MIDI Routing fields to edit the MIDI routing for the track: 

MIDI Input Port: Select the MIDI port from which to receive MIDI data. When set to All Ports, the track will 
receive all incoming MIDI data from any connected port. To view and edit the available ports, go to 
Preferences > MIDI / Sync. 

MIDI Input Channel: Sets the MIDI Channel from which to receive MIDI data. Select Any to receive from any 
MIDI channel, or select 1–16. 

MIDI Output Port: Select the MIDI port to send MIDI data to. To view and edit the available ports, go to 
Preferences > MIDI / Sync. 

MIDI Output Channel: Sets the MIDI Channel to send MIDI data to. Select Any to receive from any MIDI 
channel, or select 1–16. 

MIDI Send: Sets where the MIDI data is sent. You can use this to send the MIDI data from one track to 
another track. 

Use the MIDI Monitor field to set the monitoring behavior of the track: 

Off: The track's MIDI input is not monitored, and playback of recorded events will be heard. This setting is 
useful when using keyboards with Local Control active. 

In: The track's MIDI input is always monitored regardless of the track's Record Arm state, and playback from 
recorded events will not be heard. 

Auto: The track's MIDI input is monitored when the track is record armed, and playback of recorded events will 
be heard. 

Merge: The track's MIDI input is always monitored, and playback of recorded events will be heard. 

Check the Program Change box to enable program changes, and then use the MIDI Program Change field to 
enter a value from 1–127. The track will send this value when played. Once enabled, you can also select a MIDI 
bank change value by checking the Bank Change box to enable bank changes. Use the MIDI Bank MSB and 
MIDI Bank LSB fields to set the bank change values. 
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Use the Color field to change the track color. 

Use the Transpose field to adjust the transposition amount of the track.  

Click Delete Track at the bottom of the window to remove the track. 

Click Reset Strip at the bottom of the window to reset all mixer settings for the track. 

Click Close to close the Track Settings window.  
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CV Tracks 
 

A CV track lets you send your control voltage (CV) signals to an external device like a synth or drum machine that uses 
CV. There are two modes of CV operation: Melodic and Drum. 

Important: CV tracks are designed for use with an MPC model with CV outputs (e.g., MPC X). 

 

To create a CV track, do either of the following in the Inspector (Click the i icon to show or hide the Inspector):  

• Click the CV icon below the Track Name field, which indicates a CV track.  

• Click the + icon next to the record arm button in the Track section, or right-click 
the Track Name and select New Track, to open the New Track window. Then, 
select CV as the track Type. Use the Tracks field to create multiple CV tracks at 
the same time. 

A new CV track will be created and appended with a number (e.g., CV 002). 

 

To rename the track, double-click the Track Name field, type a name, and press 
Enter. 

 

To edit CV track settings, click the cog wheel icon to open the Track Settings 
window. 

Use the track name field to rename the track. Press Enter or select another 
field to apply the change.  

Use the Position field to change the location of the track, moving the other tracks in relation. You can also use 
the -/+ buttons at the bottom of the window. 

Use the Rec Arm field to arm (On) or disarm (Off) the track for recording.  

Use the Type field to select the mode of CV operation: Melodic or Drum.  

When Type is set to Melodic: 

Use the CV Port field to select the CV port the track is using. 

Use the Gate Port field to select the Gate port the track is using. 

Use the Md.Wheel/Mod Wheel field to select the CV port the modulation wheel is using.  

Use the Vel Port/Velocity Port field to select the CV velocity port. 

Use the Note/Note Tracking field to select the CV program’s note track: lowest, highest or last. 

When Type is set to Drum, click Edit Map to edit the pads’ CV assignments: 

Use the Pad field to select a pad. 

Use the To Port field to select the CV port on which the pad will send data. 

Use the Data Type field to select what kind of data the pad sends, Gate, Velocity, or Note. 

Use the MIDI Routing fields to edit the MIDI routing for the track: 

MIDI Input Port: Select the MIDI port from which to receive MIDI data. When set to All Ports, the track will 
receive all incoming MIDI data from any connected port. To view and edit the available ports, go to Preferences 
> MIDI / Sync. 

MIDI Input Channel: Sets the MIDI Channel from which to receive MIDI data. Select Any to receive from any 
MIDI channel, or select 1–16. 

MIDI Send: Sets where the MIDI data is sent. You can use this to send the MIDI data from one track to another 
track. 
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Use the MIDI Monitor field to set the monitoring behavior of the track: 

Off: The track's MIDI input is not monitored, and playback of recorded events will be heard. This setting is 
useful when using keyboards with Local Control active. 

In: The track's MIDI input is always monitored regardless of the track's Record Arm state, and playback from 
recorded events will not be heard. 

Auto: The track's MIDI input is monitored when the track is record armed, and playback of recorded events will 
be heard. 

Merge: The track's MIDI input is always monitored, and playback of recorded events will be heard. 

Use the Color field to change the track color. 

Use the Transpose field to adjust the transposition amount of the track.  

Click Delete Track at the bottom of the window to remove the track. 

Click Reset Strip at the bottom of the window to reset all mixer settings for the track. 

Click Close to close the Track Settings window.  
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Audio Tracks 
 

An audio track lets you record audio from an external source or insert audio files. 

 

To create an audio track, do either of the following in the Inspector (Click the i icon to show or hide the Inspector):  

• Click the waveform icon below the Track Name field, which indicates an 
Audio track.  

• Click the + icon next to the record arm button in the Track section, and then 
select Audio as the track Type. In this window, you can also configure the 
following settings.  

Use the Input field to select the input source of the external audio signal.  

Check the Ascending box to increment the assigned Input values when 
creating multiple audio tracks. For instance, if you create two Audio tracks 
starting with Input 1,2, the second audio track will automatically be 
assigned to Input 3,4.  

Check the Record Enable box to automatically enable the new audio 
track for recording.  

Use the Input Monitor field set how your audio track will be monitored: 

When set to Off, you will never hear any incoming audio. 

When set to In, you will hear incoming audio whether or not the track 
is record-enabled. 

When set to Auto, you will hear incoming audio while the track is 
record-enabled only. 

When set to Merge, the track's input is always monitored, and you 
will hear playback of recorded events. 

Use the Tracks field to create multiple Audio tracks at the same time. 

A new audio track will be created and appended with a number (e.g., Audio 002). 

 

To rename the track, double-click the Track Name field, type a name, and press Enter. 

 

To edit audio track settings, click the cog wheel icon to open the Track Settings window. 

Use the track name field to rename the track. Press Enter or select another field to apply the change.  

Use the Position field to change the location of the track, moving the other tracks in relation. You can also use 
the -/+ buttons at the bottom of the window. 

Use the Rec Arm field to arm (On) or disarm (Off) the track for recording.  

Use the Audio Routing fields to edit the audio routing and monitoring behavior for the track: 

Use the Monitor field to set how the audio track will be monitored. These are the same settings as above.  

Use the Audio Input field to select the input source of the external audio signal.  

Use the Audio Output field to select the output destination of the audio track. 

Use the Color field to change the track color. 

Click Delete Track at the bottom of the window to remove the track. 

Click Reset Strip at the bottom of the window to reset all mixer settings for the track. 

Click Close to close the Track Settings window.  
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Toolbar 
 

This chapter describes the available options in the toolbar at the top of the software window. 

 
 
Not all elements of toolbar are shown by default. For instance, some mode icons and transport controls are hidden. 
Furthermore, you can choose to hide parts of the toolbar that are shown.  

To select or deselect the items you want to see in the toolbar, click the menu icon (≡) in the upper-left corner 
and select View. See View > Toolbar for more information. 

 

Menu 
 
To access the software’s menu, click the menu icon (≡) in the upper-left corner 
of the window. 

macOS Users: Five items in this section appear differently on macOS than listed 
below: Exit/Quit MPC, Preferences, Check for Updates, Expansion Store, and 
About MPC are located in the MPC menu next to the apple icon (rather than the 
menus listed below). 

Tip: Several selections in the menu can be made by using computer keyboard 
shortcuts. You can see these keyboard shortcuts next to these selections in the 
menu. Go to Help > Software Information and select Keyboard Shortcuts to 
view a complete list of shortcuts within the MPC 3 software.  

 

File 

• New Project creates an empty project. Use this command when you want to start a project from scratch. 

• New From Template loads a user-defined project template. We recommend creating a project with the basic 
settings that suit your needs and saving it as a project template for easy access. See Preferences > Project 
Load/Save to learn how to set this template. 

• Load Recent provides shortcuts to the last 10 files you have been recently working with. The list is chronological 
with the most recent file at the top.  

• Save Project saves the current project. In the window that appears, name your project and select a save 
location. The samples in the Project panel will be automatically saved with the project. The project file (.xpj), and 
its information (samples, MIDI files, program files, etc.) will be saved in a folder with the same name on the same 
folder level. 

• Save Project As is identical to the Save Project function but lets you save the current project with a new name.  

• Save Current Track saves only the current track (.xtc). 

• Save Current Program saves only the current track’s program (.xpm). 

• Export lets you export your project or sequence data in various formats: a single project archive file, MPC 
formats, a standard MIDI file, or as an audio mixdown file. Select the desired option from the sub-menu.  

o As MPC Sample file exports the current drum track as a file that can be loaded into the MPC Sample. 
All rendered samples will be loaded to the MPC Sample pads, and note events will be imported as 
sequence data. This function works on a single drum track at a time.  

o As Audio Mixdown exports the sequence or song as an audio file. See the Export > Audio Mixdown 
chapter for more information about this process. If you are in Song Mode, it will affect the entire song. If 
you are in any other mode, it will affect the current sequence only. 

o As Ableton Live Set exports the current sequence as an Ableton Live Set (.ALS) file. See Export > 
Ableton Live Set Export for more information. 

• Exit closes the software. (On macOS, this is named Quit MPC and is located in the MPC menu next to the apple 
icon.) If you have not saved any changes made to a currently open project, it will prompt you to do so before 
quitting. 
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Edit 

• Undo undoes the last action you performed. When there are no actions left to undo, this command will be 
unavailable and appear grayed out.  

• Redo undoes the Undo command. You can continue redoing actions until there are no items left to redo, in 
which case, the Redo command will be unavailable and appear grayed out.  

Important: If you perform a new action when the Redo command is available, you will no longer be able to redo. 
In other words, as soon as you perform an editing action other than Undo, Redo is no longer available. 

• Undo History lets you view a list of previously executed commands in the Undo History panel. As you undo and 
redo commands, you can see your current “position” in the list of commands in the window. 

Tip: To revert to a previous “state” in your project, click and drag the point just after the last step. Any “undone” 
steps will be grayed out. You can do the same to redo grayed-out steps, as well. 

• Cut removes selected events from the grid and copies it to the clipboard. After cutting events, you can paste or 
insert them at another location in the same or another sequence. 

• Copy copies selected events from the grid to the clipboard without removing them. After copying events, you 
can paste or insert them at another location in the same or another sequence. 

• Paste lets you paste the contents of the clipboard at the position marker’s current location. 

• Nudge Event Left/Right by TC shifts the selected event/events left or right (respectively) by the time division set 
in the Time Correct settings. 

• Nudge Event Left/Right by Tick shifts the selected event/events left or right (respectively) by one tick. 

• Time Correct displays options for using time correct (quantization): 

o Apply quantizes the currently selected note events. If no note events are selected, nothing will be quantized. 

o Settings opens the Time Correct window where you can configure its settings. See the Time Correct 
chapter for more information about this. 

• Humanize applies randomization to the timing, length, and/or velocity of MIDI events. See Other Functions and 
Tools > Humanize for more information about this. 

• Pitch Quantize forces the pitches of note events on a MIDI track into a specific scale. See Other Functions and 
Tools > Pitch Quantization for more information about this. 

• Audio Region provides options related to editing the current audio track region: 

o Duplicate copies and pastes the track region immediately after the original one. 

o Mute silences the track region. 
o Reverse reverses the track region. 
o Warp lengthens or shortens the track region without changing its pitch. 

Note: Warp algorithms are very CPU-intensive and can result in audio drop-outs during playback if used 
too freely. Be mindful of how (and how often) you use the warp function. 

• Sequence provides options related to editing the current sequence. See Editing Processes > Track for more 
information about many of these functions. 

o Clear All erases all note events from the current sequence and resets all of its settings. After selecting 
this, click Clear All to confirm your choice or Cancel to cancel it. This operation cannot be undone. 

o Clear Events only erases all note events from the current sequence. After selecting this, click Clear 
Events to confirm your choice or Cancel to cancel it. This operation cannot be undone. 

o Half Length will immediately halve the length of the sequence (without deleting any note events). 

o Double Length will immediately double the sequence and copy all events from the first half to the 
second half. 

o Insert Blank Bars adds empty bars to a sequence at a specified point.  
o Delete Bars removes a range of bars from a sequence. 
o Copy Bars copies a range of bars from a sequence and adds them to another at a specified point.  
o Copy Events copies a range of events from a sequence and add them to another at a specified point. 

See Editing Processes > Sequence for more information. 
o Copy Sequence copies the contents of one sequence to another.  

o Copy Track copies the contents of one track to another.  
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o Transpose transposes a range of events on a track in a sequence.  
o Erase erases all or part of a track in a specific sequence.  
o Loop Cut removes selected events from the grid between the loop brace and copies it to the clipboard. 
o Loop Copy copies selected events from the grid between the loop brace to the clipboard without 

removing them. After copying events, you can paste or insert them at another location in the same or 
another sequence. 

o Loop Paste (Merge Time) lets you paste the contents of the clipboard at the loop brace’s current 
location, merging new events with the existing events. 

o Loop Paste (Insert) lets you paste the contents of the clipboard at the loop brace’s current location, 
shifting all subsequent not events to after the end of the loop brace. 

o Loop Duplicate immediately duplicates the contents between the loop brace directly after the loop 
brace’s current location.  

o Loop Clear immediately clears all note events between the loop brace.  
o Loop Delete immediately deletes the bars, including all contents, between the loop brace.  
o Loop Insert Blank Bars immediately inserts empty bars equal to the length of the loop brace, shifting all 

subsequent note events directly after the loop brace’s current location.  
o Insert Clip Row opens the Insert Clip Row window, where you can select an existing clip row from your 

project and insert its contents at the current playhead position. See Modes > Arrange Mode for more 
information. 

o Events Double Speed immediately halves the lengths of all note events on all tracks in the sequence as 
well as the distance between them. In other words, all tracks’ notes are pressed closer together so the 
sequence sounds like it is playing at twice the previous speed. This does not actually affect the pitches 
of notes or the tempo. 

o Events Half Speed immediately doubles the lengths of all note events on all tracks in the sequence as 
well as the distance between them. In other words, all tracks’ notes are spread further apart so the 
sequence sounds like it is playing at half of the previous speed. This does not actually affect the pitches 
of notes or the tempo. 

o Next Sequence selects the next sequence. If you select this during playback, the next sequence will be 
selected when the current one is done playing. 

o Previous Sequence selects the previous sequence. If you select this during playback, the previous 
sequence will be selected when the current one is done playing. 

o Next Sequence Now selects the next sequence immediately. 

o Previous Sequence Now selects the previous sequence immediately. 

o Export as MIDI lets you export the current sequence as a standard MIDI (.mid) file.  

o Bounce to Sample immediately renders the sequence (all of its tracks) as an audio sample (.wav) and 
places it in the project’s sample pool. By default, it will be named Bounce - and appended with the 
sequence name. If you have already used this function on this sequence, then it will create another audio 
sample appended with the next-highest number. 

o Bounce to New Audio Track immediately renders the sequence (all of its tracks) as an audio track (.wav) in 
the project. The Audio tab will be automatically selected. By default, the sample will be named Bounce - and 
appended with a number. This function does not work for tracks that use MIDI programs or CV programs. 

• Track provides options related to editing the current track. See Editing Processes > Track for more information 
about many of these functions. 

o Select All selects all events or audio track regions in the entire track. 

o Deselect deselects all events or audio track regions in the entire track. 

o Duplicate immediately creates an identical track. The duplicate track will use the same name but 
appended with a number (e.g., Plugin 001-1). 

o Track Settings opens the Track Settings window for the selected track. See General Features > 
Tracks to learn more about the Track Settings for each track type.  

o Merge Pads lets you merge samples and settings from two drum tracks together.  

o Merge Tracks lets you copy the pads (and their parameters) from one track into another, essentially 
consolidating two tracks into one.  

o Copy Pad opens the Copy Drum Pads window, which lets you copy a pad, bank, or range of pads from 
one Drum track to another.  
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o Copy Pads opens the Copy Pad window, which lets you copy a pad to one or more pads on the same 
track.  

o Delete erases the track from the project. The samples used in that track will remain in the project’s 
sample pool and any other tracks that use them. 

o Clear Arrangement erases all note events or audio from the current track. 

o Rename lets you rename the track.  

o The Explode function (available for Drum Tracks only) immediately breaks down a Drum track containing 
samples and events into multiple new tracks, making it easier to mute individual drum elements using 
Track Mute Mode. Each new track will keep the pad and track insert effects of the original source track. 
Where pads with events are assigned to a mute group, those pads are copied to a single track. 

o The Events Double Speed function immediately halves the lengths of all note events on the track as 
well as the distance between them. In other words, the track’s notes are pressed closer together so the 
track sounds like it is playing at twice the previous speed. This does not actually affect the pitches of 
notes or the tempo. 

o The Events Half Speed function immediately doubles the lengths of all note events on the track as well 
as the distance between them. In other words, the track’s notes are spread further apart so the track 
sounds like it is playing at half of the previous speed. This does not actually affect the pitches of notes or 
the tempo. 

o Split Events divides all notes or the selected notes into multiple parts. 

o Next Track selects the next track. 

o Previous Track selects the previous track. 

o Export as MIDI lets you export the current track as a standard MIDI (.mid) file. See Editing Processes > 
Sequence for more information. This cannot be used on audio tracks. 

o Refresh Samples Metadata option opens the Refresh Samples Metadata window, where you can 
refresh the samples in a selected program to update the associated file information. 

o Tidy Keygroup Sample Names automatically renames all samples belonging to a keygroup based on 
their keygroup, layer, and other information. This option is available only for keygroup programs. 

o Pad Color opens the Pad Color window where you can assign specific colors to your pads in each 
program. See Pad Color for more information. 

o Note Mapping opens the Note Mapping window where you can assign a MIDI note to each pad in a 
program. 

o Flatten Pad renders all samples on a pad as an audio sample and places it on the first layer of that pad.  

o Previous Preset and Next Preset select presets when using a plugin program. 

o Save Plugin Preset… saves the current preset when using a plugin program. 

o Load Plugin Preset… lets you select a saved preset when using a plugin program. 

 

Preferences opens the Preferences window, which contains many customizable elements of the software. (On 
macOS, Preferences is located in the MPC menu next to the apple icon.) Click the corresponding tab on the left to 
select it (e.g., MIDI, Sequencer, etc.). Click the OK button to close the Preferences window. Preferences are 
automatically saved. See the following Preferences chapter for more information about this. 
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Tools 

• Metronome 

o Count-In enables or disables the metronome pre-count before recording. 

Off disables the metronome pre-count. 

Record enables the pre-count during recording only. 

Record + Play enables pre-count in both Record and Playback Modes. 

o Enable offers the settings for the metronome. 

Off disables the metronome. 

Play enables the metronome sound during playback only. 

Record enables the metronome sound during recording only. 

Record + Play enables the metronome to happen in both Record and Playback Modes. 

o Rate lets you select the metronome click’s time division: 1/4, 1/4T, 1/8, 1/8T, 1/16, 1/16T, 1/32 or 1/32T 
(T indicates a triplet-based time division). 

o Sound lets you select the sound that you want to hear for the metronome: Sidestick 1, Sidestick 2, 
Clap, Metroclick, Shake, Tambourine, Cowbell, or MPC Click. 

o Output lets you set where the metronome signal will be heard: a pair of main outputs (Out 1,2–31,32) or 
a single main output (Out 1–32). 

• 16 Level opens the 16 Levels window. See Other Functions and Tools > 16 Level for more information. 

• Arpeggiator opens the Arpeggiator window, a fully featured arpeggiator and phrase player for melodic program 
types. See Other Functions and Tools > Arpeggiator for more information. 

• MIDI Keys enables or disables the use of your computer keyboard to enter or play a range of 17 MIDI notes, 
starting from a C. This is the same as using the Keyboard button in the toolbar. 
On standard US/American computer keyboard, use the A, S, D, F, G, H, J, K, L, and ; keys to play the white 
keyboard keys, and use the W, E, R, T, Y, U, I, O, and P keys to play the black keyboard keys. Press [ or ] to 
shift the range of playable notes up or down (respectively) by one octave. 

If the MIDI keyboard is shown, the corresponding computer keyboard character will be shown above each key 
(though you can still use MIDI keys even if it is hidden). 

Enabling MIDI Keys disables Pad Keys. 

Tip: Show the MIDI keyboard to visualize the keys in a traditional piano keyboard. See Panels > MIDI Keyboard 
to learn about this. 

• Pad Keys enables or disables use of your computer keyboard to play the 16 pads of 
the current pad bank. This is the same as using the Keyboard button in the toolbar. 
On a standard US/American computer keyboard, use the keys as follows: 

the Z, X, C, and V keys play Pads 01, 02, 03, and 04 

the A, S, D, and F keys play Pads 05, 06, 07, and 08 

the Q, W, E, and R keys play Pads 09, 10, 11, and 12 

the 1, 2, 3, and 4 keys play Pads 13, 14, 15, and 16 

Enabling Pad Keys disables MIDI Keys. 

• Delete Unused Samples deletes any samples not assigned to a pad from the project.  

Important: The samples will be deleted immediately from the project. The software will not ask for confirmation or 
allow you to cancel, but you can undo this action (i.e., with the Undo command or hardware button), if needed. 

Tip: You can delete unused samples by clicking the trash can icon in the upper-right corner of the Project 
panel, as well. 

• Tuner opens the built-in tuner for checking the pitch of an instrument connected to an audio input.  

Use the Input field to select the input for the instrument you would like to tune. 

Use the Frequency field to set the base tuning frequency. 

Play a note and use the indicator to adjust your instrument to the correct pitch. 

To close the tuner screen, click Close or anywhere outside the window. 
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• Auto Sampler opens the Auto Sampler window which lets you capture and convert any plugin preset or 
external instrument preset into a keygroup sampler patch. See Other Functions and Tools > Auto Sampler for 
more information about this.  

• Generate Random Events lets you create random melodic or drum patterns on the current MIDI track. See 
Other Functions and Tools > Generate Random Events for more information about this. 

• Convert To Progression opens the Convert Track to Progression window that automatically detects the 
chords that are played on the currently selected track, which you can save as a chord progression. See Other 
Functions and Tools > Convert To Progression for more information about this. 

• Current Sample To Keygroup immediately converts a selected drum sample to a new keygroup program on a 
new track. 

• Rebuild Media Browser Database resets and rescans your Media Browser. See Browsers > Media Browser 
to learn more about the Media Browser. 

• Retrospective Record immediately captures recently played MIDI events and adds them to the current track. 

• Record Config opens the Record Configuration window. 
o Check the Write automation when recording box to set automation to always write when recording.  
o Use the Record Arm field to set the arming behavior of the Rec Arm buttons. When set to Single, MPC 3 

automatically record arms the current track when changing tracks and disarms any others. When set to 
Multi, MPC can record arm multiple tracks at the same time. 

When using Single Record Arm, it is still possible to record arm multiple tracks using the Channel Mixer. 

• Stop All Sounds immediately stops all sounds within the software. 

• Plugin Manager opens the Plugins window which contains a list of all available plugins, based on your selected 
plugin folders. This is the same as clicking the gear icon in the lower-left corner of the effect selection menu. 
See the Plugins chapter to learn about this. 

• Expansion Manager opens the Expansions window which contains a list of your MPC expansions. See the 
Expansions chapter to learn about this. 

 
 
View 

• Mode lets you select from any of the available software modes. See Modes to learn about these. 

• Q-Link Mode lets you select from any of the five edit modes for the Q-Link knobs. See Panels > Q-Links to learn 
about these. 

• Workspace lets you adjust what is shown in the MPC interface, allowing you to prioritize Simple or Advanced 
feature sets. 

• Toolbar lets you select or deselect the items you want to see in the toolbar at the top of the window. This 
includes the Mode Icons, the Timing Controls, the Transport Controls, and overall Status indicators. 
The Toolbar Modes submenu lets you select or deselect each mode icon. Selected ones will be shown in the 
toolbar. You can also select All to show all of them or Default to show the default ones (which we find are the 
most often used). 

• Inspector lets you select or deselect the items you want to see in the Inspector on the left edge of the window. 
This includes the Inspector itself (Show Inspector), send effect knobs on the channel strips (Sends), and insert 
effect slots on the channel strips (Inserts). You can also select which channel strip you want to display: the pad 
channel strip (Pad Channel), or the track channel strip (Track Channel). See Inspector to learn more about this. 

• Browser lets you select or deselect options that determine how the Browser is shown on the right edge of the 
window. You can hide or unhide the Browser (Hidden); show the File Browser, Expansion Browser, Media 
Browser, MIDI Learn Browser, or MIDI Monitor; Project Information Browser, Project Notes Browser, or 
Undo History Browser; show the Quick Help panel; or allow the Media Browser to show all tags. See Browser 
to learn more about this. 

• Editor lets you select or deselect options that determine how the editor is shown in the top half of the window. 
You can show or hide the bottom panel (this is the same as clicking the two-panels icon in the lower-left corner 
of the main software window); show or hide the automation lane under the Grid Editor; or switch between the 
Grid Editor, Wave Editor, or List Editor (when each option is available, depending on the mode). 
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• Show Mixer Window opens the Mixer Window, which allows you to view the Pad Mixer and the Channel Mixer 
at the same time. 

• Show MIDI Keyboard shows or hides a piano keyboard at the bottom of the window. You can use these keys to 
play or enter notes. See Panels > MIDI Keyboard to learn about this. 

• Zoom In Horizontally At Playhead and Zoom Out Horizontally At Playhead zoom horizontally into or out of 
the Grid Editor or Wave Editor (respectively) while keeping the audio playhead or last-moved marker at the 
center. 

• Zoom In Vertically and Zoom Out Vertically zoom vertically into or out of the Grid Editor or Wave Editor 
(respectively). 

• Minimize minimizes the MPC 3 software window. 

• Full Screen expands the MPC 3 software window into a full-screen mode. 

 

 

Help 

• Search (macOS only) allows you to find results for specific search terms, which you can enter in this field.  

• Quick Help shows or hides the Quick Help panel in the lower-right corner of the window under the Browser. 
This is the same as going to View > Browser > Quick Help or clicking the ? icon in the lower-right corner of the 
window. This panel is visible only when one of the Browsers is shown. 

• Keyboard Shortcuts opens a window with a list of all available keyboard shortcuts to execute various actions in 
the MPC 3 software. 

• MPC Help lets you open the user manual PDFs for the MPC 3 software as well as the different types of MPC 
hardware that can control the MPC 3 software. 

• Software Information lets you open various items specific to this MPC 3 software: the release notes PDF for 
this version of the MPC 3 software (MPC Release Notes); the user manual PDF for Hybrid 3 (Hybrid 
Instrument). 

• Set Up Guides lets you open a PDF with instructions on how to set up MMC control in this software (MMC Control). 

• Check for Updates checks online for any available updates to the MPC 3 software. (On macOS, Check for 
Updates is located in the MPC menu next to the apple icon.) You must have an internet connection to use this 
feature. 

• Deactivate License allows you to deactivate MPC 3 software authorization on the current device from your inMusic 
Profile, and log you out of your account. Click Log Out to continue, or Cancel to return to the MPC 3 software. You 
can reauthorize the MPC 3 software by opening it again, logging into your account, and activating it on your device.  

• Expansion Store opens an online store of available MPC Expansions on the Akai Professional website. (On macOS, 
Expansion Store is located in the MPC menu next to the apple icon.) You must have an internet connection to use 
this feature. 

• About MPC opens a window with information about this MPC 3 software. (On macOS, About MPC is located in 
the MPC menu next to the apple icon.) 
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Mode Icons 

 

The mode icons let you select the current software mode. 

 

Main Track Edit Pad Mixer Step Seq. Looper Track Mute Song 

Arrange Sample Edit Channel Mixer Sampler Pad Mute Next Sequence MIDI Control 

 

Click a mode icon to enter its corresponding mode. 

Click the down arrow () to show a menu of all modes, and click a mode to enter it. 

 

 

Timing Controls 

 

Click the metronome icon at the top of the window to enable or disable the metronome. 

Click and drag the Metro meter at the top of the window to set the volume of your 
metronome click. 

The Metronome menu contains all settings regarding the metronome (click track). 

To view the metronome settings, click the menu icon (≡), select Tools, and click 
Metronome. See Metronome for more information about this. 

 

Click the TC icon to enable or disable Timing Correct. 

Click the TC field to set the quantization value. Note events will “snap” to these time 
divisions on the grid. The T indicates a triplet-based value. 

Click the Swing field to set the amount of swing from 50% to 75%. Swing lets you “shuffle” 
your beats—from subtle to extreme. 

The Timing Correct window contains all settings to help quantize events in your sequence. 

To open the Timing Correct settings, click the menu icon (≡), select Edit, select Time 
Correct, and click Settings…. See Time Correct for more information about this. 

 

The time counter indicates the current playhead position. 

To adjust the position, click and drag each field up or down. 

To switch the time increments, click the note icon or stopwatch icon. 

When set to Beats (note icon), the time is shown in Bars, Beats, and Ticks. 

When set to Time (stopwatch icon), the time is shown in hours (HH), minutes (MM), 
seconds (SS), and frames (FF). 

 

Click the Sync field to determine whether the MPC 3 software receives MIDI Clock 
information (MIDI Clock), MIDI Time Code information (MTC), communication from 
Ableton Link, or none of these (Off). This is the same setting as the Receive menu in Sync 
tab of your Preferences. See Preferences for more information. 

Note: Audio recording is disabled when receiving MIDI Clock sync. 

Note: Ableton Link is a new technology that synchronizes beat, phase and tempo of 
Ableton Live and Ableton Link-enabled applications over a wireless or wired network. 

 

The MIDI monitor indicates incoming MIDI events. 
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Use the BPM field to adjust the tempo of the sequence. Click and 
drag it up or down, or double-click it, type a value, and press Enter. 
Alternatively, click Tap at the desired rate; the software will 
automatically detect the tempo.  

Click the Seq/Gbl button to set whether each sequence follows its 
own tempo (Seq) or a global tempo (Gbl). 

 

 

Transport Controls 

 

Click Record () to record-arm the sequence. Click Play () or Play 
Start (|) to start recording. Recording in this way (as opposed to 
using Overdub) erases the events of the current sequence. After the 
sequence plays through once while recording, Overdub (⊕) will be 
enabled. 

 

Click Overdub (⊕) to enable Overdub. When enabled, you can record 
events in a sequence without overwriting any previously recorded 
events. You can enable Overdub before or during recording. 

 

Click Retrospective Record to immediately capture recently played 
MIDI events and add them to the current sequence at the playhead. 
This is useful for capturing performances when Record was not 
enabled. 

 

After you record-arm the track and start playback, click Record 
from Sequence Start to start recording once the sequence loops 
back to its start. This is essentially a punch-in feature for the entire 
track, enabling you to start playing a record-armed track while 
allowing more time than the usual count-in to prepare for the actual 
recording to start. 

 

Click Punch In to enable or disable the Punch In feature, which 
enables you to record over a specified length of time in the track. 
While recording, the entire sequence will play, but you will record 
over only the area between the Punch In and Punch Out markers, 
indicated by a red striped line below the timeline. Any part of the 
sequence before the Punch In marker or after the Punch Out marker 
will remain untouched, even if you perform over it during recording. 

 

Click Stop () to stop playback. Alternatively, press the space bar. 
You can double-click this button to silence audio that is still 
sounding once a note stops playing. Quickly clicking this button 
three times will act as a “MIDI panic” and shut off all voices and stop 
all audio processing.  

 

Click Play () to play the sequence from the playhead’s current 
position. 

 

Click Play Start (|) play the sequence from its start point. 
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Status 

 

The In and Out boxes indicate the MPC 3 software is receiving or sending 
(respectively) MIDI messages from or to your MPC hardware. 

 

The CPU meter shows the software’s current usage of your computer’s CPU. 

 

The automation button indicates the global automation state. See Automation to 
learn about this. 

 

Use the Auto-Scroll selector to set how the editor behaves relative to the audio 
playhead. 

Follow: Depending on the zoom setting, the editor will scroll along in the 
background while keeping the audio playhead centered. 

Page: The editor will move to the “next page” to follow the audio playhead. 

Off: The editor will not move at all. 

 

Click the Keyboard button to cycle through three options: 

Off: Pad Keys and MIDI Keys are off. Your computer keyboard will work 
normally. 

Pad Keys: Pad Keys is on, enabling your computer keyboard to play the 16 
pads of the current pad bank. See Menu > Tools > Pad Keys to learn about 
this. 

MIDI Keys: MIDI Keys is on, enabling your computer keyboard to enter or play a 
range of 17 MIDI notes, starting from a C. See Menu > Tools > MIDI Keys to 
learn about this. 

 

The volume meter shows the software’s main output level. Click and drag the volume 
slider to adjust it.  

 

The user area is active when you are logged into your inMusic profile.  

Click Log Out to log out of your profile. This will also release all activations on 
the current device. 

Click My Activations to access your downloads and manage your account. See 
Preferences > Activations for more information. 
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Preferences 
 

The Preferences window contains many customizable elements of the software. Click the corresponding tab on the left to 
select it (e.g., MIDI, Sequencer, etc.). Click the OK button to close the Preferences window. Changes to the Preferences 
are saved automatically except for Vintage Mode (in the General tab) and Start Time (in the MIDI / Sync tab). 

To open the Preferences: 

Windows: Click the menu icon (≡), select Edit, and click Preferences. 

macOS: Click the MPC menu, and click Preferences. 

 
Audio Device 

Audio Device Type and Device or Output & Input: Click these drop-down menus to select an audio hardware 
driver in your computer system. 

Test: Click this button to play a test tone. This is for checking your audio output. Careful! You should lower the 
volume on your audio system beforehand. 

Sample Rate: Click this drop-down menu to select the desired sample rate for your project. This depends on the 
available sample rates of the type of MPC hardware you are using or of your audio interface (i.e., select 96000 Hz 
only if your interface allows a 96 kHz sample rate). 

Audio Buffer Size: Click this drop-down menu to set your audio system’s latency. Lower values result in a more 
immediate playing response but also more CPU consumption. If you are working with larger projects, this may 
cause audible clicks and pops. Higher values are more CPU-friendly but can produce more delay between 
pressing a pad and hearing the corresponding sound. The ideal audio buffer size also depends on your 
computer’s CPU performance. Experiment with this to find the best setting for your system. 

Latency Adjust: This indicates the amount of latency (delay) in your audio system. 

 
Audio/Export 

The settings on this screen determine the parameters for recording and exporting. 

Enable Disk Streaming: This determines whether disk streaming is enabled or disabled. MPC will require a 
restart after disk streaming is enabled or disabled, which may require you to save or discard changes to the 
current project. Once enabled, a sample can be set to stream from disk or memory using the Project window. By 
default, Drum and Keygroup samples are loaded into memory, as this works better for on-demand, rapid 
triggering of multiple, simultaneous voices. 

Note: Disk streaming relies on the performance of the disk you are streaming from. For best operation, it is 
recommended to use an SSD (solid-state drive). Once you have saved a project to your SSD, your files will 
stream from that location. For an unsaved project, your MPC 3 software uses a temporary file location from 
which to stream audio files. Go to Preferences > Project Load/Save and set the Temporary File Location to 
your SSD for best results.  

Recording Bit Depth: This determines bit depth of the audio recorded from a sample.  

Bounce Bit Depth: This determines bit depth of the audio file that is exported when you click the Export Audio 
icon: 16-bit or 24-bit. 

Audio Export: This determines what part of the sequence is exported when you click the Export Audio icon. 

Track: When this is selected, Export Audio will export the currently shown track in the current sequence. 

Program: When this is selected, Export Audio will export all tracks in that sequence that use the currently 
shown program. 

Main: When this is selected, Export Audio will export all tracks in that sequence that use programs routed to 
the main outputs. 

Audio Tail Length: This determines the length of an audio tail (silence) that will be applied to the exported audio 
file. When set to 0, the audio file will not have any additional audio tail. 

Include Track Volume/Pan Settings: When enabled, the exported audio or MIDI file will include its volume and 
pan settings. When disabled, the volume and pan settings will be set to 0 dB and center (C), respectively. 

Bypass Program Effects Plugins: When enabled, the exported audio or MIDI file will include any third-party 
effect plugins that are used with it, but those effects will be bypassed (deactivated). When disabled, those effects 
will be activated. 
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MIDI Export: This determines what part of the sequence is exported when you click the Export MIDI icon. 

Track: When this is selected, Export MIDI will export the currently shown track in the current sequence. 

Sequence: When this is selected, Export MIDI will export all tracks in the current sequence. 

Audio Warp Algorithm: This determines the default time-stretching algorithm, which determines how a sample 
is “warped” when you adjust the length of a sample (e.g., the Warp function in Audio Region Edit Mode for audio 
tracks or in Track Edit Mode for Drum/Keygroup tracks). Select Elastique Pro, Pro Ten or Repitch. When using 
Repitch, warping an audio sample will adjust its pitch to synchronize it with the MPC tempo. You can override 
the default algorithm by selecting another option in Track Edit Mode or by changing the algorithm in the Audio 
Editor.  

Note: Warp algorithms can be very CPU-intensive, and can result in audio drop-outs during playback if used too 
freely. Be mindful of how (and how often) you use the warp function.  

Audio Track Auto Warp: This determines how recorded audio track regions are warped. When set to On, any 
audio track region that you record will be warped automatically to match the current sequence tempo. You can 
then adjust the sequence tempo while the audio track region remains in time. 

Note: When you record an audio file, the current sequence tempo will be embedded with it. This information is 
stored within the sample file when you save the project. When you warp an audio track region, the warping 
algorithm uses this sequence tempo and the current value in the BPM field to generate the “stretch factor.” 

BPM Auto Detection: This enables automatic detection of BPM from loaded samples. 

BPM Detection Range: This defines the range of detectable BPM values when you use any automatic BPM 
detection function in the software or when you press the Tap Tempo button to enter a new tempo. 

 

MIDI / Sync 

The settings on this screen determine how the MPC 3 software sends, receives and synchronizes with connected 
USB and MIDI devices. 

Input Ports: This indicates the available installed MIDI Input ports on your computer system and any connected 
devices. Next to each port are three options: 

Global: Enable this option to always send incoming MIDI data from this port to the current track. 

Control: Enable this option to send incoming MIDI data from this port to MIDI Learn. 

Track: Enable this option for this MIDI port to appear in the list of available track MIDI inputs. 

Output Ports: This indicates the available MIDI Output ports. Next to each port are two options: 

Sync: Enable this option to send MIDI Clock or MTC information over this output port, based on the Sync 
Output setting. 

Track: Enable this option for this MIDI port to appear in the list of available track MIDI outputs. 

Click the reset arrow to reset the MDI Input/Output Port settings. Double-click the port name to rename it.  

Enable MIDI ports when discovered: When enabled, the Track ports are automatically turned on when a MIDI 
device is plugged in so it can immediately be selected as an input or output. 

MIDI Machine Control (MMC) Receive: When enabled, the MPC 3 software will be able to receive MIDI 
Machine Control (MMC) information. When disabled, the MPC 3 software will not receive this information. 

Ableton Start/Stop Sync: When enabled, the MPC 3 software will sync with Ableton Link to synchronize the 
beat, phase and tempo of Ableton Live and Ableton Link-enabled applications over a wireless or wired network. 

Sync Receive: This determines whether the MPC 3 software receives MIDI Clock information (MIDI Clock), MIDI 
Time Code information (MIDI Time Code (MTC)), communication from Ableton Link, or no synchronization 
information (Off). 

Important: Audio recording is disabled when receiving MIDI Clock sync. Use MIDI Time Code to record audio 
while receiving MIDI sync.  

MIDI Machine Control (MMC) Send: When enabled, the MPC 3 software will be able to send MIDI Machine 
Control (MMC) information. When disabled, the MPC 3 software will not send this information. 

Sync Output: This determines whether the MPC 3 software sends MIDI Clock information (MIDI Clock), MIDI 
Time Code information (MIDI Time Code (MTC)), or neither (Off). 

MTC Frame Rate: This determines the frame rate used by MIDI Time Code (MTC), which is important for correct 
timing, especially when working on film scoring projects: 24, 25, 30 drop, or 30 non-drop. In most cases, you 
should select 25. 
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Start Time: This is the starting time that will be sent when Sync Output is set to anything other than Off. The 
time is formatted in hours:minutes:seconds:frames. 

Filter ‘All Notes Off’ CC: When enabled, “All Notes Off” (“MIDI panic”) messages will be ignored. This is useful if 
you are using an external MIDI device that can send these types of messages but you want to filter them out. 
When disabled, “All Notes Off” messages will be received normally.  

Program Change: This determines what an incoming MIDI program change message will change: a Program, 
Sequence, or Track. 

 

Activations 

If you have purchased an MPC instrument or effect plugin, use this screen to activate your purchase. You can 
activate purchases on up to three devices. 

Note: Activation requires an internet connection. 

 
To activate plugins: 

1. Click the Log In button to sign into your inMusic Profile through a browser. If you do not already have an 
account, you will be prompted to create one.  

2. Once you have been logged in, you can try out plugin instruments through a free trial, or activate your 
purchases. 

To register a purchase, use the Enter Serial field to enter your serial number and then click Register. 

To refresh the page with your latest purchases or activations, click Refresh.  

To sort this list of purchases or activations, tap the All, Instruments, FX, or Features categories at 
the top of the list.  

To start a trial, click the Get Trial button next to the desired plugin. 

To activate a plugin on your computer, click the Activate button next to its name. Click Deactivate to 
remove the plugin activation from your computer.  

To download a purchase to your device, tap the download icon to begin downloading the plugin to your 
computer. The download icon will change to show the installation progress. Once the process is complete, 
you can use your plugin with MPC. 

To log out of your account, click Log Out. All plugin activations associated with your device will be 
released and will need to be reactivated if you log back in. 

 

Plugins 

Here you can select up to four locations on your hard disk where the software will look for installed VST or AU 
plugins that you can use in the MPC 3 software. 

Click the … button to the right of the field to select a desired location. After selecting a new location, we recommend 
using the Scan New function. When you configure these Plugin tab settings for the first time, you should click 
Rescan All to perform a complete scan of all selected plugin locations. 

See the Plugins chapter to learn about managing your plugins once they are scanned. 

 

Sequencer 

The settings on this screen determine how sequencing works in Grid Editor and in the Step Sequencer. 

Track Mute State Per Sequence: When enabled, you can maintain separate track mute statuses when 
changing sequences. This can allow you to create unique mute setups for each sequence, providing greater 
flexibility in live performance and arrangement creation. 

Instant MIDI Track Mute: When disabled, if you mute a MIDI track, its Note On messages will be ignored, and 
samples and notes that are playing will finish playing their entire length (this is how legacy MPCs’ track-muting 
worked). This is useful if you are using loops and want a loop to play to the end of a bar but not play the next 
time the sequence loops. When enabled, if you mute a track, the MIDI track volume (0) will be sent. The loop will 
continue to play but at zero volume, allowing the loop to continue playing when the track is unmuted. This is 
useful when you want to have the track muted immediately. 

Instant Audio Track Mute: When disabled, if you mute an audio track, it’s audio will continue playing for the 
length of the current sample. When enabled, the audio will be muted immediately. 
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Rec Arm: This determines the behavior of the Record Arm buttons. When set to Single, selecting a different track 
will automatically arm that track and disarm all other tracks. This is the default mode and it is the same as previous 
MPC releases. When set to Multi, you can tap any track's record button to add it to the group of armed tracks. 

Solo: This determines the behavior of the Solo buttons. When set to Single, only one track can be soloed at a 
time by default. However, you can still press and hold Shift to solo multiple tracks at the same time. When set to 
Multi, you can solo multiple tracks at the same time by default.  

Record Track Mute Events: When enabled, track mute events are recorded when you are in Track Mute Mode 
(timing correct settings will affect the recorded position events). When disabled, track mute events will not be 
recorded while in Track Mute Mode. This feature is useful if you want to use Track Mute Mode to record track 
mutes into your sequences as opposed to using Track Mute Mode for performance or listening purposes only. 

Track Mute Events Write Automation: When enabled, track mute events can be captured when writing 
automation. Make sure the global automation button is set to W (write) before recording to capture track 
automation. When disabled, these events cannot be recorded with automation. 

Track Mute and Solo Events Are Undoable: When enabled, track mutes and solos can be undone and will 
appear in the Undo History. When disabled, these actions will not be affected by pressing undo. 

Track Mute Uses Track Colors: When enabled, each track’s color will be applied to the respective pads in 
Track Mute Mode. When disabled, track mute pad colors are always yellow (unmuted) and red (muted). 

Pad Mute and Solo Events Write Automation: When enabled, pad mute and solo events can be captured when 
writing automation. Make sure the global automation button is set to W (write) before recording to capture pad 
automation. When disabled, these events cannot be recorded with automation. 

Pad Mute and Solo Events Are Undoable: When enabled, pad mutes and solos can be undone and will appear 
in the Undo History. When disabled, these actions will not be affected by pressing undo. 

Pad Mute Uses Track Colors: When enabled, each pad’s color will be applied to the respective pads in Pad 
Mute Mode. When disabled, pad mute pad colors are always yellow (unmuted) and red (muted). 

Record Pad Aftertouch Events: When enabled, pad aftertouch data (from your MPC hardware’s pressure-
sensitive pads) will be recorded. When disabled, pad aftertouch data will be ignored. 

Record Pad XY Events: When enabled, XY data from the MPCe pads will be recorded. When disabled, XY data 
will be ignored. 

Place Events Recorded During Count-In at Start Point: When enabled, pressing a pad during the recording’s 
pre-count will record that note event at the start of the recording (this is how the MPC3000 worked). When 
disabled, no notes will be recorded until the pre-count is finished and recording has begun. 

Note: This setting is ignored when recording with the Arpeggiator active. 

Truncate Duration: This determines if/how events are cropped if they exceed the length of the current Sequence 
when recording: 

To Sequence Length: If the length of an event exceeds the length of the sequence, it will be truncated. This 
ensures that the event will not overlap itself when the sequence loops. 

To Sequence End: If an event exceeds the length of the sequence, it will be truncated to the end of the 
current sequence. In other words, the event will stop playing when the sequence ends or loops. 

As Played: Events will play back exactly as they were recorded, even if they overlap themselves when the 
sequence loops. 

For example, if you record a note starting on the second bar of a 4-bar loop 
and hold it for 5 bars, the note would end: at bar 7 (As Played), at bar 6 (To 
Sequence Length), or bar 4 (To Sequence End). See image for details. 

Play Truncate Duration: This determines if/how events are cropped if they 
exceed the length of the current track during playback. 

As Recorded: Events will play back exactly as they were recorded, even if they overlap themselves when the 
sequence loops. 

Truncate Length: If the length of an event exceeds the length of the sequence, it will be truncated. This 
ensures that the event will not overlap itself when the sequence loops. 

Q-Link Playhead Increment: This determines whether turning Q-Link Knob 2 (Playhead) in Main Mode will move 
the playhead location by 1/16th-note increments (1/16 Note) or according to the time division (TC Division). 

Q-Link Swing Control Applies TC Settings On Release: When this box is selected, moving the Swing 
parameter assigned to a Q-Link knob will apply the timing correct settings (including the new Swing value) when 
you release the knob. 

Display Resolution: This is the display resolution (in PPQN—pulses per quarter note) of pulse values in certain 
areas of the operating system. Please note that this setting affects the display resolution, not the timing. 

Bar 1 2 3 4 5 6 7 8

As played

To Sequence Length

To Sequence End



  

 
38 

 

 

Hardware 

The settings on this screen determine the behavior of your MPC hardware’s pads as well as connected footswitches. 

Pad Threshold: This determines how much force is required to strike the pads for them to trigger. 

Pad Sensitivity: This determines how the pads respond to touch. At lower values, you need to use more force to 
generate a high-velocity note. At higher values, it is easier to generate high-velocity notes, even if you do not use 
much force while pressing a pad. 

Pad Curve: This determines how striking the pads translates into velocity values. The A 
curve is essentially linear, while the B, C, and D curves are exponential. 

Pad Response (Velocity & Aftertouch): View these meters when striking and pressing 
the pads to help gauge the force and pressure you are applying to them. These meters 
are useful when adjusting the Pad Threshold and Pad Sensitivity parameters (above). 

Footswitch 1 & Footswitch 2: These determine how footswitches connected to your 
MPC hardware will work. You can select either transport commands (e.g., Play or Stop) 
or trigger commands for pads and other buttons. 

Display: This determines how the display functions for a connected MPC Touch. 

Screen Dimming: This determines how much time must pass before your MPC 
hardware automatically dims its touchscreen while On Battery (if applicable, this can 
help preserve battery life) or on Wall Power. 

VU Meter Source (only when using MPC X/MPC X SE in Controller Mode): This determines what audio signal 
level is shown in the level meters (on the right side of the screen). When set to Main, the level meters show the 
audio signal sent out of Outputs 1/2 (the Main L/R outputs on the rear panel). When set to Current Program, 
the level meters show the audio signal of the currently selected program (i.e., the program used by the currently 
selected track and any other tracks that also use it). 

Show Hardware Info: Click this button to open a window with information about your connected MPC hardware 
(firmware version, driver version, etc.). 

Tap Tempo: This determines how many times you have to press the Tap Tempo button before the new tempo is 
recognized. 

Flash Tap Tempo Light: When enabled, the Tap Tempo button’s light will flash in time with the tempo. When 
disabled, the Tap Tempo button’s light will be off. 

Bank Button Press: This determines how the Pad Bank buttons work.  

Select A-D: Pressing a Pad Bank button once will select the corresponding bank from Pad Banks A–D. 
Pressing and holding Shift while pressing a Pad Bank button will select the corresponding bank from Pad 
Banks E–H. 

Select/toggle bank: Pressing a Pad Bank button will alternate between the corresponding bank from Pad 
Bank A–D and Pad Bank E–H. In other words, you do not need to hold Shift to select one of Pad Banks E–H. 

Shift + Q-Link Press: This determines the behavior of pressing Shift and the Q-Link button (if applicable) on your 
MPC hardware. Select Q-Link Edit to open the Q-Link Edit window, or Cycle Backwards to move backwards 
between the four Q-Link banks.  

Default Touch Strip Mode: For MPC hardware with a Touch Strip controller (MPC Key 61/37, MPC Live III), this 
determines the default Touch Strip control mode. 

Disable Internal Mic While Speaker is On (MPC Live III only): When enabled, the MPC Live III internal mic is 
automatically turned off when the built-in speaker is set to On. When disabled, you can use the microphone and 
speaker at the same time, but Monitor controls for tracks using the microphone are automatically disabled.  

Global Pitch Bend: When enabled, this will override the pitch bend settings of all programs, so that those with 
pitch bend disabled or set to different ranges will only use the Global Range instead. When disabled, all 
programs may use their individual pitch bend settings. 

Range Down and Range Up: These determine the maximum shift of semitones up or down that will be applied 
when pitch bend is used.  

MIDI 
Velocity 

Applied
Force
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Project Defaults 

The settings on this screen determine various default values for any new project that you create. 

Default Tempo: This is the default tempo in BPM. 

Default Global Tempo: When set to On, the default tempo value will be used for the global tempo. When set to 
Off, the default tempo will be used for sequences. 

Default Mode: This determines the default mode when connected MPC hardware is powered on; Main Mode or 
Sounds mode. 

Default QLink Mode: This determines the default mode for the Q-Link knobs (default: Screen). See Panels > Q-
Links to learn more about each mode.  

Default Sequence Bars: This determines the default number of bars of a new sequence. 

Default Sequence Loop: This determines whether the sequence has loop enabled (On) or disabled (Off) by default. 

Use Clip Workflow: For MPC Live III, MPC XL, and MPC Pro Pack users, this allows you to toggle Clip workflow 
on and off. Changing this setting requires you to close MPC 3 and reopen it. If you have unsaved changes in 
your current project, a pop-up will appear to alert you before MPC software is closed.  

Default Time Signature: This determines the default time signature of new projects.  

Default Pad Slice: This determines how new samples will play when you load them or record them into a 
project. When set to Pad, the Slice menu in Track Edit Mode will be set to Pad, which lets you set the start 
point, end point, etc. for the layer. When set to All, the Slice menu in Track Edit Mode will be set to All, in which 
the entire sample plays. 

Default Drum Filter: This determines the default type of filter that drum and keygroup tracks will use.  

Default Plugin Synth: This determines the default instrument plugin that a new plugin program will use. Use the 
window that appears to select it. See Plugins > Selecting Plugins to learn about this. 

Default Audio Monitor: This determines the default monitor state for audio tracks. 

Default MIDI Monitor: This determines the default monitor state for drum, keygroup, MIDI, and CV tracks. 

Use Fixed Track/Row Color: Check this box to enable all tracks to be created using a fixed color. When Clip 
Workflow is enabled, all clip rows will also share the set track color.  

Default Track/Row Color: Use this option to select the default color used when the Use Fixed Track/Row 
Color option is enabled.  

Enable pads fixed user level velocity by default: When enabled, pads will send a fixed velocity value no matter 
how hard or soft they are hit. 

Default pads user level velocity value: Use this to set the default velocity value when fixed user level velocity is 
enabled.  
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Project Load/Save 

The settings on this screen determine if (and how) projects are automatically saved. 

New Project Behavior: This determines what is loaded when a New Project is selected: and Empty Project, the 
default Factory Project, or the User Auto Load Project file. 

User Auto Load File: Click the … button to select a project (.xpj) or program (.xpm) on your computer to load 
automatically anytime a new project is created if New Project Behavior is set to User Auto Load Project. 

Tip: To “bypass” or ignore the auto load file, you can also press and hold Shift while opening the MPC 3 
software. This will open an empty project instead of your selected Auto Load file.  

New Project Dialog: This determines what options you see when you start a new project. When set to Off, a 
new project will be empty with no preconfigured settings except for the project defaults shown here. When set to 
Demo, you can choose to load a demo project (from several different genres) as a starting point or an empty 
project. When set to Recent, you can select from recently loaded projects. When set to 
Demo/Template/Recent, you can choose to load a demo project, a project template file, or a recently loaded 
project. You must have a project in the Template File field of the Project Load/Save tab to select a template in 
this window. 

Template File: Click the … button to select a project to load when you create a new project from a template. To do 
this, click the menu icon (≡) in the upper-left corner of the window, select File, and then click New From Template. 

Temporary File Location: Click the … button to select a location on your computer as a record path for 
temporary files. 

Auto Save Enabled: When enabled, the MPC 3 software will automatically save your current project after each 
Timeout interval. When disabled, the MPC 3 software will not automatically save your project; you must save your 
project manually. 

Timeout: Use this field to select how often your project will automatically save. 
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General 

The settings on this screen determine how other features work in the hardware and operating system. 

Vintage Mode: This determines the type of emulation applied to the audio output. You can apply the particular 
sonic qualities of, for example, the MPC3000 or MPC60, or of course no emulation (None). 

Audition Auto Play: This determines how long a sample will sound when auto-previewing it. 

Audition Outputs: This determines which pair of outputs will play any auditioned sounds: Out 1,2–31,32. These 
sounds include: samples, programs, and projects in the Browser; sample playback, Cue Preview, and Slice 
Preview in Sample Edit Mode; and sample playback in the Keep or Discard Sample window in the Sampler. 

Cue Preview: This determines if/how audio is played as you move the cue playhead. As you move the cue 
playhead through a sample waveform, you can set it to play the small part of the sample before the cue playhead 
(Before), play the small part of the sample after the cue playhead (After), or not play at all (Off). 

Slice Preview: This determines if/how audio is played as you move a slice marker. As you move the slice marker 
through a sample waveform, you can set it to play the small part of the sample before the slice marker (Before), 
play the small part of the sample after the slice marker (After), or not play at all (Off). You can also configure this 
setting in the Wave Editor (see Editors > Wave Editor). 

Show Mode Shortcut Panel: When enabled, you can use the mode shortcut panel on your MPC touchscreen 
hardware. To use this, swipe the black touch handle to the right from the left edge of the touchscreen while 
viewing any mode. The five modes from the left-most column of the Menu can be accessed here. 

Allow Multiple Plugin Windows: This determines whether multiple plugin windows can be displayed at the 
same time (a feature added to MPC 2.1) or only one plugin window can be displayed at a time (how plugin 
windows worked prior to MPC 2.1). 

Desktop Screensaver Disable: This determines if/when your computer’s screensaver is disabled while using 
the MPC 3 software (using your MPC hardware in Controller Mode): 

Never: Your computer’s screensaver will function normally. 

When hardware used: As long as your MPC hardware is connected to your computer and being used, your 
computer’s screensaver will be disabled. 

When hardware attached: As long as your MPC hardware is connected to your computer and powered on, 
your computer’s screensaver will be disabled. It will function normally again if you power off or disconnect 
your MPC hardware from your computer. 

Always: Your computer’s screensaver will be disabled as long as the MPC 3 software is open (whether or 
not your MPC hardware is connected or powered on). 

Collect Usage Statistics: This determines whether or not your usage statistics will be sent occasionally to us, 
enabling us to improve the MPC experience. 

Multi Process Threads: This determines how many cores of your computer’s processor will be used to render 
audio. The available range depends on your processor. 
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Inspector 
 

The “Inspector” is a panel on the left edge of the window shows information about the 
current sequence, track, and program as well as two “dynamic” channel strips for 
convenient monitoring and mixing. 

 
To show or hide the Inspector, do one of the following: 

• Click the i icon in the lower-left corner of the window. 

• Click the menu icon (≡), go to View > Inspector, and select Show Inspector. 
 
 
Sequence 
 
Click the > or ∨ next to the Sequence field to collapse or expand this section. 

Click the Sequence field or down arrow () to select a sequence. 

Double-click the Sequence field to rename the sequence.  

Click the small menu icon (≡) to select or deselect which items are shown in this section: 

Bars: the number of bars in the sequence 

BPM: the sequence tempo (as opposed to the global tempo) 

Trans (Transpose): the transposition of the sequence in semitones 

Loop: determines whether or not sequence playback will loop 

Start: the first bar of the sequence loop 

End: the last bar of the sequence loop 

Time Signature: the number of beats per bar, and the note value of each beat 

 

Right-click the Sequence field to show a menu of some editing processes. See Editing 
Processes > Sequence for more information. 

 

Right-click the Sequence field and select Sequence Settings to open the Sequence 
Settings window. 

Use the Name field to rename the sequence.  

Use the Auto-Select Track field to select a track in your project that will automatically 
be selected when selecting the sequence. Select None to keep the current track in 
focus when changing sequences.   
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Track 
 

Click the > or ∨ next to the Track field to collapse or expand this section. 

Click the Track field or down arrow () to select a track. 

Double-click the Track field to rename the track.  

Double-click the Track field to rename the track.  

Click the record button to arm the track for recording. 

Click the duplicate icon to duplicate the current track (without events). 

Click the new track + icon to open the New Track dialog. 

Click the small menu icon (≡) to select or deselect which items are shown in this section.  

For Drum, Keygroup, Plugin, MIDI, and CV tracks: 

Type: the type of program the track is using. 

Midi Input Port: the input port where MIDI data is received. 

Midi Input Channel: the MIDI channel that receives MIDI input data. Select Any to 
receive MIDI input from all channels and preserve each event’s channel 
information, or select 1–16 to receive only from a specific channel. 

Midi Out Port: the output port where MIDI data is sent (MIDI tracks only). 

Midi Out Channel: the MIDI channel that sends MIDI output data (MIDI tracks 
only). Select a specific channel 1–16 to force all output to that channel, or select 
Any to output each MIDI event on its originally recorded channel (ideal for 
multitimbral playback). 

Midi Send: an additional track where MIDI output data can be sent. 

Monitor: the monitoring behavior of the track:  

Off: The track's MIDI input is not monitored, and playback of recorded events will be heard. This setting is 
useful when using keyboards with Local Control active. 

In: The track's MIDI input is always monitored regardless of the track's Record Arm state, and playback 
from recorded events will not be heard. 

Auto: The track's MIDI input is monitored when the track is record armed, and playback of recorded events 
will be heard. 

Merge: The track's MIDI input is always monitored, and playback of recorded events will be heard. 

Length: the length of the track in beats. When set to Seq, the track will use the length of the sequence. 

Velo (Velocity): the velocity of the track. 

Trans/Transpose: the transposition of the track in semitones. 

Mute/Solo: Mute or Solo buttons for the track. 

For Audio Tracks: 

Length: the length of the track in beats. When set to Seq, the track will use the length of the sequence. 

Mute/Solo: Mute or Solo buttons for the track. 

 

Right-click the Track Name field to show a menu of some editing processes. See Editing Processes > Track for 
more information. 

 

Right-click the Track Name field and select Track Settings to open the Track Settings window. Track settings for 
each track type are described in the Tracks chapter. 
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Program 

 

The Program section is shown only when a Plugin, MIDI, or CV track is selected. 

Click the > or ∨ next to the Program field to collapse or expand this section. 

Click the small menu icon (≡) to select or deselect which items are shown in this 
section, depending on the selected track type: 

Plugin Track: 

Plugin: the plugin that the program is using. See the Plugins chapter to learn 
about scanning and selecting plugins. Click the window icon next to the menu 
to show the plugin’s graphical user interface in a separate window. 

Preset: the preset/patch (if any) within the plugin. 

MIDI Channel: the MIDI channel the program is using. 

MIDI Track: 

Prog Ch: the program change message the program sends out. 

Bank: the Bank message (Most Significant Byte or MSB) that the program 
sends out. 

LSB: the Least Significant Byte (LSB) message that the program sends out. 

CV Track: 

Melodic or Drum CV Program: Tap the keys icon to select Melodic 
operation or the pads icon to select Drum operation. 

In Melodic operation:  

CV Port: the CV port the program is using. 

Gate Port: the Gate port the program is using. 

Md.Wheel/Mod Wheel: the CV port the modulation wheel is using. 

Vel Port/Velocity Port: the CV velocity port. 

Note/Note Tracking: the CV program’s note track: lowest, highest or last. 

In Drum operation: 

CV Map: click Edit to assign each pad in the program to a specific CV 
Port and Data Type. 

Note: This window is currently only supported while using MPC hardware 
in controller mode. 
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Channel Strips 

 

The Inspector can display two “dynamic” channel strips, which vary slightly in appearance depending on whether a 
MIDI track or Audio track is selected.  

Click the pad icon at the bottom of the Inspector to show or hide the pad channel strip. When a drum track or 
keygroup track is selected, this will show the current pad or keygroup on the left side, and the corresponding track 
on the right side. For all other track types, this will show or hide the current track only. 

Click the four-pads icon at the bottom of the Inspector to show or hide the track channel strip. This will show the 
current track or submix on the left side and the main output channel strip on the right side.  

 

Pad & Keygroup Channel Strips 

The number of the pad or keygroup is at the bottom 
of the channel strip. Press a pad or key to select a 
different pad or keygroup. 

Tip: This is useful for mixing your pads or 
keygroups without having to enter the Pad Mixer. 

The Inserts slots show any enabled or disabled 
effects for that pad or keygroup. See Effects > Insert 
Effects to learn more about pad or keygroup insert 
effects. 

Click and drag the Send knobs, which control the 
send levels for the pad or keygroup. A return 
channel strip will automatically be shown on the 
right side. Click anywhere in the lower half of the 
pad/keygroup channel strip to show the program 
channel strip again. See Effects > Send/Return 
Effects to learn more about pad or keygroup 
send/return effects. 

The menu below the Sends shows where the pad or 
keygroup is routed, which you can set to the current 
track (Track), a submix (Submix > Sub 1–8), a pair 
of main outputs (Outputs 1,2–31,32) or a single 
main output (Output 1–32). Usually, this is set to 
Track. 

Click M or S to mute or solo the pad or keygroup 
(respectively). 

Click the monitor button to change the monitor behavior of the pad or keygroup.  

• Off: The track's MIDI input is not monitored, and playback of recorded events will be heard. This setting is 
useful when using keyboards with Local Control active. 

• In: The track's MIDI input is always monitored regardless of the track's Record Arm state, and playback from 
recorded events will not be heard. 

• Auto: The track's MIDI input is monitored when the track is record armed, and playback of recorded events 
will be heard. 

• Merge: The track's MIDI input is always monito red, and playback of recorded events will be heard. 

Adjust the pan knob or level slider to change the panning or level (respectively) of the pad or keygroup. The 
green level meter next to the slider shows the pad’s current volume level in dB. 

 

See below for descriptions of the adjacent track channel strip. 
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Track Channel Strip  

The name of the track is at the bottom of the channel strip. Click it to rename the 
track. 

The Inserts slots show any enabled or disabled effects for that track. See Effects 
> Insert Effects to learn more about program insert effects. 

Click and drag the Send knobs, which control the send levels for the track. A 
return channel strip will automatically be shown on the right side. Click anywhere 
in the lower half of the track channel strip to show the main or submix channel 
strip again. See Effects > Send/Return Effects to learn more about track 
send/return effects. 

The menu below the Send knobs shows where the track is routed, which you can 
set to a submix (Submix > Sub 1–8), a pair of main outputs (Outputs 1,2–31,32) or 
a single main output (Output 1–32). Send knobs are not available for CV tracks. 

Click M or S to mute or solo the track (respectively). 

Click the track automation button to toggle between two possible states of track 
automation: 

When set to Read (R), the program will read automation data but will not 
record any additional automation over it. You can still manually edit and enter 
automation. (Think of this as a protective feature to prevent accidental 
changes to your automation while recording.) 

When set to Write (W), the program can record automation. (If you have any 
Q-Link knobs assigned to automatable parameters, make sure not to touch 
any accidentally while you are recording.) 

To disable or enable track automation, hold Shift and click the track 
automation button. When off, the track will ignore automation data. If you 
have already recorded or entered automation, clicking this will switch between 
Read (R) and Write (W) only, but you can override this and turn it off by 
pressing and holding Shift while clicking the button.  

Important: If you have already recorded automation and turn it off, the track will still use the effect and its 
parameter values at the point where you turned it off. 

See Automation to learn about recording and editing automation. 

Tip: You can quickly set all tracks to the same automation by clicking the global automation button in the upper-
right corner of the window, or in the Main Output Channel Strip. 

Click the monitor button to change the monitor behavior of the track.  

For MIDI tracks: 

• Off: The track's MIDI input is not monitored, and playback of recorded events will be heard. This setting is 
useful when using keyboards with Local Control active. 

• In: The track's MIDI input is always monitored regardless of the track's Record Arm state, and playback 
from recorded events will not be heard. 

• Auto: The track's MIDI input is monitored when the track is record armed, and playback of recorded 
events will be heard. 

• Merge: The track's MIDI input is always monitored, and playback of recorded events will be heard. 

For audio tracks: 

• Off: The track’s incoming audio is never monitored.  

• In: The track’s incoming audio is monitored whether or not the track is record-enabled.  

• Auto: The track’s incoming audio is monitored while the track is record-enabled only. 

• Merge: The track's incoming audio is always monitored, and you will hear playback of recorded events. 

Adjust the pan knob or level slider to change the panning or level (respectively) of the track. The level meter 
behind the slider shows the tracks’ current volume level in dB (or velocity level for MIDI tracks). These controls 
are not available for CV tracks. 

Important: If you copy a sequence, the volume and pan values will be copied with that sequence. 
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Click the Record Arm () button to record-enable the track.  
Tip: You can record-enable multiple tracks in Track View Mode or in the Channel Mixer by pressing and holding 
Ctrl (Windows) or  (macOS) while clicking the Arm button to each track. You can also adjust the Record Arm 
behavior by changing the Rec Arm setting under Preferences > Sequencer. 

 

See below for descriptions of the adjacent main channel strip. 

 

 

Main Output & Return Channel Strips 

The main output pair or return channel is shown at the bottom of the channel 
strip. Click it to rename the track. 

The Inserts slots show any enabled or disabled effects for those outputs or 
that submix. See Effects > Insert Effects to learn more about submix insert 
effects. 

For return channel strips, the menu below the Inserts slots shows where the 
return is routed, which you can set to a pair of main outputs (Outputs 1,2–
31,32) or a single main output (Output 1–32). 

Click M to mute the main output or return. 

Click the global automation button to toggle between two possible states of 
global automation: 

When set to Read (R), automation data will be read but not recorded. 
You can still manually edit and enter automation. (Think of this as a 
protective feature to prevent accidental changes to your automation 
while recording.) 

When set to Write (W), automation can be recorded and will overwrite 
any existing automation. (Make sure not to touch Q-Link knobs 
accidentally while you are recording.) 

To disable or enable global automation, hold Shift and click the global 
automation button in the Toolbar. When off, automation data will be 
ignored.  

Important: If you have already recorded automation and turn it off, tracks 
will still use their effects and their parameter values at the point where you 
turned it off. 

See Automation to learn about recording and editing automation. 

Click the Record Arm () button to record-enable the main output or return 
channel. 

Adjust the pan knob or level slider to change the panning or level 
(respectively) of the outputs or submix. The green level meter next to the slider 
shows the outputs’ or submix’s current volume level in dB. 
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Browser 
 

You can use the File Browser, Expansion Browser, and Media Browser to 
navigate your hard disks and other storage devices to load samples, 
sequences, projects, MPC Expansions/instruments, and other media. Using 
filter buttons and user-definable folders, you can easily adapt it to your preferred 
workflow. You can also audition (preview) samples before loading them. 

 

You can also use the Project Info Browser, Project Notes Browser, and 
Undo History Browser to access and edit additional information about your 
project overall. 

 

The MIDI Learn Browser lets you assign areas of the MPC 3 software to 
external MIDI controllers. Global MIDI mappings are helpful if you use certain 
MIDI controllers across multiple projects. Project MIDI mappings are saved 
within a project, which can be helpful if your MIDI controller usage is particular 
to each one.  

 

The Browser also includes the Quick Help panel. This panel is visible only 
when one of the Browsers is shown. Click the menu icon (≡), select Help, 
and then click Quick Help to show or hide this panel. Alternatively, click the ? 
icon in the lower-right corner. 

You can also click the feedback button () to suggest a feature or report a 
bug. We always try to take your feedback into account as we continually 
improve the MPC experience! 

 

To show or hide the Browsers, do one of the following: 

• Click the menu icon (≡), select View > Browser, and then click the 
desired option: Hidden, File Browser, Expansion Browser, Media 
Browser, MIDI Learn Browser, MIDI Monitor, Project Info, Project 
Notes, or Undo History. 

• In the lower-right corner, click the corresponding icon (as shown 
from right to left): 

o MIDI Monitor: MIDI plug icon 

o Project Info Browser: P/page icon 

o Project Notes Browser: notebook icon 

o MIDI Learn Browser: MIDI-controller icon 

o Undo History Browser: clock-and-arrow icon 

o Media Browser: six-rectangles icon 

o Expansion Browser: list icon 

o File Browser: hard-drive icon 
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File Browser 

 
When the File Browser is selected, you can do any of the following: 

To move up one folder level, click the up arrow () next to the file path. 

To select a file or folder, click it once. 

To enter a folder, double-click it. 

To load a sample directly to a pad, click and drag the sample onto a pad in 
the lower half of the window. 

To load a sample directly to an audio track, click and drag the sample onto 
the Grid Editor when an Audio track is selected when one is shown in the 
upper half of the window. 

To load a selected file to the project’s sample pool, double-click it or click 
and drag it anywhere in the window outside of the File Browser. If the file is a 
sample, it will be loaded to the project’s sample pool. If the file is a project, it 
will be loaded in its entirety (you will be asked if you want to close your current 
project). 

To load all files in a selected folder, click and drag the folder onto anywhere 
in the window outside of the File Browser. 

To preview a selected sound, click and hold Play () in the lower-left corner 
of the Browser. 

To enable or disable the audition function and set its volume level, click 
the volume icon in the lower-left corner of the Browser. Click and drag the 
level slider left or right to set the volume level. 

To sync samples when auditioning, tap the sync icon in the lower-left 
corner of the Browser. When enabled, samples will be auditioned at the 
beginning of the next bar of the sequence when playback is active. 

To warp samples when auditioning, tap the warp icon in the lower-left 
corner of the Browser. When enabled, samples with an embedded tempo will 
be warped to the project tempo. 

To load included sequence events with track files, click the + file icon 
and select Load Sequence so it is checked.  

To browse your files by search term, click the Search field and type a search term. 

To enable recursive searching, click the menu icon next to the Search field and select Search includes 
subfolders. 

To view additional file information, click the menu icon next to the Search field. You can add the following 
information to each file entry: File size, Modified date, Created date. Click the option to enable or disable it 
from appearing in the Browser. 

To hide or show project folders, click the menu icon next to the Search field and select Hide project data 
folders. 

 
To get the most efficient use of the File Browser, set the file paths to your favorite drive locations first. There are five 
folder buttons labeled 1–5 at the top. You can set these to be shortcuts to five locations on your computer’s hard 
drive or any connected storage devices, giving you quick access to your files. 

To assign the current location to a folder button, press and hold Shift, and then click one of the folder buttons 
(1–5). Now, when you click that folder button again, the File Browser will show that folder’s content immediately. 

 
Use the five filter buttons to show only specific types of files in the list below. Folders will still be shown in the list. 

To show project files only, click the Proj/page button. 

To show sequence files only, click the Seq/bars button. 

To show program files only, click the Prog/four-squares button.  

To show preset files only, click the Preset/plug button. 

To show sample files only, tap the Sample/waveform button. 

To show all file types, tap the All button. 
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Expansion Browser 

 

When the Expansion Browser is selected: 

Your available MPC Expansions will appear in the Browser, which you can 
expand or collapse. 

MPC Expansions may have lists of patches that you can expand or collapse, 
as well. 

To preview a selected sound, click and hold Play () in the lower-left corner 
of the Browser. 

To enable or disable the audition function and set its volume level, click 
the volume icon in the lower-left corner of the Browser. Click and drag the 
level slider left or right to set the volume level. 

 

See Expansions to learn more about MPC Expansions. 
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Media Browser 
 
When the Media Browser is selected: 

Your MPC Expansions will appear under the Expansions panel, which you can expand or collapse. 

You can filter through your media library in the Filter panel, which you can expand or collapse. 

Use the Search field to browse your media by search term. 

To preview a selected sound, click and hold Play () in the lower-left corner of the Browser. 

To enable or disable the audition function and set its volume level, click the volume icon in the lower-left 
corner of the Browser. Click and drag the level slider left or right to set the volume level. 

 
Use the four filter buttons to show only specific types of files in the list below. Folders will still be shown in the list. 

To show program files only, tap the Program/four-squares button.  

To show project files only, tap the Project/page button. 

To show sequence files only, tap the Sequence/bars button. 

To show sample files only, tap the Sample/waveform button. 

 
To enable or disable tags in the Media Browser, click the menu icon (≡), go to View > Browser, and select Media 
Browser Shows All Tags. 
 
 Program filter + no tags selected. Program filter + Kit and RnB tags. Sample filter + Chill Trap and Kick tags. 
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MIDI Learn Browser 

 

The MIDI Learn Browser lets you assign areas of the MPC 3 software to external MIDI controllers. Global MIDI 
mappings are helpful if you use certain MIDI controllers across multiple projects. Project MIDI mappings are saved 
within a project, which can be helpful if your MIDI controller usage is particular to each one.  

 

To select a MIDI Learn mode, click Global or Project at the top of the browser to show its assignments below. 
Global MIDI mappings are helpful if you use certain MIDI controllers across multiple projects. Project MIDI 
mappings are saved within a project, which can be helpful if your MIDI controller usage is particular to each 
one. See Global or Project below. 

 

  
 

Each assignment has the following settings: 

Target: This is the assigned command or parameter. The list of targets in the Global tab is comprehensive, while 
the list of targets in the Project tab must be added and selected. 

Type: This is the type of message: Toggle Button, Momentary Button, Fixed Button, Note, Abs CC, Rel CC 
Offset, Rel CC 2’s Complement. This is automatically detected based on the parameter itself, but you can use 
this field to assign it manually if it does not detect it properly. 

Ch: This is the MIDI channel the control is using. 

Data: This is the MIDI note number or CC number. 

Flip: Click this box to select or deselect it. When selected, the control’s polarity will be reversed (e.g., a button’s 
“off” state will become its “on” state and vice versa). 
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Global 

 

Use the Global MIDI Learn feature to assign your MIDI controller to pads, 
Q-Link knobs, transport controls, or other assignable parameters in the 
MPC 3 software. 

 

To assign a global parameter to a hardware control: 

1. Click Learn at the top of the MIDI Learn browser so it turns yellow.  

2. Click a parameter that has a yellow overlay to select it. Alternatively, 
click it in the list in the MIDI Learn Browser. 

 
3. Move or press the desired control on your MIDI controller. 

To assign more controls, repeat Steps 2–3. 

To stop assigning controls, click Learn again so it turns gray. 

 

To clear an assignment, right-click or press and hold Ctrl (Windows) or 
Control (macOS) and click the assignment in the MIDI Learn browser. 
Click Clear MIDI Mapping to clear the assignment, or press Esc or click 
anywhere else to cancel. 

 

To select an assignment, click Learn so it turns yellow, and then press and hold Shift while moving the control on 
your MIDI controller. 

 

Each collection of these assignments is called a MIDI map, which you can export as a file (.xmm) to import into other 
MPC projects. You can also disable, re-enable, or switch between different MIDI maps while working with your project. 

To select a MIDI map, click the menu next to Learn. Select Factory to view the available preset MIDI maps, or 
select User to view MIDI maps you have created. 

To show only mappings for specific controls or commands, click the View menu above the list of assignments, 
and then click a type of control or command. 

To show only mappings for the selected control type, click the three-lines icon next to the controller menu, 
and then click List Follows Control so it is selected. 

To create a new MIDI map, click the three-lines icon next to the controller menu, and then click New MIDI Map. 
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To create a duplicate of the current MIDI map, click the three-lines icon next to the controller menu, and then 
click Duplicate. An identical MIDI map will be created and appended with Copy. 

To clear all assignments from the current MIDI map, click the three-lines icon next to the controller menu, 
and then click Clear. In the window that appears, click OK to continue and clear the assignments, or click 
Cancel to close the window and keep them. (You can do this with MIDI maps from the list of User maps only, 
not the Factory list.) 

To delete the current MIDI map, click the three-lines icon next to the controller menu, and then click Delete. 
In the window that appears, click OK to continue and delete the MIDI map, or click Cancel to close the window 
and keep it. (You can do this with MIDI maps from the list of User maps only, not the Factory list.) 

To export the current MIDI map, click three-lines icon next to the controller menu, and then click Export. In the 
Export MIDI Mapping window that appears, do any of the following: 

To select the storage device you want to view, click the down arrow () next to the file path. If you have 
storage devices connected to your MPC hardware, they will appear in this column, as well. 

To enter a folder, double-click it or press Enter. 

To create a new folder, click New Folder, type a name for the new folder, and then click OK or press Enter 
to confirm the name, or click Cancel or press Esc to keep the original name. You will immediately enter the 
new folder. 

To move up one folder level, click the up arrow (). 

To name the file, click the File field at the bottom of the window, and type a name. 

To save the file, click Save or press Enter. 

To cancel, click Cancel or press Esc. 

To import a different MIDI map, do any of the following: 

• Click and drag a MIDI map file (.xmm) onto the software window and release it. That map will be 
selected immediately. 

• Place a MIDI map file (.xmm) in the MIDI Learn folder on your computer, and then click the three-lines 
icon next to the controller menu, and then click Refresh. 

Windows: [your hard drive]\Program Data\Akai\MPC\Midi Learn 

macOS: [your hard drive]\Users\[your user name]\Library\Application Support\Akai\MPC\Midi Learn 

• Click the three-lines icon next to the controller menu, and then click Import. In the Import MIDI 
Mapping window that appears, do any of the following: 

To select the storage device you want to view, click the down arrow () next to the file path. If 
you have storage devices connected to your MPC hardware, they will appear in this column, as well. 

To enter a folder, double-click it or press Enter. 

To move up one folder level, click the up arrow (). 

To import the file, click Open or press Enter. 

To cancel, click Cancel or press Esc. 

To refresh the list of MIDI maps, click the three-lines icon next to the controller menu, and then click Refresh. 
Do this if you have manually placed a MIDI map file (.xmm) in the Midi Learn folder (in the MPC application 
folder) and need it to appear in the list. 
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Project 

 

Use the Project MIDI Learn feature to assign your MIDI controller to 
various parameters in your specific MPC project: 

• Mixer parameters such as volume, pan, mute, and/or sends for 
tracks, returns, submixes, and main outputs. 

• Pad parameters (for drum tracks only) such as tuning, filter and 
amp envelopes, layer settings, LFO settings, and velocity. 

• Track parameters, which depend on the track type. 

• Insert effects parameters, which depend on the effect type. 

• Plugin instrument parameters, which depend on the plugin. 

 

These assignments will be saved with your MPC project. 

Tip: Because these MIDI assignments are saved within a project, you can 
use them while working with a project on both the desktop version of the 
MPC 3 software or on your MPC hardware in Standalone Mode. 

 

To assign a project parameter to a hardware control: 

1. Click Learn at the top of the MIDI Learn browser so it turns yellow. 

2. Click the + icon in the upper-right corner of the browser to create an 
“empty” assignment (its Target menus will be set to None and Off).  

Alternatively, click an assignment that is already in the list if you want to 
change it. 

3. Click a project-specific parameter (e.g., a mixer setting or program 
parameter) to select it. The two Target menus will indicate the 
parameter you selected. 

Alternatively, click the first Target menu to select a track, return, 
submix, or main output (for drum programs, you can select the entire 
track or a single pad within it). After that, click the second Target menu 
to select the parameter. 

4. Move or press the desired control on your MIDI controller. You can 
press and hold Alt (Windows) or Option (macOS) while moving or 
pressing multiple controls to assign them simultaneously. 

To assign more controls, repeat Steps 2–4. 

To stop assigning controls, click Learn again so it turns gray. 

 

To clear an assignment, right-click or press and hold Ctrl (Windows) or  (macOS) and click the assignment in the 
MIDI Learn browser. Click Clear MIDI Mapping to clear the assignment, or press Esc or click anywhere else to 
cancel. 

 

To delete an assignment (the entire slot), right-click or press and hold Ctrl (Windows) or  (macOS) and click the 
assignment in the MIDI Learn browser. Click Delete Assignment to delete the assignment, or press Esc or click 
anywhere else to cancel. 

 

To clear all assignments, click the three-lines icon next to the controller menu, and then click Clear All 
Assignments. In the window that appears, click OK to continue and delete the assignments, or click Cancel to close 
the window and keep them.  
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MIDI Monitor 

 

The MIDI Monitor lets you view incoming and outgoing MIDI messages as 
a list. While the MIDI Monitor panel is open, you can do the following: 

Click Input to view incoming MIDI messages. 

Click Output to view outgoing MIDI messages. 

Click Clear to clear the current event view.  
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Project Info Browser 

 

The Project Info browser contains information about the current project’s 
tracks, sequences, and samples. This Browser is identical to the Project 
panel (see Panels > Project) but in a vertical layout rather than horizontal. 

 

All available tracks and sequences in the project will appear in the upper 
half of the Browser under Projects.  

To duplicate a track in the project, right-click it and click Duplicate. 
An identical track will be created immediately. The duplicate track will 
use the same name but appended with a number (e.g., Drum 002). 

To duplicate a track including its events, right-click it and click 
Duplicate with events. An identical track will be created immediately 
with the same events as the original track. The duplicate track will use 
the same name but appended with a number (e.g., Drum 002).  

To delete a track, right-click it and click Delete. 

To save a track, right-click it and click Save. Use the window that 
appears to enter a name for the track file (.xtp) and select a location. 
Click Save to confirm your choice, or Cancel to cancel saving. 

To rename a program or sample, right-click it and click Rename. 
Enter a name in the window that appears, and then click Do It to 
confirm your choice, or Cancel to cancel saving. 

To adjust the track position, right-click it and select Move Up or 
Move Down. Other tracks will be moved in relation to the new track 
position.  

 

A list of samples will appear in the lower half under Samples (the samples 
that are listed are part of the selected track or sequence under the Project 
list). 

To audition the sample, hover your cursor over the waveform icon so 
it turns into a speaker icon. Click this icon to hear the sample. 

To delete samples from the project, click the trash can icon. In the 
screen that appears, select Purge Unused Samples to delete all 
unused samples from the project (from all tracks and sequences), or 
select Delete All Samples to delete all samples from the project. 

To delete a sample, right-click it and click Delete. Click Delete or 
Delete Sample to confirm your choice, or Cancel to cancel the deletion. 

To save a program or sample, right-click it and click Save. Use the 
window that appears to enter a name for the sample file (.wav) and 
select a location. Click Save to confirm your choice, or Cancel to 
cancel saving. 

To rename a sample, right-click it and click Rename. Enter a name in 
the window that appears, and then click Do It to confirm your choice or 
Cancel to cancel saving. 

To view a sample in Sample Edit Mode, right-click it and click Edit. 
Alternatively, double-click the sample. You will immediately enter 
Sample Edit Mode and show the sample’s waveform in the Wave 
Editor. 
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You can also use this section to sort and assign samples to Memory or to 
Stream from disk. Click each header to show only samples in each 
category. 

If a sample is loaded to memory, right-click it and select Stream From 
Disk to remove it from memory and stream it from a disk drive. Disk 
streaming samples will be marked with a green waveform icon.  

If a sample is streaming from disk, right-click it and select Load To 
Memory to disable streaming the sample from a disk drive and return it 
to memory. Samples loaded to memory will be marked with a grey 
waveform icon.  

Note: Disk streaming relies on the performance of the disk you are 
streaming from. For the best operation, it is recommended to use an 
SSD (solid-state drive). Once you have saved a project to your SSD, 
your files will stream from that location. For an unsaved project, MPC 
uses a temporary file location from which to stream audio files. Go to 
Menu > Preferences > Project Load/Save and set the Temporary 
File Location to your SSD for best results.  

 

 

 

 

 

Project Notes Browser 

 

When the Project Notes Browser is selected: 

Information about the project will be shown in several fields: Title, Artist, 
Original Artist, Album, Year, Genre, and Copyright. Note that these are 
not ID3 tags. 

You can also write notes in the lower panel. 

To enter text into a field, click it and type. 
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Undo History Browser 

 

When the Undo History Browser is selected: 

All undoable (and redoable) actions you have performed within the 
software will appear in this list in sequence. Each step is numbered in 
the # column. Each action is named in the Action column with 
additional information in the Detail column. 

The magenta action marker indicates the current “undo state” 
location—the last-performed action. 

To undo or redo multiple actions at once, click and drag the action 
marker to the desired location in the list. The project will immediately 
revert to that state. Actions that can be redone (below the action 
marker) are grayed out. 
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Editors 
 
You can switch the editor between the Grid Editor, Wave Editor, and List Editor, depending on what mode you are in. 
 
To enter each editor, click Grid, Wave, or List below 
the mode icons. You can do this only when editing 
MIDI tracks; audio tracks only have the Audio Editor 
in place of the Grid Editor that displays the audio 
track waveform. 
 
 
In all three editors, these buttons are available in the 
toolbar: 
 
Click the lock icon to turn the Link Track & Grid Views feature on and off. 
When off, you set the zoom distances of the upper and lower halves of the 
window to be independent. 
Note: This only applies when using MPC hardware in Controller Mode. 

 
Click the magnet icon to switch between the two different modes of 
“snapping” note events to the grid: Absolute or Relative. 

Absolute: Events will “snap” to the nearest time division on the grid (as 
determined by the TC field or Time Correct window). This is the 
typical and traditional method of using the snap/quantization feature. 

Relative: Events will “snap” to the nearest time division on the grid (as 
determined by the TC field or Time Correct window) plus the original 
time position of the event (e.g., an event that is originally three ticks 
past a time division on the grid will snap only to positions that are 
three ticks past every time division). 

 
Click the Hitting Pad Selects All Events icon to turn the feature on (red) or 
off (gray). When on, pressing a pad will automatically select all note events 
for that pad in the sequence on that track. When off, pressing a pad will 
simply play its sound without selecting any note events. 
 
Click the left-arrow icon to undo your last action. 
Click the right-arrow icon to redo the last action you undid. 
 
Click the Export Audio icon (star-and-waveform) to export the track as an 
audio file (.wav). Once this is done, the icon will be red. You can then click 
and drag the icon onto your computer desktop or external storage device to 
copy it to that location. Press and hold Shift and click the icon to reset it to 
gray. 
Click the Export MIDI icon (star-and-bars) to export the track as a MIDI 
sequence. Once this is done, the icon will be red. You can then click and 
drag the icon onto your computer desktop or external storage device to 
copy it to that location. Press and hold Shift and click the icon to reset it to 
gray. 
You can use the Record/Export tab in the Preferences to determine precisely 
what is exported with each of these features. See Preferences to learn about 
this. 
Note: Audio tracks can be exported as 16-bit or 24-bit, 44.1 kHz .wav files, 
and MIDI tracks are exported as .mid files. These files placed in the 
[Exports] folder in [your hard drive]\Documents\MPC. 
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Grid Editor 

 
The Grid Editor lets you view and edit the note events of each MIDI track of a sequence and their velocities. 

 
 
For drum tracks, the left column shows you all available pads in a vertical view with their corresponding data.  

For keygroup, plugin, MIDI, and CV tracks, the left column shows a vertical “piano roll” keyboard. 

 

 
Grid Editor of a drum track. 

 

 
Grid Editor of a keygroup track or MIDI track. 
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In the Grid Editor, these three icons enable you to use different functions in the grid. Click 
one to select its mode:  

 

Pencil: Draw Mode: 

To enter a note in an empty grid square, click the square. 

To select a note, click it. 

To move a note, click and drag it to another grid square. Press and hold Shift while doing this to 
move it without restricting (“snapping”) it to the quantization grid. 

To erase a note, double-click it. 

To adjust the start or end point of a note, click and drag its left or right edge. Press and hold Shift 
while doing this to adjust the start or end point without restricting (“snapping”) it to the quantization grid. 

 

Marquee: Marquee Mode: 

To select a note, click it.  

To select multiple notes, click and drag across the grid to create a box around them. 

To move a note, click and drag it to another grid square. Press and hold Shift while doing this to 
adjust the start or end point without restricting (“snapping”) it to the quantization grid. 

To move multiple notes, select them as described above, and then click and drag them. Press and 
hold Shift while doing this to move them without restricting (“snapping”) them to the quantization grid. 

To adjust the start or end point of a note, click and drag its left or right edge. Press and hold Shift 
while doing this to adjust the start or end point without restricting (“snapping”) it to the quantization grid. 

 

Eraser: Erase Mode: 

To erase a note, click it. 

 

 

To zoom in or out, use the sliders in the lower-right corner of the Grid Editor (along each axis) or click the blue timeline 
and drag down or up. 

 

To show or hide the automation lane, click the up or down arrow (∧ or ∨) button next to the horizontal scroll bar 
under the grid. 

 

To adjust the velocity of the selected notes (manually), click Velocity in the automation lane below the grid to 
select it, and then click and drag the handle/handles below the note/notes. Each note’s velocity is represented by a 
vertical bar. The higher and more red the bar is, the higher the velocity is. The current velocity value will appear next 
to the cursor. 

Alternatively, select the pencil tool and click the desired height for each handle. You can also draw an automation 
curve across the entire automation lane. 
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The automation curve can contain points at the current Time Correct intervals. Press and hold Shift while creating 
and editing the automation curve to adjust it without restricting (“snapping”) it to the quantization grid. 

 
 

To show the automation of an automatable parameter, click the down arrow () in the lower-left corner of the 
Grid Editor. You can select a track, program, or pad parameter—the parameter name will appear below Modifier. 
You can then use any of the tools to create and edit automation for this parameter in the automation lane. 

To create a point in the automation curve, click the desired location with the pencil tool, or double-click the 
desired location with any other tool. Press and hold Shift while clicking to create it without restricting 
(“snapping”) it to the quantization grid. 

To draw part or all of an automation curve, click and drag the desired curve with the pencil tool. Press and 
hold Shift while clicking to draw it without restricting (“snapping”) it to the quantization grid. 

To erase a point in the automation curve, click and drag over it with the eraser tool, or double-click it with 
any other tool. 

To erase part or all of an automation curve, click and drag over the desired section of the curve with the 
eraser tool. 

To select a point in the automation curve, click it. 

To move a point in the automation curve, click and drag it to another location in the automation lane. Press 
and hold Shift while clicking to move it without restricting (“snapping”) it to the quantization grid. 

 

Each parameter in the automation lane has an icon next to it that indicates the type of parameter it is: 

Velocity 

 

Track MIDI CC Automation (0–127) 

 

Track Parameter Automation (Aftertouch, Pitchbend, Channel Pressure, or Program Change) or 
Modifier Automation 
 
Articulation  

 
Track Automation (Volume, Pan, Mute, Solo, or Send 1–4) 

 

Track Parameter Automation (options vary based on the type of track) 

 

Track Insert Effect Automation (options vary based on the effect) 

 

Pad/Keygroup Mixer Automation (Level, Pan, Pad Mute, Pad Solo, or Send 1–4) 

 

Pad/Keygroup Parameter Automation (options vary based on the type of track) 

 

Pad/Keygroup Insert Effect Automation (options vary based on the effect) 

 

Probability 

 

Ratchet 

 

Global Sequence Tempo 
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Wave Editor 

 
The Wave Editor lets you view and edit the samples or oscillators of drum tracks or keygroup tracks in a project. 

 
The selected pad (e.g., A01, B16, etc.) is shown just below the Grid Editor tab. Click a pad in the Pads panel or 
press a pad to select it. 

 
Use the Layer menu to select the layer (of the current pad) with the sample or oscillator you want to view. This will 
adjust the appearance of the Wave Editor accordingly.  

 

Sample 

 

 
 

Use the Sample menu to change the sample assigned to the current pad layer. 

 

Click the Edit All Layers button to enable or disable editing control of all sample layers at the same time. When this 
is enabled, edits made to sample parameters such as Start/End points or Semi/Fine tuning on any one layer are 
automatically applied uniformly to all four layers at once (even if some layers are empty). 

 

Important: The following parameters work in conjunction with Chop Mode (in Sample Edit Mode). Here’s how it works: 

When working in Sample Edit Mode and using Chop Mode to divide a sample into slices for your pads, you can 
convert a slice using Non-Destructive Slice or Pad Parameters. 

A Non-Destructive Slice will let its pad to refer to that slice when you press it; the original sample remains intact and 
each slice marker is like a “bookmark” for a pad. In Track Edit Mode, you’ll see that the pad/layer to which it’s 
assigned has its Slice drop-down menu set to the corresponding slice number in the original sample. Playing that 
pad will cause it to refer to that slice marker like a “bookmark” instead of creating an entirely new sample of that 
slice. This means that you no longer have to clutter your Project with a new sample for every slice (though you can 
still use this earlier method, if you prefer). 

A slice converted using Pad Parameters is very similar to a non-destructive slice described above. The difference is 
that in Track Edit Mode, the pads/layers they’re assigned to have their Slice drop-down menus set to Pad (instead of 
the slice number), and the Pad Start and Pad End points will correspond to the slice markers in the original sample. 

See Modes > Sample Edit Mode > Chop Mode to learn more about this. 

 

Use the Start field to determine the position (in samples) where the pad’s playback will start. The minimum value is 
0, and the maximum value is the End value. 

Note: When Loop Lock is on, the loop position (as determined in the Loop field) is the same as the pad start. When 
off, the loop position is independent from the pad start. 

Use the End field to determine the position (in samples) where the pad’s playback will stop. The minimum value is 
the Start value, and the maximum value is the sample’s total length (in samples). 
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Use the Loop menu to select the Pad Loop mode.  

Important: For Pad Loop to work, you must (1) set the Sample Play field to Note On in the Pad Play Modes section 
of Track Edit Mode (see Modes > Track Edit Mode) and (2) set the Slice field to Pad. 

Off: The sample will not loop. 

Fwd: You can hold down the pad to cause that sample to repeat from the Loop position to the end of the 
sample. Release the pad to stop the repeating playback. 

Rev: You can hold down the pad to cause that sample to play in reverse, repeating from the end of the sample to 
the Loop position. Release the pad to stop the repeating playback. 

Alt: You can hold down the pad to cause that sample to play from the Loop position to the end of the sample 
and then play in reverse until it reaches the Loop position again. This will repeat as long as you are holding the 
pad down. Release the pad to stop the repeating playback. 

 

Click the lock icon to turn Loop Lock on or off. When on, the lock icon will be red 
and the Loop field will be disabled. 

 

Use the Slice field to select what part/parts of the sample will play: 

All: The entire sample will play. 

Pad: The sample will play from the Start position to the End position. This also lets you activate Pad Loop. 

Slice 1, 2, 3, etc.: If you have sliced the sample in Chop Mode, you can select which slice will play when you 
trigger the pad. 

 

Click Rev to reverse the sample’s playback. 

 

Use the Tail Length and Tail Start fields to add extra tail to the end of a sample.  

Tail Length: Sets the overall length of time the tail is active. 

Tail Start: Sets the point at which the tail starts looping. 

 

Use the X-Fade field to add real-time crossfade looping to sample playback.  

Use the X-Fade field to set the length of the crossfade in samples. 

Click the icons next to the X-Fade field to select a Linear (straight lines) or Equal Power (curved lines) crossfade. 

 

Use the Offset field to determine a time offset for the sample’s playback. 

Positive values: When the pad is played, playback will start immediately but at a later point in the sample 
specified by the offset value.  

Negative values: When the pad is played, playback will be delayed by the amount specified by the offset value. 

 

Use the Repeats field to set a sample to play a specified number of times. First make sure Pad Loop is set to On, 
then use this field to set the number of times you want to have the sample loop between the Sample Loop and End 
points. For example, a value of 4 would repeat the selected area of the sample 4 times. 

Note: The behavior difference between Repeats set to 0 and 1 is only evident when a Pad’s Sample Play parameter 
is set to Note On. Then, when hold a note, a Repeat value of 0 will create infinite repeats, and a value of 1 will play a 
sample one time through. 

 

When a Slice is selected, you can use the Motion field to trigger a different sample slice each time a pad is played. 
Select Increment to increase the slice number with each new note event, or select Random to play the slices in a 
random order.  

Use the Cycles field to select how many of the slices are played.  

Tap the pad repeatedly, or turn Note Repeat on and hold the pad, to hear the slices of your chopped loop play. 
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Use the Semi field to adjust the tuning of the sample. The sample’s detected Key will be shown to the right and will 
change based on how the sample is tuned. 

 

Use the Warp Algorithm field to select the preferred algorithm for warp for the selected sample: Default, Elastique 
Pro, Pro Ten, or Repitch. When using Repitch, warping an audio sample will adjust its pitch to synchronize it with 
the MPC tempo. The default setting can be adjusted in the Audio Warp and BPM Detect section in Preferences > 
Audio/Export. Changing the setting for a sample will override the default Preferences setting.  

Click Warp to lengthen or shorten the sample (based on the BPM) without changing its pitch. 

Use the Stretch field to set the “stretch factor,” which affects how the sample is warped (if Warp is on). 

Use the BPM field to enter a tempo, which affects how the sample is warped (if Warp is on). You can also click X2 to 
double the value or /2 to halve it. 

Click the circular-arrows icon to enable or disable BPM Sync. When BPM Sync and Warp are both enabled, the 
sample’s BPM will be “locked” to the tempo of the sequence. When BPM Sync is disabled but Warp is enabled, the 
sample will be independent of the tempo of your sequence—use the Stretch field to lengthen or shorten a sample. 

Tip: You can configure audio track recording to ensure the resulting track region is warped automatically. You can 
then adjust the sequence tempo while track region remains in time. See Preferences > General to learn about this. 

Note: When you record an audio file, the current sequence tempo will be embedded with it. This information is 
stored within the sample file when you save the project. When you warp an audio track region, the warping algorithm 
uses this sequence tempo and the current value in the BPM field to generate the “stretch factor.” 

Note: Warp algorithms can be very CPU-intensive, and can result in audio drop-outs during playback if used too 
freely. Be mindful of how (and how often) you use the warp function. You can reduce the CPU resources required by 
doing any/all of the following: 

• Avoid using extreme Stretch values, especially anything below 100. 

• Minimize the amount of pitch adjustment (e.g., the Semi and Fine parameters) of warped audio. 

• Avoid warping very small track regions. 

• Warp as few tracks or track regions as possible (i.e., reduce the number of total number of voices of the 
polyphonic limit that use the Warp algorithm at a given time), especially instances where the warped regions start 
at the same time. 

• Avoid rapidly triggering samples that are warped. 

• If you have warped samples used in a drum program, consider using the Flatten Pad function to consolidate the 
affected pad’s layers into one audio sample. After you flatten the pad, its sample/samples no longer need to be 
warped. 

• Use a Warp algorithm other than Elastique Pro, which is very CPU-intensive. See Preferences > General to 
learn how to change this. 

• Using a higher buffer size (usually above 256) can reduce the possibility of CPU issues. See Preferences > 
Audio Device to learn how to do this. 



  

 
67 

 

 

Click the gear icon to enable or disable Link Slices and Zero Snap, to select 
an editing process (Process Sample), to set the Slice Preview behavior: 

Link Slices: When Link Slices is set to On, changing the start point of a 
slice (after you have created slices of a sample in Chop Mode) will also 
change the end point of the previous slice. Similarly, changing the end 
point of a slice will also change the start point of the next slice. When set 
to Off, you can create slices that are nonsequential, noncontiguous, or 
overlapping. This is the same as clicking the Link Slices button in the Q-
Links panel in Sample Edit Mode. 

Process Sample: Select an editing process to apply to the sample. These 
are the same processes available in Sample Edit Mode while in Track 
Mode (see Modes > Sample Edit Mode > Track Mode to learn more). 

Slice Preview: This determines if/how audio is played as you move a slice 
marker. As you move the slice marker through a sample waveform, you 
can set it to play the small part of the sample before the slice marker 
(Before), play the small part of the sample after the slice marker (After), or 
not play at all (Off). You can also configure this setting in the Preferences 
(see Preferences > General). 

Zero Snap: Enable Zero Snap to force start points, end points, and loop 
points to occur only at the waveform’s “zero-crossings.” This can help to 
avoid clicks and glitches when playing a sample. This is the same as 
clicking the Zero Snap button in the Q-Links panel in Sample Edit Mode. 

 

The large waveform display shows the “active” section of the sample waveform. 
The strip above the large display shows an overview of the entire sample 
waveform. If the waveform display is showing only part of the entire sample 
waveform, a white box in the overview will indicate the current position. 

The timeline provides a reference for the length of the sample. Click the down 
arrow () or right-click anywhere on the timeline to select the increments it 
will use: Time (secs:ms), Samples, or Beats. 

Scroll left or right on the waveform to move through it. Use the sliders in the 
lower-right corner or click the timeline and drag down or up to zoom in or out. 

The green marker and red marker are the start point and end point (respectively). 
These two points define the region of the sample that will be played. 
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Oscillator 

 

 

 

Use the Oscillator menu to change the oscillator assigned to the current layer. 

 

Use the Decay field to adjust the length of the oscillator amplitude decay.  

 

Use the Phase field to set the starting point of the waveform phase.  

 

Depending on the oscillator type selected, the following additional parameters will be available: 

Warm Sine 

• Precision: Controls the accuracy of the synthesis algorithm. 

• Fuzz: Adds noise and harmonic texture. 

 
Saw / Square 

• Shape: Morphs the waveform between saw and square. 

• Tone: Reduces high‑frequency content by morphing the waveform toward a sine shape. 

 
Digital Saw 

• Direction: Switches between saw and ramp waveforms. 

 
Pulse 

• Pulse Width: Adjusts the width of the pulse waveform. 

 
Noise 

• Tone: Controls the cutoff frequency of an internal low‑pass filter. 

 
FM2 

• Level: Controls the amount of FM modulation applied. 

• Decay: Sets the decay time of the second operator. 

• Coarse: Controls the coarse pitch of the second operator. 

• Tune: Controls the fine pitch of the second operator. 

• Feedback: Sets the amount of feedback applied to the second operator. 
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RM3 

• Coarse 1–3: Control the pitch of each operator. 

• Decay 1: Controls the decay of the first operator. 

• Decay 2–3: Control the decay of the second and third operators. 

 
Hat 

• Tone: Controls the brightness of the hi‑hat sound. 

 
Single‑Cycle and Single‑Cycle (ALG) 

• Feedback: Controls the amount of FM applied to the oscillator. 

• Feedback Shape: Applies waveshaping to the feedback signal. 

 
Wavetable 

• Position: Selects the waveform index within the wavetable. 

• XFade: Controls smoothing when transitioning between adjacent waveforms. 

 

Oscillator parameters can also be modulated using the Mod Matrix in the same way as other parameters. This can be 
found in the Track Editor for Drum Tracks and Keygroup Tracks. 
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List Editor 

 

In the List Editor, you can perform the same operations as in the Grid Editor but with a different interface/workflow. 

 

 

The List Editor has two views, which you can toggle between by pressing the Events and Tempo buttons. The 
Tempo view allows you to view and adjust sequence tempo automation. All other events and automation are shown 
on the Events tab.  

 

The sequence for the track will be shown as a list of events, with the following parameters: 

#: This is number of the note event. 

Time: This is the position of the note event in bars, beats, and ticks. Hover the mouse over the value to see its 
equivalent in pulses. If multiple note events occur at the same time, additional note events will be listed 
immediately below, but their Time values will be grayed out. 

Event Type: This icon indicates the type of event (e.g., Note, Aftertouch, Track Automation, etc.). See the 
description of the View menu below for a list of types of events to learn how to show only specific ones. 

Pad/Note: This is the pad and/or corresponding MIDI note number. For drum programs, you will see the pad 
number. For keygroup programs, plugin programs, and midi programs, you will see the note. 

Length: This is the length of the note event in ticks. Click and drag the field to adjust it. 

Velocity: This is the velocity of the note event with a velocity bar of corresponding color and length below it. 
Click and drag the field to adjust it. 

Mod Type: This is the type of modifier used on the note event. Modifiers are note-based and travel with the note, 
lasting for the full ringing duration of the note event. The available modifier types are Tuning (coarse), Tuning 
(fine), Cutoff, Resonance, Filter Env Amount, Pan, Level, Env Attack, Env Decay, Env Release, Sample 
Layer, and Sample Slice. There are additional modifier types when using MPCe pads with compatible MPC 
hardware. 

Value: This is the value of the modifier type. Click and drag the field to adjust it. 

Probability: This is the probability percentage of the event. Click and drag the field to adjust it. 

Ratchet: This is the ratchet value of the event. Click and drag the field to adjust it. 

Articulation: This is the drum articulation applied to the event. Click and drag the field to adjust it. 

Channel: This is the MIDI channel of the event.  
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To edit the parameters of an event, double-click it. In the window that 
appears, use the fields and menus to edit the event. Click OK to confirm your 
edits or Cancel to close the window without changing anything. 

 

 

 

To show or hide specific parameter columns, right-click one of the parameter 
names, and select the parameter column to show or hide. You can also choose 
to Auto-size this column or Auto-size all columns to fit the contents. 

 

 

 

The red arrow () on the left side of the list represents the playhead’s current 
position. If your sequence is playing, the arrow will move accordingly. 

 

 

 

Click the View menu in the lower-right corner of the List Editor to select which 
types of events are shown in the list. 

All: Select this option to show all event types. 

Notes: Select this option to show only notes. 

Aftertouch: Select this option to show only aftertouch messages. 

MIDI Automation: Select this option to show only MIDI automation events. 

Track Automation: Select this option to show only track automation events. 

Sequence Automation: Select this option to show only sequence tempo 
automation events. Note that these events are only visible when the Tempo 
tab is selected. 

Pitch Bend: Select this option to show only pitch bend events. 

Control Change: Select this option to show only MIDI CC messages. 

Program Change: Select this option to show only MIDI program change. 

Ch Pressure: Select this option to show only channel pressure messages. 

Mute: Select this option to show only mute events for tracks and pads. 

MPCe: Select this option to show only MPCe events such as Pad X/Y 
position. 

 

Click the Channel menu to select a MIDI channel to view events from. Select 1–
16 to display only events recorded on that channel. Select All to view events 
from all channels.  
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The following icons indicate the corresponding types of events: 

 

Note 

 

Track Mixer Automation (Volume, Pan, Mute, Solo) 

 

Track MIDI CC Automation (0–127) 

 
Track Parameter Automation (Aftertouch, Pitchbend, Channel Pressure, or Program Change), Pad X/Y 
Position  
 

Track Mixer Automation (Volume, Pan, Mute, Solo, or Send 1–4) 

 

Track Parameter Automation (options vary based on the type of program) 

 

Track Insert Effect Automation (options vary based on the effect) 

 

Pad/Keygroup Mixer Automation (Level, Pan, Pad Mute, Pad Solo, or Send 1–4) 

 

Pad/Keygroup Parameter Automation (options vary based on the type of program) 

 

Pad/Keygroup Insert Effect Automation (options vary based on the effect) 

 

Global Sequence Tempo 
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To insert a step in the list, click the + icon in the lower-right corner, and select one of the options: 

Note: Select this option to create a note in the list. The note will be at the earliest possible location not occupied 
by another note played by that pad. (This location takes the Time Correct settings into account.)  

MIDI: Select this option to create a MIDI event in the list. You can select: 

a MIDI CC: 0–127 

a MIDI-specific parameter: Aftertouch, Pitchbend, Channel Pressure, or Program Change 

a MIDI track-specific parameter: Volume or Pan 

Event: Select this option to add a Track Mute event in the list. 

Mixer: Select this option to add a Track Mixer event in the list. You can select Volume, Pan, Mute, Solo, or 
Send 1–4. 

Track: Select this option to create a track-specific automation event in the list. Options vary based on the type of 
track. 

Pad/Keygroup: Select this option to create a pad or keygroup automation event in the list. You can select: 

a pad or keygroup mixer parameter (Mixer > Level, Pan, Pad Mute, Pad Solo, or Send 1–4) 

a pad or keygroup track parameter (options vary based on the type of track) 

a pad or keygroup insert effect parameter (options vary based on the effect) 

an MPCe pad parameter (MIDI:Aftertouch, Pad X/Y position) 

Insert 1–4: Select these options to create a track insert effect parameter (options vary based on the effect) in the 
list. 

Global: Select this option to create a sequence tempo event in the list. Note that these are only visible when the 
Tempo tab is selected.  

 

To duplicate the currently selected step in the list, click the two-pages-and-+ icon in the lower-right corner. 
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Audio Editor 

 
When an audio track is selected, the Grid, Wave, and List editors will not be available. Instead, the audio editor is 
automatically selected, which lets you view and edit the audio waveform of the sample in the track. 

 

 

 

In the Audio Editor, these six icons enable you to use different functions 
in the waveform timeline. Click one to select its mode:  

 

Marquee: Marquee Mode: 

To select a region of the audio track, click the light-blue strip at the top of it. 

To move a track region (or multiple selected track regions), click the light-blue strip at the top of a 
track region and drag it to the desired location. Press and hold Shift after clicking it to move it 
without restricting (“snapping”) it to the quantization grid. You can move multiple regions as well. 

To duplicate a track region (or multiple selected track regions), press and hold Alt (Windows) or 
Option (macOS), click the light-blue strip at the top of a track region, and drag it to the desired 
location. Press and hold Shift after clicking it to move it without restricting (“snapping”) it to the 
quantization grid. You can duplicate multiple regions as well. 

To split a track region at two specific points (creating track regions on either side and between 
them), click and drag across anywhere in the upper two thirds of it to create a translucent white box, 
and then click the light-blue strip at the top of it. You can do this to multiple track regions as well.  

To shorten or lengthen a track region (or multiple selected track regions), click and drag the lower 
third of its left or right edge. Press and hold Shift while dragging it to adjust the length without 
restricting (“snapping”) it to the quantization grid. 

 

Arrow: Selection Mode: 

To select a region of the audio track, click anywhere in the upper two thirds of it. 

To move a track region, click and drag anywhere in the upper two thirds of it. Press and hold Shift 
after clicking it to move it without restricting (“snapping”) it to the quantization grid. 

To duplicate a track region (or multiple selected track regions), press and hold Alt (Windows) or 
Option (macOS), click the light-blue strip at the top of a track region, and drag it to the desired 
location. Press and hold Shift after clicking it to move it without restricting (“snapping”) it to the 
quantization grid. You can duplicate multiple regions as well. 

To adjust the start or end point of a track region, click and drag anywhere in the lower third of its 
left or right edge. Press and hold Shift while doing this to adjust the start or end point without 
restricting (“snapping”) it to the quantization grid. 
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Pencil: Draw Mode: 

To create a point in the automation curve, click the desired location in the automation lane. Press 
and hold Shift while clicking to create it without restricting (“snapping”) it to the quantization grid. 

To draw part or all of an automation curve, click and drag the desired curve in the automation lane. 
Press and hold Shift while clicking to draw it without restricting (“snapping”) it to the quantization grid. 

To select a point in the automation curve, click it. 

To move a point in the automation curve, click and drag it to another location in the automation lane. 
Press and hold Shift while clicking to move it without restricting (“snapping”) it to the quantization grid. 

To erase a point in the automation curve, double-click it. 

 

Eraser: Erase Mode: 

To erase a track region (or multiple selected track regions), click it.  

To copy a track region, press and hold Alt (Windows) or Option (macOS) and then click and drag it. 

To erase part or all of an automation curve, click and drag over the desired section of the curve in 
the automation lane. 

 

Scissors: Split Mode: 

To select a track region, click its left or right edge. 

To split the track at a specific point (creating a track region on either side), click that point in the 
track. Press and hold Shift while clicking to split the track without restricting (“snapping”) it to the 
quantization grid. 

To copy a track region, press and hold Alt (Windows) or Option (macOS) and then click and drag it. 

 

Mute: Mute Mode: 

To mute or unmute a track region (or multiple selected track regions), click it. 

To copy a track region, press and hold Alt (Windows) or Option (macOS) and then click and drag it. 

 

 

To zoom in or out, use the slider in the lower-right corner of the Audio Editor or click the timeline and drag down or 
up. 

 

 

 

The Region field shows the name of the currently selected region of the audio track. Double-click it to rename the region. 

 

Click the two-pages-and-+ icon to duplicate the currently selected region of the audio track. The duplicate region 
will appear immediately after the original one. 

 

Use the Fade In or Fade Out fields to create a fade-in or fade out for the currently selected region of the audio track. 
The fades will be shown as a sloped line at the start or end of the region. 

 

Use the Level slider to set the level of the currently selected region of the audio track. The waveform amplitude will 
change accordingly. Alternatively, click the dB value next to the slider and enter the desired level. 
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Click M to mute or unmute currently selected region of the audio track. 

 

Click Rev to reverse the currently selected region of the audio track. 

 

To lengthen or shorten the currently selected region of the audio track without changing its pitch, click Warp, 
which will enable the Semi, Fine, and BPM fields next to it.  

Use the Warp Algorithm field to select the preferred algorithm for warp for the audio track: Default, Elastique Pro, 
Pro Ten, or Repitch. When using Repitch, warping an audio sample will adjust its pitch to synchronize it with the 
MPC tempo. The default setting can be adjusted in the Audio Warp and BPM Detect section in Preferences > 
Audio/Export. Changing the setting for a sample will override the default Preferences setting.  

Use the BPM field to change the tempo, which will change the length of the region accordingly. You can also click X2 
to double the value or /2 to halve it. Use the Semi and Fine fields if you want to change the pitch (this is useful for 
matching the durations of two samples with different pitches). 

Tip: You can configure audio track recording to ensure the resulting track region is warped automatically. You can 
then adjust the sequence tempo while track region remains in time. See Preferences > General to learn about this. 

Note: When you record an audio file, the current sequence tempo will be embedded with it. This information is 
stored within the sample file when you save the project. When you warp an audio track region, the warping algorithm 
uses this sequence tempo and the current value in the BPM field to generate the “stretch factor.” 

Note: Warp algorithms can be very CPU-intensive, and can result in audio drop-outs during playback if used too 
freely. Be mindful of how (and how often) you use the warp function. You can reduce the CPU resources required by 
doing any/all of the following: 

• Minimize the amount of pitch adjustment (e.g., the Semi and Fine parameters) of warped audio. 

• Avoid warping very small track regions. 

• Warp as few tracks or track regions as possible (i.e., reduce the number of total number of voices of the 
polyphonic limit that use the Warp algorithm at a given time), especially instances where the warped regions start 
at the same time. 

• Avoid rapidly triggering samples that are warped. 

• If you have warped samples used in a drum program, consider using the Flatten Pad function to consolidate the 
affected pad’s layers into one audio sample. After you flatten the pad, its sample/samples no longer need to be 
warped. 

• Using a higher buffer size (usually above 256) can reduce the possibility of CPU issues. See Preferences > Audio 
Device to learn how to do this. 
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To show or hide the automation lane, click the up or down arrow (∧ or ∨) button next to the horizontal scroll bar 
under the grid. 

 

The automation curve can contain points at the current Time Correct intervals. Press and hold Shift while creating 
and editing the automation curve to adjust it without restricting (“snapping”) it to the quantization grid. 

 

 

To show the automation of an automatable parameter, click the down arrow () in the lower-left corner of the Grid 
Editor. You can select a track parameters only (for the mixer or insert effects)—the parameter name will appear below 
Modifier. You can then use any of the tools to create and edit automation for this parameter in the automation lane. 

To create a point in the automation curve, click the desired location with the pencil tool, or double-click the 
desired location with any other tool. Press and hold Shift while clicking to create it without restricting 
(“snapping”) it to the quantization grid. 

To draw part or all of an automation curve, click and drag the desired curve with the pencil tool. Press and 
hold Shift while clicking to draw it without restricting (“snapping”) it to the quantization grid. 

To erase a point in the automation curve, click and drag over it with the eraser tool, or double-click it with 
any other tool. 

To erase part or all of an automation curve, click and drag over the desired section of the curve with the 
eraser tool. 

To select a point in the automation curve, click it. 

To move a point in the automation curve, click and drag it to another location in the automation lane. Press 
and hold Shift while clicking to move it without restricting (“snapping”) it to the quantization grid. 

 

Each parameter in the automation lane has an icon next to it that indicates the type of parameter it is: 

Audio Track Mixer Automation (Volume, Pan, Mute, Solo), Insert Effect Automation (options vary based on 
the effect), or Global Automation (Sequence Tempo). 
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Mixer Window 
 

If you want to see channel strips for both the Pad Mixer and the Channel Mixer at the same time, you can open the 
Mixer Window, which provides an overview of the channel strips in both modes in one screen. 

 

To open or close the mixer window, do one of the following: 

• Click the menu icon (≡), and go to View and click Show Mixer Window. 

• Click the two-sliders icon in the lower-left corner of the window. 

 

 

 

The upper half of this window shows the Pad Mixer channel strips (see Modes > Pad Mixer to learn about these). 

The lower half of the window shows the Channel Mixer channel strips (see Modes > Channel Mixer to learn about these). 

All selectors and channel strips work as they normally do in their respective modes. 

Tip: This window can be very helpful when using a dual-monitor computer setup.  

 

Use the three icons at the top of the window to select which channel strips are shown: 

Click the pad-and-slider icon to show just the Pad Mixer channel strips. 

Click the two-sliders icon to show just the Channel Mixer channel strips. 

Click the pad-and-three-sliders icon to show both Pad Mixer and Channel Mixer channel strips. 
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Panels 
 

In several modes, the lower half of the window shows 
several different panels. 

To show or hide each panel, click its selector. 

To show or hide the entire bottom panel, click the two-
panels icon in the lower-left corner of the window. 

This chapter describes the available panels. 

Note: Similar to these panels, the lower half of the window 
of the Pad Mixer and Channel Mixer shows several different 
channel strips, which you can show or hide by clicking the 
selectors. See Modes > Pad Mixer and Modes > Channel 
Mixer chapter to learn about these. 

 

 

MIDI Keyboard 

 

The MIDI keyboard feature is a graphical representation of a piano keyboard at the bottom of the window.  

To show or hide the MIDI keyboard, do one of the following: 

• Click the menu icon (≡), and go to View and click Show MIDI Keyboard. 

• Click the two-panels icon in the lower-left corner of the window. 

 

 
 

Whenever a note is played (by pressing a pad, playing the current sequence, etc.), the corresponding keys on the 
MIDI keyboard will be lit, appearing to be “played.” These keys will correspond to the notes played in the current 
track only. 

Similarly, you can click keys on the MIDI keyboard to trigger those notes on the current track. This can be useful for 
auditioning the sound of the track’s program in different octaves. 

Click the left-arrow or right-arrow button on either side of the MIDI keyboard to shift the range of the keys displayed 
in the window. 

If the MIDI Keys feature is enabled, the corresponding computer keyboard 
character will be shown above each key, though you can still use MIDI keys even if 
it is hidden. Furthermore, you can use the MIDI keyboard even if MIDI Keys is 
disabled. See Toolbar > Menu > Tools to learn about this feature. 
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Q-Links 

 

The Q-Links panel shows the 16 Q-Link knobs with their assigned 
parameters listed below. 

Click the Q-Link Mode menu to select the current edit mode of the Q-Link 
knobs: 

Screen: In this edit mode, the Q-Link knobs will control a default 
parameter or group of parameters in your currently selected mode 
(e.g., Main Mode, Sample Edit Mode, etc.). 

Project: In this edit mode, the Q-Link knobs can control 16 parameters 
within the current project overall. See the following Project section to 
learn how to use this mode. 

Track: In this edit mode, the Q-Link knobs control 16 track parameters. 
See the following Track section to learn how to use this mode. 

Pad Scene (for drum programs only): In this edit mode, the Q-Link 
knobs can control 16 parameters for the currently selected pad. See 
the following Pad Scene section to learn how to use this mode. 

Pad Parameters: In this edit mode, the 16 Q-Link knobs correspond to 
the 16 pads, each one controlling the same parameter for each pad. 
This is useful if you need to adjust the same parameter on multiple pads 
at once rather than having to select and edit each pad individually. See 
the following Pad Parameters section to learn how to use this mode. 

Track FX Rack: In this edit mode, the Q-Link knobs can control 16 FX Rack parameters. The assignments can 
be saved as part of an FX Rack preset. 

MIDI: In this edit mode, the Q-Links are fixed to a selection of MIDI performance controls, allowing you to control 
modulation, pitch bend, sustain and other common MIDI messages as you play.  

Volume: In this edit mode, the Q-Links are fixed to control the volume level of the available tracks. 

Pan: In this edit mode, the Q-Links are fixed to control the stereo panning of the available tracks. 

Send 1–4: In these edit modes, the Q-Links are fixed to control each Send control on the available tracks. 

Step Sequencer: In this edit mode, the Q-Links are fixed to control the velocity of notes in Steps 1–16, based on 
the current Time Division value.  

Note: When using MPC hardware with four Q-Link knobs (e.g., MPC Live, MPC One, etc.), a gold rectangle in this 
panel indicates the four knobs that can be controlled by that bank of four Q-Link knobs. 
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Project 

 

In the Project Q-Link Edit Mode, the Q-Link knobs control 16 parameters within the current project. 

 

These are the available sources for each Q-Link knob: 

Track: track parameters—select one of the tracks in your project. For drum programs and keygroup programs, 
you can select either the entire track or a specific pad or keygroup within it. 

Return: return mixer parameters (Returns 1–4). 

Submix: submixer parameters (Submixes 1–8). 

Main: main mixer parameters (Outputs 1/2–31/32). 

 

These are the available parameters for each Q-Link knob: 

Mixer: mixer parameters (options vary based on the Source) 

Track: track parameters (options vary based on the type of track; available only if the Source is a drum track, 
keygroup track, MIDI track, or CV track) 

Insert 1–4: insert effect parameters (options vary based on the effect; available only if the Source has an insert 
effect loaded) 

 

Track 
 
In the Track Q-Link Edit Mode, the Q-Link knobs control 16 parameters within the currently selected track. 
 
These are the available sources for each Q-Link knob: 

Track: track parameters—select the track. For drum tracks, you can select either the entire track or a specific 
pad within it. 

 
These are the available parameters for each Q-Link knob: 

Mixer: track mixer parameters (options vary based on the Source) 
Track: track parameters (options vary based on the type of track; available only if the Source is a drum track, 
MIDI track, or CV track, not an audio track) 
Insert 1–4: insert effect parameters (options vary based on the effect; available only if the Source has an insert 
effect loaded)  

 
 
Pad Scene 
 
In the Pad Scene Q-Link Edit Mode, the Q-Link knobs control your favorite 16 parameters for the currently selected 
pad. You can select another pad simply by pressing it, allowing you to adjust the same 16 parameters for that new 
pad. (These 16 parameter assignments are automatically saved with other user settings. Any project you load will use 
these assignments.) 
This option works for drum tracks only. 
 
The only available sources for each Q-Link knob are pads within a drum track. 
To select a pad, press it. 
 
These are the available parameters for each Q-Link knob: 

Mixer: pad mixer parameters (Level, Pan, Pad Mute, Pad Solo, or Send 1–4) 
Track: pad parameters (i.e., parameters used in Track Edit Mode) 
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Pad Parameters 
 
In the Pad Parameters Q-Link Edit Mode, the Q-Link knobs control the same pad parameter for each of the 16 pads 
in the current pad bank. 
For example, if the Parameter is set to Level, the 16 Q-Link knobs will adjust the 16 independent Level settings for 
each pad in the current pad bank. You could then set the Parameter to Pan and use the Q-Link knobs to adjust the 
panning of all 16 pads. 
This option works for drum tracks only. 
 
The only available sources for each Q-Link knob are pads within a drum track. 
To select a pad, press it. 
 
These are the available parameters for each Q-Link knob: 

Mixer: pad mixer parameters (Level, Pan, Pad Mute, Pad Solo, or Send 1–4) 
Track: pad parameters (i.e., parameters used in Track Edit Mode) 

 
 
 

Pads 

 

The Pads panel shows the 16 pads with their assigned samples. All pads will 
display their assigned colors. 

Click a Pad Bank letter at the top of this panel to select a pad bank. 

Each pad will display different contents, depending on the current mode. See the 
description of this panel in the chapter for each mode. 

Each pad can also display a color, which you can customize for each track. See 
Pad Color to learn how to do this. 

 

 

 

 

 

 

 

Pad Perform  

 

The Pad Perform panel lets you assign musical scales/modes, chords, or 
progressions to the pads for more creative performance. Learn about the specific 
parameters in Modes > Main Mode > Pad Perform. 
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Track Editor 
 

 
 

The Track Editor panel contains the parameters for Track Edit Mode, which vary depending 
on the type of track. Learn about the specific parameters for each program type in Modes > 
Track Edit Mode. 

 

 

Parameters 
 

The Parameters panel shows the available parameters and editing processes in Sample 
Edit Mode. 

See the Modes > Sample Edit Mode chapter to learn more about this panel and its 
different features in Trim Mode, Chop Mode, and Track Mode. 
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Project 
 

The Project panel is a list of all available tracks, 
sequences, and samples in the project. This panel is 
identical to the Project Info Browser (see Browser > 
Project Info Browser) but in a horizontal layout rather 
than vertical. 

To duplicate a track in the project, right-click it 
and click Duplicate. An identical track will be 
created immediately. The duplicate track will use 
the same name but appended with a number (e.g., 
Drum 002). 

To duplicate a track including its events, right-
click it and click Duplicate with events. An 
identical track will be created immediately with the 
same events as the original track. The duplicate 
track will use the same name but appended with a 
number (e.g., Drum 002).  

To delete a track, right-click it and click Delete. 

To save a track, right-click it and click Save. Use the window that appears to enter a name for the track file 
(.xtp) and select a location. Click Save to confirm your choice or Cancel to cancel saving. 

To rename a program or sample, right-click it and click Rename. Enter a name in the window that appears, 
and then click Do It to confirm your choice or Cancel to cancel saving. 

To adjust the track position, right-click it and select Move Up or Move Down. Other tracks will be moved in 
relation to the new track position.  

 
A list of samples will appear to the right of the Project list under Samples (the samples that are listed are part of the 
selected track or sequence under the Project list). 

To audition the sample, hover your cursor over the waveform icon so it turns into a speaker icon. Click this 
icon to hear the sample. 

To delete samples from the project, click the trash can icon. In the screen that appears, select Purge Unused 
Samples to delete all unused samples from the project (from all tracks and sequences), or select Delete All 
Samples to delete all samples from the project. 

To delete a sample, right-click it and click Delete. Click Delete or Delete Sample to confirm your choice or 
Cancel to cancel the deletion. 

To save a program or sample, right-click it and click Save. Use the window that appears to enter a name for 
the sample file (.wav) and select a location. Click Save to confirm your choice or Cancel to cancel saving. 

To rename a sample, right-click it and click Rename. Enter a name in the window that appears, and then click 
Do It to confirm your choice or Cancel to cancel saving. 

To view a sample in Sample Edit Mode, right-click it and click Edit. Alternatively, double-click the sample. You 
will immediately enter Sample Edit Mode and show the sample’s waveform in the Wave Editor. 

 
You can also use this section to sort and assign samples to Memory or to Stream from disk. Click each header to 
show only samples in each category. 

If a sample is loaded to memory, right-click it and select Stream From Disk to remove it from memory and 
stream it from a disk drive. Disk streaming samples will be marked with a green waveform icon.  

If a sample is streaming from disk, right-click it and select Load To Memory to disable streaming the sample 
from a disk drive and return it to memory. Samples loaded to memory will be marked with a grey waveform icon.  

Note: Disk streaming relies on the performance of the disk you are streaming from. For best operation, it is 
recommended to use an SSD (solid-state drive). Once you have saved a project to your SSD, your files will 
stream from that location. For an unsaved project, MPC uses a temporary file location from which to stream 
audio files. Go to Menu > Preferences > Project Load/Save and set the Temporary File Location to your SSD 
for best results.  
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Sampler & Looper 

 

The Sampler and Looper panels show similar 
controls for setting levels, monitoring, inputs, 
and effects of your incoming audio signal. 

See Modes > Sampler and Modes > Looper to 
learn more about each one. 

 

 

 

 

 

 

   

Pad Banks & Mute 

 

The Pad Banks and Mute panels let you select pads, assign pad or track groups, 
and adjust timing correct settings in Pad Mute Mode and Track Mute Mode. 

See Modes > Pad Mute Mode and Modes > Track Mute Mode to learn more about each one. 

       
 
 

Sequence List  

 

The Sequence List panel has 
different appearances in Next 
Sequence Mode and Song Mode. 

In Next Sequence Mode, it shows a list of all available 
sequences in your project as well as their length and 
tempo. See Modes > Next Sequence Mode to learn 
about this. 

In Song Mode, it shows the list of steps in the song, 
including the number of repeats, the tempo of each 
sequence, and the length of each step. See Modes > 
Song Mode to learn about this. 
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Performance Controls 

 

The Performance Controls panel shows the available commands you can execute in 
Next Sequence Mode.  

See Modes > Next Sequence Mode to learn about this. 

 

 

 

 

 

 

 

 

 

Song Parameters 

 

The Song Parameters panel shows the available controls to create a song in Song 
Mode. This includes controls for inserting and deleting song steps, a sequence selector 
for the current step, and parameters that determine how long each step plays. 

See Modes > Song Mode to learn about this. 
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Time Correct 
 

The Timing Correct window contains various settings to help 
quantize events in your sequence. You can quantize note events on 
MIDI tracks or track regions on audio tracks (though you cannot apply 
all types of quantization to audio tracks). 

To open the Timing Correct settings, click the menu icon (≡), 
select Edit, select Time Correct, and click Settings…. 

 

Click the Global Timing Correct button to enable or disable Global 
Timing Correct. 

To apply the settings you selected to all tracks, click All Tracks. 

To apply the settings you selected to the current track, click 
Do It. 

To cancel and return to the previous screen, click Close. 

You can also enable or disable Global  Timing Correct by clicking the TC button in the Timing Controls section of 
the Toolbar at the top of the window. 

 

Use the Type selector to set how timing corrections are applied. 

Start: The entire note event or audio track region will be nudged forward or backward so the start point aligns 
with the closest time division marker in the grid. You can apply this to MIDI tracks or audio tracks. 

End: The end points of note events will be extended or shortened to align with the closest time division marker in 
the grid. The start points will remain untouched. You can apply this to MIDI tracks only. 

Length: The end points of note events will be extended or shortened so that each event’s length is a multiple of 
the time division, regardless of where it is in the grid. The start points will remain untouched. You can apply this 
to MIDI tracks only. 

Legato: The end points of note events will be extended or shortened to create a long, unbroken phrase from the 
first note event’s start point to the last note event’s end point. Each note event will sustain until another note event 
starts. If multiple note events start at the same time (and are not the last note events), their lengths will become 
identical. Selecting Legato disables all other options in this window. You can apply this to MIDI tracks only. 

  
 Without legato applied. With legato applied. 

 

Use the Time Division selector to set the quantization value. Events will “snap” to these time divisions on the grid. 
The T indicates a triplet-based value. 

Alternatively, click the TC field in the Timing Controls section of the Toolbar at the top of the window and select a 
time division. 

 

Use the Swing field to set the amount of swing from 50% to 75%. Swing lets you “shuffle” your beats—from subtle 
to extreme.  

This value can also be set using the Swing field in the Timing Controls section of the Toolbar at the top of the 
window. 



  

 
88 

 

 

Use the Shift Timing field to shift all events by clock ticks.  

 

Use the Window field to set how many events around a quantize value will be quantized. Any events outside this 
range will not be quantized; events inside will. 

 

Use the Strength field to set how strictly events will be quantized (i.e., shifted toward the quantize value). Lower 
values move events a little bit towards the closest quantize value, resulting in a less mechanical feel than a strict 
quantization (a higher value). 

 
Use the Events selector to set the target range for the time correction. You can apply the time correction to All note 
events or to just the Selected ones. To select note events to which to apply time correction, either use the various 
tools in the editors, or press or click the pad with the desired events (while Hitting Pad Selects All Events is set to 
On). You must do this before opening the Time Correct window. 

When Range is selected, you can define the locations (From and To) as well as the pads or keys that will be 
quantized. When applying time correction to an audio track region, you will not be able to specify pads or keys. 
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Metronome 
 
The Metronome menu contains all settings regarding the metronome (click track). 

 

To view the metronome settings, click the menu icon (≡), select Tools, and click Metronome. 

 
Use the Count-In submenu to set if/when the metronome counts before recording. 

Off disables the metronome pre-count. 

Record enables the pre-count during recording only. 

Record + Play enables pre-count in both Record and Playback Modes. 

 
Use the Enable submenu to set if/when the metronome is enabled. 

Off disables the metronome. 

Play enables the metronome sound during playback only. 

Record enables the metronome sound during recording only. 

Record + Play enables the metronome to happen in both Record and Playback Modes. 

 
Use the Rate submenu to select the metronome click’s time division: Auto, 1/4, 1/4T, 1/8, 1/8T, 1/16, 1/16T, 1/32 or 
1/32T. T indicates a triplet-based time division. When set to Auto, the Metronome will automatically adjust to the 
current time signature’s denominator value. 
 
Use the Sound submenu to select the sound that you want to hear for the metronome: Sidestick 1, Sidestick 2, 
Clap, Metroclick, Shake, Tambourine, or MPC Click. 

 
Use the Output menu to set where the metronome signal will be heard: a pair of main outputs (Out 1,2–31,32) or a 
single main output (Out 1–32). 

 
Click the metronome icon in the Timing Controls section of the Toolbar at the top of the window to enable or 
disable the metronome. 

Use the Metro meter next to this icon to set the volume of your metronome click. 
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Editing Processes 
 

You can use the processes described in this chapter to edit an Audio Region, Sequence, or Track.  

 

 

Audio Region 
 

You can use any of these functions when an audio track is selected and an audio region is selected in the Audio 
Editor. Click the menu icon (≡), select Edit > Audio Region, and select the following: 

 

• The Duplicate function copies and pastes the track region immediately after the original one. 

 

• The Mute function silences the track region. 

 

• The Reverse function reverses the track region. 

 

• The Warp function lengthens or shortens the track region without changing its pitch.  

Use the BPM field above the Audio Editor to change the tempo, which will change the length of the track 
region accordingly. 

Use the Semi and Fine fields above the Audio Editor to change the pitch (this is useful for matching the 
durations of two samples with different pitches). 

Note: The Warp algorithms are very CPU-intensive and can result in audio drop-outs during playback if used 
too freely. Be mindful of how (and how often) you use the warp function. 

 

 

You can also do the following while editing an audio track by right-clicking the Track field in the Inspector and 
selecting the following: 

 

• The Clear Regions function erases all regions from the audio track without erasing the track itself. 

 

• The Reset Channel Strip function:  

o clears all Insert effect slots; 

o turns Mute, Solo, automation, and Monitor off; 

o resets the pan knob to the center; 

o resets the level slider to 0.00 dB; and  

o turns the Record Arm () button off.  

It does not change the track’s inputs or outputs. 

Click Reset to continue or Cancel to return to the previous screen. 
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Sequence 

 

You can use any of these functions on the currently selected sequence. Right-click 
click the Sequence field in the Inspector to select the following: 

 

• The Half Length function will immediately halve the length of the sequence 
(without deleting any note events). 

 

• The Double Length function will immediately double the sequence and copy all 
events from the first half to the second half. 

 

• The Clear Arrangement function erases all events from the sequence and resets 
all of its settings. 

 

• The Erase function erases all or part of a track in a specific sequence. 

Use the Sequence field to select the sequence you want to erase. 

Use the Track field to select the track you want to erase within the sequence. 

Use the Start and End fields to set the time range (in bars, beats, and ticks) of the sequence you want to 
erase. The Start fields set the start of the time range, and the End fields set the end of the time range.  

Select one of the Erase options to select what types of events you erase: 

o All erases all pad events from the designated time range and reset all of its settings. 

o Automation erases only automation from the designated time range. Use the Parameter field to select 
what type of automation is erased. 

o Note erases only specific pad events from the designated time range. In the diagram of the eight pad 
banks that appears, press each pad in each bank to select or deselect its notes. 

o Except Note erases everything except pad events from the designated time range.  

Click Do It to continue or Cancel to return to the previous screen. 

 

• The Copy function copies the contents of one sequence to another. 

Use the Copy Contents of Sequence field to select the “source” sequence. This is the sequence whose 
events you want to copy. 

Use the Over Contents of Sequence field to select the “destination” sequence. This is the sequence where 
the source sequence will be copied. 

Use the Sequence Name field to rename the destination sequence. 

Click Do It to continue or Cancel to return to the previous screen. 

 

• The Insert Bars function adds empty bars to a sequence at a specified point. 

Use the Sequence field to select the desired sequence. 

Use the # of Bars field to set how many bars you will insert. 

Use the Before Bar field to set where you will insert the bars. The bars will be inserted before this one. 

Click Do It to continue or Cancel to return to the previous screen. 
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• The Delete Bars function removes a range of bars from a sequence. 

Use the Sequence field to select the sequence whose bars you want to delete. 

Use the First Bar and Last Bar fields to set the range of bars you want to delete. The bar in each field and 
all bars in between them will be deleted. 

Click Do It to continue or Cancel to return to the previous screen. 

 

• The Copy Bars function copies a range of bars from a sequence and adds them to another at a specified point. 

Use the Copy From > Sequence field to select the “source” sequence. This is the sequence whose bars you 
want to copy. 

Use the First Bar and Last Bar fields to set the range of bars to copy in the source sequence. 

Use the Paste To > Sequence field to select the “destination” sequence. This is the sequence where the 
source sequence bars will be copied. 

Use the After Bar field to set where you want to add the copied bars. The copied bars will be inserted after 
this one. 

Use the Copies field to set how many instances of the copied bars you want to add. 

Click Replace to overwrite the destination sequence. 

Click Merge to add the events to the destination sequence without erasing anything. 

Click Cancel to return to the previous screen. 

 

• The Copy Events function copies a range of events or selected audio track regions from a sequence and adds 
them to another at a specified point. 

Use the Copy From > Sequence field to select the “source” sequence. This is the sequence whose events 
you want to copy. 

Use the Copy From > Track field to select the “source” track. This is the track whose events you want to 
copy. 

Use the Copy From > Time fields to set the time range (in bars, beats, and ticks) of the events you want to 
copy. The Time fields set the start of the time range, and the To fields set the end of the time range.  

Click the Copy All Events/Copy Only Selected Events menu to select either option. Select Copy All 
Events to copy and paste all events in the track. Select Copy Only Selected Events to copy and paste 
only the events that are currently selected. 

Use the Paste To > Sequence field to select the “destination” sequence. This is the sequence where the 
source sequence events will be copied. 

Use the Paste To > Track field to select the “destination” track. This is the track where the source track 
events will be copied. 

Use the Paste To > Time fields to set where (in bars, beats, and ticks) you want to add the copied events. 
The events will be added after this point. 

Use the Copies field to set how many instances of the copied events you want to add. 

Click Replace to overwrite the destination sequence. 

Click Merge to add the events to the destination sequence without erasing anything. 

Click Cancel to return to the previous screen. 
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• Export as MIDI lets you export the current sequence as a standard MIDI (.mid) file. In the Export Current 
Sequence as Standard MIDI file window, do any of the following: 

Click the down arrow () next to the file path to select the storage device you want to view. If you have 
storage devices connected to your MPC hardware, they will appear in this column, as well. 

Double-click a folder to enter it, or press Enter. 
Click New Folder to create a new folder. Type a name for the new folder, and then click OK or press Enter 
to confirm the name, or click Cancel or press Esc to keep the original name. You will immediately enter the 
new folder. 

Click the up arrow ()to move up one folder level. 

Click the File field at the bottom of the window to name the file. 

Click Save or press Enter to save the file. 

Click Cancel or press Esc to cancel. 

 

• The Bounce to Sample function immediately renders the sequence (all of its tracks) as an audio sample and 
places it in the project’s sample pool. By default, it will be named Bounce - and appended with the sequence 
name. If you have already used this function on this sequence, then it will create another audio sample appended 
with the next-highest number. 

You can also press Shift+Alt+S (Windows) or Shift+Option+S (macOS). 

 

• The Bounce to New Audio Track function immediately renders the sequence (all of its tracks) as an audio track 
in the project. The new Audio track will be automatically selected. By default, the sample will be named Bounce - 
and appended with a number. This function does not work for tracks that use MIDI programs or CV programs. 

You can also press Alt+S (Windows) or Option+S (macOS). 

 

• The Sequence Settings function opens a window where you can edit the following settings:  

Use the Name field to rename the sequence.  

Use the Auto-Select Track field to select a track in your project that will automatically be selected when 
selecting the sequence. Select None to keep the current track in focus when changing sequences.   
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Track 
 
You can use any of these functions on the currently selected track. To access the following functions, click the menu 
icon (≡), select Edit > Track, and select the following: 

 

• The Merge Tracks function lets you copy the pads (and their parameters) from one program into another, 
essentially consolidating two programs into one. The name of the new program will be the names of the original 
two programs separated by and. 

Use the From track menu to select the track you want to copy. 

Use the Into track menu to select the track to which the copied pads will be added. 

Check the Include program and pad parameters box if you want to also copy all current track and parameter 
settings into the new track.  

Click OK to continue or Cancel to return to the previous screen. 
 

• The Copy Pad function lets you copy a pad, bank, or range of pads from one Drum track to another. 

Use the Copy Type menu to select whether you want to copy an individual Pad, a Bank of pads or a Range 
of pads. Use the fields that appear to select the Pad, From Bank or Start/End Pads that will be copied. 

Use the From Track menu to select the track from which the pads will be copied. 

Use the To Track menu to select the track to which the copied pads will be added. 

Use the Pad, To Bank or Start Pad where the copied pads will be added starting from.  

Click Apply to confirm your setting, and then click Do It to copy the pads or Cancel to return to the previous 
screen. 

 

• The Copy Pads function lets you copy a pad to one or more pads on the same track.  

Use the Copy from pad menu to select the pad that will be copied. 

Use the Copy to pad section to select the new pad or pads where the pad will be copied. Click to select the 
desired pads in the pad banks. 

Click Do It to copy the pad, or Cancel to return to the previous screen. 
 

• The Delete function erases the track from the project. The samples used in that track will remain in the project’s 
sample pool and any other tracks that use them. 

Click Delete to confirm, or Cancel to return to the previous screen. 

 

• The Clear Arrangement function erases all note events or audio from the current track. 

Click Clear to confirm, or Cancel to return to the previous screen. 

 

• The Rename function lets you rename the track.  

Use the text field to enter a new track name. 

Click Do It to continue, or Cancel to return to the previous screen. 

 

• The Explode function (available for Drum Tracks only) immediately breaks down a Drum track containing 
samples and events into multiple new tracks, making it easier to mute individual drum elements using Track Mute 
Mode. Each new track will keep the pad and track insert effects of the original source track. Where pads with 
events are assigned to a mute group, those pads are copied to a single track. 

 

• The Events Double Speed function immediately halves the lengths of all note events on the track as well as the 
distance between them. In other words, the track’s notes are pressed closer together so the track sounds like it 
is playing at twice the previous speed. This does not actually affect the pitches of notes or the tempo. 

 
• The Events Half Speed function immediately doubles the lengths of all note events on the track as well as the 

distance between them. In other words, the track’s notes are spread further apart so the track sounds like it is 
playing at half of the previous speed. This does not actually affect the pitches of notes or the tempo. 



  

 
95 

 

 

• The Split Events function divides all notes or the selected notes into multiple parts. Select one of the preset 
number of events (2–9), or click Split Events… to open the Split Events Setup window. 

Use the Into slider to set the number of events to split notes into, 2–32. 

Check the Only select events to only split the currently selected notes. When unchecked, all note events in 
the track will be split.  

Click Do It to continue, or Cancel to return to the previous screen. 

 

• The Next Track and Previous Track options select the next or previous track in your sequence (respectively). 

 

• The Pad Color option opens the Pad Color window where you can assign specific colors to your pads in each 
program. See the Pad Color chapter to learn how to use this. 

 

• The Note Mapping option opens the Note Mapping window where you can where you can assign a MIDI note 
to each pad in a program. See the Note Mapping chapter to learn how to use this. 
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Right-click click the Track field in the Inspector to select the following: 

 

• The New Track function opens the New Track window, where you can select the 
type of new track to add. This is the same as clicking the + icon in the track area. 

 

• The Save Track function lets you save the current track. 

 

• The Delete function erases the entire track. 

 

• The Clear function erases all note events or audio from the current track.  
 

• Export as MIDI lets you export the current track as a standard MIDI (.mid) file. In the Export Current Track as 
Standard MIDI file window, do any of the following: 

Click the down arrow () next to the file path to select the storage device you want to view. If you have 
storage devices connected to your MPC hardware, they will appear in this column, as well. 

Double-click a folder to enter it, or press Enter. 
Click New Folder to create a new folder. Type a name for the new folder, and then click OK or press Enter 
to confirm the name, or click Cancel or press Esc to keep the original name. You will immediately enter the 
new folder. 

Click the up arrow ()to move up one folder level. 

Click the File field at the bottom of the window to name the file. 

Click Save or press Enter to save the file. 

Click Cancel or press Esc to cancel. 

 

• The Bounce to Sample function immediately renders the track as an audio sample and places it in the project’s 
sample pool. By default, it will be named Bounce - and appended with the sequence name. If you have already used 
this function on this sequence, then it will create another audio sample appended with the next-highest number. 

 

• The Bounce to New Audio Track function immediately renders the track (for the current sequence only) as an 
audio track in the project. The Main Mode will automatically switch to the new Audio track, and the original track 
will be muted. By default, it will be named Audio and appended with a number (e.g., Audio 002). This function 
does not work for tracks that use MIDI programs or CV programs. 

 

• The Explode Track function (available for Drum Tracks only) immediately breaks down a Drum track containing 
samples and events into multiple new tracks, making it easier to mute individual drum elements using Track 
Mute Mode. Each new track will keep the pad and track insert effects of the original source track. Where pads 
with events are assigned to a mute group, those pads are copied to a single track. 

 

• The Reset Channel Strip function:  

o clears all Insert effect slots; 

o turns Mute, Solo, automation, and Monitor off; 

o resets the pan knob to the center; 

o resets the level slider to 0.00 dB; and  

o turns the Record Arm () button off.  

It does not change the track’s inputs or outputs. 

Click Reset to continue or Cancel to return to the previous screen. 

Note: This option is only available when an audio track is selected.  

 

• The Track Settings opens the Track Settings window for the selected track. See Operation > General Features 
> Tracks to learn more about these settings.  
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Effects 
 

You can apply various effects to the pads, keygroups, audio tracks, programs, submixes, and main outputs, using 
insert and send/return effects. This chapter can help you get a good overall understanding of how the effects work. 
 
See Appendix > Effects & Parameters for a list of all available effects (with a brief description of each) and their 
editable parameters. 
 
 

Overview 
 
In a program, each pad or keygroup can have up to four insert effects applied to it. An entire program can have up 
to four insert effects applied to it, as well. 
 
An audio track, like a program, can have up to four insert effects applied to it, as well. 
 
For even further flexibility, each submix can have up to four insert effects applied to it. You can route pads, 
keygroups, audio tracks, or programs to a submix, which is then routed to a main output. 
 
Additionally, each pad, keygroup, audio track, program, and submix can be sent to (up to) four return channels 
(returns), each of which can have up to four insert effects of their own. Their audio will be routed through the insert 
effects on those returns, and the processed audio will be sent to a main output. 
 
Finally, you can apply up to four insert effects to each main output (a stereo pair of channels: Outputs 1/2, Outputs 
3/4, etc.). 
 
When you create an audio mixdown of a sequence or song, you can choose whether or not main insert effects are 
included or send/return effects are included, depending on what you are mixing down: 

If you are creating an audio mixdown of a pair of main outputs, you can choose whether or not main insert 
effects will be included in the mixdown. 
If you are creating an audio mixdown of separate programs or exploded tracks, you can choose whether or 
not send/return effects will be included in the mixdown. 

See Audio Mixdown to learn about these options. 
 
The Sampler and Looper handle effects differently: 

The Sampler can use up to four insert effects, which are applied to the audio as you record it. This means that the 
effects cannot be “removed” from the sound later. Learn more about the Sampler in the Modes > Sampler chapter. 
Similarly, the Looper can use up to four insert effects, which are applied to the audio as you record it. This 
means that the effects cannot be “removed” from the sound later. Learn more about the Looper in the Modes > 
Looper chapter. 

 
Finally, there is a special effect type called TouchFX, which is specially designed for use the touch strip controller 
on hardware such as MPC Key 61 and MPC Key 37, but can be used on any MPC hardware and controlled using the 
onscreen touch slider or an external MIDI device.  

 
Please see the rest of this chapter to learn how to use insert effects as well as send/return effects.  
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You can load, edit, remove, and activate or deactivate effects in the 
Inserts section of a channel strip. Each Inserts section has four insert 
effect slots.  

 

 
To load an effect, click an empty slot in the Inserts section of a 
channel strip. In the window that appears: 

Use the Search field at the top of the window to search for an 
effect by name.  

Click the + or – button to expand or collapse each category. 

The right edge of the window shows how many MIDI channels can 
be sent to and from each effect. 

Select Sort by type to sort the effects by type. 

Select Sort by manufacturer to sort the effects by manufacturer. 

Double-click an effect or click it and then click Select to load it. 

Click the gear icon to open the Plugin Manager. See Plugins > 
Plugin Manager to learn about this. 

Click Close or press Esc to close the window without loading any 
effect. 

 
To remove a loaded effect, click the down arrow () next to its 
name the Inserts section. In the window that appears, double-click 
the <none> option at the top of the list of effects, or click it once and 
then click Select. 

 

In addition to individual insert effects, you can also load and save FX 
Racks by clicking the down arrow () at the top of the inserts field. 

To load an FX rack, use the Factory and User lists to browse 
and select a rack.  

To save the current insert effects as an FX rack, click Save FX 
Rack. 
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To edit an effect, click its name in the Inserts 
section of a channel strip. A window with the 
effect’s parameters will appear. 

To adjust a parameter, click and drag its knob 
up or down. To make finer adjustments, press 
and hold Ctrl (Windows) or  (macOS) and then 
click and drag its knob up or down. 

To enable or disable the effect, click the 
On/Off button in the upper-left corner.  

To keep the window on top at all times, click 
the down arrow () in the upper-right corner so 
it becomes an up arrow (). Click it again to 
allow the window to be hidden under others. 

Click the menu icon to show additional options: 

To save the current preset, click Save 
Preset. Alternatively, click the disk icon 
next to the preset name. 

To load a saved preset, click Load Preset. 
To change presets, click the / buttons 
next to the preset name to move to the next or 
previous preset, respectively. Alternatively, click 
the preset name to open the preset browser, 
and then select a preset. 

To close the window, click the X in the upper-
right corner. 

 

To activate or deactivate an effect, click the on/off button next to it. 

To deactivate all four effects, click the on/off button next to Inserts 
so it turns gray (off). Previously active effects will be off even though 
the button appears to be on. 

To reactivate the previously active effects, click the on/off button 
next to Inserts so it turns blue (on). 

 

To move an effect from one slot to another, click and drag it from its 
original slot to another slot (the new slot will be outlined in yellow before 
you release it). The effect will retain all of its editable parameters. 

To copy an effect from one slot to another, press and hold Alt 
(Windows) or Option (macOS) and then click and drag it from its 
original slot to another slot (the new slot will be yellow before you 
release it). The effect will retain all of its editable parameters. 
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Insert Effects 

 

Insert effects can be applied to a pad, track, submix or main output. The audio signal produced by that source is 
processed by any insert effect/effects that are loaded to that source (in the Inserts section of its channel strip) and 
activated. Each one can have up to four insert effects loaded and activated. 

Below is an outline of where you can set the effects for a pad, track, submix, or main output. 

Note:  

If the Inserts section is not shown in a channel strip in the Inspector, click the menu icon (≡), go to View > 
Inspector, and click Inserts. 

If the Inserts section is not shown in a channel strip in the Pad Mixer or Channel Mixer, click the box icon. 

 

Pad: You can load up to four insert effects to each pad. The Inserts section for a pad is available in two places: 

• the pad channel strip in the Inspector (in any mode) 

• the pad channel strip in the Pad Mixer 

Tip: When using pad insert effects, they will be applied to the selected pad only. This means that you could apply 
unique combinations of effects to each pad within a program. If you want to apply the same effect to all pads, do this 
with a program insert effect. 

 

Track: You can load up to four insert effects to each track. The Inserts section for a track is available in two places: 

• the track channel strip in the Inspector (in any mode) 

• the track channel strip in the Channel Mixer 

Important: When using keygroup track insert effects, they will be applied to that keygroup only. Keep this in mind if 
you load insert effects to multiple keygroups with overlapping note ranges—the effects will overlap in that range as 
well.  

 

Submix: You can load up to four insert effects to each submix. The Inserts section for a submix is available only in 
the submix channel strip in the Channel Mixer. 

 

Main Output: You can load up to four insert effects to each main output (a stereo pair of channels: Outputs 1/2, 
Outputs 3/4, etc.). The Inserts section for a main output is available in two places: 

• the main channel strip in the Inspector 

• the main channel strip in the Channel Mixer 
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Send/Return Effects 

 

Send/return effects work in the following way: 

1. A pad, track, or submix can send its audio to a return at a designated send level. 

2. That audio is processed by the effects on the return. Each return can have up to four insert effects loaded and 
activated. 

3. The processed audio is sent to a pair of main outputs (stereo) or a single main output (mono). 

 

There are four available returns. Any pad, track, or submix can send its audio to any combination of those returns at 
the same time. 

 

You can load send/return effects and set the return levels in two places: 

• the return channel strip in the Inspector 

• the return channel strip in the Channel Mixer 

 

Below is a description of where to set the desired send levels for a pad, track, or submix. 

Note:  

If the Send knobs are not shown in a channel strip in the Inspector, click the menu icon (≡), go to View > 
Inspector, and click Sends. 

If the Send knobs are not shown in a channel strip in the Pad Mixer or Channel Mixer, click the four-circles icon. 

 

Pad: The Send knobs for a pad are available in two places: 

• the pad channel strip in the Inspector (in any mode) 

• the pad channel strip in the Pad Mixer 

 

Track: The Send knobs for a track are available in two places: 

• the track channel strip in the Inspector (in any mode) 

• the track channel strip in the Pad Mixer 

Important: When using keygroup track send/return effects, they will be applied to that keygroup only. Keep this in 
mind if you use send/return effects with multiple keygroups with overlapping note ranges—the effects will overlap in 
that range as well. 

 

Submix: The Send knobs for a submix are available only in the submix channel strip in the Channel Mixer. 
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Touch FX 

 

MPC 3 software also includes the Touch FX plugin, which is designed for use with Touch Strip controls on hardware 
such as the MPC Live III or MPC Key 61. This plugin gives you expressive control of 10 effects that can be used in 
any MPC project. 

 
To load the Touch FX plugin:  

1. Click an empty slot in the Inserts section of any channel strip. 

2. Click the + or – button to expand the Harmonic category. 

3. Select TouchFX. 

 
To edit the effect, double-click its name in the Inserts section of the channel strip. Use the window that appears to 
edit the Touch FX parameters. 

 

 
 

Use the controls on the left side to adjust the settings for compatible MPC hardware’s Touch Strip control. For other 
hardware, you can control the Touch Strip by assigning it to a MIDI control or by using the virtual touch strip on the 
touchscreen. 

Touch Strip: This strip represents the MPC Studio mk2’s touch strip control, and can also be controlled 
manually by clicking and dragging from the software, tapping and dragging from a hardware touchscreen, or by 
assigning it a MIDI control. Use this to control the selected Touch FX. 

Touch Enable: Click this box to enable the currently selected Touch FX. 

Assigned Parameter: Use this field to select a preset parameter to be controlled by the touch strip. This can be 
separate from or in addition to controlling the Wet/Dry amount, depending on the Touch > Wet/Dry setting. 

Touch Value: Use this slider to control the value of the Assigned Parameter controlled by the touch strip. 

Wet Amount: Use this slider to set the blend the original signal (dry) and the effect signal (wet). 

Touch Value / Wet/Dry Lock: Click the lock icon to use the touch strip to control the Wet/Dry amount in 
addition to the touch value of the Assigned Parameter. 

Touch Attack: Use this slider to set the length of the attack phase of the envelope, which is triggered when you 
move the touch strip control.  

Touch Release: Use this slider to set length of the release phase of the envelope, which is triggered when you 
release the touch strip control. 

 

Use the controls on the right side of the Touch FX plugin window to select a Touch FX type and adjust its settings. 
You can also select from the included presets at the top of the window.  

See Appendix > Effects & Parameters > Harmonic > TouchFX for a full list of TouchFX preset settings. 
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Automation 
 

You can set the automation for tracks to be “written,” “read,” or disabled entirely. You can do this globally or for 
individual tracks. 

 

 

Global 

 

A button in the upper-right corner of the toolbar controls the global automation. When you click this button to 
change its state, it will change the automation state for all tracks in the project. (If you have changed the automation 
state of an individual track as described below, then this global automation button will indicate that rather than the 
global automation state.) 

 

Click this global automation button to toggle between two states: 

When set to Read (R), automation data will be read but not recorded. You can still manually edit and 
enter automation. (Think of this as a protective feature to prevent accidental changes to your 
automation while recording.) 

When set to Write (W), automation can be recorded and will overwrite any existing automation. (Make 
sure not to touch Q-Link knobs accidentally while you are recording.) 

Press and hold Shift on your keyboard and click the global automation button to disable or enable global 
automation. When off, automation data will be ignored. 

Important: If you have already recorded automation and turn it off, the track will still use the effect and its 
parameter values at the point where you turned it off. 

 

 

Tracks 

 

You can also set the automation for each track by using the track automation button in the channel strip for that 
track (shown in the Inspector, Pad Mixer, and Channel Mixer). Automation is available for all track types. 

Note: Remember that clicking the global automation button will change the automation state for all tracks in the 
project; if they were originally different, all of them will then match the global automation state. 

 

Click this track automation button to toggle between two states: 

When set to Read (R), the track will read automation data but will not record any additional automation 
over it. You can still manually edit and enter automation. (Think of this as a protective feature to prevent 
accidental changes to your automation while recording.) 

When set to Write (W), the track can record automation. (If you have any Q-Link knobs assigned to 
automatable parameters, make sure not to touch any accidentally while you are recording.) ] 

Press and hold Shift on your keyboard and click the track automation button to disable or enable track 
automation. When off, the track will ignore automation data. 

Important: If you have already recorded automation and turn it off, the track will still use the effect and its 
parameter values at the point where you turned it off. 
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Recording Automation 

 

Automating various parameters is a good way to add some motion and dynamism to your sequences. 

 

You can automate these types of parameters for tracks: 

• Track Parameters:  

o the mixer parameters of the track (Volume, Pan, Mute, Solo, and Send 1–4) 

o the parameters of the track (options vary based on the type of track) 

o the parameters for insert effects (options vary based on the effect) 

o the MIDI CCs of the track (0–127) 

o aftertouch messages 

o pitch bend messages 

o channel pressure messages 

o program change messages 

• Pad Parameters (for drum tracks and keygroup tracks): 

o the mixer parameters of the pad/keygroup (Level, Pan, Pad Mute, Pad Solo, or Send 1–4) 

o parameters of the pad/keygroup (options vary based on the type of program) 

o parameters for insert effects on the pad/keygroup (options vary based on the effect) 

 

To enter automation for track parameters: 

1. Select the track, and then click Rec () or Overdub (⊕) to record-arm it. 

2. Click Play () or Play Start (|) to start playback of the sequence. 

3. Use whatever controls you want to adjust the parameter/parameters as the sequence plays. Your changes will 
be recorded in real time. Note that recording automation is not an overdub-style process (even if you clicked 
Overdub to record-arm the track); when the sequence repeats, it will overwrite/replace any automation that was 
previously recorded. 

4. Click Stop () to stop the automation recording. 

Alternatively, create the automation curves manually (see Editing Automation to learn how to do this). 

 

To record automation of a track parameter or pad parameter: 

1. Set the track automation button to the red Write (W) option for any track whose parameters (or pad 
parameters) you want to automate. Alternatively, click the global automation button in the upper-right corner of 
the window to change the state of all tracks. 

2. Click Play () or Play Start (|) to start playback of the sequence. 

3. Use whatever controls you want to adjust the parameter/parameters as the sequence plays. Your changes will 
be recorded in real time. Note that recording automation is not an overdub-style process; when the sequence 
repeats, it will overwrite/replace any automation that was previously recorded. 

4. Click Stop () to stop the automation recording. 

Once you are done, we recommend setting the track automation button for that track to the green Read (R) 
option. This ensures your track uses the automation you just recorded when you play it back (and will not be 
overwritten by any future adjustments you make to parameters during sequence playback). 
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Editing Automation 

 

You can use automation editing tools to adjust or create automation curves for all available parameters.  

 

To edit automation of a track parameter or pad parameter, use the automation lane in the Grid Editor: 

1. In the Grid Editor, make sure the automation lane is shown. If it is not, click the up arrow (^) in the lower-left 
corner of the Grid Editor. 

2. Click the down arrow () in the lower-left corner of the Grid Editor. Use the menu and submenus that appear to 
select the desired parameter. The parameter name will then appear below Modifier. 

3. Use the pencil and marquee tools described below to create and edit automation for this parameter in the 
automation lane. 

 

 

 

Use these tools in the Grid Editor to create or edit the automation curve in the automation lane. See Editors > Grid 
Editor to learn more about using the Grid Editor in general. 

Important: An automation curve consists of several points placed according to current time division—aligned with 
the quantization grid). You can create or move points without restricting them to the time division by pressing and 
holding Shift. 

 

Pencil: Draw Mode: 

To create a point, click the desired location in the automation lane. 

To select a point, click it. 

To move a point, click and drag it to another location in the automation lane. Press and hold Shift while 
doing this to move it without restricting (“snapping”) it to the quantization grid. 

To erase a point, double-click it. 

 

Marquee: Marquee Mode: 

To select a point, click it.  

To select multiple points, click and drag across the automation lane to create a box around them. 

To move a point, click and drag it to another location in the automation lane. Press and hold Shift while 
doing this to move it without restricting (“snapping”) it to the quantization grid. 

To move multiple points, select them as described above, and then click and drag them to another 
location in the automation lane. Press and hold Shift while doing this to move them without restricting 
(“snapping”) them to the quantization grid. 
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Other Functions and Tools 
 

Humanize 

 
The Humanize function lets you apply randomization to the timing, length, and/or velocity of MIDI events. 

To open the Humanize window, click the menu icon (≡), select Edit, and click Humanize. 

 

 

 

Check the Humanize Time box to determine whether or not humanization will be applied to the timing of MIDI 
events. 

Use the Amount (Pulses) slider to determine the maximum number of pulses by which the timing of an event will be 
adjusted. 

Use the Eagerness slider to determine how dramatically the humanization effect is applied to the timing. Negative 
values correspond to playing “ahead of the beat” while positive values correspond to playing “behind the beat.” 

 

Check the Humanize Note Length box to determine whether or not humanization will be applied to the duration of 
MIDI note events. 

Use the Length (%) slider to determine how dramatically the humanization effect is applied to note lengths. 

 

Check the Humanize Velocity box to determine whether or not humanization will be applied to the velocities of MIDI 
note events. 

Use the Strength (%) slider to determine how dramatically the humanization effect is applied to note velocities. 

Check the Only apply to selected events box to determine whether or not these humanization values will be applied 
to all notes in the track (deselected) or just the currently selected notes (selected).  

 

Click Apply to apply the humanization values while keeping this window open. 

Click Do It to apply the humanization values and close the window.  

Click Close to close the window without making any changes. 
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Pitch Quantization 

 
The Pitch Quantize function lets you force the pitches of note events in a MIDI track into a specific scale.  

To open the Pitch Quantize window, click the menu icon (≡), select Edit, and click Pitch Quantize. 

 

 

 

Click the Setup menu and select the desired root note of the scale. 

Click the Scale menu and select a type of scale. 

Click Only apply to selected events to select or deselect it. When selected, only the currently selected note events 
will be quantized. When deselected, all pitches in the current track will be quantized. 

Click the Start note and End note menus and select the lowest-possible and highest-possible pitches (respectively) 
where the quantized note events will be placed. If a note event is originally outside of this range, it will be forced to 
the nearest pitch (within the scale) inside the range.  

Click Do It to continue or Close to return to the previous screen. 
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16 Level 
 
When 16 Level is first activated, the selected pad (Pad A01 by 
default) will be temporarily copied to all 16 pads. The pads will 
now output the same note number as the initial pad, but a 
selectable parameter will be fixed at values that increase as the 
pad numbers increase (e.g., Pad 1 is the minimum, Pad 16 is the 
maximum), regardless of how hard you press them. 
 

To show the 16 Level window, click the menu icon (≡), select Tools, and click 16 Level. Alternatively, click the 
16 Level button above the Pads section in Main Mode or Track Edit Mode. 

 
To select a pad, do one of the following: 

• Press and hold 16 Level, and then press the desired pad. 

• Click the 16 Levels box to deselect it (temporarily disabling the feature), press the desired pad, and then 
click the 16 Levels box again to select it. 

• Click the Pad field, and use the data dial or –/+ buttons. 

• Double-click the Pad field, and click the desired pad in the list that appears. 

 
In the 16 Levels window, click the Type menu to choose the parameter:  

Velocity: The sample velocity increases from lowest (7) to highest (127). 

Tune: The sample tuning increases from the lowest pitch to highest pitch. Click the Original pad menu and 
select the pad that will contain the note at its original pitch (tuning). Click the Scale menu and select a scale to 
apply to the sample tuning. 

Filter: The cutoff value for the filter increases from lowest to highest. You can set the filter type for the pad in 
Track Edit Mode.  

Layer: Each row of four pads covers a range of velocity from lowest to highest: 0-31, 32-64, 65-96 and 97-127. 
Pads with multiple samples will play back each layer according to the Velocity Start and Velocity End settings 
for each layer. 

Slice: The slices of the sample assigned to the pad increase, starting from Slice 1 in the lower-left corner. If less 
than 16 slices of the sample exist, the remaining pads will not trigger anything.  

Articulation: Pad 1 plays the original sample, and Pads 2–16 play the first 15 articulations in the articulation list. 

Attack: The attack envelope increases from lowest to highest.  

Decay: The decay envelope increases from lowest to highest.  

Probability: The probability that the note is played increases from lowest to highest. 

Ratchet: The number of note subdivision ratchets increases from lowest to highest. 
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Arpeggiator 
 
MPC includes a full-featured arpeggiator and phrase player for melodic program types. 

 
To open the arpeggiator setting window: 

1. Set the current track type to Plugin, Keygroup, MIDI, or CV. 

2. Click the menu icon (≡), select Tools, and click Arpeggiator. 

 
To activate the arpeggiator, click Enable so it is checked. Click again to Disable the arpeggiator.  

Alternatively, click the ARP button in the Pads panel when a Plugin, Keygroup, MIDI, or CV track is selected. 

 

To latch the arpeggiator, click Latch so it is checked. Click again to Disable Latch. 

 
The Setup section of the Arpeggiator window sets what kind of 
arpeggiator will be used and its functions: 

Use the Action field to set the type: Arp, Note Repeat, 
Rhythm and Pattern. See below for more details about these 
types and their additional parameters. 
 
Use the Step Size field to set the note value of each 
arpeggiator step from 1/1–1/64 beats, including T (triplet) 
variations. This field is not used in Pattern mode. 
 
Use the Note Length slider to set the length of the played 
note in each step, from 1–100%. 
 
Use the Velocity field to set the velocity of the arpeggiator 
notes. Choose As played, From first note, Accented, Full, 
3/4, Half or 1/4. 
 
Use the Swing field to set the amount of swing in the 
arpeggiator from 50% to 75%. Swing lets you "shuffle" your 
beats—from subtle to extreme. 

 
 
The Arp mode section of the Arpeggiator window is available 
when the Action is set to Arp. When this action is selected, hold 
down a chord and the arpeggiator will play a pattern based on the 
notes held.  

Use the Pattern field to set how the arpeggiator triggers the 
held notes. 

Use the Octaves field to set how many octaves of the held 
notes the arpeggiator will cycle through. 

Use the Variation field to apply rhythmic variation to the set 
pattern. 

 
The Rhythm section of the Arpeggiator window is available when 
Action is set to Rhythm. When the Rhythm arpeggiator action is 
selected, hold down a chord and the arpeggiator will play the held 
notes in a rhythmic pattern.  

Use the Rhythm Pattern field to choose the pattern played 
when notes are held.  
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The Pattern section of the Arpeggiator window is available when 
the Action is set to Pattern. When this arpeggiator action is 
selected, hold down a single note to trigger a melodic phrase. As 
you change what note is held, the melodic phrase will be 
transposed. 

Use the Pattern field to choose the pattern. 

 

The Settings section of the Arpeggiator window offers additional 
options to control the arpeggiator. 

If you have a sustain pedal connected, you can enable 
Sustain Pedal Latches to use it to control latching. 

Use the Latch Mode setting to set the latch behavior. When 
set to Reset, adding a new note(s) will reset the currently 
latched note(s). When set to Add, new notes will be added to 
currently latched notes. 

 

The Probability section of the Arpeggiator window lets you add 
further variation to your arpeggiator by adjusting the probability of 
how notes are played. 

Use the Accent (%) field to set the percent probability that a 
note in the arpeggio is accented.  

Use the Normal (%) field to set the percent probability that a 
note in the arpeggio is normally articulated.  

 

The Arpeggiator modifiers section of the Arpeggiator window 
enables additional controls to modify the arpeggiator. 

Click the Channel Pressure box so it is checked to enable 
Channel Pressure messages from external MIDI controllers to 
modify the arpeggiator. 

Click the Mod Wheel box so it is checked to enable 
Modulation messages (MIDI CC #1) from external MIDI 
controllers to modify the arpeggiator. 

Click the Aftertouch box so it is checked to enable Expression 
messages (MIDI CC #11) from external MIDI controllers to 
modify the arpeggiator. 

Click the Expression box so it is checked to enable 
Expression messages (MIDI CC #11) from external MIDI 
controllers to modify the arpeggiator. 
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Use the Arpeggiator modifier settings field to select what 
arpeggiator settings are modified by the selected controls, and by 
how much. 

Click the Modify Time Division box so it is checked to enable 
modification of the arpeggiator time division. Use the Max 
Amount to set by how much the time division can be changed, 
from 1–4. For example, if the Time Division is set to 1/8 and the 
Max Amount is set to 2, adjusting the selected modifier control 
will increase the Time Division to 1/8T and 1/16, which are the 
next two higher time divisions. 

Click the Modify Octaves box so it is checked to enable 
modification of the arpeggio octave range. Use the Extra 
Octaves field to select how many additional octaves (on top of 
what the current Octaves setting is) can be added with the 
modifier control, from 1–4. For example, if the current Octaves 
setting is 1 and the Extra Octaves is set to 2, adjusting the 
selected modifier control will increase the total octaves up to 3. 

Click the Modify Note Length box so it is checked to enable 
modification of the arpeggio note length. Use the Max Amount 
(%) field to select by how much percentage the note length is 
increased, from 1–100%. For example, if the current Note 
Length setting is 50% and the Max Amount (%) is set to 20%, 
adjusting the selected modifier control will increase the note 
length up to 60%. 

Click the Modify Swing box so it is checked to enable 
modification of the arpeggio swing amount. Use the Max 
Amount (%) field to select by how much percentage the swing 
amount is increased, from 1–50%. For example, if the current 
Note Length setting is 50% and the Max Amount (%) is set to 
20%, adjusting the selected modifier control will increase the 
swing amount up to 60%. 

Click the Modify Variation box so it is checked to enable 
modification of the arpeggio Variation setting. Use the Max 
Amount field to select by how the variation setting can be 
changed, from 1–4. For example, if the current Variation setting 
is Variation 1 and the Max Amount is set to 2, adjusting the 
selected modifier control will increase the Variation setting up 
to Variation 3. 

Click the Modify Probability box so it is checked to enable 
modification of the arpeggio probability amount. Use the Max 
Amount (%) field to select by how much percentage the 
probability amount is increased, from 1–100%. For example, if 
the current Probability setting is 50% and the Max Amount 
(%) is set to 20%, adjusting the selected modifier control will 
increase the probability amount up to 60%. 

 

Click Close to close the Arpeggiator window. 
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Auto Sampler 
 
The Auto Sampler lets you capture and convert any plugin preset or external instrument preset into a keygroup 
sampler patch. 

 

To open the Auto Sampler window, click the menu icon (≡), select Tools, and click Auto Sampler. 

 

 

 

Sample Source Information 

The Track name and Program name fields show the target track and program that will be sampled. This will be 
automatically selected as the active track and program when Auto Sampler is opened. 

Use the Record from field to select an external or resample input to record from: 

To capture the output of a plugin, simply select a Plugin track before opening Auto Sampler. 

Note: When a plugin track is selected, the Auto Sampler will only sample the plugin track, regardless of the 
setting in the Record From field. 

To capture a preset from an external instrument such as a sound module, select the Input that the 
external instrument is connected to. 

 
Note Range 

Use the Min note and Max note settings to determine the lowest and highest notes used to create the sampler 
patch. 

Use the Note stride to determine the range of notes that each sample will cover. For instance, a note stride of 5 
means that every 5 notes will utilize a different sample. 

Check the Extend min/max notes box to sample all the way to the lowest and highest notes, regardless of the 
Min Note and Max Note settings. 
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Velocity 

Tap the boxes next to Layers 1–8 to select how many layers will be used to create the sampler patch. 

Use the Velocity value sliders to set the velocity of each layer. 

 
Sampling 

Use the Note length slider to set the length of the sampled 
note in seconds. 

Use Tail slider to set the length of the Audio Tail in seconds. 
This will add extra seconds to the end of the resulting audio 
file. This is useful if you are capturing samples whose sounds 
exceed the defined audio length (e.g., long reverb or delay, 
one-shot samples with long decays, etc.). We recommend 
using an audio tail of at least a couple of seconds. 

Use Base name to set the naming convention for the samples 
that will be created by the Auto Sampler. 

 
Looping 

Use the Enable looping field to select how the resulting 
samples can or cannot be looped: 

• Off: The sample will not loop. 

• Forwards: You can hold down the pad to cause that 
sample to repeat from the Loop Position to the end 
of the sample. Release the pad to stop the repeating 
playback. 

• Alternating: You can hold down the pad to cause that 
sample to play from the Loop Position to the end of 
the sample and then play in reverse until it reaches the 
Loop Position again. This will repeat as long as you 
are holding the pad down. Release the pad to stop the 
repeating playback. 

• Reverse: You can hold down the pad to cause that 
sample to play in reverse, repeating from the end of 
the sample to the Loop Position. Release the pad to 
stop the repeating playback. 

Use the Loop start and Loop end sliders to set the starting 
and ending points in the sample where the loop will occur. 

Use the Crossfade slider to set the amount of crossfade 
between the loop end and loop start in seconds. 

Use the Crossfade Type field to select Equal Power or 
Linear crossfade. 

 
Under Info, the Session Duration field provides an estimate of how long the auto sampling process will take. 

 

Click OK to initiate the auto sampling process. A Progress window will appear. Click Cancel to stop the auto 
sampling process. Any samples already created will be retained. 

 

Click Cancel to close the Auto Sampler window without continuing.  
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Generate Random Events 
 
The Generate Random Events function lets you create random melodic or drum patterns on the current MIDI track. 
 

To open the Generate Random Events window, click the menu icon (≡), select Tools, and click Generate 
Random Events. 

 

Click the Event Type menu to select the type of events you want to create: Drum events or Melodic events. 

Click the Replace menu to select how the events will be created relative to the existing events on the track: 

• Replace all events: Select this option to replace all events on the track with the randomly generated ones. 

• Replace events in note range: Select this option to replace all events in the designated note range on the track 
with the randomly generated ones. Use the Bank or Start pad and End pad menus to set the note range for 
drum events or the Start note and End note menus to set the note range for melodic events. 

• Add to existing events: Select this option to add the randomly generated events to the track without replacing or 
overwriting the existing ones. 

Click and drag the Pattern size (bars) field up or down to set how many bars the events will use. Alternatively, click it, type 
a value, and press Enter. The highest possible value is the number of bars in the current sequence. 

Click the Note length menu to select the duration of the events. (This feature is nonfunctional if Legato is enabled 
while generating melodic events.) 

Click Apply to generate the events while keeping this window open. 

Click Do It to generate the events and close the window.  

Click Close to close the window without generating any events. 

 

If Event Type is set to Drum events: 

 

Click the Bank menu to select the pad bank that will be used to generate the events or select Range to use the 
Start pad and End pad menus to define a specific pad range instead. 

Click the Start pad or End pad menus to define a specific pad range over which the events will be generated. 
You can use these menus only if the Bank menu is set to Range. 

Click and drag the Density (%) slider left or right to set how closely together the events will be placed in the 
track. Alternatively, click anywhere along its length, or click it, type a value, and press Enter.  

Click and drag the Rhythm variation slider left or right to set how widely or narrowly the rhythmic patterns of the 
generated notes vary. Alternatively, click anywhere along its length, or click it, type a value, and press Enter. 
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If Event Type is set to Melodic events: 

 

Click the Start note or End note menus to define a specific note range over which the events will be generated. 

Click Legato to select or deselect it. When selected, the generated notes will be extended or shortened to create 
a long, unbroken phrase from the first note event’s start point to the last note event’s end point. Each note event 
will sustain until another note event starts. If multiple note events start at the same time (and are not the last note 
events), their lengths will become identical. When deselected, the generated notes will use the duration set by the 
Note length menu. 

  
 Without legato applied. With legato applied. 

Click and drag the Polyphony field up or down to set the maximum number of note events that can be sounding 
simultaneously in the track: 1–8. Alternatively, click it, type a value, and press Enter. 

Click Constrain notes to scale to select or deselect it. When selected, the notes will be within the scale 
determined by the Scale menu. When deselected, the notes will be chromatic. 

Click and drag the Density (%) slider left or right to set how closely together the events will be placed in the 
track. Alternatively, click anywhere along its length, or click it, type a value, and press Enter. 

Click the Root note menu to set the root note of the scale that the generated notes will use. 

Click the Scale menu to select the scale or mode that the notes will use (based on the Root note selection). 
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Convert To Progression 
 

The Convert Track to Progression function automatically detects the 
chords that are played on the currently selected track, which you can save 
as a chord progression. 

 

To open the Generate Random Events window, click the menu 
icon (≡), select Tools, and click Convert to Progression. 

 
Use the Name field to enter a name for the progression. 

The Saved To field indicates where the file is saved. The file will be 
saved as a .progression file in the Progressions folder in [your hard 
drive]\Program Files\Akai Pro\MPC (Windows) or [your hard 
drive]/Users/[your user name]/Library/Akai/MPC/Progressions (macOS). 

Use the Root Note field to set the root note of the progression. This 
defines the starting note of the scale of the progression. 

The Chords Detected field indicates how many chords were automatically 
detected in the track. 

Use the Scale Type menu to select the scale or mode of the progression 
based on the Root Note. 

 

The panel below lists the chords in the order they are played. 

Click the red root note of a chord to play it. Click the text next to it to rename the chord. 

Click and drag the Type field up or down to select whether the chord is played at its root note (Root), in the 
octave range as it appears in the track (Normal), above its root note (AboveRoot), or below its root note 
(BelowRoot). 

The Notes column indicates how many notes were detected in the chord. 

 

Click Do It to convert the track or Cancel to close the window without converting. 
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Note Mapping 
 

Note Mapping lets you assign specific MIDI notes to your pads in 
each track except for keygroup tracks. 

 

To show the Note Mapping window, click the menu icon 
(≡), select Edit > Track, and click Note Mapping. 

Important: If the Note Mapping window is already open and 
you want to assign pad colors for another track, click Close, 
select a track that uses the desired track, and then open the 
Note Mapping window again. 

 
The Pad column indicates the pad bank and number of each pad 
in the track. 

The Note Name column indicates the note value (e.g., G#3, A 4, 
etc.). 

The MIDI Note column indicates the MIDI note number 
(corresponding to the note value). 
 
Click Edit next to each pad to open a submenu listing the 
available octaves. Select an octave and then select the note you 
want to assign to the pad. 
 
Click Classic MPC to assign a preconfigured note mapping to the pads that was used on early MPCs. 
 
Click Chromatic C-2 or Chromatic C1 to assign all notes to all pads chromatically in an ascending order, beginning 
with either C-2/MIDI Note 0 or C1/MIDI Note 36 assigned to Pad A01. 
 
Click Close to close this window and use the current note mapping. 
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Pad Color 
 

Pad Color lets you assign specific colors to your pads in 
each track. 

To show the Pad Color window, click the menu icon (≡), 
select Edit > Track, and click Pad Color. 

Important: If the Pad Color window is already open and 
you want to assign pad colors for another track, click 
Close, select a track that uses the desired track, and then 
open the Pad Color window again. 

 

 

 

 

 

Use the Display As field to set how the pad lights will display: 

Off: The pads will be unlit whether you are playing them or not. 

Classic Velocity: The pads will be unlit while you are not playing them. When you press them, they will light with 
colors according to the velocity: red indicates a high velocity, yellow indicates a low velocity. 

Fixed: The pads will be lit with their assigned colors whether you are playing them or not. 

Off->Velocity: The pads will be unlit when you are not playing them. When you press them, they will light with 
their assigned color with a brightness that corresponds with the velocity. 

Dim->Velocity: The pads will be dimly lit when you are not playing them. When you press them, they will light 
with their assigned color with a brightness that corresponds with the velocity. 

Bright->Velocity: The pads will be brightly lit when you are not playing them. When you press them, they will 
light with their assigned color with a brightness that corresponds with the velocity. 

 

Use the Pads field to determine whether you are setting the color for one pad (Edit single pads) or all pads (Edit all pads). 

Tip: To quickly assign that color to all pads in the track, press and hold Shift while clicking a color button. 

 

Use the Empty pads menu to set how empty pads will display: 

Empty pads off: Pads without any sounds will remain off. 

Empty pads dim: Pads without any sounds will remain more dimly lit than pads with sounds assigned. 

Empty pads normal: Pads without any sounds will appear the same as pads with sounds assigned. 

 

Check the Pads Follow Track Color to set all pads to the current track’s color. 

 

Click a pad to select it, and then click one of the color buttons to assign its color. 

Tip: To select the color button corresponding a specific pad’s color, press and hold Shift, and then press the 
pad or click it on the window. 

 

To make the current pad color settings the defaults for all tracks on the same type (e.g., drum tracks, keygroup 
tracks, etc.), click Make Default. 

 
Click Close to close the window. 
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Export 
 

Audio Mixdown 

 

The Audio Mixdown window lets you render and export either the current 
sequence or song as an audio file. In Song Mode, this will export the 
entire song. In any other mode, this will export the current sequence only. 

To open the Audio Mixdown window, click the menu icon (≡), and go 
to File > Export and click As Audio Mixdown. 
 

 

Audio Length 

Use the Start Bar and End Bar fields to define where the resulting 
audio file will start and end, respectively. 

Use the Audio Tail field to add extra seconds to the end of the resulting 
audio file. This is useful if you are using effects or samples whose 
sounds exceed the defined audio length (e.g., long reverb or delay, one-
shot samples with long decays, etc.). We recommend using an audio 
tail of at least a couple of seconds. 

 

Render Source 

Select Stereo Output and use the adjacent field to select a pair of outputs: Out 1,2–31,32. The mixdown will be 
taken from these outputs. 

Select Separate Tracks to create a mixdown of each track used in the sequence or song. 

Important: Each pad or keygroup must have their output routed to Track to be included in the mixdown. This is 
the typical (and default) setting.  

 

Render Options 

If your Render Source is set to Stereo Output, select Main Inserts to include main insert effects in the mixdown. 

If your Render Source is set to Separate Tracks, select Export Returns to include return buses in the 
mixdown. 

If your Render Source is set to Stereo Output, click Save as Project Preview to save the sequence or song as 
a project preview file (which you can play for reference in the Browser). If you select this box, Stereo Output will 
automatically be selected, as well. 

 

File Formats 

Click WAV, AIFF, MP3, FLAC or OGG to select the file format of the mixdown. 

For WAV and AIFF files, use the Bit Depth field to select a bit depth of 8, 16, or 24 bits, or 32 bits, floating point 
(32 F). For FLAC files, you can select a bit depth of 16 or 24 bits. For MP3 and OGG files, you can select a 
Bitrate of 128, 160, 192, or 320 kbps. 

Use the Sample Rate field to select a sample rate of 44.1 kHz, 48 kHz, 88.2 kHz, or 96 kHz. In most cases, we 
recommend selecting 44.1 kHz. 

 

Click Export to enter the Save screen where you can select a name and location to save your audio mixdown. 

Click Cancel to return to the previous screen. 
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Ableton Live Set Export  

 
The Ableton Live Set Export function lets you can export the current MPC sequence as an Ableton Live Set (.ALS) 
file. 

 
To open the Ableton Live Set export window, click the menu 
icon (≡), go to File > Export and then click As Ableton Live Set…. 

 

Use the Export MIDI As settings to choose how MIDI tracks and 
clips are exported, either as Audio files or MIDI files. When using 
Plugin, Drum or Keygroup programs, you can render clips as Audio 
to preserve the sound of the instruments, or render clips as MIDI 
data. 

 

Check the Export Arrangement as Clips box to export the entire arrangement as a clip for each track. 

 

Check the Include Track Volume/Pan Settings box to include these settings in the export. 

 

Check the Bypass Track Effects Plugins box to not include track effects plugins in the export. 

 

Use the Audio Tail field to set the amount, in seconds, of extra time added to the end of the resulting audio files. 

 

Use the Bit Depth field to set the bit depth to 8, 16 or 24. 

 

Use the Sample Rate field to set the sample rate to 44.1, 48, 88.2 or 96 kHz. In most cases, we recommend selecting 
44.1 kHz. 

 
Click Export to enter the Save screen where you can select a name and location to save your export.  

Click Close to cancel and return to the previous screen. 

 
 
MPC Sample File 

 
The Export as MPC Sample file function lets you can export the current drum track as a project file which can then 
be loaded into MPC Sample. All rendered samples will be loaded to the MPC Sample pads, and note events will be 
imported as sequence data. 

 
To open the Export to MPC Sample window, click the menu 
icon (≡), go to File > Export and then click As MPC Sample file…. 

 
After selecting a save location, you can access the additional 
options below. Save to an SD card which can then be inserted 
into MPC Sample.  

 
Check the Use Insert FX box to render samples with the Insert FX for each pad enabled.  

 
Check the Use volume and pan settings box to render samples with each pad’s volume and pan settings enabled.  

 
Use the Tail Length field to set the amount, in seconds, of extra time added to the end of the resulting audio samples. 

 
Click Do It to save your export.  

Click Cancel to cancel and return to the previous screen. 
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Plugins 
 

The MPC 3 software enables you to scan third-party plugins (VST, VST3, or AU formats) to use within your projects.  

Instrument plugins can be used with plugin tracks. See Tracks > Plugin Tracks to learn about this. 

Effect plugins can be used as insert effects on pads, keygroups, audio tracks, most types of tracks, submixes, 
returns, and main outputs. See Effects > Insert Effects to learn about this. 

See the following Scanning Plugins section to learn how to scan your computer and external storage devices for the 
plugins you want to use. 

See the Plugin Manager section to learn how to manage all of your scanned plugins. 

See the Selecting Plugins section to learn how to select a plugin when using plugin tracks or insert effects. 

 

 

Scanning Plugins 

 

In order to use plugins in the MPC 3 software, the 
software must scan any folders on your computer or 
external storage device where they are located. 

 

To scan your plugins: 

1. Windows: Click the menu icon (≡), select Edit, and 
click Preferences. 

macOS: Click the MPC menu and click Preferences. 

2. In the Preferences window that appears, click the 
Plugins tab. 

3. Click the … button next to one of the VST Folders 
fields. 

4. In the window that appears, select the location where 
your plugins are stored. Select the folder and click 
Open (while not actually in the folder). 

5. The file path will appear in the VST Folders field. 
Click the box next to it so it is selected. 

If you have plugins stored in other locations, you can 
repeat Steps 3–5 to select those locations. 

6. Click Scan New to scan these recently selected 
locations. This is helpful if you have already scanned 
other locations and want to scan just the one/ones 
you recently added. 

Alternatively, click Rescan All to scan all four 
locations again.  

The list of scanned plugins will appear in the list 
below. When the scan is completed, the status bar 
above it will show Done. 

7. Click OK to close the window. 
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Plugin Manager 

 

The Plugin Manager lets you view and manage the status of all plugins in your MPC 3 software. 

To open the Plugin Manager, click the menu icon (≡), select Tools, and click Plugin Manager. The Plugins window 
will appear. Alternatively, click the gear icon in the lower-left corner of the window that appears when selecting a 
plugin or an insert effect. 

 

 

 

Use these boxes and the Search field to filter the plugins shown in the list below. 

VST: Select this box to show VST plugins. 

VST3: Select this box to show VST3 plugins. 

Instruments: Select this box to show instrument plugins. 

Insert Effects: Select this box to show insert effect plugins. 

Good: Select this box to show plugins that were successfully scanned. 

Bad: Select this box to show plugins that failed to scan. 

Search: Use this field to enter a search term. The results will appear in the list below. 

 

The columns (described below, left to right) indicate the plugins’ status. Click a column to sort the list by that category. 
Right-click the top of a column to auto-size this column, auto-size all columns, or to show or hide specific columns. 

Note: The MPC 3 software supports VST, VST3, or AU plugins. 

Use: Select this box to allow the MPC 3 software access to this plugin. If this box is deselected, it will not appear 
if you select an instrument plugin (to use for a plugin track) or an effect plugin (to use on an insert effect slot).  

Name: This is the plugin’s name. 

Manufacturer: This is the plugin’s manufacturer. 

Version: This is the version of the plugin. 

Type: This is the type of plugin. An FX icon indicates an effect plugin. A keyboard icon indicates an instrument 
plugin. 

Path: This is where the plugin is located on your computer or external storage device. 
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Channels: This is how many MIDI channels can be sent to and from the plugin. 

OK: This indicates whether the plugin has been successfully scanned or not. OK indicates that the plugin is 
properly scanned and can be used in the MPC 3 software. Failed indicates that the plugin was not properly 
scanned. To rescan the plugin, click it and then click Rescan in the lower-right corner. 

Fav: This indicates whether the plugin is a “favorite” or not. Favorites will appear in a separate category when 
you select an instrument or effect plugin. Click the box to select or deselect it. 

Rescan: Click this to prompt the MPC 3 software to rescan the selected plugin. 

Close: Click this to close the window. Alternatively, press Esc. 

 
 
Selecting Plugins 

 
Instrument plugins can be used with plugin tracks (see Tracks > Plugin Tracks to learn how to create a plugin 
track). 

 
To select an instrument plugin for a plugin track, select the plugin 
track, and then click the Plugin field in the Program section of the 
Inspector. 

In the window that appears: 

Click the + or – button to expand or collapse each category. Favorites 
are instrument plugins whose Fav box is selected in the Plugin 
Manager. 

The right edge of the window shows how many MIDI channels can be 
sent to and from each plugin. 

Use the Search field to search for an instrument plugin by name. 

Select Sort by type to sort the plugins by type. 

Select Sort by manufacturer to sort the plugins by manufacturer. 

Double-click a plugin or click it and then click Select to load it. 

Click the gear icon to open the Plugin Manager. See Plugin Manager to learn about this. 

Click Close or press Esc to close the window without loading any plugin. 

 
 
Effect plugins can be used as insert effects on pads, keygroups, audio tracks, most types of tracks, submixes, 
returns, and main outputs (see Effects > Insert Effects to learn how these work). 

 
To load an effect plugin, double-click an empty slot in the Inserts 
section of a channel strip. In the window that appears: 

Click the + or – button to expand or collapse each category. Favorites 
are effect plugins whose Fav box is selected in the Plugin Manager. 

The right edge of the window shows how many MIDI channels can be 
sent to and from each effect. 

Use the Search field to search for an effect plugin by name. 

Select Sort by type to sort the effects by type. 

Select Sort by manufacturer to sort the effects by manufacturer. 

Double-click an effect or click it and then click Select to load it. 

Click the gear icon to open the Plugin Manager. See Plugin Manager 
to learn about this. 

Click Close or press Esc to close the window without loading any effect. 
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Expansions 
 
The MPC 3 software enables you to use MPC Expansions, collections of samples, loops, riffs, etc. available in the 
Akai Professional Expansion Store.  

To open the Expansion Store: 

Windows: Click the menu icon (≡), select Help, and select Expansion Store. 

macOS: Click the MPC menu and click Expansion Store.  

This opens an online store of available MPC Expansions on the Akai Professional website. You must have an internet 
connection to use this feature. 

See the Expansion Manager chapter to learn how to manage all of your scanned MPC Expansions. 

See the Selecting Expansions section to learn how to select an MPC Expansion when using plugin tracks. 

See the Browser > Expansion Browser chapter to learn how to use the Expansion Browser. 

 
 
Expansion Manager 

 
The Expansion Manager lets you view and manage the status of all MPC Expansions in your MPC 3 software. 

To open the Expansion Manager, click the menu icon (≡), select Tools, and click Expansion Manager. The 
Expansions window will appear. 

 

 

 
The columns (described below, left to right) indicate the MPC Expansions’ status. Right-click the top of a column to 
auto-size this column or auto-size all columns. 

Use: Select this box to allow the MPC 3 software access to this MPC Expansion. If this box is deselected, it will 
not appear in the Expansion Browser. 

Expansion Details: This shows the MPC Expansion’s name, the manufacturer, and the version. 

Type: This indicates the type of MPC Expansion. A gear icon indicates an MPC Expansion that is included by 
default with the MPC 3 software. 

Close: Click this to close the window. Alternatively, press Esc. 
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Selecting Expansions 

 

MPC Expansions can be used with plugin tracks (see Tracks > Plugin Tracks to learn how to create a plugin track). 

 

To select an MPC Expansion for a plugin track, select the plugin 
track, and then click the Plugin field in the Program section of the 
Inspector. 

In the window that appears: 

Click the + or – button to expand or collapse each category. 
Favorites are instrument plugins whose Fav box is selected 
in the Plugin Manager. 

The right edge of the window shows how many MIDI channels 
can be sent to and from each plugin or MPC Expansion. 

Select Sort by type to sort the list by type. 

Select Sort by manufacturer to sort the list by manufacturer. 

Double-click a plugin or MPC Expansion or click it and then 
click Select to load it. 

Click the gear icon to open the Plugin Manager. See Plugins 
> Plugin Manager to learn about this. 

Click Close or press Esc to close the window without loading 
any plugin or MPC Expansion. 

 

 

Exporting Expansions 

 

You can export MPC Expansion Packs (installed on your computer) to your MPC for use in its Standalone Mode. 

 

To export MPC Expansions: 

1. Connect your standalone MPC hardware to your computer. 
Make sure both are powered on. 

2. On your computer, open the MPC 3 software. 

3. On your MPC, enter Controller Mode. 

4. In the MPC 3 software window, click the menu icon (≡), select 
File > Export, and then click Export…. 

5. In the Export Expansion to Standalone MPC window that 
appears, click the Drive menu and select a storage device that 
you will use with your MPC: the internal SATA drive (if you 
have installed one in your standalone MPC hardware), an SD 
card, or a USB flash drive. 

6. In the Expansions list, click the box next to each one to select or 
deselect it. Only the selected ones will be exported. Click Select 
all to select all of them or Select none to deselect all of them. 

7. Click Export to start exporting, or click Cancel to close the 
window and not export anything. 

The exporting process creates an Expansions folder at the root 
level of your storage device and copies your MPC Expansions 
into it. 
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Modes 
 

The MPC 3 software is always in one of 14 modes. This chapter describes the various features and functions of each 
one. 

 

To enter a mode, click its mode icon. If its icon is not shown, click the down arrow () to show a menu of all 
modes, and then click it. 

You can customize which mode icons are shown here by click the menu icon (≡) in the upper-left corner and going 
to View > Toolbar > Toolbar Modes. 

If you have MPC hardware connected, you can also press and hold the Menu button and press a pad to select a 
mode following the layout on the touchscreen. 

Important: If a sequence is currently playing, you will not be able to enter Song Mode. Stop playback before entering 
Song Mode. 

 

Click an icon below to skip directly to that chapter. 

 

    Main                Track Edit            Pad Mixer            Step Seq.              Looper             Track Mute               Song 

 Arrange            Sample Edit       Channel Mixer          Sampler             Pad Mute        Next Sequence     MIDI Control 
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Main Mode 
 

Main Mode provides access to all three editors as well as basic track editing functions. 

 

To enter Main Mode, do any of the following: 

• Click the house icon in the toolbar (if shown). 

• Click the down arrow () next to the other mode icons in the toolbar, and click Main Mode. 

• Click the menu icon (≡), and go to View > Mode and click Main. 

 

 

 

The upper half of the window can display the Grid Editor, Wave Editor, or List Editor. Click the Grid, Wave, or List 
tab to enter the corresponding editor. See General Features > Editors to learn more about each one. 

The lower half of the window can display the Q-Links panel, Pads panel, and Project panel. Click the corresponding 
selector to show or hide each one. See General Features > Panels to learn more about the Q-Links or Project 
panels. The Pads panel is described below. 
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Pads 

 

When the MIDI tab is selected in Main Mode, the Pads panel shows information for each pad, depending on the 
currently selected track. 

Drum Tracks: Each pad will show the samples assigned to it (all four layers). Click the Pad Bank letters to 
access additional pads or the full range of notes. For keygroup tracks, Pad D13 plays the sample at its original 
pitch. Click a pad to play its sample/samples or note. 

Keygroup Tracks, Plugin Tracks, MIDI Tracks, and CV Tracks: Each pad will show the note it will play as both 
a MIDI note number (0–127) and note value (e.g., C-1, G#5, etc.). Click the Pad Bank letters to access the full 
range of notes. Click a pad to play its note. 

 

 Drum Track Keygroup, Plugin, MIDI, or CV Track 

   

 

Each pad can also display a color, which you can customize for each track. See General Features > Pad Color to 
learn how to do this. 

 

When an Audio track is selected in Main Mode, the Pads panel is not available. 
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Pad Perform 

 

In Main Mode, the Pad Perform panel is available for assigning the pads in a keygroup 
track, MIDI track, plugin track, or CV track to specific scales, chords, or progressions.  

 

Use the Type selector determine what will be mapped over the pads: 

Off: The pads use standard mapping. 

Chromatic: Each pad is assigned a note, ascending by one semitone with each pad. 
Pads with notes in the key determined by the Scale will be lit, while pads with notes 
between the scale degrees will be unlit. 

Notes: Each pad is assigned a note, ascending by one scale degree with each pad. 

Chords: Each pad is assigned a chord, the root note ascending by one scale degree 
with each pad. All available chords will play in the key determined by the Scale. 

Chromatic Chords: Each pad is assigned a chord, the root note ascending by one 
scale degree with each pad. You can play any chord type regardless of the key 
determined by the Scale. Essentially, this is like the Chords setting but with more 
options to play chords out of the set key. 

Progressions: Each pad is assigned a chord in a chord progression. You can play the 
pads in (or out of) order to construct songs quickly. The available chords are 
determined by the Chord field. You can also create and use your own progressing by 
using the Convert to Progression feature. See Menu > Tools for more information. 

Custom: Each pad is assigned a custom MIDI note assignment. Click 
the Edit Note Map button to open the Edit MIDI Note Map window.  

 Use the Pad field to select the pad to edit. 

 Use the MIDI Note field to assign a note to the pad. 

You can also choose from three presets by clicking the 
Chromatic C1, Chromatic C-2, or Classic MPC buttons. 

 

Use the Pad Rows selector to determine how the notes are mapped across the pad banks. 

Continuous: Pad 01 of one bank is always one scale degree higher than Pad 16 of the previous bank. 

Start on Root: Pad 01 will always be the root note of the scale in every pad bank. 

 

Use the Root Note field to set the starting point of the scale. The available notes are all chromatic notes across the 
range of the pads. The pad that’s assigned the root note will be lit differently (and highlighted on the screen) to 
indicate where the scale starts in each octave. 

 

Use the Scale field to set the scale or mode based on the root note (this is disabled when Type is set to 
Progressions). The available scales are: 

Major Blues (minor) Major Bebop Lydian 

Natural Minor Flamenco Whole Tone Mixolydian 

Harmonic Minor Gypsy Chromatic Aeolian 

Pentatonic Major Hungarian Gypsy Dorian Locrian 

Pentatonic Minor Persian Phrygian  

 

Use the Octave field to set the starting octave for the Root Note. 

 

Use the Velocity field to set the pads to respond to velocity As played, or trigger at a fixed velocity for all note on 
messages at 12%, 18%, 25%, 31%, 37%, 43%, Half, 56%, 62%, 68%, 75%, 81%, 87%, 93% or Full velocity. 
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When Type is set to Chords, use the Scale Chord field to determine what chord type will play when pressing a pad. 
The chord will use those scale degrees based off the pad’s root note. 

1-3-5 (major/minor) 1-3-5-7 (major7/minor7) 

1-4-5 (sus4) 1-3-5-7b (dominant) 

1-2-5 (sus2)  

 

When Type is set to Chromatic Chords, use the Chromatic Chord field to determine what chord type will play when 
pressing a pad. The chord will that chord shape based off the pad’s root note. 

Major Major7 Augmented 

Minor Minor7 Diminished 

Sus2 Major9  

Sus4 Minor9  

 

Use the Filter Input field to determine how specific notes are filtered. Select As Played to apply no filtering, Snap to 
Scale to shift non-scale notes played to the nearest scale degree, or Filter to Scale to disable non-scale notes from 
playing entirely. 

 

Check the Use Aftertouch box to enable aftertouch. 
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Arrange Mode 
 

Arrange Mode is a fully-featured linear sequencer where you can record a performance or live input (MIDI 
or audio) into a linear timeline to create an arrangement of a song. You can use the powerful Arrange Edit 
commands to edit and arrange your song and then mix it down to a stereo audio file, or stem it as separate 
tracks. 

A beta implementation of Arrange Mode is included with MPC Software v3.9, but you can also use 
compatible MPC hardware in controller mode for additional control. See the latest MPC Standalone OS 
User Guide for more information on using Arrange Mode. 

 

To enter Arrange Mode, do any of the following: 

• Click the three-bars icon in the toolbar (if shown). 

• Click the down arrow () next to the other mode icons in the toolbar, and click Arrange Mode. 

• Click the menu icon (≡), and go to View > Mode and click Arrange. 

 

 

 

The upper half of the window displays the linear arrangement of your tracks. 

The lower half of the window can display the Grid Editor, Wave Editor, List Editor, or Audio Editor. Click the Grid, 
Wave, or List tab to enter the corresponding editor. When an Audio Track is selected, the Auto Editor is 
automatically displayed. See General Features > Editors to learn more about each one. 
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Click a track header in the upper half of the window to select a track. You can also select a track using the Inspector, 
and the track will be selected in the arrangement view. When a track is selected, the current Editor view will update 
to show that track’s information. 

 

Each track header will show Mute, Solo, Record Arm, and Track Automation states. Note that this requires the 
vertical zoom to be adjusted so there is enough space to show all components. Use the sliders in the lower-right 
corner of the Arrange Mode panel to adjust the zoom level. 

 

Click the Buses button to open the buses view, displaying the Submixes, Returns, and Main Output tracks in the 
upper half of the window. You can use these to create automation on these tracks in your linear arrangement.  

 

The buttons at the top of the arrangement view function as quick-edit tools using the loop brace as the selection 
range: 

Cut: Removes and copies the contents inside the loop brace. 

Copy: Copies the contents inside the loop brace. 

Paste: Inserts the copied or cut contents at the current playhead position. 

Duplicate: Copies the contents inside the loop brace and pastes the copy immediately after the selection. The 
loop brace automatically moves to the newly duplicated region for quick-repeated duplication. 

 

You can adjust the size of the loop brace by clicking and dragging from each end. Clicking and dragging from within 
the center of the loop brace will move the entire range. 

The loop brace can be activated or deactivated using the Loop button in the Sequence section of the Inspector. 
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Edit functions can also be accessed by clicking the Edit button at the top-right corner of the arrangement view, or by 
right-clicking in the arrangement timeline. 

Cut removes selected events from the arrangement between the loop brace and copies it to the clipboard. 

Copy copies selected events from the arrangement between the loop brace to the clipboard without removing 
them. After copying events, you can paste or insert them at another location in the same or another sequence. 

Paste (Merge Time) lets you paste the contents of the clipboard at the loop brace’s current location, merging 
new events with the existing events. 

Paste (Insert) lets you paste the contents of the clipboard at the loop brace’s current location, shifting all 
subsequent note events to after the end of the loop brace. 

Duplicate immediately duplicates the contents between the loop brace directly after the loop brace’s current location. 

Clear immediately clears all note events between the loop brace. 

Delete immediately deletes the bars, including all contents, between the loop brace. 

Insert Blank Bars immediately inserts empty bars equal to the length of the loop brace, shifting all subsequent 
note events directly after the loop brace’s current location. 

Insert Clip Row opens the Insert Clip Row window, where you can select an existing clip row from your project 
and insert its contents at the current playhead position. 

Use the Clip Row field to select the row of clips to be captured. 

The Playhead Position fields display the current playhead position where the clip contents will be inserted.  

Use the Bars field to determine the number of bars to be copied.  

Check the Bars follows longest Clip in Row to automatically determine the value of the Bars field based on 
the length of the longest clip in the selected row.  

Check the Close popup on action to close the Insert Clip Row window once the action is completed.  

Click Replace to replace the contents of the arrangement starting at the playhead position with the clip row 
content. Click Insert to insert the clip row contents at the playhead position and shift existing content.  

Click Close to close the Insert Clip Row window.  

Copy Bars Popup opens the Copy Bars function, where you can copy a range of bars from a sequence and add 
them at a specified point to the same or another sequence. You can learn more about this function in Editing 
Processes > Sequence. 

Note: The Copy Bars Popup option can only be selected using the Edit dropdown menu, not by right-clicking 
the arrangement timeline. 

These functions can also be accessed by clicking the menu icon (≡), navigating to Edit > Sequence, and using the 
Loop functions. 



  

 
134 

 

 

Track Edit Mode 
 

Track Edit Mode contains all parameters for editing your Tracks. 

For drum tracks, this mode includes the parameters of four layers as well as all synthesis parameters and 
insert effect settings. See the Drum Tracks section to learn more. 

For keygroup tracks, this mode contains slightly more parameters than drum tracks. See the Keygroup 
Tracks section to learn more. 

For plugin tracks, this mode shows the graphical user interface for the plugin. Skip to Plugin Tracks to 
learn more. 

For MIDI tracks and CV tracks, skip to MIDI Tracks and CV Tracks. 

For general information on the differences between the types of tracks, please see General Features > 
Tracks. 

 

To enter Track Edit Mode, do any of the following: 

• Click the four-pads icon in the toolbar (if shown). 

• Click the down arrow () next to the other mode icons in the toolbar, and click Track Edit. 

• Click the menu icon (≡), and go to View > Mode and click Track Edit. 

 

 

 

The upper half of the window can display the Grid Editor, Wave Editor, or List Editor. Click the Grid, Wave, or List 
tab to enter the corresponding editor. See General Features > Editors to learn more about each one. 

The lower half of the window can display the Q-Links panel, Pads panel, Track Editor panel, and Project panel. 
Click the corresponding selector to show or hide each one. See General Features > Panels to learn more about the 
Q-Links or Project panels. The Pads panel is described in this chapter here. The Track Editor panel is described in 
this chapter here. 
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Pads 
 
When the MIDI tab is selected in Track Edit Mode, the Pads panel shows information for each pad, depending on the 
currently selected track. 

Drum tracks: Each pad will show the samples assigned to it (all four layers). Click the Pad Bank letters to 
access additional pads or the full range of notes.  

Keygroup tracks, Plugin tracks, MIDI tracks, and CV tracks: Each pad will show the note it will play as both a 
MIDI note number (0–127) and note value (e.g., C-1, G#5, etc.). Click the Pad Bank letters to access the full 
range of notes. Click a pad to play its note. 

 

 Drum Track Keygroup, Plugin, MIDI, or CV Track 

   

 

Each pad can also display a color, which you can customize for each track. See General Features > Pad Color to 
learn how to do this. In Track Edit Mode, these colors will be displayed only when the pad is being played. 

 

When an Audio track is selected in Track Edit Mode, the Pads panel is not available. 

 



  

 
136 

 

 

Track Editor 
 
The Track Editor shows different settings depending on the type of track that is selected in Track Edit Mode. This is 
non-functional when an Audio track is selected. 
 
 
Drum Tracks 
 

 
 
When using a drum track, the Track Editor shows the parameters for each pad and the track overall. 
To select a pad, press it. Its parameters will appear on the screen immediately. 
 
In the Global section, set the playback mode and tuning for the overall track. 

Note: The Sample/Osc Layers section has some parameters similar to those in this section (Semi, Fine). Remember 
that the Global section parameters control the overall settings for the track, while Sample/Osc Layers controls the 
settings for each layer (up to eight). 

Polyphony sets the playback mode for the track’s pads. In Mono Mode, only one pad will sound at a time. If a 
pad is played while another (or the same one) is still playing its sample/samples, the new pad will immediately 
mute all other currently playing pads in that track. In Poly Mode, several pads can be triggered at the same time 
(limited only by the total number of voices available). 

Semi lets you transpose the track up to 36 semitones up or down. 

Fine provides fine-tuning of the track up to 99 cents up or down. 
 
In the Pad section, set the volume and panning for the current pad. 

Note: The Sample/Osc Layers section has some parameters similar to those in this section (Level, Pan). Remember 
that the Pad section parameters control the overall settings for the pad, while Sample/Osc Layers controls the 
settings for each layer (up to eight). 

Level controls the overall volume level of the loaded sample(s) or oscillator(s). 

Pan controls the overall panning of the loaded sample(s) or oscillator(s) in the stereo field. 
Vel Scale controls the velocity scaling of the pad. For example, if the scaling is set to 50 and the incoming note 
velocity is 120, the note velocity would be 60 instead. 

 
The Simultaneous Play section lets you set up to four pads that can be triggered by pressing one pad only. This 
function is useful for triggering a stack of sounds (e.g., layered bass drums). Use each Pad menu to select the desired 
pad. 
 
The Mute Targets section lets you select up to four pads (in the same track) for the currently selected pad. When the 
currently selected pad is played, it will immediately silence its mute targets. Use each Pad menu to select the desired 
mute target. 

Tips: 

This feature is useful for programming realistic hi-hats, especially if only the open or closed hat should be heard. 

This feature is similar to the mute group feature, available for both drum tracks and keygroup tracks. 
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The Pad Play Modes section lets you set the behavior for each pad’s samples or oscillators in a drum track. 

Click the Sample Play menu to determine how much of the sample or oscillator is played.  

One-Shot: The entire sample or oscillator will play from start to end. Use this when you want to play short 
sounds. 

Note-Off: The entire sample or oscillator will play from start to end after the pad has been pressed and 
released.  

Note-On: The sample or oscillator will play only as long as the pad is held. This is better for longer samples 
so you can control a sound’s duration by pressing and holding its corresponding pad. If this option is 
selected, the Filter Envelope and Amp Envelope will use an ADSR type rather than AD or AHDS (see 
Anatomy of an Envelope to learn about this).  

Click the Layer Play menu to determine how multiple samples or oscillators assigned to the same pad are 
played: 

Cycle: Each time the pad is played, it will play the next layer’s sample or oscillator. In other words, the 
samples or oscillators will cycle through the layers as follows: 1, 2, 3, 4, 5, 6, 7, 8, 1, 2… etc. 

Velocity: The pad will switch between layers depending on how hard you press a pad.  

Random: Each time the pad is played, it will play one of its layer’s samples or oscillators at random.  

Crossfade: Crossfade between pad layers using modulation sources like envelopes and LFOs in the Mod 
Matrix, allowing for wave sequencing or vector synthesis-like effects. Use the Crossfade Mode menu to 
select how the layers are arranged on the pad: 

A  B  C  D 

3 4 
 

3+7 4+8 
 

5    6 7    8 
 

1 — 8 

  
1 2 

 
1+5 2+6 

 
1    2 3    4 

 

 
Click the Mute Group menu to assign the selected pad to one of the 32 available groups. When pads assigned 
to the same mute group receive MIDI notes, the last pad played will silence all other pads in that mute group. A 
mute group affects pads within that track only; mute groups do not affect pads in other tracks. 

Tip: This feature is useful for programming realistic hi-hats, especially if only the open or closed hat should be heard. 

Click the Pad Poly menu to determine how the pad’s sound behaves when multiple hits are registered. When set 
to Mono, only one pad will sound at a time. If a pad is played while another (or the same one) is still playing its 
sample/samples, the new pad will immediately mute all other currently playing pads in that track. When set to 
Poly, several pads can be triggered at the same time (limited only by the total number of voices available). You 
can also select a specific number of pads (2–64) so that you can trigger up to this many pads at the same time 
(unless they exceed the total number of voices available). 

 
The Articulations section allows you to apply variable drum articulations and rudiments like flams, paradiddles, and 
other dynamic phrases.  

Click the dropdown menu to select the type of articulation applied. Articulations are grouped into eight 
categories: Default Articulations, Standard Rudiments, Dotted Rudiments, Triplet Rudiments, Rolls, 
Pitched Rolls, Metric Rudiments, and Note Repeats. 

Use the Speed knob to adjust the length of the articulation (25–400%). You can also use the /2, x1, and x2 
buttons to quickly modify the set articulation speed. 

Use the Dynamics knob to apply velocity modulation to the articulation (0–200%). 

Use the Stereo knob to adjust the stereo spread of the articulation (0–100%). 

Click the MPCe button to enable MPCe articulation control. This allows you to assign up to four different 
articulations to the four corners of each pad for dynamic articulation switching. This can be controlled directly 
from MPC Live III’s MPCe hardware pads, but you can also click and drag on the pads in the Pads panel to 
apply MPCe effects.  
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The Edit Zones section provides an overview of any selected pads. Use the selector at the top to set how the 
selected pads will be edited: 

Current: Only the currently selected pad will be edited. 

Multiple: All selected pads will be edited simultaneously. 

All: All pads will be edited simultaneously. 

 

The Drum FX section allows you to use up to eight dedicated effects for each pad. There are eight available Drum FX 
slots, each with an adjustable parameter: 

• Ring Mod 

• Bit Crush 

• Decimator 

• Tube Drive 

• Soft Clipper 

• Hard Clipper 

• Low Pass 

• High Pass  

• Rectifier 

• Bass Enhancer (Tight) 

• Bass Enhancer (Medium) 

• Bass Enhancer (Wide) 

• Wave Folder 

• Gain 

Use the Type dropdown menu to select the effect in each slot and turn each knob to adjust the selected effect 
parameter. 

 

The Sample/Osc Layers section shows eight layers, each of which can use an assigned sample or . Each layer has 
identical, independently assignable parameters. 

Click the OSC button to set the sound source for the selected layer to an oscillator.  

Use the Oscillator dropdown menu to select the waveform for the layer.  

When OSC is activated, click the Edit button to access additional Oscillator editing controls. Each oscillator 
includes a Decay parameter (to adjust the length of the oscillator amplitude decay) and a Phase parameter 
(to set where the in waveform shape the oscillator starts when played). Other parameters may be available 
depending on the type of Oscillator selected. See Editors > Wave Editor > Oscillator to learn more about 
the different oscillator parameters.  

Click the Get Oscillator Content button to open the Activations tab of the Preferences menu, where you 
can download and install the oscillator content.  

Click the Sample menu to select the sample for that layer. Remember that the sample has to be loaded into the 
project’s sample pool beforehand. 

Use the MPCe field to enable or disable individual quadrants on each layer of the pad.  

Semi lets you transpose the selected layer up to 36 semitones up or down. 

Fine provides fine-tuning of each layer up to 99 cents up or down. 

Level lets you adjust each layer’s volume, letting you control the “balance” of the samples or oscillators assigned 
to the pad. 

Use the pan knob to adjust the stereo placement of the respective layer. 

Use the Velocity slider to define the velocity range of each layer. 

A range from 0 to 127 lets the layer respond to the entire velocity range which is input from the respective 
pad while, for example, a range from 100 to 127 lets the layer respond only to higher velocity levels. By 
assigning several samples of one instrument, you can create a realistic-sounding “multi-sample” by adjusting 
the velocity ranges of each layer accordingly. 

For example, you may have three samples of a drum hit with low force, medium force, and high force. You can 
set each sample to a layer and set the Velocity ranges so only low velocities trigger the low-force sample, only 
mid-range velocities trigger the medium-force sample, and only high velocities trigger the high-force sample. 

Use the Edit All Layers button to enable or disable editing control of all pad layers at the same time. When this is 
enabled, edits made to parameters such as Start/End points or Semi/Fine tuning on any one layer are automatically 
applied uniformly to all eight layers at once (even if some layers are empty).  
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The Randomize section lets you add randomized variety to the Pitch, Level, Pan, and Sample Offset parameters of 
each layer. You can also adjust the Envelope (Attack, Decay, Cutoff, Resonance) parameters of all layers. Turn each 
knob to adjust the amount of randomization for the selected parameter. Use the Total Amount field to scale the total 
amount of randomization applied. The Random Seed field provides a randomization value between 1–999,999. Re-
entering this value provides repeatable randomness across sessions, projects, or presets.  

 

The Envelope section lets you create a variable control signal that can be used, for instance, to modulate the filter, 
amplitude, or pitch settings of a sound over a given period of time. 

The Amp Envelope controls affect level changes over time. Use the fields or click and drag the “handles” of the 
envelope to shape the envelope or time-variant modulation output. See the later Anatomy of an Envelope 
section to learn about the envelope parameters. 

The Filter Envelope controls affect the filter frequency. Use the fields or click and drag the “handles” of the 
envelope to shape the envelope or time-variant modulation output. See the later Anatomy of an Envelope 
section to learn about the envelope parameters. 

The Pitch envelope controls affect the pitch of the sample. Use the fields or click and drag the “handles” of the 
envelope to shape the envelope or time-variant modulation output. See the later Anatomy of an Envelope 
section to learn about the envelope parameters. 

You can also save and load Partial Pad Presets in the Envelope section. These can be used to save and load the 
complete state of the synthesis engine that processes a pad, along with a selection of setup parameters, including 
filter and drum effect chains and expressive Mod Matrix routings for MPCe pads.  

Tap the disk icon to save the current pad state as a partial preset. 

Tap the menu icon to open the list of included partial pad presets saved to your computer.  

 

The Filter section lets you set the type and characteristics of the filter. 

Click the Type menu to select a filter for the selected pad. You can set the default Type setting for new drum 
tracks and keygroup tracks in Project tab of the Preferences (see General Features > Preferences). 

Use the Cutoff knob to set the cutoff frequency for low-pass and high-pass filter types or the center frequency 
for band-pass and band-stop filter types. 

Use the Reso knob to set the resonance/emphasis of the frequencies around the cutoff point. 

You can also click and drag the filter handle to adjust the Cutoff and Resonance at the same time with instant 
visual feedback. 

Tip: Use values lower than 80 to give more brilliance to the sound. At values higher than 80, the sound will result 
in a strong audible boost around the cutoff frequency.  
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The LFO section lets you select periodic waveforms generated by the two low-frequency oscillators. You can adjust 
the frequency and shape of each for modulation purposes. 

Click 1 or 2 to view and edit the two available LFOs. 

Click the Shape menu to select the LFO waveform type: 

Sine (best suited for smooth modulations) 

Triangle (best suited for smooth modulations) 

S&H (samples a random value and holds it until the next value is generated) 

Saw (can generate interesting filter or volume changes) 

Saw Down (can generate interesting filter or volume changes) 

Square (interesting results with hard-panning modulations) 

Noise (generates random values and glides) 

Use the Reset field to determine whether the LFO retriggers on each note played (On) or not (Off). 

Use the Fade In knob to set the length of time for the LFO to reach full level once triggered. 

Use Fade In [Sync] to synchronize the fade in with the tempo. You can select one of several time divisions (a . 
indicates a dotted note; a T indicates a triplet-based time division). When None is selected, Sync is off, and the 
fade in length is determined by the Fade In knob. 

Use the Delay knob to set the length of time between when the note is triggered and when the LFO is triggered.  

Use Delay [Sync] to synchronize the delay time with the tempo. You can select one of several time divisions (a . 
indicates a dotted note; a T indicates a triplet-based time division). When None is selected, Sync is off, and the 
delay length is determined by the Fade In knob. 

Use the Rate knob to determine the LFO frequency. At lower values, it might take some time for the LFO to 
complete a cycle, while higher values will come closer to audible range. 

Use Rate [Sync] to synchronize the LFO’s rate with the tempo. You can select one of several time divisions (a . 
indicates a dotted note; a T indicates a triplet-based time division). When None is selected, Sync is off, and the 
frequency is determined by the Rate knob. 

Use the Level knob to set the overall amount of modulation applied by the LFO. At lower values, the modulation 
is more subtle, and at higher values it is more extreme. 

Click the  in the LFO waveform window to display the Destinations sliders, which determine how much the 
LFO affects the pitch of the sound (Pitch), the cutoff frequency of the filter (Filter), the volume level of the sound 
(Amp) and panning of the sound (Pan). Click the X to close the Destinations window again. 

 
Use the Note Counter 1/2 Size fields to set stepped modulation values. These can be used as part of the Mod 
Matrix to change parameter values based on the number of voices selected (2–64). 

 
The Voice section allows you to add additional free running LFOs which can be used for subtle modulations in the 
Mod Matrix. Use the Global Drift knob to set the amount of drift applied to the entire drum track, or use the Voice 
Drift knob to set the amount of drift applied to the selected pad. 

 
Use the Ramp Time 1/2 fields to adjust the ramp length. These can be used to apply additional modulation shaping 
to other parameters via the Mod Matrix.  
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The Velocity Sensitivity section lets you set how much velocity is required to modulate certain other parameters as 
well as your filter envelope and amp envelope.  

Start sets how much velocity is needed (for a triggered pad) to modulate the sample start point. 

Filter Attack sets how much velocity is needed (for a triggered pad) to modulate the Attack phase for the Filter 
envelope.  

Filter Depth enables velocity information to control the amount of the filter envelope’s effect on the amount of 
filter applied. 

Filter Cutoff uses the velocity to modulate the cutoff frequency directly. 

Pitch determines how much the velocity affects the pitch of the sound. 

Amp Attack determines how much the velocity affects the Attack phase of the Amplitude envelope. 

Amp determines how much the velocity affects the amplitude level. 

Pan determines how much the velocity affects the panning of the sound.  

Use the sliders to adjust the setting of each. When you press a pad softly, only minimal modulation is applied. When 
you press it harder, the modulation amount also gets stronger depending on the setting of the corresponding knob. 

 

The Mod Matrix section provides 32 modulation points which can be configured to add a wide variety of sound 
shaping tools. 

Click the 1/2/3/4 icons to cycle between the available modulation points. 

Use the Source field to select the modulation source. 

Use the first Amt (Amount) field to set how much modulation is applied by the source. 

Use the Target field to select the output target for modulation.  

Use the Dir (Direction) field to set the modulation direction: 

• Select  for linear modulation. 

• Select ± for bipolar modulation. 

Use the Min and Max fields to set the minimum and maximum modulation levels of the selected target. 

Use the Via Source field to add a secondary modulation shaper using another source. 

Use the second Amt (Amount) field to set how much modulation is applied by the secondary source. 

Use the Shaper field to apply an additional modifier that affects the modulation relationship between the source 
and target. 

Use the third Amt (Amount) field to set how much modulation is applied by the shaper. 
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Keygroup Tracks 

 

 
 

When using a keygroup track, the Track Editor shows the parameters for each keygroup and the track overall. 

 

Click the Legacy button to enable or disable the Legacy Keygroup editing functions. When this button is enabled, 
keygroup editing functions the same as it has in previous MPC releases. When this button is disabled, the new 
Advanced keygroup synthesis engine is enabled. Legacy mode is enabled by default. The following sections are 
labeled as being available in Legacy mode, Advanced Mode, or both Legacy and Advanced modes. 

 

To select a keygroup, press a pad within that keygroup. Its parameters will appear on the screen immediately.  

 

 

Legacy and Advanced 
 

In the Global section (Legacy and Advanced), set the playback mode and tuning for the overall track. 

Semi lets you tune the track up to 36 semitones up or down. 

Fine provides fine-tuning of the track up to 99 cents up or down. 

Trans shifts the pitch of the MIDI notes sent to the track up to 36 semitones up or down. 

Polyphony sets the playback mode for the track’s keygroups. In Mono Mode, only one keygroup will sound at a 
time. If a keygroup is played while another (or the same one) is still playing its sample(s) or oscillator(s), the new 
keygroup will immediately mute all other currently playing keygroups in that track. In Poly Mode, several 
keygroups can be triggered at the same time (limited only by the total number of voices available). 

#KG (number of keygroups) lets you create up to 128 keygroups within a keygroup track. This is useful when 
working with multi-samples. For example, if you want to create a realistic piano, you can use different keygroups 
(e.g., 88 for a grand piano) with every keygroup containing its own sampled note (with up to eight possible 
velocity layers). 
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Use the Keygroup section (Legacy and Advanced) to set the playback modes, level, tuning, and other settings for 
the keygroup. 

Note: The Sample/Osc Layers section has some parameters similar to those in this section (Level, Pan, Semi, 
Fine). Remember that Keygroup section parameters control the overall settings for the selected keygroup, while 
Sample/Osc Layers controls the settings for each layer (up to eight). 

The Keygroup Select field lets you select a specific keygroup for editing. This parameter works in conjunction 
with the #KG (number of keygroups) parameter at the top of the window, which lets you create up to 128 
keygroups within one keygroup track. A default keygroup track contains only one single keygroup. When you 
have created more than one keygroup with #KG, use Keygroup Select to select any keygroup for editing. All 
selects all available keygroups of a keygroup track for simultaneous editing. 

Semi lets you transpose the selected keygroup up to 36 semitones up or down. 

Fine provides fine-tuning of each keygroup up to 99 cents up or down. 

Level controls the overall volume level of the loaded sample(s) or oscillator(s). 

Pan controls the overall panning of the loaded sample(s) or oscillator(s) in the stereo field. 

Key Track allows you to switch a sample or oscillator’s automatic transposition on or off. If this is off, you will 
always hear the same pitch of the sample, no matter which note is triggered by pads or a connected MIDI 
keyboard. 

Note Range lets you restrict the key range used for a sample or oscillator’s playback. Only notes with a key 
number higher or equal (Lo) or lower and equal (Hi) to the selected value will trigger a sound. 

Tip: Set the Lo parameter to A0 and the Hi parameter to C8 to emulate the range of a standard 88-key piano. 
Click the KG Poly (keygroup polyphony) menu to determine how the keygroup will play. When set to Mono, only 
one pad will sound at a time. If a pad is played while another (or the same one) is still playing its sample(s) or 
oscillator(s), the new pad will immediately mute all other currently playing pads in that track. When set to Poly, 
several pads can be triggered at the same time, limited only by the total number of voices available. You can also 
select a specific number of pads (2–64) so that you can play up to this many pads at the same time (unless they 
exceed the total number of voices available).  

Click the Mute Group menu to assign the selected pad to one of the 32 available groups. When pads assigned 
to the same mute group receive MIDI notes, the last pad played will silence all other pads in that mute group. A 
mute group affects pads within that track only; mute groups do not affect pads in other tracks. 

Layer Play determines how multiple samples or oscillators assigned to the same pad are played: 

Cycle: Each time the pad is played, it will play the next layer’s sample or oscillator. In other words, the 
samples or oscillators will cycle through the layers as follows: 1, 2, 3, 4, 5, 6, 7, 8, 1, 2… etc.  

Velocity: The pad will switch between layers depending on how hard you press a pad.  

Random: Each time the pad is played, it will play one of its layer’s samples or oscillators at random.  

Crossfade: Crossfade between layers using modulation sources like envelopes and LFOs in the Mod 
Matrix, allowing for wave sequencing or vector synthesis-like effects. Use the XFade Mode menu to select 
how the layers are arranged on the pad: 

A  B  C  D 

3 4 
 

3+7 4+8 
 

5    6 7    8 
 

1 — 8 

  
1 2 

 
1+5 2+6 

 
1    2 3    4 

 

Sample Play determines how much of the sample or oscillator is played: 

One-Shot: The entire sample or oscillator will play from start to end. Use this when you want to play short 
sounds. 

Note-Off: The entire sample or oscillator will play from start to end after the pad has been pressed and 
released.  

Note-On: The sample or oscillator will play only as long as the pad is held. This is better for longer samples 
or oscillators so you can control a sound’s duration by pressing and holding its corresponding pad. If this 
option is selected, the Filter Envelope and Amp Envelope will use an ADSR type rather than AD or AHDS 
(see Anatomy of an Envelope to learn about this). 
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The Sample/Osc Layers section (Legacy and Advanced) shows eight layers, each of which can use an assigned 
sample. Each layer has identical, independently assignable parameters. 

Click the OSC button to set the sound source for the selected layer to an oscillator.  

Use the Oscillator dropdown menu to select the waveform for the layer.  

When OSC is activated, click the Edit button to access additional Oscillator editing controls. Each oscillator 
includes a Decay parameter (to adjust the length of the oscillator amplitude decay) and a Phase parameter 
(to set where the in waveform shape the oscillator starts when played). Other parameters may be available 
depending on the type of Oscillator selected. See Editors > Wave Editor > Oscillator to learn more about 
the different oscillator parameters.  

Click the Get Oscillator Content button to open the Activations tab of the Preferences menu, where you 
can download and install the oscillator content.  

Click the Sample menu to select the sample for that layer. Remember that the sample has to be loaded into the 
project’s sample pool beforehand. 

Semi lets you transpose the selected layer up to 36 semitones up or down. 

Fine provides fine-tuning of each layer up to 99 cents up or down. 

Level lets you adjust each layer’s volume, letting you control the “balance” of the samples assigned to the pad. 

Use the pan knob to adjust the stereo placement of the respective layer. 

Use the Velocity slider to define the velocity range of each layer. 

A range from 0 to 127 lets the layer respond to the entire velocity range which is input from the respective 
pad while, for example, a range from 100 to 127 lets the layer respond only to higher velocity levels. By 
assigning several samples of one instrument, you can create a realistic-sounding “multi-sample” by adjusting 
the velocity ranges of each layer accordingly. 

For example, you may have three samples of a piano key with low force, medium force, and high force. You can 
set each sample to a layer and set the Velocity ranges so only low velocities trigger the low-force sample, only 
mid-range velocities trigger the medium-force sample, and only high velocities trigger the high-force sample. 

Root Note lets you set the key of the sample layer. This can be detected automatically by choosing SMP or 
manually by selecting a specific note. 

Use the Edit All Layers button to enable or disable editing control of all layers at the same time. When this is 
enabled, edits made to parameters such as Start/End points or Semi/Fine tuning on any one layer are automatically 
applied uniformly to all eight layers at once (even if some layers are empty).  

 
 
Legacy 
 
The Randomize (Legacy) section lets you add randomized variety to the Pitch, Level, Pan, and Sample Offset 
parameters of each layer. You can also adjust the Envelope (Attack, Decay, Cutoff, Resonance) parameters of all 
layers. Turn each knob to adjust the amount of randomization for the selected parameter. Use the Total Amount 
field to scale the total amount of randomization applied. 

 
The Envelope (Legacy) section lets you create a variable control signal that can be used, for instance, to modulate 
the filter, amplitude, or pitch settings of a sound over a given period of time. 

The Filter Envelope controls affect the filter frequency. Use the fields or click and drag the “handles” of the envelope 
to shape the envelope or time-variant modulation output. See the later Anatomy of an Envelope section to learn 
about the envelope parameters. 

The Amp Envelope controls affect level changes over time. Use the fields or click and drag the “handles” of the 
envelope to shape the envelope or time-variant modulation output. See the later Anatomy of an Envelope section to 
learn about the envelope parameters. 

The Pitch envelope controls affect the pitch of the sample. Use the fields or click and drag the “handles” of the 
envelope to shape the envelope or time-variant modulation output. See the later Anatomy of an Envelope section to 
learn about the envelope parameters. 
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The Filter (Legacy) section lets you set the type and characteristics of the filter. 

Click the Type menu to select a filter for the selected keygroup. You can set the default Type setting for new drum 
tracks and keygroup tracks in the Project tab of the Preferences (see General Features > Preferences). 

Use the Cutoff knob to set the cutoff frequency for low-pass and high-pass filter types or the center frequency 
for band-pass and band-stop filter types. 

Use the Res knob to set the resonance/emphasis of the frequencies around the cutoff point. 

Tip: Use values lower than 80 to give more brilliance to the sound. At values higher than 80, the sound will result 
in a strong audible boost around the cutoff frequency.   

 

The LFO (Legacy) section lets you select a periodic waveform generated by the low-frequency oscillator. You can 
adjust the frequency and shape for modulation purposes. 

Click the Wave menu to select the LFO waveform type: 

Sine (best suited for smooth modulations) 

Triangle (best suited for smooth modulations) 

S&H (samples a random value and holds it until the next value is generated) 

Saw (can generate interesting filter or volume changes) 

Saw Down (can generate interesting filter or volume changes) 

Square (interesting results with hard-panning modulations) 

Noise (generates random values and glides) 

Use the Rate knobs to determine the LFO frequency when Sync is set to None. At lower values, it might take 
some time for the LFO to complete a cycle, while higher values will come closer to audible range. 

Click the Sync menu to set how the LFO’s rate is synchronized with the tempo. You can select one of several 
time divisions. When None is selected, Sync is off. 

Use the Destinations sliders to determine how much the LFO affects the pitch of the sound (Pitch), the cutoff 
frequency of the filter (Filter), the volume level of the sound (Amp) and panning of the sound (Pan). 

 

The Portamento section (Legacy) lets you adjust the settings for pitch gliding. 

Use the Time slider to set the length of the glide between notes. 

Click the Quantize button to synchronize the portamento time with the project tempo.  

Click the Legato button to enable or disable pitch gliding for all triggered notes or just legato notes. 

 

The Velocity Sensitivity and Filter Velocity Sensitivity sections (Legacy) let you set how much velocity is required 
to modulate certain other parameters:  

Use the Pitch slider to enable velocity information to control the pitch of the layer. 

Use the Attack slider to set how much velocity is needed (for a triggered pad) to modulate the Attack phase for 
the Amp envelope. 

Use the Amp slider to enable velocity information to control the overall amplitude (level) of the layer. 

Use the Pan slider to enable velocity information to control the stereo panning of the layer. 

Use the Keyboard slider to set how much the note value will be added to the filter cutoff. This allows layers to 
sound brighter as they are played higher on the keyboard. 

Use the Env Attack slider to set how much velocity is needed (for a triggered pad) to modulate the Attack phase 
for the Filter envelope. 

Use the Env Depth slider to enable velocity information to control the amount of the filter envelope’s effect on 
the cutoff frequency. 

Use the Cutoff slider to enable velocity information to modulate the cutoff frequency directly. 
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The Controller Mod section (Legacy) determines the influence of additional play controllers on various sound 
parameters. 

Important: To use these parameters, make sure that a connected MIDI device can send pitch bend messages as 
well as aftertouch and modulation wheel data. 

Use the Pitch Bend slider to set the range (in semitones) of a connected MIDI keyboard’s pitch-bend wheel. 

Use the Wheel>LFO slider to determine how much a connected MIDI keyboard’s modulation wheel affects the 
LFO intensity.  

Use the Aft>Filt (AftertouchFilter Cutoff) slider to determine how much a connected MIDI keyboard’s 
aftertouch data affects the filter cutoff. 

Use the Chp>Filt (Channel PressureFilter Cutoff) slider to determine how much a connected MIDI keyboard’s 
channel pressure data affects the filter cutoff. 

 

 

Advanced 

 

 

 

The Filter (Advanced) section lets you set the type and characteristics of the dual filter section. 

Click the Type menus to select the dual filter types for the selected keygroup. 

Use the Cutoff knob to set the cutoff frequency for low-pass and high-pass filter types or the center frequency 
for band-pass and band-stop filter types. 

Use the Reso knob to set the resonance/emphasis of the frequencies around the cutoff point. 

Tip: Use values lower than 80 to give more brilliance to the sound. At values higher than 80, the sound will result 
in a strong audible boost around the cutoff frequency.  

Use the Output knob to set the output level of the filter. 

Use the Env knob to set the amount of effect the Filter Envelope has on the Cutoff frequency. 

Use the KT (Keytrack) knob to adjust how the filter cutoff is tied to the pitch being played. At higher levels, the 
amount of cutoff reduction is more noticeable as the pitch is raised. 

Use the Blend slider to adjust the mix between the two filters. 

Use the Parallel/Serial button to toggle whether the filters run side-by-side (Parallel) or one into the other (Serial). 

 

The Envelope (Advanced) section lets you create a variable control signal that can be used, for instance, to modulate 
the filter, amplitude, or pitch settings of a sound over a given period of time. 

The Amp Envelope controls affect level changes over time.  

The Filter Envelope controls affect the filter frequency.  

The Pitch envelope controls affect the pitch of the sample.  

The Aux Envelope can be used as part of the Modulation matrix to apply an envelope to other parameters. 

Use the Delay, Attack, Hold, Decay, Sustain, and Release fields or click and drag the “handles” of each 
envelope to shape the envelope or time-variant modulation output. See the later Anatomy of an Envelope 
section to learn about the envelope parameters. 
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Use the Looped field to enable or disable looping of the envelope. When set to On, the envelope will restart once 
it has reached its end. The length of the envelope is determined by the Tempo Sync value, or the total envelope 
length, as set by the Delay, Attack, Hold, Decay, Sustain, and Release knobs. When set to Off, the envelope 
triggers on each note-on only.  

 

Use the Tempo Sync field to synchronize the envelope loop with the tempo. You can select one of several time 
divisions (a . indicates a dotted note; a T indicates a triplet-based time division). When None is selected, Sync is 
off, and the loop length is determined by the total length of the Delay, Attack, Hold, Decay, Sustain, and 
Release settings. 

 

Use the Time Scaling field to apply an additional time adjustment to the loop length. At 100%, the total loop length 
is unchanged. The loop length is shorted when set to below 100%, and lengthened when set to above 100%. 

 

Use the Global field to determine whether the envelope is applied to only the current voice (Off) or to the entire 
keygroup (On). 

 

The LFO section (Advanced) lets you adjust settings for the low-frequency oscillators (LFO), which generate a 
periodic waveform with an adjustable frequency and shape and can be used for modulation purposes. There are two 
per-voice LFOs and two global LFOs for extensive modulation options. 

In the LFO section: 

Click the 1/2 icons to select which of the two per-voice LFOs you are viewing and editing. 

Use the Shape field to select the LFO waveform type: 

• Sine: Best suited for smooth modulations. 

• Tri (Triangle): Best suited for smooth modulations. 

• S&H: Samples a random value and holds it until the next value is generated. 

• Saw: Can generate interesting filter or volume changes. 

• SawD (Saw Down): Can generate interesting filter or volume changes. 

• Sqr (Square): Interesting results with hard-panning modulations. 

• Noise: Generates random values and glides. 

Use the Reset field to determine whether the LFO retriggers on each note played (On) or not (Off). 

Use the Fade In field to set the length of time for the LFO to reach full level once triggered. 

Use the Fade In [Sync] to synchronize the fade in with the tempo. You can select one of several time divisions  
(a . indicates a dotted note; a T indicates a triplet-based time division). When None is selected, Sync is off, and 
the fade in length is determined by the Fade In knob. 

Use the Delay knob to set the length of time between when the note is triggered and when the LFO is triggered.  

Use the Delay [Sync] to synchronize the delay time with the tempo. You can select one of several time divisions 
(a . indicates a dotted note; a T indicates a triplet-based time division). When None is selected, Sync is off, and 
the delay length is determined by the Fade In knob. 

Use the Rate knob to determine the LFO frequency. At lower values, it might take some time for the LFO to 
complete a cycle, while higher values will come closer to audible range. 

Use Rate [Sync] to synchronize the LFO’s rate with the tempo. You can select one of several time divisions (a . 
indicates a dotted note; a T indicates a triplet-based time division). When None is selected, Sync is off, and the 
frequency is determined by the Rate knob. 

Use the Level knob to set the overall amount of modulation applied by the LFO. At lower values, the modulation 
is more subtle, and at higher values it is more extreme. 

Use the MW>LFO (Mod Wheel to LFO) knob to adjust how much control mod wheel data (MIDI CC1) has over 
the LFO. When set to 0, the mod wheel has no effect on the LFO level. When set to 100, the LFO is fully 
controlled by the mod wheel.  

Click the Destinations  button to access the destination controls. These sliders to determine how much the 
LFO affects the pitch of the sound (To Pitch), the cutoff frequency of the filter (To Filter 1/2), the volume level of 
the sound (To Amp) and panning of the sound (To Pan). Click the X to close the destination controls.  
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In the Global LFO section: 

Click the 1/2 icons to select which of the two global LFOs you are viewing and editing. 

Use the Shape field to select the LFO waveform type: 

• Sine: Best suited for smooth modulations. 

• Tri (Triangle): Best suited for smooth modulations. 

• S&H: Samples a random value and holds it until the next value is generated. 

• Saw: Can generate interesting filter or volume changes. 

• SawD (Saw Down): Can generate interesting filter or volume changes. 

• Sqr (Square): Interesting results with hard-panning modulations. 

• Noise: Generates random values and glides. 

Use the Rate knob to determine the LFO frequency. At lower values, it might take some time for the LFO to 
complete a cycle, while higher values will come closer to audible range. 

Use the Rate [Sync] knob to set if the LFO’s rate when synchronized with the tempo. You can select one of 
several time divisions (a . indicates a dotted note; a T indicates a triplet-based time division). When None is 
selected, Sync is off, and the frequency is determined by the rate knob. 

Use the Level knob to set the overall amount of modulation applied by the LFO. At lower values, the modulation 
is more subtle, and at higher values it is more extreme. 

 

The Ramp (Advanced) section lets adjust settings for the two ramp modulators, which can be used to apply 
additional modulation shaping to other parameters in the modulation matrix. 

Click the 1/2 icons to select which of the two ramps you are viewing and editing. 

Use the Time field to adjust the ramp length. 

 

The Voice (Advanced) section lets you adjust settings for pitch drifting and tonal shaping. 

Use the Global Drift knob to set the amount of pitch drift applied to the entire keygroup. 

Use the Voice Drift knob to set the amount of pitch drift applied to the selected keygroup voice. 

Use the Timbre Shift knob to adjust the amount of tonal character shaping applied to the keygroup.  

 

The Note Counter (Advanced) section lets you to set a stepped modulation value. This can be used as part of the 
Mod Matrix to change parameter values based on the Size selected (2–8). 
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The Portamento section (Advanced) lets you adjust the settings for pitch gliding. 

Use the Time slider to set the length of the glide between notes. 

Click the Legato button to enable or disable pitch gliding for all triggered notes or just legato notes. 

Click the Mono Retrig to allow the portamento to retrigger on every key press when using mono polyphony. 

Click the Quantize button to synchronize the portamento time with the project tempo.  

 

The Pitch Bend (Advanced) section allows you to set the maximum number of semitones shifted up or down when 
pitch bend is applied. 

 

The KG Stack (Advanced) section allows you to add and edit keygroup stacking effects for harmonization effects. 

Click Unison or Harmonizer to add the selected effect. Click None to disable keygroup stack effects. 

When Unison is selected: 

Use the Voices knob to adjust the number of unison voices. 

Use the Detune knob to adjust the amount of fine-tuning applied to the unison voices in cents. 

Use the Stereo Spread knob to adjust the width of the unison voices in the left-right stereo field. 

Use the type selector to select the type of unison voice stacking applied (Classic, Linear, Parabolic, or 
Random). 

 

When Harmonizer is selected: 

Click the Note number to enable each harmonizer voice. 

Use the Shift field to set the amount of pitch shifting applied to the voice in semitones. 

Use the Detune knob to adjust the amount of detuning to the voice in cents. 

Use the Volume knob to set the level of the voice. 

Use the Pan knob to set the stereo panning of the voice. 

Use the Vel Scale field to adjust the ratio of the harmonized voice velocity with the incoming note velocity. 

Use the Delay field to add an additional time delay between the note start and the harmonized voice start. 

Use the Sync field to set the Delay time when synchronized with the tempo. You can select one of several 
time divisions (a . indicates a dotted note; a T indicates a triplet-based time division). When None is 
selected, Sync is off, and the delay time is determined by the Delay knob. 

Use the Mix slider to set the overall wet/dry mix between the original note and the harmonized voices.  
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The Velo Sensitivity section (Advanced) let you set how much velocity is required to modulate certain other 
parameters:  

Use the Cutoff 1/2 sliders to adjust how the velocity of a pad to modulates the Filter 1/2 cutoff frequency 
directly. 

Use the Filter 1/2 Env sliders to enable velocity information to control the amount of the filter envelope’s effect 
on the cutoff frequency. 

Use the Filter Attack slider to set how much velocity is needed (for a triggered pad) to modulate the Attack 
phase for the Filter envelope. 

Use the Amp Attack slider to set how much velocity is needed (for a triggered pad) to modulate the Attack 
phase for the Amplitude envelope. 

Use the Amp slider to enable velocity information to control the overall amplitude (level) of the keygroup. 

Use the Pan slider to enable velocity information to control the stereo panning of the keygroup. 

Use the Pitch slider to enable velocity information to control the pitch of the keygroup. 

Use the Aftertouch To Cutoff 1/2 sliders to determine how much a connected MIDI keyboard’s aftertouch data 
affects the filter cutoff. 

Use the Press. To Filter slider to determine how much a connected MIDI device’s channel pressure data affects 
the filter envelope. 

 

The Mod Matrix section provides 32 modulation points which can be configured to add a wide variety of sound 
shaping tools. 

Click the 1/2/3/4 icons to cycle between the available modulation points. 

Use the Source field to select the modulation source. 

Use the first Amt (Amount) field to set how much modulation is applied by the source. 

Use the Target field to select the output target for modulation.  

Use the Dir (Direction) field to set the modulation direction: 

• Select  for linear modulation. 

• Select ± for bipolar modulation. 

Use the Min and Max fields to set the minimum and maximum modulation levels of the selected target. 

Use the Via Source field to add a secondary modulation shaper using another source. 

Use the second Amt (Amount) field to set how much modulation is applied by the secondary source. 

Use the Shaper field to apply an additional modifier that affects the modulation relationship between the source 
and target. 

Use the third Amt (Amount) field to set how much modulation is applied by the shaper. 
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Plugin Tracks 

 

 

 

When using a plugin track, the Track Editor shows the parameters of that plugin. Its appearance and available 
options depend on the plugin. 

 

 

MIDI Tracks 

 

 

 

When using a MIDI track, the Track Editor shows a series of knobs corresponding to MIDI CC values—six banks of 
knobs with 16 knobs in each bank (a total of 96 knobs). 

To set the MIDI CC of a knob, click the area above it next to down arrow icon () and select a number from the menu. 

To adjust the value that each MIDI CC sends, click and drag its knob. 

To rename a MIDI control, double-click the name above the knob, and then use your keyboard to enter a new 
name. Press enter or click elsewhere to set the new name. MIDI tracks can be saved with custom naming for use in 
multiple projects. 

 

CV Tracks 

 

When using a CV track, the Track Editor shows a series of knobs. The eight 
knobs correspond to CV Outputs 1–8. Although this option is selectable, it 
is usable only with MPC hardware that has CV outputs (e.g., MPC X). 

To adjust the voltage of each one, click and drag its knob. 

 

For Advanced CV control enabled with purchase of the MPC Pro Pack, 
see Addenda > MPC Pro Pack. 
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Anatomy of an Envelope 

 

An envelope creates a variable control signal. It can be used, for instance, to modulate the filter settings of a sound 
over a given period of time. 

For drum tracks, use the AD/AHDS selector to select an AD or AHDS envelope. When Sample Play is set to Note-
On, it will use an ADSR envelope. 

Keygroup tracks use AHDS envelopes. When Sample Play is set to Note-On, it will use an ADSR envelope. 

 

With AHDS envelopes, the following happens when you trigger a sample: 

1. Within the period of time defined by Attack, the sample volume rises 
to its maximum value. 

2. The sample’s maximum volume will be maintained during the Hold phase. 

3. During the Decay phase, the sample’s volume will gradually drop to 
the Sustain level. 

4. The sample’s volume will stay at the Sustain level until the pad is 
released.  

Use the additional A Shape and D Shape handles to adjust the curve of 
the Attack and Decay phases, respectively. 

 

With AD envelopes, the following happens when you trigger a sample: 

1. Within the period of time defined by Attack, the sample volume rises 
to its maximum value. 

2. The sample’s maximum volume will be maintained until its Decay 
phase, when the sample’s volume will gradually drop to “zero” over the 
set duration. Click the Type drop-down menu to select how the decay 
functions: 

Decay From Start: The volume will start decreasing immediately 
after reaching its maximum level. 

Decay From End: The maximum volume will be maintained for a 
hold phase until it reaches the decay phase. 

Use the additional A Shape and D Shape handles to adjust the curve of 
the Attack and Decay phases, respectively. 

 

With ADSR envelopes, the following happens when you trigger a sample: 

1. Within the period of time defined by Attack, the sample volume rises 
to its maximum value. 

2. During the Decay phase, the sample’s volume will gradually drop to 
the Sustain level. 

3. The sample’s volume will stay at the Sustain level until the Release 
phrase begins. 

4. The sample’s volume will drop to “zero” over the duration set by Release. 

Use the additional A Shape, D Shape and R Shape handles to adjust the 
curve of the Attack, Decay and Release phases, respectively. 
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Sample Edit Mode 
 

Sample Edit Mode lets you edit samples using various functions. 

 

 

 

 

To enter Sample Edit Mode, do any of the following: 

• Click the waveform-and-flags icon in the toolbar (if shown). 

• Click the down arrow () next to the other mode icons in the toolbar, and click Sample Edit. 

• Click the menu icon (≡), and go to View > Mode and click Sample Edit. 

• Double-click the desired sample in the Project panel or Project Info Browser. 

• Right-click the desired sample in the Project panel or Project Info Browser, and click Edit. 

 

To select a sample to edit, click it in the Project panel or Project Info Browser. 
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The upper half of the window shows the waveform. While you can edit 
the waveform in this part of the window, it is different from the 
standard Wave Editor. 

The large waveform display shows the “active” section of the sample 
waveform. The strip above the large display shows an overview of the 
entire sample waveform. If the waveform display is showing only part 
of the entire sample waveform, a white box in the overview will 
indicate the current position. 

The timeline provides a reference for the length of the sample. Click 
the down arrow () or right-click anywhere on the timeline to select 
the increments it will use: Time (secs:ms), Samples, or Beats. 

Scroll left or right on the waveform to move through it. Use the sliders 
in the lower-right corner or click the timeline and drag down or up to 
zoom in or out. 

The green marker and red marker are the start point and end point 
(respectively). These two points define the region of the sample that 
will be played. 

To move the start point or end point of the selected region, do 
either of the following: 

• Click and drag its marker left or right. 

• Use the Start or End fields in the Parameters panel. 

• Use the first column of Q-Link knobs to adjust the start point or the second column of Q-Link knobs to 
adjust the end point. The top-most Q-Link knob provides coarse adjustment (x1000), while the bottom-most 
one knob provides fine adjustment (x1). 

Tip: A recorded sample may have some silence at the beginning or end, which makes it difficult to time it correctly in 
a musical context. Fix this by adjusting the start point. You can also adjust end point to remove any extra silence or 
unwanted audio at the end. In addition to making your workflow easier, having a “tight,” well-edited sample can 
enhance your production or performance. 

 

 

The lower half of the window can display the Q-Links panel, Pads panel, Parameters panel, and Project panel. 
Click the corresponding selector to show or hide each one. See General Features > Panels > Project to learn more 
about the Project panel. 

The other three panels vary based on the current editing method: Trim Mode, Chop Mode, or Track Mode. The 
options for each mode are slightly different. Please refer to the following Trim Mode, Chop Mode, and Track Mode 
parts of this chapter to learn how each works. 

 

Tip: You can use Trim Mode for a specific slice of the sample, previously created and selected in Chop Mode. This 
allows for a more detailed view of a single slice than in Chop Mode and gives you more options for auditioning the 
slice. You can easily switch between Trim Mode and Chop Mode while doing this. 

 

To use both Trim Mode and Chop Mode to edit a sample slice: 

1. Click Chop in the Q-Links panel. 

2. Set all fields as desired to create your sample slices. 

3. Select the desired slice. 

4. Click Trim in the Q-Links panel. The region you are now editing is indicated by the normal start point and end 
point markers rather than slice markers. 

• Click Chop at any time to return to Chop Mode. 
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Trim Mode 
 

 
 

We recommend using Trim Mode to simply crop the start and/or end from a sample. 

 

To enter Trim Mode, click the Trim tab in the Q-Links panel. 

 

 

Q-Links 

 

In the Q-Links panel: 

Use the first column of Q-Link knobs to adjust the start point. This is the 
same as adjusting the Start field in the Parameters panel. 

Use the second column of Q-Link knobs to adjust the end point. This is 
the same as adjusting the End field in the Parameters panel. 

Use the third column of Q-Link knobs to adjust the loop point if Loop Lock 
is off. If Loop Lock is on, adjusting the loop point will also adjust the start 
point. This is the same as adjusting the Loop field in the Parameters panel. 

Use Q-Link Knob 16 to select the desired slice, if the sample has been split 
into multiple slices in Chop Mode. This is the same as adjusting the Slice 
field in the Parameters panel. 

Use Q-Link Knob 8 to scroll through the waveform in the large waveform 
display above. 

Use Q-Link Knob 4 to zoom in or zoom out of the waveform. 

For the first three columns, the top-most Q-Link knob provides coarse adjustment 
(x1000), while the bottom-most one knob provides fine adjustment (x1). 
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When Link Slices is enabled (after you have created slices in Chop Mode), changing the start point of a slice will also 
change the end point of the previous slice. Similarly, changing the end point of a slice will also change the start point of 
the next slice. Disable Link Slices if you are trying to create slices that use non-contiguous parts of the sample. This is 
the same as clicking the gear icon in the upper-right corner of the Wave Editor and using the Link Slices submenu. 

Important: Link Slices must be disabled to make slices nonsequential, noncontiguous, or overlapping. 

 

Enable Zero Snap to force start points, end points, and loop points to occur only at the waveform’s “zero-crossings.” 
This can help to avoid clicks and glitches when playing a sample. This is the same as clicking the gear icon in the 
upper-right corner of the Wave Editor and using the Zero Snap submenu. 

 

 

Pads 

 

The Pads panel enables you to play certain parts of the selected sample: 

 

Play Sample (One Shot) (Pad 10) plays the sample once from the start 
point to the end point. Press the pad once to play it. 

Play Sample (Note On) (Pad 11) plays the sample once from the start 
point to the end point. Press and hold the pad to play it, and release the 
pad to stop playing it. Alternatively, click and hold anywhere in the 
waveform display. 

Play Loop Continuous (Pad 16) plays the sample repeatedly from the 
loop point to the end point. 

Play Loop (Pad 13) plays the sample from the loop point to the end point. 
Press and hold the pad to play it, and release the pad to stop playing it. 

Play to Loop Start (Pad 14) plays the part of the sample just before the 
loop point. Press and hold the pad to play it, and release the pad to stop 
playing it. 

Play from Loop Start (Pad 15) plays the sample from the loop point to 
the end of the sample regardless of the end point. Press and hold the pad 
to play it, and release the pad to stop playing it. 

Play All (Pad 9) plays the entire sample. 

 

Pads 1–4 have the same respective functions as Pads 5–8, but Pads 1–4 play the sample part as “One Shots” 
(pressing the pad once will play the entire part) while Pads 5–8 play the sample part as “Note Ons” (pressing the pad 
and holding it will play the part; releasing it will stop playback): 

Play from Start (Pad 1, Pad 5) plays the sample from the start point to the end point. 

Play to Start (Pad 2, Pad 6) plays the part of the sample just before the start point to the start point. 

Play to End (Pad 3, Pad 7) plays the part of the sample just before the end point to the end point. 

Play from End (Pad 4, Pad 8) plays the part of the sample from the end point to the end of the sample. 
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Parameters 

 

The Parameters panel includes controls for editing the sample 
length and tuning as well as buttons for assigning the sample (see 
this section) and processing the slice or sample (see this 
section). 

 

Use the Slice field to select the desired slice, if the sample has 
been split into multiple slices in Chop Mode. This is the same as 
adjusting Q-Link Knob 16 in the Q-Links panel. 

 

Use the Start field to adjust the start point. This is the same as 
adjusting the first column of Q-Link knobs in the Q-Links panel. 

Use the End field to adjust the end point. This is the same as 
adjusting the second column of Q-Link knobs in the Q-Links 
panel. 

Use the Loop field to adjust the loop point if Loop Lock is off. If 
Loop Lock is on, adjusting the loop point will also adjust the start 
point. This is the same as adjusting the third column of Q-Link 
knobs in the Q-Links panel. 

 

Click the Lock button to turn Loop Lock on or off. When on, the loop point is the same as the start point. When off, 
the loop point is independent from the start point and indicated by a separate loop marker. 

 

Click the Loop dropdown menu to select from the three loop modes: 

Off: The sample will not loop. 

Forward (Fwd): When the loop reaches its end point, it will start playing again from the loop point. 

Alternating (Alt): When the loop reaches its end point, it will play in reverse. When it reaches the loop point 
again, it will start playing forward again from the loop point. 

Reverse (Rev): When the loop reaches its end point, it will play in reverse. When it reaches the loop point again, 
it will return to the end point and continue playing in reverse. 

 

Use the X-Fade field to apply a crossfade to a looping sample. You must first 
make sure the loop Lock setting is set to Off, and then use the Loop menu to 
select a loop mode. Make sure there is at least 10 samples of space between the 
Start point and Loop point, then use the X-Fade field to set the length of the 
crossfade in samples. 

Click the icons next to the X-Fade field to select a Linear (straight lines) or Equal 
Power (curved lines) crossfade. 

Press Pad A16 – Play Continuous Loop to hear the crossfade applied to the 
sample. 

 

Use the Tune field to transpose the sample from its original pitch up to 24.00 semitones up or down. 

 

Use the Root Nt field to set the root note of the sample. This defines which note will play the sample at its original 
pitch when in a keygroup track. 
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Click From BPM to tune a sample to the current sequence. Use the Edit Tuning window on connected MPC 
hardware to adjust the following: 

Use the Beats field to match the number of beats in the sequence. 

To tune the sample to the sequence, click Match. The Tune field will adjust automatically and close the 
window. The sample is now tuned to the sequence. 

To tune the sample to the sequence and adjust the sequence tempo, click To Sequence. This is the same 
as clicking Match but it also changes the sequence’s tempo to the BPM shown in the Tempo field on the right. 

To close the window, click Close. 

 

Use the BPM field to enter a tempo manually. You can also click X2 to double the value or /2 to halve it. 

 

Click Detect BPM to automatically detect the tempo. Use the Detect BPM window on connected MPC hardware to 
adjust the following: 

Use the BPM field to enter a tempo manually. You can also click X2 to double the value or /2 to halve it. 

Click Detect to detect the tempo automatically. 

Click Tap Tempo at the bottom of the window at the desired rate to use it as the tempo. You can play a sequence 
in the background to help with your timing. 

Click Close to close the window. 

Note: Before detecting tempo, it is recommended that you Normalize samples for best results. 

 

Use the Key field to set the root note of the sample and the Scale field to set whether the key is Major, Minor, or off 
(--).  

Click Detect Key to automatically detect the sample key. 
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Assigning Samples 

 

You can assign your new sample directly to a pad from Trim Mode. 

Click Assign to assign a sample. In the Assign Sample window that appears, you can click the Assign To menu to 
select a different assignment, and then click Do It to assign the sample or Cancel to close the window without 
assigning the sample. 

Important: Assigning a sample to a pad in this way will replace the sample on the first layer of the pad. 

 

If you set the Assign To menu to Assign Slice to pad, the pad will simply refer 
to the slice in this sample instead of creating a new sample. This is useful for 
reducing clutter in your project. 

 

Use the Pad menu to select the desired pad. Alternatively, press the 
desired pad. 

 

Use the Slice Type menu to select how the pad’s layer settings will be set 
when the slice is assigned to it: 

Non-Destructive Slice: The pad’s Slice setting will be set to the slice 
number. 

Pad Parameters: The pad’s Slice setting will be set to Pad. The Pad 
Start and Pad End will be set to the slice’s start point and end point 
values, and the Loop Position will be set to the slice’s start point but 
with Pad Loop deactivated. 

 

Use the Track menu to specify the track to which you want to add the slice. 

 

If you set the Assign To menu to New Sample to Pad this will create a new 
sample in your project. (The original sample will remain as it is.) 

 

Use the Pad menu to select the desired pad. Alternatively, press the 
desired pad. 

 

Select the Crop Sample box to delete the unused parts from the sample 
when it’s created and assigned. This feature is destructive, though the 
project will still contain your original sample. 

Leave this box deselected to keep the unused parts of the sample when it 
is created and assigned. This way, you will still be able to edit the entire 
sample further even though you are using only part of it at the moment. 

 

Use the Track menu to specify the track to which you want to add the slice. 
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Processing Slices & Samples 

 

Use the column of Process buttons to select an editing process. In the Process Sample window that appears, you 
can click the Function menu to select a different process, and then click Do It to apply the process or Cancel to 
close the window without processing the sample.  

You can use any of these functions as described below. 

Note: All Slice processes will affect only the part of the sample between the start point and the end point. The Sample 
processes (Bit Reduce and Stereo > Mono) will affect the entire sample regardless of its start point or end point. 

 

The Create Stems process isolates different parts of the sample and 
separates them into new stem samples. 

Click the icons to select or deselect from the following elements to create 
stems of: 

• Vocals: Isolate vocal elements of the track into a stem. 

• Bass: Isolate bass elements of the track into a stem. 

• Drums: Isolate percussive elements of the track into a stem. 

• Other: Isolate other musical textures, such as keys or guitars, into a 
stem. 

Use the Track dropdown menu to select the track where the stems will be 
added. 

The Assign to Pad function determines where the stem separated 
samples are added. When checked, you can select a pad in the chosen 
Track using the dropdown menu, and the stems will be added to the four 
layers of that pad. When unchecked, the stems will be added to the 
general project sample pool in the Project Info Browser. 

Click the Use trimmed sample box to trim the source sample between 
the Start and End points before applying the stem separation process.  

Tip: Uncheck this box if you want to retain slices with the stemmed 
results, otherwise, they will be bypassed. 

Note: Visit thempcstore.com to purchase MPC Stems, and then activate your purchase in the Preferences > 
Activation menu. 

 

The Discard process deletes the regions before the start point and after the 
end point. 

 

 

 

 

 

 

The Delete process deletes the region between the start point and end point 
and closes the gap between them. 

 

 

 

 

 

http://thempcstore.com
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The Silence process replaces the region between the start point and end 
point with silence. 

 

 

 

 

 

 

The Extract process deletes the regions before the start point and after the 
end point and saves it as a new sample in your current project. 

Use the Name field to name the new sample. 

Tip: This is useful if you recorded a drum loop and wanted to remove just a 
snare drum hit, a kick drum hit, etc. to use separately in the project. 

 

 

 

The Normalize process increases a sample’s level to the highest level 
possible without distortion. This is essentially a kind of digital gain 
optimization, so you do not have to worry about excessive level settings when 
working with samples with a wide range of amplitudes. 

 

 

 

 

 

The Reverse process reverses the region between the start point and end 
point. 
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The Fade In process sets a fade-in between the start point and end point. 
Click the Type menu to select a type of fade:  

Linear fades the audio in with a linear curve—a straight line between the 
start and end. 

Square Root fades the audio in with a square root curve—a half-parabola 
that is similar to the logarithmic curve but steeper.  

Square fades the audio in with a curve opposite to the square root curve. 
This is similar to the exponential curve but steeper.  

Log fades the audio in with a logarithmic curve—quickly rising at the start 
and flattening out towards the end. 

Exp fades the audio in with an exponential curve—slowly rising in the 
beginning and growing steeper towards the end. 

Sine fades the audio in with a sine curve—like a sine wave, it slowly rises, 
gets steeper in the middle, and flattens out at the end. 

 

                     

Linear Square Root Square Log Exp Sine 

 

 

The Fade Out process sets a fade-out between the start point and end point. 
Click the Type menu to select a type of fade. These are the same as the Fade 
In curves, but fade the audio out instead of in. 

 

 

 

 

 

                     

Linear Square Root Square Log Exp Sine 
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The Pitch Shift process changes the pitch of the sample without changing its 
length. This lets you set the sample’s pitch to your sequence without affecting 
the sample’s tempo or duration. Keep in mind that the audio quality may 
decrease at more extreme settings. 

Use the Pitch field to shift the pitch up to 12.00 semitones up or down. 

 

 

 

 

The Time Stretch process lengthens or shortens the sample without changing 
its pitch. This is useful for matching the durations of two samples with 
different pitches. You can enter the original tempo of the sample and the 
desired tempo after processing.  

Use the Number of Beats field to set the desired value number of beats. 

Use the New field to set the new tempo. The Ratio field will then 
automatically show the time stretch factor. 

Alternatively, to adjust the ratio instead, use the Ratio field to set the 
desired ratio, and then the New field will change automatically based on 
the new time stretch factor. 

 

The Gain Change process raises or lowers the volume of the sample.  

Use the Gain Amount field to adjust the gain up to 18 dB up or down.  

This function is different than Normalize because it will allow volumes beyond 
clipping level. This may be a desired effect, but remember to watch your 
output level! 

 

 

 

The Copy process saves a copy of the sample.  

Use the Name field to name the new sample. Otherwise, the process will 
add a consecutive number after the sample name. 
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The Bit Reduce process lowers the bit resolution of a sample, effectively 
reducing its degree of faithful reproduction.  

Use the Bit Depth field to set the bit depth from 1 bit to 16 bits.  

The resulting sound is similar to the Resampler effect, but Bit Reduce will 
permanently alter the sample. 

Tip: Use this on drum loops to get a dirty, “old-school” sizzle but with a digital 
“edge.” 

Note: This process affects the entire sample regardless of its start point or 
end point. 

 

The Stereo > Mono process converts a stereo sample to a new mono sample 
and saves it as a new sample.  

Click the Source menu to select which channels will be converted: 

• Left will convert the left channel only. 

• Right will convert the right channel only. 

• Sum will combine the left and right audio channels to a single mono 
channel. 

Use the Name field to name the new sample. Otherwise, the process will 
add a consecutive number after the sample name. 

Note: This process affects the entire sample regardless of its start point or 
end point. 
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Chop Mode 

 

 

 

While Trim Mode crops only the start and/or end off of a sample, Chop Mode divides the sample into multiple regions 
called slices. We recommend using Chop Mode when working with a long sample with different sounds throughout 
(e.g., a drum loop or a long melodic or harmonic passage). 

 

To enter Chop Mode, click the Chop in the Q-Links panel. 

 

To select a slice to edit, do one of the following: 

• Click the lower half of the slice in the waveform in the upper half of the window. 

• Click the corresponding pad in the Pads panel.  

• Use Q-Link Knob 16. 

• Adjust the Slice field in the Parameters panel. 
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Q-Links 

 

In the Q-Links panel: 

Use the first column of Q-Link knobs to adjust the start point. This is the 
same as adjusting the Start field in the Parameters panel. 

Use the second column of Q-Link knobs to adjust the end point. This is 
the same as adjusting the End field in the Parameters panel. 

Use Q-Link Knob 15 to adjust the cue playhead. This is the same as 
adjusting the Cue field in the Parameters panel. 

Use Q-Link Knob 16 to select the desired slice. This is the same as 
adjusting the Slice field in the Parameters panel or clicking or pressing the 
corresponding pad. 

Use Q-Link Knob 8 to scroll through the waveform in the large waveform 
display above. 

Use Q-Link Knob 4 to zoom in or zoom out of the waveform. 

When the Chop To menu is set to Regions, use Q-Link Knob 11 to set into 
how many regions the sample will be divided. 

When the Chop To menu is set to Threshold, use Q-Link Knob 11 to set 
the threshold level. 

For the first three columns, the top-most Q-Link knob provides coarse adjustment 
(x1000), while the bottom-most one knob provides fine adjustment (x1). 

 

When Link Slices is enabled, changing the start point of a slice will also change the end point of the previous slice. 
Similarly, changing the end point of a slice will also change the start point of the next slice. Disable Link Slices if you 
are trying to create slices that use non-contiguous parts of the sample. This is the same as clicking the gear icon in 
the upper-right corner of the Wave Editor and using the Link Slices submenu. 

Important: Link Slices must be disabled to make slices nonsequential, noncontiguous, or overlapping. 

 

Enable Zero Snap to force start points, end points, and loop points to occur only at the waveform’s “zero-crossings.” 
This can help to avoid clicks and glitches when playing a sample. This is the same as clicking the gear icon in the 
upper-right corner of the Wave Editor and using the Zero Snap submenu. 

 

 

Pads 

 

The Pads panel enables you to play and select each slice of the selected sample: 

 

Press the pad to play and select its corresponding the slice. If your sample has 
more than 16 slices, use the additional pad banks. This is the same as turning 
Q-Link Knob 16 in the Q-Links panel or using the Slice field in the Parameters 
panel. 

Note: When the Pad Audition menu is set to One Shot, clicking or pressing the 
pad will play the slice from its start marker. When Pad Audition is set to Note 
On, clicking (or pressing) and then holding the pad will play the slice from its 
start marker—releasing the pad will stop playback. 
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Parameters 

 

The Parameters panel includes controls for editing the sample length and tuning as well as buttons for converting or 
assigning the sample (see this section) and processing the slice or sample (see this section). 

 

Use the Chop To menu to choose how you want to use Chop Mode: 

 

Manual  

This method lets you insert slices at locations you select. 

 

 

Threshold  

This method uses an adjustable detection algorithm that derives the number of 
slices created from the volume levels present in the sample. 

Use the Threshold field to set the threshold level. Alternatively, turn Q-Link Knob 
11. The higher the selected value, the more slices will be created. 

Use the Min Time field to set the minimum length of a slice in milliseconds.  

 

Regions 

This method divides a sample into slices of equal length. 

Use the Num Regions field to set into how many regions the sample will be 
divided. Alternatively, turn Q-Link Knob 11. The higher the selected value, the 
more slices will be created. 

 

BPM 

This method divides a sample into slices based on the tempo (beats per minute). 

Use the Bars field to set how many bars are in the sample. Alternatively, turn the 
second Q-Link knob in the third bank. 

Use the Beats field to set how many beats are in each bar. Alternatively, turn the 
third Q-Link knob in the third bank. 

Use the Time Div field to set a note division. Alternatively, turn the bottom-most 
Q-Link knob in the third bank. The slice markers will be placed according to this 
setting. You can select 1/4, 1/8, 1/16, or 1/32. (In most cases, you should set this 
parameter to 1/16.) 
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Use the Slice field to select the desired slice. This is the same as turning Q-Link Knob 
16 field in the Q-Links panel or clicking or pressing the corresponding pad. 

 

Use the Start field to adjust the start point. This is the same as turning the first 
column of Q-Link knobs in the Q-Links panel. 

Use the End field to adjust the end point. This is the same as turning the second 
column of Q-Link knobs in the Q-Links panel. 

Note: When Link Slices is enabled, changing the start point of a slice will also change 
the end point of the previous slice. Similarly, changing the end point of a slice will also 
change the start point of the next slice. Disable Link Slices if you are trying to create 
slices that use non-contiguous parts of the sample. 

 

Click +Slice (under the End field) to add a slice at the current playhead position. You 
can do this at any point during sample playback. 

To insert a slice marker manually, click the upper part of the waveform at the 
desired location (the cursor will appear as a red arrow with a + symbol: +). 

To insert a slice marker during sample playback, press an unlit pad (usually Pad 1) 
to start playback of the sample, and then press an unlit pad during playback to place 
a slice marker at each location of the playhead. (If you press a lit pad, playback will 
restart from that pad’s corresponding slice marker.) The number of the pad that is lit 
green is the number of the most-recently inserted slice marker. The numbers of the 
pads that are lit yellow are the numbers of the slice markers that are already inserted. 

 

Click the – button (to the right of the Slice field) to combine the currently selected slice 
with the one before it. 

Click the + button (to the right of the Slice field) to split the currently selected slice into 
two slices of the same size. 

Click –All (to the right of the Slice field) to remove all slices from a sample. 

 

The cue playhead is useful when manually inserting slice markers. You can set its 
position and behavior to suit your workflow.  

Use the Cue field (below the Start field) to adjust the position of the cue playhead. 
Alternatively, click and drag the white marker with the triangle () in the timeline. 

Click >Play to play the sample from the cue playhead. 

Click +Slice to create a slice marker at the cue playhead position. 

 

Click the Cue Audition menu to select how the audio plays from the cue playhead: 

One Shot: Clicking >Play will play the entire sample from the cue playhead. 

Toggle: Clicking >Play once will start playback from cue playhead. Clicking it 
once more will stop playback. 

 

Click the Pad Audition menu to select how each slice plays from each start marker 
when you press the corresponding pad: 

One Shot: Clicking or pressing the pad will play the slice from its start marker. 

Note On: Clicking (or pressing) and then holding the pad will play the slice from its 
start marker. Releasing the pad will stop playback. 
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Converting or Assigning Slices 

 

In Chop Mode, you can assign your new sample directly to a pad or convert the new sample into a new track or 
patched phrase. 

Use the buttons in the Non-Destructive Convert and Extract New Samples sections to select a conversion and 
assignment process. In the Convert or Assign Slices window that appears, you can click the Convert To menu to 
select a different process, and then click Do It to apply the process or Close to close the window without processing 
the sample. 

Note: These features can be accessed with connected MPC hardware. 

 

 

If you set the Convert To menu to New [program type] program using slices, this will create a new program and 
assign the sample’s slices to its pads. The pads will simply refer to the slices in this sample instead of creating new 
samples. This is useful for reducing clutter in your project. The new program will be named after the sample and 
appended with ch. 

 

Use the Slice Type menu to select how each pad’s layer settings will be set when the slices are assigned to 
them (see Track Edit Mode to learn more about the parameters mentioned below): 

Non-Destructive Slice: Each pad’s Slice setting will be set to the slice number. 

Pad Parameters: Each pad’s Slice setting will be set to Pad. The Pad Start and Pad End parameters will 
be set to the slice’s start point and end point values, and the Loop Pos parameter will be set to the slice’s 
start point but with Pad Loop deactivated. 

 

Select the Create Events box to automatically create a new track for the new program in which each pad plays 
its corresponding slice in ascending sequence by pad number.  

 
If Create Events is selected, use the Bars field to set how many bars the slices’ events will occupy. 

 

 

If you set the Convert To menu to New clip program, this will create a new clip program and assign the sample’s 
slices to its pads as clips. The pads will simply refer to the slices in this sample instead of creating new samples. This 
is useful for reducing clutter in your project. The new program will be named after the sample and appended with ch. 

 

Use the Tempo field to enter the tempo of the clips in the new program. 

 

Select the Create Events box to automatically create a new track for the new program in which each pad plays 
its corresponding slice in ascending sequence by pad number.  

 
If Create Events is selected, use the Number of Bars field to set how many bars the slices’ events will occupy. 
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If you set the Convert To menu to New program with new samples, this will create a new sample from each slice 
and assign them to pads in a new program. 

The new program will be named after the sample and appended with ch. The new samples will be appended with SI-# 
(where # is a consecutive number). 

 

Select the Crop Samples box to delete the unused parts from the sample when they are created and assigned. 
This feature is destructive, though the project will still contain your original sample. 

Leave this box deselected to keep the unused parts of the samples when they’re created and assigned. This 
way, you will still be able to edit the entire samples further even though you are using only part of them at the 
moment. 

 

By default, this option already will create a new program. You can deselect the Create New Program box to 
convert each slice into a sample that is placed in the project’s sample pool but not assigned to a program or 
pad. 

 

If Create New Program is selected, select the Create Events box to automatically create a new track in which 
each pad plays its corresponding slice in ascending sequence by pad number.  

 

If Create Events is selected, use the Number of Bars field to set how many bars the slices’ events will occupy. 

 

 

If you set the Convert To menu to Assign slice to a pad, the pad will simply refer to the slice in this sample instead 
of creating a new sample. This is useful for reducing clutter in your project. 

Important: Assigning a sample to a pad in this way will replace the sample on the first layer of the pad. 

 

Use the Pad menu to select the desired pad. Alternatively, press the desired pad. 

 

Use the Slice Type menu to select how the pad’s layer settings will be set when the slice is assigned to it (see 
Track Edit Mode to learn more about the parameters mentioned below): 

Non-Destructive Slice: The pad’s Slice setting will be set to the slice number. 

Pad Parameters: The pad’s Slice setting will be set to Pad. The Pad Start and Pad End will be set to the 
slice’s start point and end point values, and the Loop Position will be set to the slice’s start point but with 
Pad Loop deactivated. 

 

Use the Program menu to specify the program to which you want to add the slice. 

 

 

If you set the Convert To menu to New Sample to Pad, this will create a new sample in your project. (The original 
sample will remain as it is.) 

Important: Assigning a sample to a pad in this way will replace the sample on the first layer of the pad. 

 

Use the Pad menu to select the desired pad. Alternatively, press the desired pad. 

 

Select the Crop Sample box to delete the unused parts from the sample when it’s created and assigned. This 
feature is destructive, though the project will still contain your original sample. 

Leave this box deselected to keep the unused parts of the sample when it is created and assigned. This way, 
you will still be able to edit the entire sample further even though you are using only part of it at the moment. 

 

Use the Program menu to specify the program to which you want to add the slice. 
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If you set the Convert To menu to Patched phrase, this will create a new sample that will play based on the tempo 
of your Sequence, and places it in the current project. The patched phrase will have the same name as the original 
sample but appended with pp and will use a different icon when viewing your project information.  

 

Use the Bars field to set how many bars long the patched phrase is meant to be. 

 

 

Processing Slices 

 

Use the column of Process buttons to select an editing process. In the Process Sample window that appears, you 
can click the Function menu to select a different process, and then click Do It to apply the process or Cancel to 
close the window without processing the sample. 

You can use any of these functions as described below. 

Important: Chop Mode is non-destructive: You can choose the slice/edit behavior without destroying your original 
sample, giving you more control over sample playback; you can save your sliced sample and but also reuse all of the 
slice data in another project.  

 

The Create Stems process isolates different parts of the sample and 
separates them into new stem samples. 

Click the icons to select or deselect from the following elements to create 
stems of: 

• Vocals: Isolate vocal elements of the track into a stem. 

• Bass: Isolate bass elements of the track into a stem. 

• Drums: Isolate percussive elements of the track into a stem. 

• Other: Isolate other musical textures, such as keys or guitars, into a 
stem. 

Use the Track dropdown menu to select the track where the stems will be 
added. 

The Assign to Pad function determines where the stem separated 
samples are added. When checked, you can select a pad in the chosen 
Track using the dropdown menu, and the stems will be added to the four 
layers of that pad. When unchecked, the stems will be added to the 
general project sample pool in the Project Info Browser. 

Click the Use trimmed sample box to trim the source sample between 
the Start and End points before applying the stem separation process.  

Tip: Uncheck this box if you want to retain slices with the stemmed 
results, otherwise, they will be bypassed. 

Note: Visit thempcstore.com to purchase MPC Stems, and then activate your 
purchase in the Preferences > Activation menu. 

 

The Silence process replaces the region between the start point and end 
point with silence. 
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The Extract process deletes the regions before the start point and after the 
end point and saves it as a new sample in your current project. 

Use the Name field to name the new sample. 

Tip: This is useful if you recorded a drum loop and wanted to remove just a 
snare drum hit, a kick drum hit, etc. to use separately in the project. 

 

 

 

 

The Normalize process increases a sample’s level to the highest level 
possible without distortion. This is essentially a kind of digital gain 
optimization, so you do not have to worry about excessive level settings when 
working with samples with a wide range of amplitudes. 

 

 

 

 
 
The Reverse process reverses the region between the start point and end 
point. 

 

 

 

 

 

 
 
The Fade In process sets a fade-in between the start point and end point. 
Click the Type menu to select a type of fade:  

Linear fades the audio in with a linear curve—a straight line between the 
start and end. 

Log fades the audio in with a logarithmic curve—quickly rising at the start 
and flattening out towards the end. 

Exp fades the audio in with an exponential curve—slowly rising in the 
beginning and growing steeper towards the end. 

 

The Fade Out process sets a fade-out between the start point and end point. 
Click the Type menu to select a type of fade:  

Linear fades the audio out with a linear curve—a straight line between the 
start and end. 

Log fades the audio out with a logarithmic curve—quickly rising at the 
start and flattening out towards the end. 

Exp fades the audio out with an exponential curve—slowly rising in the 
beginning and growing steeper towards the end. 
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The Pitch Shift process changes the pitch of the sample without changing its 
length. This lets you set the sample’s pitch to your sequence without affecting 
the sample’s tempo or duration. Keep in mind that the audio quality may 
decrease at more extreme settings. 

Use the Pitch field to shift the pitch up to 12.00 semitones up or down. 

 

 

 

 

The Gain Change process raises or lowers the volume of the sample.  

Use the Gain Amount field to adjust the gain up to 18 dB up or down.  

This function is different than Normalize because it will allow volumes beyond 
clipping level. This may be a desired effect, but remember to watch your 
output level! 
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Track Mode 
 

 
 
Track Mode lets you edit a sample in the context of the track in which you will use it. You can adjust the pad 
parameters as though you were in Track Edit Mode, auditioning and hearing how it will sound in the track’s audio path. 
 
To enter Track Mode, click Track in the Q-Links panel.  

 
 
Q-Links 

 

In the Q-Links panel: 

Use the first column of Q-Link knobs to adjust the start point. This is the 
same as adjusting the Start field in the Parameters panel. 

Use the second column of Q-Link knobs to adjust the end point. This is the 
same as adjusting the End field in the Parameters panel. 

Use the third column of Q-Link knobs to adjust the loop point if Loop Lock is 
off. If Loop Lock is on, adjusting the loop point will also adjust the start point. 
This is the same as adjusting the Loop field in the Parameters panel. 

Use Q-Link Knob 16 to display either the sample as it has been edited (Pad) 
or the entire sample (All). This is the same as adjusting the Slice field in the 
Parameters panel. 

Use Q-Link Knob 8 to scroll through the waveform in the large waveform 
display above. 

Use Q-Link Knob 4 to zoom in or zoom out of the waveform. 

For the first three columns, the top-most Q-Link knob provides coarse adjustment 
(x1000), while the bottom-most one knob provides fine adjustment (x1). 

 
When Link Slices is enabled (after you have created slices in Chop Mode), changing the start point of a slice will also 
change the end point of the previous slice. Similarly, changing the end point of a slice will also change the start point of 
the next slice. Disable Link Slices if you are trying to create slices that use non-contiguous parts of the sample. This is 
the same as clicking the gear icon in the upper-right corner of the Wave Editor and using the Link Slices submenu. 

Important: Link Slices must be disabled to make slices nonsequential, noncontiguous, or overlapping. 

 
Enable Zero Snap to force start points, end points, and loop points to occur only at the waveform’s “zero-crossings.” 
This can help to avoid clicks and glitches when playing a sample. This is the same as clicking the gear icon in the 
upper-right corner of the Wave Editor and using the Zero Snap submenu. 
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Pads 

 

The Pads panel shows their assigned samples in the current track. 

Click each pad to hear its sample/samples. The sample on its first layer will 
automatically appear in the waveform display for editing. 

 

 

 

 

 

 

 

 

 

 

Parameters 

 

The Parameters panel includes controls for editing the 
sample length and tuning as well as buttons for assigning 
the sample (see this section) and processing the slice or 
sample (see this section). 

 

Use the Slice field to display either the sample as it has 
been edited (Pad) or the entire sample (All). This is the same 
as adjusting Q-Link Knob 16 in the Q-Links panel. 

If the Slice field is set to All, you can display the sample as 
it has been edited but keep the start point and end point by 
clicking To Pad. The Slice field will change to Pad, but the 
start point and end point will remain in their current locations. 

 

Use the Start field to adjust the start point. This is the same 
as adjusting the first column of Q-Link knobs in the Q-
Links panel. 

Use the End field to adjust the end point. This is the same 
as adjusting the second column of Q-Link knobs in the Q-
Links panel. 

Use the Loop field to adjust the loop point if Loop Lock is 
off. If Loop Lock is on, adjusting the loop point will also 
adjust the start point. This is the same as adjusting the third 
column of Q-Link knobs in the Q-Links panel. 
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Click the Lock button to turn Loop Lock on or off. When on, the loop point is the same as the start point. When off, 
the loop point is independent from the start point and indicated by a separate loop marker. 

 

Click the Loop menu to cycle between the three loop modes: 

Off: The sample will not loop. 

Forward (Fwd): When the loop reaches its end point, it will start playing again from the loop point. 

Reverse (Rev): When the loop reaches its end point, it will play in reverse. When it reaches the loop point again, 
it will return to the end point and continue playing in reverse. 

Alternating (Alt): When the loop reaches its end point, it will play in reverse. When it reaches the loop point 
again, it will start playing forward again from the loop point. 

 

Use the X-Fade field to apply a crossfade to a looping sample. You must first make sure the loop Lock setting is set 
to Off, and then use the Loop menu to select a loop mode. Make sure there are at least 10 samples of space 
between the Start point and Loop point, then use the X-Fade field to set the length of the crossfade in samples. 

Click the icons next to the X-Fade field to select a Linear (straight lines) or Equal Power (curved lines) crossfade. 

Press Pad A16 – Play Continuous Loop to hear the crossfade applied to the sample. 

 

Use the Tune field to transpose the sample from its original pitch up to 24.00 semitones up or down. 

 

Use the Root Nt field to set the root note of the sample. This defines which note will play the sample at its original 
pitch when in a keygroup track. 

 

Click From BPM to tune a sample to the current sequence. Use the Edit Tuning 
window on connected MPC hardware to adjust the following: 

Use the Beats field to match the number of beats in the sequence. 

To tune the sample to the sequence, click Match. The Tune field will adjust 
automatically and close the window. The sample is now tuned to the sequence. 

To tune the sample to the sequence and adjust the sequence tempo, click 
To Sequence. This is the same as clicking Match but it also changes the 
sequence’s tempo to the BPM shown in the Tempo field on the right. 

To close the window, click Close. 

 

Use the BPM field to enter a tempo manually. You can also click X2 to double the 
value or /2 to halve it. 

 

Click Detect BPM to automatically detect the tempo. Use the Detect BPM 
window on connected MPC hardware to adjust the following: 

Use the BPM field to enter a tempo manually. You can also click X2 to double 
the value or /2 to halve it. 

Click Detect to detect the tempo automatically. 

Click Tap Tempo at the bottom of the window at the desired rate to use it as 
the tempo. You can play a sequence in the background to help with your timing. 

Click Close to close the window. 

Note: Before detecting tempo, it is recommended that you Normalize samples for 
best results. 
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Assigning Samples 

 

You can assign your new sample directly to a pad from Track Mode. 

Click Assign to assign a sample. In the Assign Sample window that appears, you can click the Assign To menu to 
select a different assignment, and then click Do It to assign the sample or Cancel to close the window without 
assigning the sample. 

Important: Assigning a sample to a pad in this way will replace the sample on the first layer of the pad. 

 

If you set the Assign To menu to Assign Slice to Pad, the pad will simply refer 
to the slice in this sample instead of creating a new sample. This is useful for 
reducing clutter in your project. 

 

Use the Pad menu to select the desired pad. Alternatively, press the 
desired pad. 

 

Use the Slice Type menu to select how the pad’s layer settings will be set 
when the slice is assigned to it: 

Non-Destructive Slice: The pad’s Slice setting will be set to the slice 
number. 

Pad Parameters: The pad’s Slice setting will be set to Pad. The Pad 
Start and Pad End will be set to the slice’s start point and end point 
values, and the Loop Position will be set to the slice’s start point but 
with Pad Loop deactivated. 

 

Use the Track menu to specify the track to which you want to add the slice. 

 

If you set the Assign To menu to New Sample to Pad, this will create a new 
sample in your project. (The original sample will remain as it is.) 

 

Use the Pad menu to select the desired pad. Alternatively, press the 
desired pad. 

 

Select the Crop Sample box to delete the unused parts from the sample 
when it’s created and assigned. This feature is destructive, though the 
project will still contain your original sample. 

Leave this box deselected to keep the unused parts of the sample when it 
is created and assigned. This way, you will still be able to edit the entire 
sample further even though you are using only part of it at the moment. 

 

Use the Track menu to specify the track to which you want to add the slice. 
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Processing Slices 

 

Use the column of Process buttons to select an editing process. In the Process Sample window that appears, you 
can click the Function menu to select a different process, and then click Do It to apply the process or Cancel to 
close the window without processing the sample. 

You can use any of these functions as described below. 

Important: Track Mode is non-destructive: You can choose the slice/edit behavior without destroying your original 
sample, giving you more control over sample playback; you can save your sliced sample and but also reuse all of the 
slice data in another project. See the Track Edit Mode chapter to learn more about setting a pad to play the entire 
sample, a specific slice of a sample, or a specific region of the sample (independent of its slice markers).  

 

The Create Stems process isolates different parts of the sample and 
separates them into new stem samples. 

Click the icons to select or deselect from the following elements to create 
stems of: 

• Vocals: Isolate vocal elements of the track into a stem. 

• Bass: Isolate bass elements of the track into a stem. 

• Drums: Isolate percussive elements of the track into a stem. 

• Other: Isolate other musical textures, such as keys or guitars, into a 
stem. 

Use the Track dropdown menu to select the track where the stems will be 
added. 

The Assign to Pad function determines where the stem separated 
samples are added. When checked, you can select a pad in the chosen 
Track using the dropdown menu, and the stems will be added to the four 
layers of that pad. When unchecked, the stems will be added to the 
general project sample pool in the Project Info Browser. 

Click the Use trimmed sample box to trim the source sample between 
the Start and End points before applying the stem separation process.  

Tip: Uncheck this box if you want to retain slices with the stemmed 
results, otherwise, they will be bypassed. 

Note: Visit thempcstore.com to purchase MPC Stems, and then activate your 
purchase in the Preferences > Activation menu. 

 

The Silence process replaces the region between the start point and end 
point with silence. 
 

 

 

 

 

 

The Extract process deletes the regions before the start point and after the 
end point and saves it as a new sample in your current project. 

Use the Name field to name the new sample. 

Tip: This is useful if you recorded a drum loop and wanted to remove just a 
snare drum hit, a kick drum hit, etc. to use separately in the project. 

 

 

http://thempcstore.com
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The Normalize process increases a sample’s level to the highest level 
possible without distortion. This is essentially a kind of digital gain 
optimization, so you do not have to worry about excessive level settings when 
working with samples with a wide range of amplitudes. 

 

 

 

 
 

The Reverse process reverses the region between the start point and end 
point. 

 

 

 

 

 

 

The Fade In process sets a fade-in between the start point and end point. 
Click the Type menu to select a type of fade:  

Linear fades the audio in with a linear curve—a straight line between the 
start and end. 

Log fades the audio in with a logarithmic curve—quickly rising at the start 
and flattening out towards the end. 

Exp fades the audio in with an exponential curve—slowly rising in the 
beginning and growing steeper towards the end. 

 
 
The Fade Out process sets a fade-out between the start point and end point. 
Click the Type menu to select a type of fade:  

Linear fades the audio out with a linear curve—a straight line between the 
start and end. 

Log fades the audio out with a logarithmic curve—quickly rising at the 
start and flattening out towards the end. 

Exp fades the audio out with an exponential curve—slowly rising in the 
beginning and growing steeper towards the end. 

 

The Pitch Shift process changes the pitch of the sample without changing its 
length. This lets you set the sample’s pitch to your sequence without affecting 
the sample’s tempo or duration. Keep in mind that the audio quality may 
decrease at more extreme settings. 

Use the Pitch field to shift the pitch up to 12.00 semitones up or down. 
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The Gain Change process raises or lowers the volume of the sample.  

Use the Gain Amount field to adjust the gain up to 18 dB up or down.  

This function is different than Normalize because it will allow volumes beyond 
clipping level. This may be a desired effect, but remember to watch your 
output level! 
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Pad Mixer 
 

In the Pad Mixer, you can set a pad’s levels, stereo panning, routing, and effects for drum tracks and 
keygroup tracks. 

 

To enter the Pad Mixer, do any of the following: 

• Click the pad-and-sliders icon in the toolbar (if shown). 

• Click the down arrow () next to the other mode icons in the toolbar, and click Pad Mixer. 

• Click the menu icon (≡), and go to View > Mode and click Pad Mixer. 

 

 

 

The Pad Mixer works like an audio mixer with various settings for each pad. 

 

The upper half of the window can display the Grid Editor, Wave Editor, or List Editor. Click the Grid, Wave, or List 
tab. See General Features > Editors to learn more about each one.  
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The lower half of the window displays channel strips representing the pads of the current track (used by the currently 
selected track) used in the current sequence. Each type has a slightly different appearance. 

Tip: If you want to see channel strips for both the Channel Mixer and the Pad Mixer at the same time, use the Mixer 
Window, which provides an overview of the channel strips in both modes in one screen. See General Features > 
Mixer Window to learn about this. 

 

Select a drum track or keygroup track to view the channel strips for its track and pads. 

 

Use the buttons in the lower-left corner of this area to show or hide different parts of the channel strips: 

Click the box icon to show or hide the Inserts slots on the channel strips. 

Click the four-circles icon to show or hide the Send knobs on the channel strips. 

Click the pad icon to show or hide the pad on the channel strips for drum tracks. 

 

 

 

Use the selectors between the upper and lower halves of the window to filter which channel strips are shown or hidden: 

Events: When Events is selected, channel strips whose pads play in the current sequence will be shown. All 
others will be hidden. 

Samples: When Samples is selected, only channel strips whose pads or keygroups have samples assigned to 
them will be shown. When Samples is deselected, channel strips for all pads or keygroups will be shown. 

Track: When Track is selected, the track channel strip will be shown on the right edge of the lower half of the 
window. When Track is deselected, the track channel strip will be hidden. 
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When a MIDI track is selected, the pad channel strips or keygroup channel strips for that track are grouped 
together on the left. The corresponding track channel strip will appear on the right. (When a MIDI track or CV track 
is selected, there will be no pad channel strips.) 

 

Pad Channel Strip 

When a track using a drum track is selected, the pad channel strip has these controls: 

Click a pad channel strip to select it. 

The number of the pad is at the bottom of the channel strip. If pads are shown at the bottom of the 
channel strips, you can click a pad to select its channel strip and play its sound. 

The Inserts slots show any enabled or disabled effects for that pad. See General Features > 
Effects > Insert Effects to learn more about pad insert effects. 

Click and drag the Send knobs, which control the send levels for the pad. See General Features 
> Effects > Send/Return Effects to learn more about pad send/return effects. 

The menu below the Send knobs shows where the pad is routed, which you can set to the current 
track (Track), a submix (Submix > Sub 1–8), a pair of main outputs (Stereo Output > Out 1,2–
31,32), or a single main output (Mono Output > Out 1–32). Usually, this is set to Track. 

Click M or S to mute or solo the pad (respectively). 

To change the panning or level of the pad, adjust the pan knob or level slider. The green level 
meter next to the slider shows the pad’s current volume level in dB. 

 

 

 

 

 

 

 

Keygroup Channel Strip 

When a track using a keygroup track is selected, the keygroup channel strip has these controls: 

Click a keygroup channel strip to select it. Alternatively, click the KG menu at the top of the 
channel strip and select one—that channel strip will then display that keygroup. 

The number of the keygroup is at the bottom of the channel strip. 

The Inserts slots show any enabled or disabled effects for that keygroup. See General Features 
> Effects > Insert Effects to learn more about keygroup insert effects. 

Click and drag the Send knobs, which control the send levels for the keygroup. See General 
Features > Effects > Send/Return Effects to learn more about keygroup send/return effects. 

The menu below the Send knobs shows where the keygroup is routed, which you can set to the 
current track (Track), a submix (Submix > Sub 1–8), a pair of main outputs (Stereo Output > Out 
1,2–31,32), or a single main output (Mono Output > Out 1–32). Usually, this is set to Track. 

Click M or S to mute or solo the keygroup (respectively). 

To change the panning or level of the keygroup, adjust the pan knob or level slider. The green 
level meter next to the slider shows the keygroup’s current volume level in dB. 
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Track Channel Strip 

When a track using a drum track, keygroup track, or plugin track is selected, the track channel strip 
has these controls: 

The name of the track is at the bottom of the channel strip. 

The first menu shows the current track (which you can change). 

The Inserts slots show any enabled or disabled effects for that track. See General Features > 
Effects > Insert Effects to learn more about track insert effects. 

Click and drag the Send knobs, which control the send levels for the track. See General Features 
> Effects > Send/Return Effects to learn more about track send/return effects. 

The menu below the Send knobs shows where the track is routed, which you can set to a submix 
(Submix > Sub 1–8), a pair of main outputs (Stereo Output > Out 1,2–31,32), or a single main 
output (Mono Output > Out 1–32). 

Click M or S to mute or solo the track (respectively). 

Click the track automation button to toggle between two possible states of track automation: 

When set to Read (R), the track will read automation data but will not record any additional 
automation over it. You can still manually edit and enter automation. (Think of this as a 
protective feature to prevent accidental changes to your automation while recording.) 

When set to Write (W), the track can record automation. (If you have any Q-Link knobs 
assigned to automatable parameters, make sure not to touch any accidentally while you are 
recording.) 

To disable or enable track automation, hold Shift and press the track automation button. 
When off, the track will ignore automation data. If you have already recorded or entered 
automation, clicking this will switch between Read (R) and Write (W) only, but you can override 
this and turn it off by pressing and holding Shift while clicking the button. 

Important: If you have already recorded automation and turn it off, the track will still use the 
effect and its parameter values at the point where you turned it off. 

See General Features > Automation to learn about recording and editing automation. 

Tip: You can quickly set all tracks to the same automation by clicking the global automation 
button in the upper-right corner of the window. 

Adjust the pan knob or level slider to change the panning or level (respectively) of the track. The 
green level meter next to the slider shows the track’s current volume level in dB. 



  

 
185 

 

 
Channel Mixer 
 

In the Channel Mixer, you can set levels, stereo panning, and other settings for your tracks, returns, 
submixes, and mains. 

 

To open the Channel Mixer, do any of the following: 

• Click the sliders icon in the toolbar (if shown). 

• Click the down arrow () next to the other mode icons in the toolbar, and click Channel Mixer. 

• Click the menu icon (≡), and go to View > Mode and click Channel Mixer. 

 

 

 

The Channel Mixer works like an audio mixer for the currently selected sequence with various settings for each track, 
submix, return, or main output.  
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The upper half of the window displays the Grid Editor. See General Features > Grid Editor to learn more about this. 

 

The lower half of the window displays channel strips representing the tracks, submixes, returns, and main outputs 
used in the current sequence. Each type has a slightly different appearance. 

Tip: If you want to see channel strips for both the Channel Mixer and the Pad Mixer at the same time, use the Mixer 
Window, which provides an overview of the channel strips in both modes on one screen. See General Features > 
Mixer Window to learn about this. 

 

Select a sequence to view its channel strips. 

 

Use the buttons in the lower-left corner of this area to show or hide different parts of the channel strips: 

Click the box icon to show or hide the Inserts slots on the channel strips. 

Click the four-circles icon to show or hide the Send knobs on the channel strips. 

 

Click the menu icon (≡) in the upper-right corner of the channel strips, and select or deselect Show Unused 
Tracks and/or Show Unused Tracks. 

 

 

 

Use the selectors between the upper and lower halves of the window to filter which channel strips are shown or hidden. 
When an option is selected, those channel strips will be shown. When it is deselected, its channel strips will be hidden. 

 

 

 Drum/Keygroup/  
 Plugin Track  MIDI Track CV Track Audio Track Submix Return Main 
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Drum/Keygroup/Plugin Track Channel Strip 

 

A Drum / Keygroup / Plugin track channel strip has these controls: 

The name of the track is at the bottom of the channel strip. 

The Inserts slots show any enabled or disabled effects for that program. See General Features 
> Effects > Insert Effects to learn more about program insert effects. 

Click and drag the Send knobs, which control the send levels for the program. See General 
Features > Effects > Send/Return Effects to learn more about program send/return effects. 

The menu below the Send knobs shows where the program is routed, which you can set to a 
submix (Submix > Sub 1–8), a pair of main outputs (Stereo Output > Out 1,2–31,32), or a single 
main output (Mono Output > Out 1–32). 

Click M or S to mute or solo the track (respectively). 

Click the track automation button to toggle between two possible states of track automation: 

When set to Read (R), the track will read automation data but will not record any additional 
automation over it. You can still manually edit and enter automation. (Think of this as a 
protective feature to prevent accidental changes to your automation while recording.) 

When set to Write (W), the track can record automation. (If you have any Q-Link knobs 
assigned to automatable parameters, make sure not to touch any accidentally while you are 
recording.) 

To disable or enable track automation, hold Shift and click the track automation button. 
When off, the track will ignore automation data. If you have already recorded or entered 
automation, clicking this will switch between Read (R) and Write (W) only, but you can 
override this and turn it off by pressing and holding Shift while clicking the button. 

Important: If you have already recorded automation and turn it off, the track will still use the 
effect and its parameter values at the point where you turned it off. 

See General Features > Automation to learn about recording and editing automation. 

Tip: You can quickly set all tracks and audio tracks to the same automation by clicking the 
global automation button in the upper-right corner of the window. 

Click the Monitor button to set how your MIDI track will be monitored. Clicking it will cycle 
through its three states: 

When set to In, the track's MIDI input is always monitored regardless of the track's Record 
Arm state, and playback from recorded events will not be heard. 

When set to Auto, the track's MIDI input is monitored when the track is record armed, and 
playback of recorded events will be heard. 

When set to Merge, the track's MIDI input is always monitored, and playback of recorded 
events will be heard. 

When set to Off, the track's MIDI input is not monitored, and playback of recorded events 
will be heard. This setting is useful when using keyboards with Local Control active. 

To change the panning or level of the track, adjust the pan knob or level slider. The level 
meter behind the slider shows the track’s current velocity level (0–127). 

Click the Record Arm () button to record-enable the track. When you begin recording, the 
MIDI data will be recorded to this track. 
Tip: You can select record-enable multiple tracks by pressing and holding Ctrl (Windows) or  
(macOS) while clicking the Arm button to each track (in the upper half of the window or in the 
channel strips). You can also adjust the Rec Arm behavior in the Preferences menu. 
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MIDI Track Channel Strip 

 

A MIDI track channel strip has these controls: 

The name of the track is at the bottom of the channel strip. 

Click M or S to mute or solo the track (respectively). 

Click the track automation button to toggle between two possible states of track automation: 

When set to Read (R), the track will read automation data but will not record any additional 
automation over it. You can still manually edit and enter automation. (Think of this as a 
protective feature to prevent accidental changes to your automation while recording.) 

When set to Write (W), the track can record automation. (If you have any Q-Link knobs 
assigned to automatable parameters, make sure not to touch any accidentally while you are 
recording.) 

To disable or enable track automation, hold Shift and click the track automation button. 
When off, the track will ignore automation data. If you have already recorded or entered 
automation, clicking this will switch between Read (R) and Write (W) only, but you can 
override this and turn it off by pressing and holding Shift while clicking the button. 

Important: If you have already recorded automation and turn it off, the track will still use the 
effect and its parameter values at the point where you turned it off. 

See General Features > Automation to learn about recording and editing automation. 

Tip: You can quickly set all tracks and audio tracks to the same automation by clicking the 
global automation button in the upper-right corner of the window. 

Click the Monitor button to set how your MIDI track will be monitored. Clicking it will cycle 
through its three states: 

When set to In, the track's MIDI input is always monitored regardless of the track's Record 
Arm state, and playback from recorded events will not be heard. 

When set to Auto, the track's MIDI input is monitored when the track is record armed, and 
playback of recorded events will be heard. 

When set to Merge, the track's MIDI input is always monitored, and playback of recorded 
events will be heard. 

When set to Off, the track's MIDI input is not monitored, and playback of recorded events 
will be heard. This setting is useful when using keyboards with Local Control active. 

To change the panning or level of the track, adjust the pan knob or level slider. The level 
meter behind the slider shows the track’s current velocity level (0–127). 

Click the Record Arm () button to record-enable the track. When you begin recording, the 
MIDI data will be recorded to this track. 
Tip: You can select record-enable multiple tracks by pressing and holding Ctrl (Windows) or  
(macOS) while clicking the Arm button to each track (in the upper half of the window or in the 
channel strips). You can also adjust the Rec Arm behavior in the Preferences menu. 
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CV Track Channel Strip 

 

A CV track channel strip has these controls: 

The name of the track is at the bottom of the channel strip. 

Click M or S to mute or solo the track (respectively). 

Click the track automation button to toggle between two possible states of track automation: 

When set to Read (R), the track will read automation data but will not record any additional 
automation over it. You can still manually edit and enter automation. (Think of this as a 
protective feature to prevent accidental changes to your automation while recording.) 

When set to Write (W), the track can record automation. (If you have any Q-Link knobs 
assigned to automatable parameters, make sure not to touch any accidentally while you are 
recording.) 

To disable or enable track automation, hold Shift and click the track automation button. 
When off, the track will ignore automation data. If you have already recorded or entered 
automation, clicking this will switch between Read (R) and Write (W) only, but you can 
override this and turn it off by pressing and holding Shift while clicking the button. 

Important: If you have already recorded automation and turn it off, the track will still use the 
effect and its parameter values at the point where you turned it off. 

See General Features > Automation to learn about recording and editing automation. 

Tip: You can quickly set all tracks and audio tracks to the same automation by clicking the 
global automation button in the upper-right corner of the window. 

Click the Monitor button to set how your CV track will be monitored. Clicking it will cycle 
through its three states: 

When set to In, the track's CV input is always monitored regardless of the track's Record 
Arm state, and playback from recorded events will not be heard. 

When set to Auto, the track's CV input is monitored when the track is record armed, and 
playback of recorded events will be heard. 

When set to Merge, the track's CV input is always monitored, and playback of recorded 
events will be heard. 

When set to Off, the track's CV input is not monitored, and playback of recorded events will 
be heard. This setting is useful when using keyboards with Local Control active. 

Click the Record Arm () button to record-enable the track. When you begin recording, the CV 
data will be recorded to this track. 
Tip: You can select record-enable multiple tracks by pressing and holding Ctrl (Windows) or  
(macOS) while clicking the Arm button to each track (in the upper half of the window or in the 
channel strips). You can also adjust the Rec Arm behavior in the Preferences menu. 
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Audio Track Channel Strip 

 

An audio track channel strip has these controls: 

The name of the track is at the bottom of the channel strip.  

The first menu defines the input source of the external audio signal, which you can set to a pair 
of inputs (Stereo > Input 1,2–31,32) or a single input (Mono > Input 1–32). 

The Inserts slots show any enabled or disabled effects for that track. See General Features > 
Effects > Insert Effects to learn more about audio track insert effects. 

Click and drag the Send knobs, which control the send levels for the track. See General Features 
> Effects > Send/Return Effects to learn more about audio track send/return effects. 

The menu below the Send knobs shows where the track is routed, which you can set to a submix 
(Submix > Sub 1–8), a pair of main outputs (Stereo Output > Out 1,2–31,32), or a single main 
output (Mono Output > Out 1–32). 

Click M or S to mute or solo the track (respectively). 

Click the audio track automation button to toggle between two possible states of audio track 
automation: 

When set to Read (R), the audio track will read automation data but will not record any 
additional automation over it. You can still manually edit and enter automation. (Think of this 
as a protective feature to prevent accidental changes to your automation while recording.) 

When set to Write (W), the audio track can record automation. (If you have any Q-Link 
knobs assigned to automatable parameters, make sure not to touch any accidentally while 
you are recording.) 

To disable or enable audio track automation, hold Shift and press the audio track 
automation button. When off, the audio track will ignore automation data. If you have 
already recorded or entered automation, clicking this will switch between Read (R) and Write 
(W) only, but you can override this and turn it off by pressing and holding Shift while clicking 
the button. 

Important: If you have already recorded automation and turn it off, the track will still use the 
effect and its parameter values at the point where you turned it off. 

See General Features > Automation to learn about recording and editing automation. 

Tip: You can quickly set all tracks to the same automation by clicking the global automation 
button in the upper-right corner of the window. 

Click the Monitor button to set how your audio track will be monitored. Clicking it will cycle 
through its four states: 

When set to Off, you will never hear any incoming audio. 

When set to In, you will hear incoming audio whether or not the track is record-enabled. 

When set to Auto, you will hear incoming audio while the track is record-enabled only. 

When set to Merge, the track's input is always monitored, and you will hear playback of 
recorded events. 

Adjust the pan knob or level slider to change the panning or level (respectively) of the track. 
The level meter behind the slider shows the track’s current volume level in dB. 

Click the Record Arm () button to record-enable the track. When you begin audio recording, 
the audio signal will be recorded to this track. 

Tip: You can select record-enable multiple tracks by pressing and holding Ctrl (Windows) or  
(macOS) while clicking the Arm button to each track (in the upper half of the window or in the 
channel strips). You can also adjust the Rec Arm behavior in the Preferences menu. 
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Submix Channel Strip 

 

A submix channel strip has these controls: 

The name/number of the submix is at the bottom of the channel strip. 

The Inserts slots show any enabled or disabled effects for that submix. See General Features > 
Effects > Insert Effects to learn more about submix insert effects. 

Click and drag the Send knobs, which control the send levels for the submix. See General 
Features > Effects > Send/Return Effects to learn more about submix send/return effects. 

The menu below the Send knobs shows where the submix is routed, which you can set to a pair 
of main outputs (Stereo Output > Out 1,2–31,32), or a single main output (Mono Output > Out 
1–32). 

Click M to mute the submix. 

Click the track automation button to toggle between two possible states of submix 
automation: 

When set to Read (R), the submix will read automation data but will not record any 
additional automation over it. You can still manually edit and enter automation. (Think of this 
as a protective feature to prevent accidental changes to your automation while recording.) 

When set to Write (W), the submix can record automation. (If you have any Q-Link knobs 
assigned to automatable parameters, make sure not to touch any accidentally while you are 
recording.) 

To disable or enable submix automation, hold Shift and press the submix automation 
button. When off, the submix will ignore automation data. If you have already recorded or 
entered automation, clicking this will switch between Read (R) and Write (W) only, but you 
can override this and turn it off by pressing and holding Shift while clicking the button. 

Important: If you have already recorded automation and turn it off, the track will still use the 
effect and its parameter values at the point where you turned it off. 

See General Features > Automation to learn about recording and editing automation. 

Tip: You can quickly set all tracks to the same automation by clicking the global automation 
button in the upper-right corner of the window. 

Click the Monitor button to set how your submix will be monitored. Clicking it will cycle through 
its four states: 

When set to Off, you will never hear any incoming audio. 

When set to In, you will hear incoming audio whether or not the track is record-enabled. 

When set to Auto, you will hear incoming audio while the track is record-enabled only. 

When set to Merge, the track's input is always monitored, and you will hear playback of 
recorded events. 

Adjust the pan knob or level slider to change the panning or level (respectively) of the submix. 
The level meter next to the slider shows the submix’s current volume level in dB. 
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Return Channel Strip 

 

A return channel strip has these controls:  

The number of the return is at the bottom of the channel strip. 

The Inserts slots show any enabled or disabled effects for that return. See General Features > 
Effects > Send/Return Effects to learn more about send/return effects. 

The menu above the M button shows where the return is routed, which you can set to a pair of 
main outputs (Stereo Output > Out 1,2–31,32) or a single main output (Mono Output > Out 
1–32). 

Click M to mute the return. 

Click the track automation button to toggle between two possible states of return automation: 

When set to Read (R), the return will read automation data but will not record any additional 
automation over it. You can still manually edit and enter automation. (Think of this as a 
protective feature to prevent accidental changes to your automation while recording.) 

When set to Write (W), the return can record automation. (If you have any Q-Link knobs 
assigned to automatable parameters, make sure not to touch any accidentally while you are 
recording.) 

To disable or enable return automation, hold Shift and press the return automation 
button. When off, the return will ignore automation data. If you have already recorded or 
entered automation, clicking this will switch between Read (R) and Write (W) only, but you 
can override this and turn it off by pressing and holding Shift while clicking the button. 

Important: If you have already recorded automation and turn it off, the track will still use the 
effect and its parameter values at the point where you turned it off. 

See General Features > Automation to learn about recording and editing automation. 

Tip: You can quickly set all tracks to the same automation by clicking the global 
automation button in the upper-right corner of the window. 

Click the Monitor button to set how your return will be monitored. Clicking it will cycle through 
its four states: 

When set to Off, you will never hear any incoming audio. 

When set to In, you will hear incoming audio whether or not the track is record-enabled. 

When set to Auto, you will hear incoming audio while the track is record-enabled only. 

When set to Merge, the track's input is always monitored, and you will hear playback of 
recorded events. 

Adjust the pan knob or level slider to change the panning or level (respectively) of the return. 
The green level meter next to the slider shows the return’s current volume level in dB. 
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Main Outputs Strip 

 

A main output channel strip has these controls: 

The number of the pair of main outputs is at the bottom of the channel strip. 

The Inserts slots show any enabled or disabled effects for that pair of outputs. See General 
Features > Effects > Insert Effects to learn more about main output insert effects. 

Click M to mute the outputs. 

Click the track automation button to toggle between two possible states of main output 
automation: 

When set to Read (R), the main output will read automation data but will not record any 
additional automation over it. You can still manually edit and enter automation. (Think of 
this as a protective feature to prevent accidental changes to your automation while 
recording.) 

When set to Write (W), the main output can record automation. (If you have any Q-Link 
knobs assigned to automatable parameters, make sure not to touch any accidentally while 
you are recording.) 

To disable or enable main output automation, hold Shift and press the main output 
automation button. When off, the main output will ignore automation data. If you have 
already recorded or entered automation, clicking this will switch between Read (R) and 
Write (W) only, but you can override this and turn it off by pressing and holding Shift while 
clicking the button. 

Important: If you have already recorded automation and turn it off, the track will still use the 
effect and its parameter values at the point where you turned it off. 

See General Features > Automation to learn about recording and editing automation. 

Tip: You can quickly set all tracks to the same automation by clicking the global 
automation button in the upper-right corner of the window. 

Click the Monitor button to set how your main output will be monitored. Clicking it will cycle 
through its four states: 

When set to Off, you will never hear any incoming audio. 

When set to In, you will hear incoming audio whether or not the track is record-enabled. 

When set to Auto, you will hear incoming audio while the track is record-enabled only. 

When set to Merge, the track's input is always monitored, and you will hear playback of 
recorded events. 

Adjust the pan knob or level slider to change the panning or level (respectively) of the outputs. 
The green level meter next to the slider shows the outputs’ current volume level in dB. 
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Step Sequencer 
 

The Step Sequencer lets you create or edit sequences by using the pads as “step buttons,” simulating the 
experience of a traditional step-sequencer-style drum machine.  

This is available for MIDI tracks only, not audio tracks. 

 

To enter the Step Sequencer, do any of the following: 

• Click the step-bars icon in the toolbar (if shown). 

• Click the down arrow () next to the other mode icons in the toolbar, and click Step Sequencer. 

• Click the menu icon (≡), and go to View > Mode and click Step Sequencer. 

 

 

 

To enter or delete steps in a sequence: 

1. Use the Pad field in the Pads area to select the pad whose steps you want to enter or delete. The current pad 
number is shown in the upper-left corner. 

2. Use the Bar field in the Pads area to select the bar of the sequence whose steps you want to enter or delete. 
The current bar number is shown in the upper-left corner. 

3. Click the pads. Each pad corresponds to a step in the bar and will light with a color corresponding to its velocity. 
Notes will be added at the current Timing Correct (TC) swing setting. 

Keep in mind that for time divisions larger than 16, the bar’s steps will be represented by multiple pad banks. In 
this case, use Pad Bank Buttons A and B to view all the steps within a bar. 
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The upper half of the window can display the Grid Editor, Wave Editor, or List Editor. Click the Grid, Wave, or List 
tab to enter the corresponding editor. See General Features > Editors to learn more about each one. 

The lower half of the window can display the Q-Links panel, Pads panel, and Project panel. Click the corresponding 
selector to show or hide each one. See General Features > Panels to learn more about the Project panel. The Q-
Links and Pads panels are described below. 

 

 

Q-Links 

 

The Q-Links panel (when Q-Link Mode is set to Screen or Step Sequencer) lets 
you to adjust the velocity of each step. The number of each step will be shown 
under the corresponding Q-Link knob. 

Use each Q-Link knob to adjust the velocity (1–127) of its corresponding step. 
Setting a value of 0 (Off) will delete the note event from that step. Changing a 
velocity from 0 (Off) to a value of 1 or greater will enter a note event at that step. 

 

 

 

 

 

 

Pads 

 

The Pads panel lets you quickly create and delete note events as “steps” by using 
the pads of your MPC hardware or MPC 3 software, similar to step recording with 
drum machines in the 1980s. 

Each pad represents a step in the bar. Keep in mind that the total number of steps 
depends on the Time Correct setting. For time divisions larger than 16 (e.g., 32), 
the bar’s steps will be represented by multiple pad banks. In that case, use the 
Pad field to view all the steps within a bar. 

 

Use the Bar field or the arrows ( or ) on either side of it to select the bar whose 
steps you want to edit. 

 

Use the Pad Select button to select the pad whose steps you want to edit. Click 
Pad Select to activate it, click a pad (the currently selected pad is lit green), and 
then click Pad Select again to deactivate it.  

Alternatively, click and drag the Pad field up or down. You can also click a pad in 
the Grid Editor. 

 

Click an unlit pad to enter a note event at that step. The pad will light up with a 
color corresponding to its velocity. Notes will be added at the current Timing 
Correct (TC) swing setting. 

Click a lit pad to delete the note event from that step. The pad will be unlit. 

The green pad indicates the current step (playhead position) in the sequence. 
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Sampler 
 

The Sampler lets you record audio samples to use in your projects. 

Important: To record any audio, you need to connect an audio source to your MPC hardware or to your 
computer’s audio interface. 

 

To open the Sampler, do any of the following: 

• Click the vinyl icon in the toolbar (if shown). 

• Click the down arrow () next to the other mode icons in the toolbar, and click Sampler. 

• Click the menu icon (≡), and go to View > Mode and click Sampler. 

 

 

 

To set up the Sampler before recording: 

1. Make sure to reduce the volume levels of your audio source and speakers, headphones, and/or monitors before 
you make any connections to avoid “pops” or feedback. 

2. Connect a synthesizer or other line-level audio source to the input/inputs of your MPC hardware or external 
audio interface. 

3. On your MPC hardware or external audio interface, turn the Rec Vol knob to set the input level while playing your 
audio source. You should now see the level in the meter. Make sure it does not exceed the maximum level (the 
meter should not be “peaking” constantly). 

4. Set the recording controls as desired (described in this chapter). 

5. Click the Arm button to record-arm the Sampler. 
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The upper half of the window shows the waveform. Unlike other times the 
waveform is shown here, you cannot edit the waveform in this part of the 
window; you must use the Wave Editor in Main Mode or Sample Edit Mode 
instead. 

The timeline provides a reference for the length of the sample. Click the 
down arrow () or right-click anywhere on the timeline to select the 
increments it will use: Time (secs:ms), Samples, or Beats. 

Scroll left or right on the waveform to move through it. Use the sliders in 
the lower-right corner or click the timeline and drag down or up to zoom in 
or out. 

 

 

 

 

 

 

 

 

 

The lower half of the window can display the Q-Links panel, Pads panel, Sampler panel, and Project panel. Click 
the corresponding selector to show or hide each one. See General Features > Panels > Project to learn more 
about the Project panel. 

The Pads panel varies based on the four different recording methods: Sample, Slice, Pad Tap, or Pad Hold, all 
described in this chapter. 

 

 

Q-Links 

 

In the Q-Links panel: 

Use Q-Link Knob 1 to adjust the threshold. This is the same as 
adjusting the threshold slider in the Sampler panel. 

Use Q-Link Knobs 3 and 4 to define the maximum sampling time. This 
is the same as adjusting the Max Length field as shown on your MPC 
hardware. You can record up to 19 minutes and 59 seconds (19:59) 
per sample. We recommend setting these to values that roughly match 
your estimated recording duration. 
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Pads 

 

The Pads panel has three different appearances, depending on the recording method: 

 

 Sample Method Slice Method Pad Tap & Pad Hold Methods 

   

 

While using the Sample Method, the Pads panel shows information for each pad, depending on the currently selected 
track. This is identical to how the Pads panel appears in Main Mode (see the Main Mode chapter to learn more).  

While using the Slice Method, the pads correspond to slices of the currently recorded sample. See Recording 
Methods > Slice to learn how to use the Pads panel with this method. 

While using the Pad Tap or Pad Hold Methods, clicking a pad or clicking and holding a pad immediately starts or 
continues recording directly to that pad. See Recording Methods > Pad Tap or Pad Hold to learn how to use the 
Pads panel with those methods. 
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Sampler 

 

The Input Source menu in the upper-left corner of the Sampler panel 
defines whether you are going to record an external audio signal (Stereo or 
Mono) or an internal signal from within the MPC 3 software (Resample L, 
Resample R, or Resample L+R). 

Resampling does not require an audio connection because the source is 
within the MPC 3 software and is therefore recorded without any loss in 
audio quality. You can, for example, use Resample to record two or more 
samples by pressing the corresponding pads simultaneously or by simply 
playing a sequence. 

 

The Inserts slots show any enabled or disabled effects for the Sampler. 
See General Features > Effects > Insert Effects to learn more about 
insert effects. 

Important: These effects are applied to the audio as you record it. This 
means that the effects cannot be “removed” from the sound later. 

 

Click the Mono/Stereo menu to choose whether your recorded samples 
will be monaural (Mono) or binaural (Stereo). 

 

Click the Monitor button to set how the Sampler will be monitored: 

When set to In, the audio you hear in your headphones will be taken before it reaches the Sampler, ensuring zero 
latency. 

When off, the audio you hear in your headphones will be taken after it is processed in the Sampler, so there may 
be some latency, but you will hear the audio source as it sounds in the recording. 

Tip: To avoid possible clicks or feedback while input monitoring, reduce the level of the audio sources. 

 

Use the threshold slider to adjust the threshold. Alternatively, turn Q-Link Knob 1. 

When the Sampler is record-armed, it automatically starts recording when the level of the incoming source exceeds 
this setting. If you set it too high, the recording may not start when you play the input source, or the start of the 
material you wanted to record may be missing. If you set it too low, the recording may start too early, before you play 
the external source. Set this parameter to an appropriate level using the level meter. 

 

For reference, the Sample Length counter shows you the length of your sample during the recording procedure. 

 

Click Arm to record-arm the Sampler. The button will then change to Record. 

At that point, start recording by doing either of the following: 

• Start performing so that the incoming audio level exceeds the level of the threshold slider. 

• Click the Record button under the Sample Length counter. 

 

Click the Record Method menu to select the recording method you want to use: Sample, Slice, Pad Tap, or Pad Hold, 
all described in the following section. 

 

Click Add Slice as the sample records to insert a slice marker in a sample while recording. Each time you press it, a 
slice marker will be placed at that location. 
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Recording Methods 

 

Sample 

 

Using this method, you can insert slice markers directly in your sample as you record it.  

Slice markers divide the sample into multiple regions called slices, which you can adjust in the Chop Mode of 
Sample Edit Mode (see Sample Edit Mode > Chop Mode for more information). This is useful when working with a 
long sample with different sounds throughout (e.g., a drum loop or a long melodic or harmonic passage). 

 

To start recording, do one of the following: 

• Start performing so that the incoming audio level exceeds the level of the threshold slider. 

• Click the Record button under the Sample Length counter. 

 

To insert a slice marker in a sample while recording, click Add Slice as the sample records. Each time you press 
it, a slice marker will be placed at that location. 

 

To stop recording, click the Stop button under the Sample Length counter. 

 

After you stop your recording, the Keep or Discard Sample window 
will appear. 

Use the New Name field to name the new sample. Otherwise, the 
process will add a consecutive number after the sample name. 

Click the Track menu to assign the new sample to a drum 
track. Select <none> if you want to save it to the project 
without assigning it to a track. 

Use the Assign to Pad field to assign the sample to a pad in 
the selected drum track.  

Use the Root Note field to set where the sample’s original 
pitch will be on the keyboard. 

 

If you recorded a sample while a sequence was playing, the Keep 
or Discard Sample window will show a few more options after you 
select a pad. 

Check the Add Event box to automatically add the sample to 
the currently playing sequence. 

Use the At menu to select where you want the event to start: 

Start: The sample will be a note event at the start of the 
currently playing sequence. 

Trigger: The sample will be a note event where you began 
recording it in the currently playing sequence. 

Use the Track field to set which track will contain the new event. 

 

To save the recording, click Save. 

To play the recording, click Play. 

To discard the recording and close the window, click Discard. 

To confirm your selections, click Keep.  

To edit the recording in Sample Edit Mode (recommended), click 
Edit.
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Slice 

 

Using this method, the pads correspond to slices of the currently recorded sample. Slice markers divide the sample 
into multiple regions called slices, which you can adjust in the Chop Mode of Sample Edit Mode (see Sample Edit 
Mode > Chop Mode for more information). This is useful when working with a long sample with different sounds 
throughout (e.g., a drum loop or a long melodic or harmonic passage). 

 

To start recording, do one of the following: 

• Start performing so that the incoming audio level exceeds the level of the threshold slider. 

• Click the Record button under the Sample Length counter. 

 

To insert a slice marker in a sample while recording, press any pad as the sample records. Each time you press 
it, a slice marker will be placed at that location. 

The number of the pad that flashes red is the number of the slice marker that will be inserted next. The numbers of 
the pads that are lit yellow are the numbers of the slice markers that are already inserted. 

When you are done recording, you can name the sample and create a new track using the slices.  

 

To stop recording, click the Stop button under the Sample Length counter.  

 

After you stop your recording, the Keep or Discard Sample window 
will appear. 

Use the New Name field to name the new sample. Otherwise, the 
process will add a consecutive number after the sample name. 

Click the Create New Track menu to assign the new sample to 
a new track: 

Off: No track will be created. The slices will still be added 
to your project’s sample pool. 

With Non-Destructive Slices: In the new track, each pad’s 
Slice setting will be set to the corresponding slice number. 
This is identical to how you can assign samples in Sample 
Edit Mode (as described in Sample Edit Mode > Chop 
Mode). 

With Pad Parameters: In the new track, each pad’s Slice 
setting will be set to Pad. The Pad Start and Pad End will 
be set to the slice’s start point and end point values, and 
the Loop Position will be set to the slice’s start point but 
with Pad Loop deactivated. This is identical to how you 
can assign samples in Sample Edit Mode (as described in 
Sample Edit Mode > Chop Mode). 

 

To save the recording, click Save. 

To play the recording, click Play. 

To discard the recording and return to the Sampler, click Discard. 

To confirm your selections, click Keep.  

To edit the recording in Sample Edit Mode (recommended), click 
Edit. 
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Pad Tap 

 

Important: This mode works for drum tracks only; you must select a drum track before using this mode. Otherwise, 
this feature will not do anything, even though it may appear to work. 

With this method, clicking or pressing a pad immediately starts or continues recording directly to that pad (make sure 
you are using the desired track before you start recording). Pads with assigned samples are lit bright yellow. Pads 
without samples are lit dim yellow. 

 

To start recording to a pad, click or press it. Recording will start immediately, and the pad will flash red. If you click 
or press a new pad, the recording will stop on the previous pad, which will turn green, and start on the new pad, 
which will flash red. 

Note: If you start recording by clicking Record under the Sample Length counter—or if the volume exceeds the 
level of the threshold slider—the sample will record to your project’s sample pool, not to a pad. 

 

To stop recording to a pad, click or press the currently recording pad, which is flashing red. The sample will 
continue recording. You can start recording on another pad at any time. 

To stop all recording, click the Stop button under the Sample Length counter. 

 

When you are done recording, each pad that you have clicked or pressed during recording: 

• will have its Slice setting set to Pad; 

• will have its Pad Start and Pad End set to the slice’s start point and end point values; and 

• will have its Loop Position set to the slice’s start point but with Pad Loop deactivated. 

This is identical to how you can assign samples in Sample Edit Mode (described in Sample Edit Mode > Chop Mode). 

Tip: We recommend editing your recorded sample in Sample Edit Mode (see Sample Edit Mode for more information). 

 

 

Pad Hold 

 

Important: This mode works for drum tracks only; you must select a drum track before using this mode. Otherwise, 
this feature will not do anything, even though it may appear to work. 

With this method, clicking or pressing and holding a pad immediately starts or continues recording directly to that pad 
(make sure you are using the desired track before you start recording). Pads with assigned samples are lit bright 
yellow. Pads without samples are lit dim yellow. 

 

To start recording to a pad, click and hold it, or press and hold it. Recording will start immediately, and the pad will 
light red. 

Note: If you start recording by clicking Record under the Sample Length counter—or if the volume exceeds the 
level of the threshold slider—the sample will record to your project’s sample pool, not to a pad. 

 

To stop recording, release the pad. The pad will light green, and the sample will continue recording. You can start 
recording on another pad at any time. 

To stop all recording, click the Stop button under the Sample Length counter. 

 

When you are done recording, each pad that you have clicked or pressed during recording: 

• will have its Slice setting set to Pad; 

• will have its Pad Start and Pad End set to the slice’s start point and end point values; and 

• will have its Loop Position set to the slice’s start point but with Pad Loop deactivated. 

This is identical to how you can assign samples in Sample Edit Mode (described in Sample Edit Mode > Chop Mode). 

Tip: We recommend editing your recorded sample in Sample Edit Mode (see Sample Edit Mode for more information). 
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Looper 
 

The Looper lets you record and overdub audio in real time—a great tool for live performance as well as 
spontaneous moments in the studio. You can export the loop as a sample to use in your project. 

 

To open the Looper, do any of the following: 

• Click the loop-and-waveform icon in the toolbar (if shown). 

• Click the down arrow () next to the other mode icons in the toolbar, and click Looper. 

• Click the menu icon (≡), and go to View > Mode and click Looper. 
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Below is a brief step-by-step process so you can get started quickly. Continue reading the rest of this chapter to 
learn how to use the Looper in different cases. 

 

To get started using the Looper: 

1. Make sure to reduce the volume levels of your audio source and 
speakers/headphones/monitors before you make any connections 
to avoid “pops” or feedback. 

2. Connect a synthesizer, audio player, etc. to the input/inputs of 
your MPC hardware or external audio interface.  

3. On your MPC hardware or external audio interface, turn the Rec 
Vol knob to set the input level while playing your audio source. 
You should now see the level in the meter in the Looper panel. 
Make sure it does not exceed the maximum level (the meter 
should not be “peaking” constantly). 

4. In the Looper panel, set the recording controls as desired 
(described later in this chapter). 

5. Click the Record To menu in the Looper panel and select Overdub. 

6. Click the Ovr (⊕) button in the Looper panel to record-arm the 
Looper. 

7. Play your audio source. The Looper will start recording immediately 
when the input level reaches the threshold value. Alternatively, click 
Play () in the Looper panel to manually start recording. 

Each time the Looper repeats, its contents are being overdubbed—
a new layer of audio will be added each time you let the Looper 
repeat as it records.  

Tip: You can record a loop while playing a sequence in the 
background for reference. 

8. To stop recording, click Play () in the Looper panel.  

To export your loop to an audio track, click Export to open the 
Looper Export window. 

The Audio Track field automatically selects the current audio 
track in your project where the recording will be exported.  

The Clip field automatically selects the current clip or 
arrangement where the recording will be exported. 

To clear the contents of the Looper, click Clear. 



  

 
205 

 

 

 

 

The upper half of the window shows the real-time waveform of the Looper’s audio. Unlike other times the waveform 
is shown here, you cannot edit the waveform in this part of the window. 

The audio playhead indicates the Looper’s current playback and/or recording position. 

The timeline provides a reference for the length of the sample as bars.beats.ticks. 

 

The lower half of the window can display the Q-Links panel, Pads panel, Looper panel, and Project panel. Click the 
corresponding selector to show or hide each one. 

The Pads panel shows information for each pad, depending on the currently selected track. This is identical to how 
the Pads panel appears in Main Mode (see the Main Mode chapter to learn more). 

See General Features > Panels > Project to learn more about the Project panel. 

The Q-Links panel and Looper panel are described in the following sections. 

 

 

Q-Links 
 

In the Q-Links panel: 

Use Q-Link Knob 1 to adjust the threshold. This is the same as 
adjusting the threshold slider in the Looper panel. 

Use Q-Link Knob 4 to adjust the Looper’s output gain level. This is the 
same as adjusting the Output Gain slider in the Looper panel. 
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Looper 

 

The Input Source menu in the upper-left corner of the Looper panel 
defines whether you are going to record an external audio signal (Stereo or 
Mono) or an internal signal from within the MPC 3 software (Resample L, 
Resample R, or Resample L+R). 

Resampling does not require an audio connection because the source is 
within the MPC 3 software and is therefore recorded without any loss in 
audio quality. You can, for example, use Resample to record two or more 
samples by pressing the corresponding pads simultaneously or by simply 
playing a sequence. 

 

The Inserts slots show any enabled or disabled effects for the Looper. See 
General Features > Effects > Insert Effects to learn more about insert 
effects. 

Important: These effects are applied to the audio as you record it. This 
means that the effects cannot be “removed” from the sound later. 

 

Click the Mono/Stereo menu to choose whether your recorded loop will 
be monaural (Mono) or binaural (Stereo). 

 

Click the Monitor button to set how the Looper will be monitored: 

When set to In, the audio you hear in your headphones will be taken before it reaches the Sampler, ensuring 
zero latency. 

When off, the audio you hear in your headphones will be taken after it is processed in the Sampler, so there may 
be some latency, but you will hear the audio source as it sounds in the recording. 

Tip: To avoid possible clicks or feedback while input monitoring, reduce the level of the audio sources. 

 

Use the threshold slider to adjust the threshold. Alternatively, turn Q-Link Knob 1. 

When the Looper is record-armed, it automatically starts recording when the level of the incoming source exceeds 
this setting. If you set it too high, the recording may not start when you play the input source, or the start of the 
material you wanted to record may be missing. If you set it too low, the recording may start too early, before you play 
the external source. Set this parameter to an appropriate level using the level meter. 

 

Click Rplc or Ovr (⊕) to record-arm the Looper. The Play () and Ovr (⊕) buttons will then flash. 

At that point, start recording by doing either of the following: 

• Start performing so that the incoming audio level exceeds the level of the threshold slider. 

• Click the Play () button in the Looper panel. 

Click Rev () to reverse playback and recording of the Looper. 

 

Click the Seq Sync button to sync or un-sync the looper with sequence playback. When on, the Looper will stay in step 
with your current sequence. When you play or record into the Looper, it will wait until the sequence starts playing Bar 1 
to start. 

 

Use the Bars field to define the length of your loop. Regardless of how much or how little audio you record, this is 
how long your loop will be. 
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Use the Record To selector to determine the loop recording behavior: 

Play: Before recording, you must first click the Play () button on the window, which will start playing the Looper. 

Overdub: Before recording, you must first click Rplc or Ovr (⊕) to record-arm the Looper. 

 

Use the Output Gain slider to adjust the Looper’s output gain level. This is the same as adjusting Q-Link Knob 4 in 
the Q-Links panel. 

 

Click Clear  to erase the loop immediately. 

 

Click Export  to open the Export Loop as a Sample window. 

To export to an audio track: 

1. Select an existing audio track or create a new one. 

2. Click the Export  button. 

3. The current audio track will automatically be selected in the Audio Track field. If no audio track exists, this 
will show None. Click Cancel to exit Looper Export and create an audio track before continuing. 

4. The current clip or arrangement will automatically be selected in the Clip field. Click Cancel to exit Looper 
Export to select a different clip number or the arrangement.  

5. Click Export to Track to export the looper audio, or click Cancel to return. 

 

 

Below are step-by-step instructions for using the Looper’s functions. 

 

To record with the Looper: 

Important:  

To record without erasing any audio you’ve already recorded in the loop, use the ⊕/Ovr button. 

To overwrite the audio you’ve already recorded, use the Rplc button. 

If Record To is set to Play: 

To start recording, click the Rplc or Ovr (⊕) button as the loop is playing. The Looper will start recording 
immediately. 

To stop recording, click the Rplc or Ovr (⊕) button. The Looper will stop recording but continue playing. 

To stop playback and recording, click the Play () button. 

If Record To is set to Overdub: 

To start recording, click the Play () button on the window. 

If Sync is off, you can also play your audio source so that the input level reaches the threshold value. 

If Sync is on, you can also click the Play () or Play Start (|) button in the toolbar to start playing a 
sequence; recording will start when the sequence starts on Bar 1.  

To stop recording, click the Ovr (⊕) button. The Looper will stop recording but continue playing. 

To stop playback and recording, click the Play () button, or press stop to stop sequence playback. 

 

To play or stop the loop (without recording), click the Play () button on the window. 

 

To reverse loop playback, click the Rev () button. If Seq Sync is on, playback will reverse once the Looper’s 
playhead reaches the end of the loop. If Seq Sync is off, playback will reverse immediately. 

 

To erase the loop immediately, click Clear . 
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Pad Mute Mode 
 

Pad Mute Mode lets you easily mute pads within a track or set mute groups for each pad within a track. 

 

 
To enter Pad Mute Mode, do any of the following: 

• Click the square-and-X icon in the toolbar (if shown). 

• Click the down arrow () next to the other mode icons in the toolbar, and click Pad Mute. 

• Click the menu icon (≡), and go to View > Mode and click Pad Mute. 
 

 
 

While Pad Mute is selected in the Mute panel, you can mute or unmute individual sounds (on a single track) in real 
time by pressing the pads. This is useful if you want to hear a track without a particular sound or if you want to 
isolate specific sounds or combinations of sounds.  

While Solo is selected in the Mute panel, you can solo or unsolo individual sounds (on a single track) in real time by 
pressing the pads. This is also useful if you want to isolate particular sounds, and can be more effective if you have a 
large number of pads to mute.  

Tip: These functions are similar to muting or soloing pads one at a time in the grid, but more convenient. 

The Pad Group feature in the Mute panel extends the concept of pad mutes: you can mute or unmute multiple pads 
(on a single track) by pressing one pad that you have assigned to a group. This is useful if you want to hear a track 
without a particular group of sounds or if you want to isolate specific sounds in various combinations. You can create 
up to 16 different groups. 

Tip: This function is similar to muting pads one at a time in the grid but more convenient. 

 
The upper half of the window can display the Grid Editor, Wave Editor, or List Editor. Click the Grid, Wave, or List 
tab to enter the corresponding editor. See General Features > Editors to learn more about each one. 

The lower half of the window can display the Pad Banks panel, Pads panel, Mute panel, and Project panel. Click 
the corresponding selector to show or hide each one. See General Features > Panels > Project to learn more 
about the Project panel. The other panels are described below: Pad Banks, Pads, and Mute. 
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Pad Banks 
 
The Pad Banks panel is an overview of all pads in all eight pad banks. 

Click a pad bank to select it. That bank will also appear in the Grid Editor and the Pads panel. 

While using the Pad Mute function (selected in the Pad Mute panel), click a pad to mute or unmute it. Muted pads 
are orange. The colors of other pads will not change when using this feature. 

While using the Pad Group function (selected in the Pad Mute panel), click a pad to select it to assign to a group. 
The selected pad is green. Pads that belong to the same group flash yellow. 

While using the Solo function (selected in the Pad Mute panel), click a pad to solo or unsolo it. Soloed pads are 
blue. The colors of other pads will not change when using this feature. 

Pad Mute Pad Group Solo 

         

 

Pads 
 
The Pads panel represents the pads in the current bank. If a pad is assigned to a group, the group number will appear 
at the bottom of the pad. 

Click a pad bank to select it. That bank will also appear in the Grid Editor and the Pad Banks panel. 

While using the Pad Mute function (selected in the Pad Mute panel), click a pad to mute or unmute it. Muted pads 
are orange. The colors of other pads will not change when using this feature. 

While using the Pad Group function (selected in the Pad Mute panel), click a pad to select it to assign to a group. 
The selected pad is green. Pads that belong to the same group flash yellow. 

While using the Solo function (selected in the Pad Mute panel), click a pad to solo or unsolo it. Soloed pads are 
blue. The colors of other pads will not change when using this feature. 

Pad Mute Pad Group Solo 
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Pad Mute 
 
The Pad Mute panel lets you configure how pad mutes work. 

Click Pad Mute to use Pad Mute Mode normally. Clicking or pressing a pad will mute or unmute it (and any pads in 
the same group). 

Click Pad Group to assign pads to groups. Clicking or pressing a pad will select it. 

Click Solo to use Pad Mute Mode to solo pads. Clicking or pressing a pad will solo or unsolo it (and any pads in the 
same group). 

Click the Time Correct menu to select a time division to quantize pad mutes in this mode. For example, while set to 
1 Bar, your mutes will always align with the beginning of the measure immediately after you press the pad. Select Off 
to deactivate this feature. 

While Pad Group is selected, click the Pad menu to assign the currently selected pad to a group. Select Group Off 
to un-assign the pad from any group. 

 

Pad Mute Pad Group Solo 
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Track Mute Mode 
 

Track Mute Mode lets you easily mute MIDI tracks within a sequence or set track groups, enabling you to 
mute multiple tracks at once.  

Important: Track Mute Mode applies to MIDI tracks only—not audio tracks. 

 

To enter Track Mute Mode, do any of the following: 

• Click the bars-and-X icon in the toolbar (if shown). 

• Click the down arrow () next to the other mode icons in the toolbar, and click Track Mute. 

• Click the menu icon (≡), and go to View > Mode and click Track Mute. 

 

 
 

While Track Mute is selected in the Mute panel, you can mute, unmute, or solo MIDI tracks (in a single sequence) in 
real time by pressing the pads. This is useful if you want to hear a sequence without a particular MIDI track (e.g., 
muting your keyboard track to focus on the bass) or if you want to isolate specific sounds or combinations of sounds 
that are separated by track. 

While Solo is selected in the Mute panel, you can solo or unsolo individual sounds (on a single track) in real time by 
pressing the pads. This is also useful if you want to isolate particular sounds, and can be more effective if you have a 
large number of pads to mute.  

Tip: This function is similar to, but more convenient than, muting MIDI tracks one at a time in the Track View. 

The Track Group feature in the Mute panel extends the concept of track mutes: you can mute or unmute multiple 
MIDI tracks (in a single sequence) by pressing one pad that you have assigned to a track group. This is useful if you 
want to hear a track without a particular group of sounds or if you want to isolate specific sounds in various 
combinations. You can create up to 16 different track groups. 

 

The upper half of the window displays the Arrangement View. See Modes > Arrange Mode to learn more about this. 

The lower half of the window can display the Pad Banks panel, Pads panel, Mute panel, and Project panel. Click 
the corresponding selector to show or hide each one. See General Features > Panels > Project to learn more 
about the Project panel. The other panels are described below: Pad Banks, Pads, and Mute. 
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Pad Banks 

 

The Pad Banks panel is an overview of all pads in all eight pad banks. Each pad represents a MIDI track in the 
current sequence. 

Click a pad bank to select it. 

While using the Track Mute function (selected in the Track Mute panel), click a pad to mute or unmute its track. 
Pads with muted tracks flash orange. Pads with unmuted tracks are yellow, or follow the track color. 

While using the Track Group function (selected in the Track Mute panel), click a pad to select its track to assign to 
a group. The pad with the selected track is green. Pads with tracks that belong to the same group flash yellow. 

While using the Solo function (selected in the Track Mute panel), click a pad to solo its track (muting all others). The 
pad with the soloed track is green. The colors of other pads will not change when using this feature. 

Track Mute Track Group Solo 

         

 

Pads 

 

The Pads panel represents 16 MIDI tracks (per bank) in the current sequence. If a pad’s track is assigned to a group, 
the group number will appear at the bottom of the pad. 

Click a pad bank to select it. 

While using the Track Mute function (selected in the Track Mute panel), click a pad to mute or unmute its track. 
Pads with muted tracks flash orange. Pads with unmuted tracks are yellow, or follow the track color. 

While using the Track Group function (selected in the Track Mute panel), click a pad to select its track to assign to 
a group. The pad with the selected track is green. Pads with tracks that belong to the same group flash yellow. 

While using the Solo function (selected in the Track Mute panel), click a pad to solo its track (muting all others). The 
pad with the soloed track is green. The colors of other pads will not change when using this feature. 

Track Mute Track Group Solo 
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Mute 

 

The Mute panel lets you configure how track mutes work. 

Click Track Mute to use Track Mute Mode normally. Clicking or pressing a pad will mute or unmute its track (and 
any tracks in the same group). 

Click Track Group to assign tracks to groups. Clicking or pressing a pad will select its track. 

While Track Group is selected, click the Track menu to assign the track of the currently selected pad to a group. 
Select Group Off to un-assign the track from any group. 

Click Solo to enable or disable the solo feature. When enabled, click a pad to solo its track (muting all others). 

Track Mute   Track Group  Solo 

   

 

The Audio Mute / Event Mute toggle allows you to separately mute audio or mute track events on tracks that 
contain both audio and MIDI paths, including Drum, Plugin, and Keygroup tracks. MIDI and CV tracks will apply 
Event Mute regardless of the selection, and Audio tracks will apply Audio Mute regardless of the selection.  

 

Click Settings to open the Track Mute Settings window: 

Check the Track Mute State Per Sequence box to maintain separate track mute statuses when changing 
sequences. This can allow you to create unique mute setups for each sequence, providing greater flexibility in 
live performance and arrangement creation. 

Check the Track Mute Events Write Automation box to capture track muting and soloing when recording 
automation. Make sure the global automation button is set to W (write) before recording to capture track 
automation.  

Check the Track Mute and Solo Events are Undoable to allow track mute and solo status to be undone and 
appear in the Undo History. 

Check the Use Track Colors box to apply each track’s color to the respective pads in the Pad Banks and Pads 
panels. 

Use the Solo Behavior function to select whether only a Single track can be soloed at a time, or multiple tracks 
can be soloed together (Multi). 

 

Click the Time Correct menu to select a time division to quantize track mutes in this mode. For example, while set to 
1 Bar, your mutes will always align with the beginning of the measure immediately after you press the pad. Select Off 
to deactivate this feature. 

 

 

 
 



  

 
214 

 

 
Next Sequence Mode 
 

Next Sequence Mode lets you trigger different sequences simply by playing the pads. This is useful for live 
performances, letting you change a song’s structure in real time. 

 

To enter Next Sequence Mode, do any of the following: 

• Click the double-arrow icon in the toolbar (if shown). 

• Click the down arrow () next to the other mode icons in the toolbar, and click Next Sequence. 

• Click the menu icon (≡), and go to View > Mode and click Next Sequence. 

 

 

 

In Next Sequence Mode, every pad is assigned to a sequence, starting from Pad A01 with Sequence 1 and 
ascending from there. 

In this mode, you can start playback and choose the sequence that plays next in real time. Select the next sequence 
by pressing its corresponding pad. Alternatively, allow the current sequence to repeat indefinitely. When you stop 
playback, you can copy the order of sequences you played into Song Mode to export it. 
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The upper half of the window displays a representation of the sequences that have played. 

 

 

 

The dark blue timeline at the top indicates the number of bars that have elapsed with each sequence. The white 
arrow () is the audio playhead, indicating the current playback position. 

Each block represents a sequence with miniature track note events. The sequence number and name is at the top of 
each block. A repeat symbol (||:) next to the sequence name indicates it is a repeat of the previous sequence. 

Use the sliders in the lower-right corner of this area (along each axis) to zoom in or zoom out. 

 

The lower half of the window can display the Sequence List panel, Pads panel, Performance Controls panel, and 
Project panel. Click the corresponding selector to show or hide each one. See General Features > Panels > 
Project to learn more about the Project panel. The other panels are described below: Sequence List, Pads, and 
Performance Controls. 

 

 

Sequence List 

 

The Sequence List panel shows a list of all available sequences in your project 
as well as their length and tempo. The currently selected one is highlighted. 
Select one by clicking or pressing its corresponding pad. 

The Sequence column shows the name of the sequence. 

The Length column indicates the length of the sequence in bars. 

The Tempo column indicates the tempo of the sequence in BPM. Keep in 
mind that each sequence will not play back at this tempo if the Seq/Gbl 
button in the toolbar is set to Gbl; if it is set to Seq, then each sequence 
follows its own tempo during playback. 

Note: To set the BPM of a sequence, select that sequence and then use 
(A) the BPM field in its Sequence section of the Inspector or (B) the BPM 
field in the toolbar (when set to Seq instead of Gbl). 
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Pads 

 

The Pads panel represents 16 sequences (per bank). Each pad shows the 
length of the sequence in bars, the tempo of the sequence in BPM, and the 
name of the sequence. (Keep in mind that each sequence will not play back at 
this tempo if the Seq/Gbl button in the toolbar is set to Gbl; if it is set to Seq, 
then each sequence follows its own tempo during playback.) 

Click a pad bank to select it. 

Click a pad to select its sequence. Pads with sequences will be lit bright 
yellow. Pads without sequences will be dim yellow. 

If a sequence on another pad will play next, that pad will flash green. 

During playback, the pad with the currently playing sequence will be lit green. 

 

 

 

 

 

 

Performance Controls 

 

The Performance Controls panel shows the available commands you can execute.  

 

As a sequence plays, you can use the buttons in this panel to change how 
playback works in this mode: 

Click Hold to repeat the current sequence indefinitely and temporarily 
ignore pad presses. Click it again to return to normal operation. This is 
useful if you want to select other pads without selecting them to play next. 

Click Sudden to switch to the currently selected sequence immediately. 
The new sequence will start playing whether or not the current sequence is 
done. This is useful in live performances if you need to switch to the next 
sequence instantly at a certain cue. 

Click Next Bar to switch to the currently selected sequence at the 
beginning of the next bar. This is useful if you want to switch to another 
sequence before the current one ends without having to worry about timing 
issues. 

If there is a sequence that will play next, you can click Clear to cancel it. 
The current sequence will continue playing or you can click or press a pad 
to select another sequence to play next. This option is available only if that 
sequence is not playing at that moment. 

 

While playback is stopped, you can use these buttons: 

While playback is stopped, click Copy to Song to copy the sequence playlist 
to a song (see the Song Mode chapter to learn about creating a song). 

While playback is stopped, click Erase Song to clear all sequences from 
the upper half of the window. 
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Song Mode 
 

Song Mode lets you arrange sequences in a specific order and/or repetition to create songs. You can edit 
the structure of a song during playback for easy, on-the-fly composing. 

A project can contain up to 32 songs, each consisting of up to 999 “steps.” Each step can have an 
assigned sequence as well as the number of times that sequence will repeat. 

 
To open Song Mode, do any of the following: 

• Click the musical-notes icon in the toolbar (if shown). 
• Click the down arrow () next to the other mode icons in the toolbar, and click Song. 
• Click the menu icon (≡), and go to View > Mode and click Song. 

Important: If a sequence is currently playing, stop playback before entering Song Mode. You cannot enter Song 
Mode during playback. 
 

 
 
In Song Mode, every pad is assigned to a sequence, starting from Pad A01 with Sequence 1 and ascending from there. 

In this mode, you can create a song as a list “steps.” Each step corresponds to a sequence and will play a certain 
number of times. 
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The upper half of the window displays a representation of the sequences in the song. 

 

 

 

The dark blue timeline at the top indicates the number of bars that have elapsed with each sequence. The white 
arrow () is the audio playhead, indicating the current playback position. 

 

Each block represents a sequence with miniature track note events. The sequence number and name is at the top of 
each block. A repeat symbol (||:) next to the sequence name indicates it is a repeat of the previous sequence. 

Click the blue bar at the top of each block to select that step in the song. The bar will be yellow when selected. 
If the step contains repetitions of a sequence, all repetitions in that step will be selected. 

Click the X in the blue bar at the top of a block to delete that step in the song. If the step contains repetitions of 
a sequence, all repetitions in that step will be deleted. 

 

Use the sliders in the lower-right corner of this area (along each axis) to zoom in or zoom out. 

 

The lower half of the window can display the Sequence List panel, Pads panel, Song Parameters panel, and 
Project panel. Click the corresponding selector to show or hide each one. See General Features > Panels > 
Project to learn more about the Project panel. The other panels are described below: Sequence List, Pads, and 
Song Parameters. 
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Sequence List 

 

The Sequence List panel shows a list of the steps of the song. Each step can 
have one sequence assigned to it and will show its information. The currently 
selected one is highlighted. Select one by clicking it. 

The Step column shows the number of the step. Each song can contain up 
to 999 steps.  

The Sequence column shows the number and name of the assigned 
sequence. Click this menu to select a different sequence. This is the same 
as the Step menu in the Song Parameters panel. 

The Rpts column indicates how many times the sequence plays. Click and 
drag this field up or down to set the number of repeats. Each step can play 
up to 999 times. You can set it to Hld (the lowest/minimum value) to set the 
sequence to repeat indefinitely until you stop playback. 

The BPM column indicates the tempo of the sequence in BPM. Keep in 
mind that each sequence will not play back at this tempo if the Seq/Gbl 
button in the toolbar is set to Gbl; if it is set to Seq, then each sequence 
follows its own tempo during playback. 

Note: To set the BPM of a sequence, select that sequence and then use 
(A) the BPM field in its Sequence section of the Inspector or (B) the BPM 
field in the toolbar (when set to Seq instead of Gbl). 

The Bars column indicates the length of the sequence in bars. 

 

 

Pads 

 

The Pads panel represents 16 sequences (per bank). Each pad shows the 
length of the sequence in bars, the tempo of the sequence in BPM, and the 
name of the sequence. (Keep in mind that each sequence will not play back at 
this tempo if the Seq/Gbl button in the toolbar is set to Gbl; if it is set to Seq, 
then each sequence follows its own tempo during playback.) 

The pad whose sequence is assigned to the currently selected step will flash 
green. 

Click a pad bank to select it. 

Click and drag a pad onto one of the following locations to use it in the song: 

• onto a step in the Sequence List panel or onto a block in the upper 
half of the window. This will replace its currently assigned sequence 
with the one you clicked and dragged onto it. 

• between two steps in the Sequence List panel or between two 
blocks in the upper half of the window. This will insert a step at that 
location and assign the sequence to it. 

If a sequence on another pad will play next, that pad will flash yellow. 

During playback, the pad with the currently playing sequence will be lit green. 
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Song Parameters 

 

The Song Parameters panel shows the available controls for Song 
Mode. You can use the buttons in this panel to edit the song. 

 

Click the Song menu to select the song you want to show. 

Double-click the name in this menu to rename the song. 

 

Click Convert > Seq to open the Convert Song window. In this window: 

Click the To Sequence menu to select the sequence that will use 
the converted song. 

Click the Track Status menu to select how you want to convert 
muted tracks. Select Include Muted Tracks if you want muted 
tracks to be included in the converted song. Select Ignore Muted 
Tracks if you want muted tracks to be excluded from the 
converted song. 

Click Do It to convert the song to that sequence, or click Close to 
close the window without converting. 

 

Click Clear to clear the entire sequence playlist (delete all steps) and 
the name of the song. 

 

Click Insert Step to insert a step after the currently selected one. 

 

Click Delete Step to delete the currently selected step. 

 

The Step menu shows the number and name of the sequence 
assigned to the currently selected step. Click this menu to select a 
different sequence. This is the same as the Sequence menu/column 
in the Sequence List panel. 

The First Bar and Last Bar values indicate the numbers of the bars 
(in the entire song) where the step starts and ends, respectively. 

The Total Bars value indicates the length of the sequence in bars. 

The Repeats value indicates how many times the sequence plays. 
Click and drag the Rpts field in the Sequence List panel up or 
down to set the number of repeats. Each step can play up to 999 
times. When this is set to Hold (the lowest/minimum value), the 
sequence to repeat indefinitely until you stop playback. 

The Time Sig value indicates the time signature of the sequence. 

The BPM value indicates the tempo of the sequence assigned to 
the currently selected step in BPM. Keep in mind that each 
sequence will not play back at this tempo if the Seq/Gbl button in 
the toolbar is set to Gbl; if it is set to Seq, then each sequence 
follows its own tempo during playback. 

 

To render/export your song as an audio file, click the menu icon (≡), 
and go to File > Export and click As Audio Mixdown. See General 
Features > Audio Mixdown to learn how to use this screen to export 
your song. 
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MIDI Control Mode 
 

You can use MIDI Control Mode to customize what MIDI messages are sent from certain controls on your 
MPC hardware. This custom “control map” will then work whenever you are in MIDI Control Mode. The 
edits you make in MIDI Control Mode will be retained with the current MPC project. 

 

To enter MIDI Control Mode, do any of the following: 

• Click the MIDI-controller icon in the toolbar (if shown). 

• Click the down arrow () next to the other mode icons in the toolbar, and click MIDI Control. 

• Click the menu icon (≡), and go to View > Mode and click MIDI Control. 

Important: Make sure your MPC hardware is connected to your computer and powered on. MIDI Control Mode is 
not functional without a connected MPC hardware unit. 

 

 

 

In the window, use the following fields and selectors to set each control’s parameters to your preference. The 
available parameters depend on its type: Pads, Buttons, Q-Link Knobs, and XY Pad. When you have set all of the 
parameters as desired, you can select another control or enter another mode. 

The software window will also display a graphical representation of your MPC hardware. Editable controls show their 
current MIDI message. Pads and Q-Link knobs show their current MIDI channels. 
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To select a control to edit, do one of the following: 

• Press or turn it on your MPC hardware. 

• Click it on the graphical representation of your MPC hardware. 

• Click the Control menu in the upper-left corner of the window and select one. 

Note: The Control menu may show many more hardware controls than are actually available on your MPC hardware. 
This is because the list includes all possible controls from all current MPC models (MPC Renaissance, MPC Studio, 
MPC Touch, etc.). 

 

 

Pads 

 

These are the MIDI parameters you can edit for each pad: 

Control: This is the hardware control you are currently editing (Pad 1–Pad 16). Click 
this menu to select another control. 

Bank: This is the pad bank of the current pad (A–H). If you select the Set All box, the 
pad’s messages and parameters will be identical across all eight banks. Click this 
menu to select another bank. 

Set All: Click this box to select or deselect it. When selected, the pad’s messages and 
parameters will be identical across all eight banks. When deselected, the pad’s 
messages and parameters will apply to the current pad only. 

Light LED: This determines how the pad’s LEDs will behave. Click this menu to select 
an option: 

When set to Never, the LEDs will always be off. 

When set to MIDI Input, the LEDs will light up when the software receives a MIDI 
message that matches the pad. 

When set to Local, the LEDs will light up when you press the pad and/or MIDI 
input is received. 

MIDI Ch: This determines which MIDI channel (1–16) the pad will use to send its 
message to the software. 

CC Number: This determines what MIDI Control Change number the pad will send to 
the software when you press it. 

Velocity: This determines whether the pad will be velocity-sensitive (On) or not (Off). 
When set to Off, pressing the pad will send a note at full-level (127) always. 

Aftertouch: This determines how the pad’s aftertouch (pressure applied to the pad 
after the initial press) behaves. 

Off: The pad will not send any aftertouch messages. 

Channel: If you press multiple pads that have this setting, the aftertouch messages 
they send will be identical. 

Poly: If you press multiple pads, the aftertouch message each pad sends will be 
independent from the others. 



  

 
223 

 

 

Buttons 
 

These are the MIDI parameters you can edit for each button: 

Control: This is the hardware control you are currently editing (Erase, Tap Tempo, 
Undo, Copy, etc.). Click this menu to select another option. 

Light LED: This determines how the button’s LED/LEDs will behave. Click this menu to 
select an option: 

When set to Never, the LEDs will always be off. 

When set to MIDI Input, the LEDs will light up when the software receives a MIDI 
message that matches the button. 

When set to Local, the LEDs will light up when you press the button and/or MIDI 
input is received. 

MIDI Ch: This determines which MIDI channel (1–16) the button will use to send its 
message to the software. 

CC Number: This determines what MIDI control change number the button will send to 
the software. 

Type: This determines whether the button will behave as a Momentary switch or 
Toggle (latching) switch. 

 

 

Q-Link Knobs 
 

These are the MIDI parameters you can edit for each Q-Link knob: 

Control: This is the hardware control you are currently editing (Q-Link 1–16). Click this 
menu to select another option. 

Light LED: Although you can edit this parameter, it does not actually have a function 
on your MPC hardware. Click this menu to select an option: 

When set to Never, the LEDs will always be off. 

When set to MIDI Input, the LEDs will light up when the software receives a MIDI 
message that matches the Q-Link knob. 

When set to Local, the LEDs will light up when you touch or turn the Q-Link knob 
and/or MIDI input is received. 

MIDI Ch: This determines which MIDI channel (1–16) the Q-Link knob will use to send 
its message to the software. 

CC Number: This determines what MIDI Control Change number the Q-Link knob will 
send to the software. 

Mode: This determines how the Q-Link knob will control its parameter. 

Absolute: The Q-Link knob’s current position determines its parameter’s value; 
moving it may cause its parameter to “snap” to a new position if you’re using it to 
control different parameters in different modes. 

Relative: Moving the Q-Link knob will increase or decrease its parameter 
regardless of its physical position. 

Low Range: This is the Q-Link knob’s lowest possible value (0–127). 

High Range: This is the Q-Link knob’s highest possible value (0–127). 

Touch Sense: This activates or deactivates the Q-Link knob’s touch-capacitive circuitry. 

On: You can touch the Q-Link knob to send a Note On message to the software 
(this is how your MPC hardware normally works). 

Off: The Q-Link knob will not send any Note On messages; it will only send CC 
messages when you turn it. 

Touch Note: This is the MIDI note number the Q-Link knob will send to the software 
when you touch it (0–127 or C-2 to G8). Touch Sense must be set to On for this to work. 
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XY Pad 

 

These are the MIDI parameters you can edit for each axis of the XY pad of your MPC 
hardware: 

Control: This is the axis you are currently editing (XYFX X-Axis or XYFX Y-Axis). 

Mute: This button determines whether the axis is muted or not. When muted, its MIDI 
output is disabled. You must be viewing the Settings to do this.  

MIDI Ch: This determines which MIDI channel (1–16) the axis will use to send its 
message to the software. 

CC Number: This determines what MIDI Control Change number the axis will send to 
the software. 

Low Range: This is the axis’s lowest possible value (0–127). 

High Range: This is the axis’s highest possible value (0–127). 
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Appendix 
 
Effects & Parameters 
 

This chapter lists the available effects and their parameters. To learn more about how effects work in general in the 
MPC 3 software, please see Operation > General Features > Effects. 

Effects with a * next to their name are not included with MPC and are available for purchase from thempcstore.com. 

Note: Some of these effects have a “sync” version (e.g., Flanger Sync, Autopan Sync, etc.) whose rates will be 
affected by the current tempo. While viewing the rate of these effects, a “.” next to the time division indicates a 
triplet-based rate. 

 

 

Delay/Reverb 
 

Options: AIR Delay, AIR Diff Delay, AIR Multitap Delay*, AIR Non-Lin Reverb, AIR Reverb, AIR Spring Reverb, 
Delay Analog Sync, Delay Analog, Delay HP, Delay LP, Delay Mono Sync, Delay Mono, Delay Multi-Tap, Delay 
Ping Pong, Delay Stereo, Delay Sync (Stereo), Delay Tape Sync, Reverb In Gate, Reverb Large 2, Reverb 
Large, Reverb Medium, Reverb Out Gate, Reverb Small, Sample Delay 

 

 

AIR Delay 

This is a classic delay line effect with a variable feedback 
filter. Additional Ratio and Width parameters enable you to 
achieve a wide range of stereo delay effects. 

Parameter Value Range Default Value 

Time 
Sync Off 
Sync On 

 
1 ms – 2.00 s 
1/32 – 8/4 

 
388 ms 
1/8D 

Sync Off, On Off 

Feedback 0–100% 40% 

Mix 0–100% (dry–wet) 50% 

Delay Ratio 50:100 – 100:50 100:100 

Delay HPF 20.0 Hz – 1.0 kHz 20.0 Hz 

Delay Width 0–100% 100% 

Feedback Damp 1.0 – 20.0 kHz 20.0 kHz 

Feedback Reso 0–100% 0% 

 Fdbk. Reso Freq 100 Hz – 10.0 kHz 1.0 kHz 

 

http://thempcstore.com
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AIR Diff Delay 

This is a delay line effect that is synchronized to 
your session tempo and uses an adjustable amount 
of diffusion to emulate the dissipation of echoes in 
reverberant space. 

Parameter Value Range Default Value 

Time 
Sync Off: 
Sync On: 

 
1 – 1000 ms 
1/64 – 4/4 (including 
Triplet and Dotted 
variations) 

 
161 ms 
1/16D 

Sync Off, On On 

Width 0–100% 100% 

Mix 0–100% (dry–wet) 40% 

Feedback 0–100% 50% 

Fdbk. Diffusion 0–100% 40% 

 Fdbk. High Damp 0–100% 35% 

 Low Cut 20.0 Hz – 1.00 kHz 20.0 Hz 

 Pan -100 – 0 – +100% 0% 

 

AIR Multitap Delay * 

This effect is a versatile, creative delay plugin with a 
wide range of applications from subtle stereo delays 
to complex repeating patterns. 

 
 

Parameter Value Range Default Value  

Delay   

Sync On: 1/16 – 8/4 4/4 

Sync Off: 0 ms – 4.00 s 2.25 s 

Feedback 0–100% 50% 

Mix -100.0 – 0.0 dB -50.0 dB 

From/To Varies Tap 5 / Input 

Sync Off, On On 

Low Cut 20.0 Hz – 1.00 kHz 500 Hz 

High Cut 1.00 kHz – 20.0 kHz 2.00 kHz 

1–5 Off, On On 

Tap Delay 10.0 ms – 10.0 s Varies 

Pan L100 – C – R100 Varies 

Level -Inf – 0.0 dB 0.0 dB 
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AIR Non-Lin Reverb 

This is a spatial effect, designed to produce synthetic, 
processed ambience with special gated and reversed reverb 
effects. 

Parameter Value Range Default Value 

Pre-Delay 0–250 ms 0 ms 

Dry Delay 0–1500 ms 0 ms 

Time 0–1000 ms 250 ms 

Mix 0–100% (dry–wet) 50% 

Diffusion 0–100% 100% 

Width 0–100% 50% 

Shape Gated, Reverse Gated 

Low-Cut 20.0 Hz–1.00 kHz 141 Hz 

High-Cut 1.00–20.0 kHz 9.46 kHz 

 

AIR Reverb 

This is a spatial effect, with a wide range of reverb types to add space or room to your audio signal. 

Tab Parameter Values Default Value 

Reverb Pre-Delay 0–250 ms 0 ms 

 Room Size 0–100% 100% 

 Time 0.4 ms – +inf s 1.9 s 

 Mix 0–100% 50% 

Early Reflection Type Off, Booth, Club, Room, Small 
Chamber, Medium Chamber, Large 
Chamber, Small Studio, Large 
Studio, Scoring Stage, 
Philharmonic, Concert Hall, Church, 
Opera House, Vintage 1, Vintage 2 

Off 

 Length 0–100% 100% 

 ER / Tail Mix 0–100% 50% 

Reverb Input Width 0–100% 0% 

 Output Width 0–100% 0% 

 Delay 0–250 ms 0 ms 

Room Ambience 0–100% 0% 

 Density 0–100% 100% 

Hi/Lo Freq    

Hi Freq Time -100 – 0 – 100% 0% 

 Freq 2.00 – 20.0 kHz 6.32 kHz 

 Cut 1.0 – 20.0 kHz 9.46 kHz 

Lo Freq Time -100 – 0 – 100% 0% 

 Freq 20.0 Hz – 2.00 kHz 200 Hz 

 Cut 1 – 1000 Hz 1 Hz 
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AIR Spring Reverb 

This is a spatial effect, designed to emulate the sound of a 
spring reverb tank. 

Parameter Value Range Default Value 

Pre-Delay 0–250 ms 3 ms 

Time 1.0–10.0 s 4.0 s 

Mix 0–100 (dry–wet) 50% 

Diffusion 0–100% 100% 

Width 0–100% 0% 

Low Cut 20.0 Hz –1.0 kHz 141 Hz 

 

Delay Analog Sync 

Analog Delay is similar to Mono Delay, except that it’s 
designed to emulate an analog “Bucket Brigade”-style delay. 
This delay has a unique character to it that gives a warmer 
sound by adding subtle inaccuracies in phase and timing. 

Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 50 

Time 1 bar – 1/16 triplets 1/4 

Feedback 0–100 50 

Ramp 0–100 50 

 

Delay Analog 

Analog Delay is similar to the Mono Delay, except that it’s 
designed to emulate an analog “Bucket Brigade”-style delay. 
This delay has a unique character to it that gives a warmer 
sound by adding subtle inaccuracies in phase and timing. 

Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 50 

Time 2–2000 ms 100 

Feedback 0–100 25 

 

Delay HP 

HP Delay is identical to the Mono Delay, but it uses a 
resonant high-pass filter in the delay line. 

Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 50 

Time 2–2000 ms 100 

Feedback 0–100 50 

Cutoff 0–100 33 

Resonance 0–100 33 

 

Delay LP 

LP Delay is identical to the Mono Delay, but it uses a 
resonant low-pass filter in the delay line. 

Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 50 

Time 2–2000 ms 500 

Feedback 0–100 50 

Cutoff 0–100 50 

Resonance 0–100 20 
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Delay Mono Sync 

This mono effect delays the original signal for a specified 
period of time (synced to the project tempo) and plays it 
back over an adjustable period of time. 

Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 50 

Time 1 bar – 1/16 triplets 1/4 

Feedback 0–100 50 

Damping 0–100 100 

 

Delay Mono 

This mono effect delays the original signal for a specified 
period of time and plays it back over an adjustable period of 
time. 

Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 50 

Time 2–2000 ms 100 

Feedback 0–100 25 

Damping 0–100 100 

 

Delay Multi-Tap 

This delay is a mono delay which has three delay generators 
with independently adjustable delay times and stereo 
position. 

Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 50 

Time 1 2–2000 ms 100 

Time 2 2–2000 ms 100 

Time 3 2–2000 ms 100 

Feedback 0–100 25 

Pan 1 0–100 50 

Pan 2 0–100 50 

Pan 3 0–100 50 

Damping 0–100 100 

Gain 1 0–100 25 

Gain 2 0–100 25 

Gain 3 0–100 25 

 

Delay Ping Pong 

This stereo delay allows you to set different delay times for 
its left and right repeats. 

Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 50 

Time, Left 2–2000 ms 100 

Time, Right 2–2000 ms 100 

Feedback 0–100 25 

Damping 0–100 100 
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Delay Stereo 

Stereo Delay operates similarly to Mono Delay but in true 
stereo. 

Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 50 

Time 2–2000 ms 100 

Feedback 0–100 25 

Damping 0–100 100 

 

Delay Sync (Stereo) 

This effect is the same as Delay Stereo but is synced to the 
project tempo. 

Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 50 

Time 1 bar – 1/16 triplets 1/4 

Feedback 0–100 50 

Damping 0–100 100 

 

Delay Tape Sync 

Tape Delay emulates a delay system using an analog tape 
loop and a series of tape heads to produce an echo effect. 
This delay type yields a very distinct echo sound often heard 
in reggae and dub-style music. 

Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 50 

Time 1 bar – 1/16 triplets 1/4 

Feedback 0–100 50 

Ramp 0–100 50 

Head 1 0–100 100 

Head 2 0–100 0 

Head 3 0–100 0 

Head 4 0–100 0 

Tone 0–100 50 

Spread 0–100 50 

Wow & Flutter 0–100 50 

 

Reverb In Gate 

This is a hall reverb with an additional control. The reverb 
effect is cut off when the input drops below the level set in 
the Gate In parameter. 

Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 50 

Pre-Delay 1–100 50 

Early Reflection 0–100 50 

Density 0–100 50 

Diffuse 0–100 50 

Decay 0–100 75 

Lo-Cut 0–100 10 

Hi-Cut 0–100 10 

Gate In 0–100 0 
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Reverb Large 2 

This is a less CPU-intensive spatial effect, emulating the 
sound of a large hall. 

Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 50 

Pre-Delay 1–100 50 

Early Reflection 0–100 50 

Density 0–100 50 

Diffuse 0–100 50 

Decay 0–100 75 

Lo-Cut 0–100 10 

Hi-Cut 0–100 10 

 

Reverb Large 

This is a spatial effect, designed to emulate the sound of a 
large hall. 

Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 50 

Pre-Delay 1–100 50 

Early Reflection 0–100 50 

Density 0–100 50 

Diffuse 0–100 50 

Decay 0–100 75 

Lo-Cut 0–100 10 

Hi-Cut 0–100 10 

 

Reverb Medium 

This is a spatial effect, designed to emulate a medium room. Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 50 

Pre-Delay 1–100 50 

Early Reflection 0–100 50 

Density 0–100 50 

Diffuse 0–100 50 

Decay 0–100 50 

Lo-Cut 0–100 15 

Hi-Cut 0–100 10 
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Reverb Out Gate 

This is a hall reverb that has an additional control. The reverb 
effect is cut off when the output drops below the level set in 
the Gate Out parameter. 

Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 50 

Pre-Delay 1–100 50 

Early Reflection 0–100 50 

Density 0–100 50 

Diffuse 0–100 50 

Decay 0–100 75 

Lo-Cut 0–100 10 

Hi-Cut 0–100 10 

Gate Out 0–100 0 

 
 

Reverb Small 

This is a spatial effect, designed to emulate a small room. Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 50 

Pre-Delay 1–100 50 

Early Reflection 0–100 50 

Density 0–100 50 

Diffuse 0–100 50 

Decay 0–100 50 

Lo-Cut 0–100 15 

Hi-Cut 0–100 10 

 

Sample Delay 

This effect is a utility delay plugin that can delay the left and 
right channels by different, small amounts to loosen 
percussion elements or add stereo width. 

Parameter Value Range Default Value 

Left / Right 0–11025 Samples 
or 
0.0–250.0 ms 

0 Samples 
or 
0.0 ms 

Samples / MS Samples, MS Samples 

Link Off, On Off 
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Dynamics 
 

Options: AIR Channel Strip, AIR Compressor, AIR Expander*, AIR Limiter, AIR Maximizer, AIR Noise Gate, AIR 
Pumper, AIR Transient, Bus Compressor, Compressor Opto, Compressor VCA, Compressor Vintage, Mother 
Ducker Input, Mother Ducker, Transient Shaper 

 

AIR Channel Strip 

This specially-designed plugin combines multiple effects with a fast interface. The EQ section provides a highpass 
filter, low and high shelves, and a fully parametric mid-band. For dynamics, the AIR Compressor and Gate algorithms 
are perfect for achieving hard-hitting drum sounds. 

Tab Parameter Value Range Default Value 

 EQ Enable Enabled, Bypass Enabled 

 Gate Enable Enabled, Bypass Enabled 

 Comp Enable Enabled, Bypass Enabled 

 Output -Inf – +24.00 dB 0.00 dB 

EQ High Shelf Gain -12.0 – +12.0 dB 0.0 dB 

 High Shelf Freq 1.20 – 20.0 kHz 6.00 kHz 

 Mid Gain -18.0 – +18.0 dB 0.0 dB 

 Mid Freq 40.0 Hz – 16.0 kHz 247 Hz 

 Mid Q 0.40 – 10.00 1.00 

 Low Shelf Gain -12.0 – +12.0 dB 0.0 dB 

 Low Shelf Freq 20.0 Hz – 1.00 kHz 100 Hz 

 HP Filter 0 – 1000 Hz 0 Hz 

Gate/Comp Gate Thresh -120.0 – 0.0 dB -120.0 dB 

 Gate Depth 0 – -120.0 dB -120.0 dB 

 Gate Attack 0.01 – 1000.00 ms 0.18 ms 

 Gate Release 1.00 – 3000.00 ms 7.40 ms 

 Comp Thresh 0.0 – -60.0 dB 0.0 dB 

 Comp Ratio 1.0:1 – 100.0:1 3.9:1 

 Comp Attack 100 us – 300 ms 5.48 ms 

 Comp Release 10.0 ms – 4.00 s 200 ms 
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AIR Compressor 

This basic compressor effect changes the dynamic 
range of a signal by automatically reducing its gain if it 
exceeds a certain level (the threshold). 

Parameter Value Range Default Value 

Threshold -60.0 – 0 dB -48.0 dB 

Ratio 1.0:1 – 100.0:1 3.9:1 

Output 0.0 – 30.0 dB 15.0 dB 

Mix 0–100% (dry-wet) 100% 

Knee 0–100% 50% 

Attack 100 us – 300 ms 5.48 ms 

Release 10.0 ms – 4.00 s  200 ms 

 

AIR Expander * 

This effect is a vital dynamic processor to reduce and 
remove the unwanted quieter elements of your tracks. 

 
 

Parameter Value Range Default Value 

Threshold -40.0 – 0.0 dB -15.4 dB 

Output -20.0 – 0.0 – +20.0 dB 0.0 dB 

Ratio 1:1.0 – 1:100 1:10 

Range 0.0 – 40.0 dB 40.0 dB 

Attack 10.0 us – 100 ms 1.00 ms 

Release 10.0 ms – 10.0 s 166 ms 

 

AIR Limiter 

This is a lookahead limiter perfect for mastering or 
mixing.  

Parameter Value Range Default Value 

Gain -12.0 – 36.0 dB 0.0 dB 

Ceiling -24.0 – 0.0 dB 0.0 dB 

Look Ahead 0.0 – 20.0 ms 0.0 ms 

Release 10.0 ms – 10.0 s 316 ms 

 LF Mono 10.0 Hz – 1.00 kHz 10.0 Hz 

 

AIR Maximizer 

This effect is a limiter optimized for professional 
mastering.  

Parameter Value Range Default Value 

Threshold -40.0 – 0.0 dB -20.0 dB 

Ceiling -20.0 – 0.0 dB FS -5.0 dB FS 

Look Ahead 0.0 – 20.0 ms 0.0 ms 

Knee Hard, Soft Hard 

Release 10.0 ms – 10.0 s 316 ms 

LF Mono 10.0 Hz – 1.00 kHz 10.0 Hz 
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AIR Noise Gate 

This effect is similar to a compressor, but instead of 
attenuating audio signal that rises above a threshold, a noise 
gate attenuates audio signal that falls below a threshold by a 
set amount. This can help reduce background noise in your 
audio signal. 

Parameter Value Range Default Value 

Threshold -120.0 – 0.0 dB -48.0 dB 

Depth 0 dB – -120.0 dB -120 dB 

Denoise Filter Off, On Off 

Denoise Thresh -120.0 – 0.0 dB -60.0 dB 

Attack 0.01 – 1000.00 ms 0.18 ms 

Hold 0 – 1000 ms 250 ms 

 Release 1.00 – 3000.00 ms 7.40 ms 

 

AIR Pumper 

This effect creates a rhythmic pumping effect, similar to that 
of sidechain compression. 

Parameter Value Range Default Value 

Depth 0–100% 80% 

Speed Bar, 1/2 – 1/32T 1/4 

Release Shape 0–100% 10% 

Trigger Offset -100.0 – +100.0 ms 0.0 ms 

Attack 0–100% 5% 

Hold 0–100% 10% 

 Release 0–100% 60% 

 

AIR Transient 

This effect is used to enhance or soften the Attack and 
Release phases of audio material. 

Parameter Value Range Default Value 

Attack -100 – 0 – +100% 0% 

Attack Shape 0–100% 50% 

Sustain -100 – 0 – +100% 0% 

Output -20.0 – +20.0 dB 0.0 dB 

Limit Off, On On 

 

Bus Compressor 

This is the most transparent compressor, able to perform 
substantial volume adjustments without artifacts. 

Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 100 

Attack 0–100 50 

Release 0–100 50 

Threshold -50 – 0 dB 0 

Ratio 1–20 1 

Oldskool Off, On Off 

Output -6 – 24 dB 0 
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Compressor Opto 

The Opto Compressor is modeled after a vintage 
compressor type using an optical circuit to control the 
volume reduction of the input signal. These compressors are 
usually associated with soft and unobtrusive attack and 
release characteristics. 

Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 100 

Input -6 – 18 dB 0 

Attack 0–100 50 

Release 0–100 50 

Threshold -50 – 0 dB 0 

Ratio 1–20 1 

Knee 1–100 1 

Output -6 – 24 dB 0 

 

Compressor VCA 

This compressor is more modern-sounding, with a slightly 
more transparent sound. A VCA Compressor tends to have 
quicker attack and release times than an Opto Compressor. 

Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 100 

Input -6 – 18 dB 0 

Attack 0–100 50 

Release 0–100 50 

Threshold -50 – 0 dB 0 

Ratio 1–20 1 

Knee 1–100 1 

Output -6 – 24 dB 0 

 

Compressor Vintage 

This compressor has a sound similar to classic tube 
compressors, with their gentle yet pumping response and a 
dash of tube saturation. 

Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 100 

Input -6 – 18 dB 0 

Attack 0–100 50 

Release 0–100 50 

Threshold -50 – 0 dB 0 

Ratio 1–20 1 

Knee 1–100 1 

Output -6 – 24 dB 0 
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Mother Ducker Input 

Add this effect as an insert to the track you want to use as a 
trigger input, such as a kick drum track. 

Parameter Value Range Default Value 

To Bus 1–8 Bus 1 

 

Mother Ducker 

Add this effect as an insert to the track you want to have the 
ducking effect applied to. Use the meters to monitor the 
level from your trigger input and tweak the Threshold and 
Ratio parameters to adjust the amount of ducking. The 
Attack and Release parameters can be used to sculpt the 
envelope of the gain reduction to achieve exactly the 
pumping effect you are after. Mother Ducker has eight 
internal buses so you can set up multiple channel strips with 
ducking effects from different sources. 

Parameter Value Range Default Value 

Ratio 1.00:1 – 60.00:1 6.00:1 

Knee 0.000 – 6.000 dB 0.000 dB 

Attack 1.0 – 1000.0 ms 10.0 ms 

Release 1.0 – 1000.0 ms 100.0 ms 

Threshold -100.000 – 0.000 dB -6.021 dB 

Gain -100.000 – +12.000 dB  -0.000 dB 

Auto Gain On, Off On 

From Bus 1–8 Bus 1 

 

Transient Shaper 

A transient shaper can be used to enhance or soften the 
Attack and Release phases of audio material. 

Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 100 

Attack 0–100 50 

Release 0–100 50 

Output 0–100 50 

 

 

EQ/Filter 
 

Options: Options: AIR Enhancer, AIR Filter Gate, AIR Filter, AIR Kill EQ, AIR Para EQ, AIR Vintage Filter*, HP 
Filter Sweep, HP Filter Sync, HP Filter, HP Shelving Filter, LP Filter Sweep, LP Filter Sync, LP Filter, LP 
Shelving Filter, PEQ 2-Band, 2-Shelf, PEQ 4-Band 

 
 

AIR Enhancer 

This effect enhances the low and high 
broadband frequencies of the audio signal. 

Parameter Value Range Default Value 

High Gain 0.0 – 12.0 dB 0.0 dB 

Low Gain 0.0 – 12.0 dB 0.0 dB 

Output - Inf – 0.0 dB 0.0 dB 

Freq. High 1.0 – 10.0 kHz 3.16 kHz 

Freq. Low 40.0 – 640 Hz 160 Hz 

Harmonics 0.0 – 12.0 dB 0.0 dB 

Phase + (positive), - (negative) + 
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AIR Filter Gate 

This effect chops your audio signal into 
rhythmic patterns with variable filtering, 
amplitude and panning. 

Parameter Value Range Default Value 

Pattern Straight, Pulse, Pumper, Marching, 
Fader, Offbeats, Off+Pan, L/R Pan, 
LL/RR Pan, Slow Pan, Rand Pan, 
Shorter, Longer, Reverse, Random, 
Keyed 1–2, Half Time, 12-Step, 
Ducked, Trance 1–6, Tech 1–6 

Straight 

Rate 1/2–1/32, including Dotted and Triplet 1/16 

Swing 50.0–66.7% 50.0% 

Mix 0–100% 100% 

Filter Mode Off, LP, BP, HP, Phaser LP 

Filter Cutoff -100 – 0 – 100% 0% 

Filter Reso -100 – 0 – 100% 0% 

Gate Attack 0–100% 25% 

Gate Hold 0–100% 50% 

Gate Release 0–100% 25% 

Mod LFO Wave Random; 2–12, 16, 24, 32, 48, 64, 
96, 128, 192, 256 Steps 

Random 

Mod Env -100 – 0 – 100% 0% 

Mod LFO 0–100% 0% 

 

AIR Filter 

This effect applies a filter to the audio 
signal and then applies selectable 
saturation or reduction to the filtered 
signal. 
 
 

Parameter Value Range Default Value 

Cutoff Freq 55.0 Hz – 20.0 kHz 20.0 kHz 

Reso Factor 0.7 – 20.0 1.0 

Type LP4–1, BP2, BP4, HP2_LP1, 
HP3_LP1, HP4–1, BR2, BR4, 
BR2_LP1, BR2_LP2, HP1_BR2, 
BP2_BR2, HP1_LP2, HP1_LP3, 
AP3, AP3_LP1, HP1_AP3 

LP4 

Output Gain -Inf dB – 0.0 dB 0.0 dB 

Saturation 
Type 

Resample, Bit Crush, Rectify, Hard 
Clip, Distort, Overdrive 

Overdrive 

Saturation 
Drive 

0.0 – 12.0 dB 0.0 dB 

Saturation 
Mode 

DCF, CVF DCF 
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AIR Kill EQ 

This effect can zap out the Low, Mid or High broadband 
frequency from an audio signal.  

Parameter Value Range Default Value 

High Thru, Kill Thru 

Mid Thru, Kill Thru 

Low Thru, Kill Thru 

Output -20.0 – +20.0 dB 0.0 dB 

High Gain -Inf – +12.0 dB 0.0 dB 

Mid Gain -Inf – +12.0 dB 0.0 dB 

 Low Gain -Inf – +12.0 dB 0.0 dB 

 High Freq. 500 Hz – 8.00 kHz 2.00 kHz 

 Offset -100 – +100% 0% 

 Low Freq. 50.0 – 800 Hz 200 Hz 

 

 

AIR Para EQ 

This effect is a powerful four-band parametric equalizer with 
four independent EQ ranges, adjustable Low and High EQ 
filter types, and dedicated Low Cut and High Cut. 

Parameter Value Range Default Value 

High Freq 1.2 – 20.0 kHz 6.00 kHz 

High Q 
Shelf 
Bell 

 
0.40 – 2.00 
0.40 – 10.00 

 
1.00 
1.00 

High Gain 
Shelf 
Bell 

 
-12.0 – +12.0 dB 
-18.0 – 18.0 dB 

 
0.0 dB 
0.0 dB 

High Type Shelf, Bell Shelf 

High Out/In Out, In  

High Mid Freq 120 Hz – 16.0 kHz 2.00 kHz 

High Mid Q 0.40 – 10.00 1.00 

High Mid Gain -18.0 – 18.0 dB 0.0 dB 

High Mid Out/In Out, In  

Low Mid Freq 40.0 Hz – 16.00 kHz 247 Hz 

Low Mid Q 0.40 – 10.00 1.00 

Low Mid Gain -18.0 – 18.0 dB 0.0 dB 

 Low Mid Out/In Out, In  

 Low Freq 20.0 Hz – 1.00 kHz 100 Hz 

 Low Q 
Shelf 
Bell 

 
0.40 – 2.00 
0.40 – 10.00 

 
1.00 
1.00 

 Low Gain 
Shelf 
Bell 

 
-12.0 – +12.0 dB 
-18.0 – 18.0 dB 

 
0.0 dB 
0.0 dB 

 Low Type Shelf, Bell Shelf 
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AIR Para EQ (continued) 

 Parameter Value Range Default Value 

Low Out/In Out, In  

Output -20.0 – +20.0 dB 0.0 dB 

High Cut 
Freq 

120 Hz – 20.0 kHz 20.0 kHz 

High Cut Type 6, 12, 18, 24 dB 12 dB 

High Cut Out/In Out, In  

Low Cut Freq 20.0 Hz – 8.00 kHz 100 Hz 

Low Cut Type 6, 12, 18, 24 dB 12 dB 

Low Cut Out/In Out, In  

 

AIR Vintage Filter * 

This effect is a powerful filter plugin for bringing 
those classic analog filter sounds to your tracks, 
perfect for synths, guitars plus loads more. 

 
 

Parameter Value Range Default Value 

Cutoff 20.0 Hz – 20.0 kHz 878 Hz 

Resonance 0–100% 0% 

Fat 0–200% 200% 

Mode LP24, LP18, LP12, BP, HP LP18 

Attack 10.0 ms – 10 s 10.0 ms 

Release 10.0 ms – 10 s 966 ms 

Env. Depth -100 – 0 – +100% +37% 

Sync Off, On On 

Rate   

Sync On: 16 – 8/4 4T 

Sync Off: 0.01–10.0 Hz 2.54 Hz 

LFO Depth 0–100% 61% 

 Output –Inf dB — 0.0 dB 0.0 dB 

 

 

HP Filter Sweep 

This effect is a high-pass filter with its cutoff frequency 
modulated by an LFO. 

Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 80 

Low Frequency 0–100 50 

High Frequency 0–100 100 

Resonance 0–100 33 

Rate 0–100 10 
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HP Filter Sync 
This effect is a high-pass filter with its cutoff frequency 
modulated by an LFO. 

Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 100 

Low Frequency 0–100 0 

High Frequency 0–100 100 

Resonance 0–100 50 

Rate 8 bars – 1/32 1/4 

 

HP Filter 

This effect is a static filter without modulation. Parameter Value Range Default Value 

Frequency 10–19999 Hz 1500 

Resonance 0–100 0 

 

HP Shelving Filter 
This filter differs from the standard filter type, as it attenuates 
all frequencies after the cutoff point equally. 

Parameter Value Range Default Value 

Frequency 10–19999 Hz 1500 

Resonance 0–100 0 

Gain -18.0 – 18.0 dB 0.0 

 

LP Filter Sweep 
This effect is a low-pass filter with its cutoff frequency 
modulated by an LFO. 

Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 80 

Low Frequency 0–100 0 

High Frequency 0–100 100 

Resonance 0–100 33 

Rate 0–100 10 

 

LP Filter Sync 
This effect is a low-pass filter with its cutoff frequency 
modulated by an LFO. 

Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 100 

Low Frequency 0–100 0 

High Frequency 0–100 100 

Resonance 0–100 50 

Rate 8 bars – 1/32 1/4 

 

LP Filter 
This effect is a static filter without modulation. Parameter Value Range Default Value 

Frequency 10–19999 Hz 1500 

Resonance 0–100 0 
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LP Shelving Filter 
This filter differs from the standard filter type, as it attenuates 
all frequencies after the cutoff point equally. 

Parameter Value Range Default Value 

Frequency 10–19999 Hz 1500 

Resonance 0–100 0 

Gain -18.0 – 18.0 dB 0.0 

 
 

PEQ 2-Band, 2-Shelf 

This effect is a combination of one two-band parametric 
equalizer and two shelving filters. 

Parameter Value Range Default Value 

Low Frequency 22–1000 Hz 220  

Frequency 1 82–3900 Hz 820  

Frequency 2 220–10000 Hz 2200  

High Frequency 560–19999 Hz 5600  

Q1 0–100 0 

Q2 0–100 0 

Low Gain -18.0 – 18.0 dB 0.0  

Gain 1 -18.0 – 18.0 dB 0.0  

Gain 2 -18.0 – 18.0 dB 0.0  

High Gain -18.0 – 18.0 dB 0.0  

 

PEQ 4-Band 

This effect is a powerful four-band parametric equalizer with 
four independent EQ ranges. 

Parameter Value Range Default Value 

Low Frequency 22–1000 Hz 220 

Frequency 1 82–3900 Hz 820  

Frequency 2 220–10000 Hz 2200  

High Frequency 560–19999 Hz 5600  

Q1 0–100 5 

Q2 0–100 5 

Q3 0–100 5 

Q4 0–100 5 

Gain 1 -18.0 – 18.0 dB 0.0  

Gain 2 -18.0 – 18.0 dB 0.0 

Gain 3 -18.0 – 18.0 dB 0.0  

Gain 4 -18.0 – 18.0 dB 0.0  
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Harmonic 
 

Options: AIR Amp Sim, AIR Diode Clip, AIR Distortion, AIR Flavor, AIR Freq Shift, AIR Lo-Fi, AIR Talk Box, AIR 
Tube Drive, Decimator, Distortion Amp, Distortion Custom, Distortion Fuzz, Distortion Grimey, Distortion 
Overdrive, Frequency Shifter, Granulator, Resampler, TouchFX, XYFX 

 

AIR Amp Sim 

This effect simulates guitar and bass amplifiers with a 
wide range of available cabinet models and tone shaping 
options. 

Parameter Value Range Default Value 

Cab Model D.I., Brit, 1x8”, 1x12”, 
2x10”, 2x12”, 4x10”, 
4x12”, 1x15” Bass, 
4x10” Bass, Radio 

4x10” 

Drive 0.0–11.0 0.0 

Mode Mono, Stereo Stereo 

Output -12.0 – 0.0 – +12.0 dB 0.0 dB 

Soft Clip 0–100% 0% 

Top Boost 0–100% 0% 

Bias 0–100% 0% 

Bass -12.0 – 0.0 – +12.0 dB -12.0 dB 

Mid -12.0 – 0.0 – +12.0 dB 0.0 dB 

Mid Freq 250 Hz – 4.00 kHz 1.00 kHz 

Treble -12.0 – 0.0 – +12.0 dB 0.0 dB 

 

AIR Diode Clip 

This is a distortion effect that can be used for anything 
from adding subtle grit to drum breaks to aggressive 
distorted mayhem. 

Parameter Value Range Default Value 

Input HP 200 – 800 Hz 500 Hz 

Env Speed 0–100% 50% 

Output HP 1000 – 4000 Hz 2000 Hz 

Output LP 1000 – 12000 Hz 6000 Hz 

Wide Off, On Off 

Solo Off, On Off 

 Oversampling Off, On On 

 Level -inf – 0.0 – +12.0 dB 0.0 dB 
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AIR Distortion 

This effect is a multi-type distortion that adds color to your 
audio signal with varying types and amounts of distortion. 

Parameter Value Range Default Value 

Mode Hard, Soft, Wrap Hard 

Drive 0 – 60 dB 15 dB 

Output 0–100% 100% 

Mix 0–100% (dry-wet) 100% 

Tone Pre-Shape -100 – 0 – +100% 0% 

 Tone High Cut 1.00 – 20.0 kHz 20.0 kHz 

 Stereo On, Off Off 

 Clipping Thresh. -20.0 – 0.0 dB FS -10.0 dB FS 

 Clipping Edge 0–100% 0% 

 

AIR Flavor 

This effect applies EQ simulations of radios, phones, tape 
machines, and more to dramatically change the timbre of 
your sound. 

Parameter Value Range Default Value 

Timbre Varies Neutral 

Timbre Depth 0–100% 100% 

Vinyl Distortion 0–100% 0% 

Vinyl Noise 0–100% 0% 

Flutter 0–100% 0% 

 Monofy 0–100% 0% 

 

AIR Freq Shift 

This effect shifts the audio signal's individual frequencies for 
unique effects. 

Parameter Value Range Default Value 

Mode Up, Down, Up & 
Down, Stereo 

Up 

Frequency 10.0 mHz – 10.0 kHz 316 mHz 

Feedback 0–100% 0% 

Mix 0–100% (dry–wet) 100% 
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AIR Lo-Fi 

This effect is used to bit-crush, down-sample, clip, rectify and mangle an audio signal. 
 

Tab Parameter Value Range Default Value 

Lo-Fi Bit Depth 1.0 – 16.0 bit 16.0 bit 

 Sample Rate 500 Hz – 50.0 kHz 50.0 kHz 

 Mix 0–100% 100% 

Distortion Clip 0.0 – 40.0 dB 0.0 dB 

 Rectify 0–100% 0% 

 Noise Mod 0–100% 0% 

Anti-Alias Pre 0.125 – 2.000 Fs 0.5000 Fs 

 Post 0.125 – 2.000 Fs 1.000 Fs 

 Enable On, Off Off 

LFO / Env Wave Sine, Tri, Saw, Square, Morse, 
S&H, Random 

Sine 

 Rate 
Sync Off: 
Sync On: 

 
0.01 – 10.0 Hz 
8/4 – 16 

 
1.00 Hz 
2T 

 Sync On, Off Off 

 Depth -100 – 0 – 100% 0% 

 Attack 0.1 – 10.0 s 0.5 s 

 Release 0.1 – 10.0 s 0.5 s 

 Depth -100 – 0 – 100% 0% 

 

AIR Talk Box 

This effect adds voice-like resonances to 
audio signals.  

Parameter Value Range Default Value 

Vowel OO, OU, AU, AH, AA, AE, EA, EE, 
EH, ER, UH, OH, OO 

AH 

Env Depth -100 – 0 – +100% 0% 

Formant -12.00 – +12.00 0.00 

Mix 0–100% 100% 

LFO Wave Sine, Tri, Saw, Square, S&H, 
Random 

Sine 

LFO Rate 
Sync Off: 
Sync On: 

 
0.01 – 10.0 Hz 
8/4 – 16 

 
1.00 Hz 
2T 

 LFO Sync Off, On Off 

 LFO Depth -100 – 0 – +100% 0% 

 Env Thresh -60.0 – 0.0 dB -30.0 dB 

 Env Attack 0.1 – 10.0 s 0.5 s 

 Env Release 0.1 – 10.0 s 0.5 s 
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AIR Tube Drive 

This effect is designed to reproduce the sound of an 
overdriven tube amplifier. 

Parameter Value Range Default Value 

Drive 0–100% 0% 

Headroom -30.0 – 0.0 dB -15.0 dB 

Saturation 0–100% 50% 

Output -20.0 – +20.0 dB 0.0 dB 

 

Decimator 

Decimator down-samples the incoming signal by removing 
bits from the digital signal. The difference between 
decimation and resampling is that Decimator does not use 
any filtering to mask or correct digital artifacts. The result is 
an effect ranging from mild to almost completely pure digital 
distortion, depending on the setting and the source material. 

Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 100 

Decimate 0–100 0 

Bit Reducer 4–32 32 

 

Distortion Amp 

This effect is designed to reproduce the sound of a tube 
amplifier at high volumes. 

Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 100 

Drive 0–100 50 

Tone 0–100 50 

Dynamics 0–100 50 

Output 0–100 50 

 

Distortion Custom 

This effect is a highly customized distortion, capable of a 
wide range of useable sounds. 

Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 100 

Drive 0–100 50 

+Soft 5–75 2 

+Clip 5–50 25 

–Soft 5–75 2 

–Clip 5–50 25 

Low -18.0 – 18.0 dB 0.0  

Mid -18.0 – 18.0 dB 0.0  

High -18.0 – 18.0 dB 0.0  

Output -18.0 – 18.0 dB 50  
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Distortion Fuzz 

This popular effect uses hard clipping of the audio signal, 
which, at extreme settings, can turn a standard waveform 
into a square wave, producing a “razor” effect. 

Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 100 

Drive 0–100 50 

Output 0–100 50 

Low 0–100 50 

Low-Mid 0–100 50 

High-Mid 0–100 50 

High 0–100 50 

 

Distortion Grimey 

This is a unique distortion effect that distorts a frequency 
range in a selectable band. 

Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 100 

Drive 0–100 50 

Grime 0–100 50 

Center 0–100 50 

Width 0–100 50 

Resonance 0–100 50 

Output 0–100 50 

 

Distortion Overdrive 

This distortion is designed to sound like a mildly distorting 
amplifier at medium volumes. It is the smoothest distortion 
type available. 

Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 100 

Drive 0–100 50 

Tone 0–100 50 

Output 0–100 50 

 

Frequency Shifter 

A frequency shifter changes the frequencies of an input 
signal by a fixed amount and alters the relationship of the 
original harmonics. This can produce a chorus-like effect as 
well as very crazy artificial timbres. 

Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 100 

Frequency -1000 – 1000 0 

Asynchrony 0–1000 0 

A Pan 0–100 0 

B Pan 0–100 100 

A Gain 0–100 75 

B Gain 0–100 75 
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Granulator 

This effect turns your incoming audio into small grains of 
sound that can be looped, pitch shifted, and manipulated 
in new and interesting ways. 

Parameter Value Range Default Value 

Grain Density 1.0–300.0 
grains/sec 

68.0 
grains/sec 

Grain Window 20.0–1000.0 ms 608.0 ms 

Grain Length 10.0–200.0 ms 171.9 ms 

Grain Feedback -99.9 – 0.0 – 99.9% 0.0% 

Trigger 
Randomization 

0–100% 0.0% 

Pitch 
Randomization 

0–100% 0.0% 

 Pitch -12.0 – 0.0 – 12.0 
semitones 

0.0 semitones 

 Fine -50.0 – 0.0 – 50.0% 0.0% 

 Stereo 0–100% 0.0% 

 Mix 0–100% 34.6% 

 Freeze Off, On Off 

 

Resampler 

Resampler is similar to Decimator in that it removes bits 
from an incoming signal. The difference is that Resampler 
applies a complex suite of filters and anti-aliasing to 
attempt to retain the original sound quality. This is a 
method used by popular vintage samplers and sampling 
drum machines from the 1980s. Resampler can be used 
to achieve a “dirty” sound on drum loops, without the 
harshness of distortion. 

Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 100 

Rate 0–100 0 

Decimate 0–100 0 

   

 

TouchFX 
 
TouchFX is specially designed for use the touch strip controller on hardware such as MPC Key 61 and MPC Key 37, 
but can be used on any MPC hardware and controlled using the onscreen touch slider or an external MIDI device. 
The following effects can be selected: 
 

Manual Filter 

The touch strip controls a static, multi-mode filter 
without modulation. 

Parameter Value Range Default Value 

Cutoff 40.00–10000 Hz 2530.00 Hz 

Resonance 0.00–1.00 0.50 

Mode LowPass, 
BandPass, HiPass 

LowPass 
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Beat Sync Filter 

The touch strip controls a multi-mode filter with its cutoff 
frequency modulated by an LFO, which can be synced 
to the project tempo.  

Parameter Value Range Default Value 

Cutoff 40.00–10000 Hz 34737.15 Hz 

Resonance 0.00–1.00 0.50 

Manual Speed Off, 0.10–50.00 Hz Off 

Depth 0.0–100.0% 50.0% 

Mode LowPass, 
BandPass, HiPass 

BandPass 

Shape Ramp Up, Ramp 
Down, Triangle, 
Sine, Square, 
Random1, 
Random2 

Ramp Up 

Sync Speed Off, 2 Bars, 1 Bar, 
1/2, 1/4, 1/4t, 1/8, 
1/8t, 1/16, 1/16t, 
1/32, 1/64 

1/4 

 

 

Beat Sync Delay 

The touch strip controls repeated instances of the 
original signal that decay over a period of time that is 
synced to the project tempo.  

Parameter Value Range Default Value 

Cutoff 40.00–10000 Hz 3052.90 Hz 

Resonance 0.00–1.00 0.50 

Feedback -99.00 – 0.00 – 
99.00 

49.50 

Diffusion 0.00–1.00% 0.50% 

Mode LowPass, 
BandPass, HiPass 

LowPass 

Delay Time 1 Bar, 1/2, 1/4, 1/4t, 
1/8, 1/8t, 1/16, 
1/16t, 1/32, 1/64 

1/4 

Delay Mode Normal, Cross-
Feedback, Ping-
Pong 

Normal 

Octave Mode Off, On Off 
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Beat Repeat 

The touch strip controls an effect that will slice and 
repeat the source audio according to a tempo-synced 
beat value. 

Parameter Value Range Default Value 

Cutoff 40.00–10000 Hz 2530.00 Hz 

Resonance 0.00–1.00 0.50 

Mode LowPass, 
BandPass, HiPass 

LowPass 

Delay Time 1/4, 1/4t, 1/8, 1/8t, 
1/16, 1/16t, 1/32, 
1/64 

1/4 

Reverse Off, On Off 

 
Tape Stop 

The touch strip controls a tape stop effect that emulates 
the slowing down of analog tape playback. 

Parameter Value Range Default Value 

Cutoff 40.00–10000 Hz 2530.00 Hz 

Manual Stop 
Time 

1.00 – 4.00 s 2.50 s 

Sync Stop 
Time 

Off, 1/4, 1/4t, 1/8, 
1/8t, 1/16, 1/16t, 
1/32, 1/64 

Off 

 

Phaser 

The touch strip controls a phaser effect, created by 
multiple ganged all-pass filters to create “notches,” or 
sharp spikes, in the frequency spectrum. The 
frequencies of these all-pass filters can be modulated by 
an LFO to create a sweeping sound. 

Parameter Value Range Default Value 

Feedback 0.0–100.0% 100.0% 

Manual Speed 0.10–50.00 Hz Off 

Sync Speed Off, 2 Bars, 1 Bar, 
1/2, 1/4, 1/4t, 1/8, 
1/8t, 1/16, 1/16t, 
1/32, 1/64 

1/4 

 

Comb Filter 

The touch strip controls a comb filter, which creates 
“notches” in the frequency spectrum, similar to the 
phaser, by delaying the audio signal and adding it back 
to itself.  

Parameter Value Range Default Value 

Feedback 0.0–100.0% 100.0% 

Manual Speed 0.10–50.00 Hz Off 

Sync Speed Off, 2 Bars, 1 Bar, 
1/2, 1/4, 1/4t, 1/8, 
1/8t, 1/16, 1/16t, 
1/32, 1/64 

1/4 
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Washout 

The touch strip controls an echo effect that is useful for 
creating transitions. 

Parameter Value Range Default Value 

Cutoff 40.00–9000 Hz 1160.00 Hz 

Resonance 0.00–100.00% 0.50% 

Feedback 0.00–100.00% 0.50% 

Diffusion 0.0–10000.0% 5000.0% 

Delay Time 1 Bar, 1/2, 1/4, 
1/4t, 1/8, 1/8t, 
1/16, 1/16t, 1/32, 
1/64 

1 Bar 

 

Granulator 

The touch strip controls a granulator effect, which turns 
your incoming audio into small grains of sound that can 
be looped, pitch-shifted, and manipulated. 

Parameter Value Range Default Value 

Density 1.0–300.0 
grains/sec 

150.0 
grains/sec 

Window Length 20.0–1000.0 ms 510.0 ms 

Grain Length 10.0–200.0 ms 105.0 ms 

Grain Feedback -99.00 – 0.00 – 
99.00 

0.0% 

Pitch -12.0 – 0.0 – 12.0 
semi 

0.0 semi 

Stereo Spread 0.0–100.0% 0.0% 

 

Manual Flanger 

The touch strip controls a flanger effect, a modulated 
delay that emulates the sound created when running two 
analog tape machines in parallel with a slight time 
misalignment.  

Parameter Value Range Default Value 

Frequency 100.00–4000.00 
Hz 

4000.00 Hz 

Feedback 0.0–100.0% 100.0% 

 

 

XYFX 

Adds the XYFX effect for use with MPC touchscreen hardware. 
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Modulation 
 

Options: AIR Chorus*, AIR Ensemble, AIR Flanger, AIR Fuzz-Wah, AIR Half Speed, AIR Multi-Chorus, AIR 
Phaser, AIR Pitch Shifter, AIR Stereo Width, AIR Stutter, Auto Wah, Autopan Sync, Autopan, Chorus 2-Voice, 
Chorus 4-Voice, Flanger Sync, Flanger, Phaser 1, Phaser 2, Phaser Sync, Tremolo Sync, Tremolo 

 

AIR Chorus * 

This effect is a compact but powerful plugin for 
classic chorus warmth and depth. 

 
 

Parameter Value Range Default Value 

Rate 0.01 – 10.0 Hz 1.01 Hz 

Depth 0.00 – 24.00 ms 7.10 ms 

Mix 0–100% 50% 

Feedback 0–100% 0% 

Pre-Delay 0.00–24.00 ms 2.00 ms 

Wave Triangle, Sine Sine 

Offset -180 – 0 – +180 deg. +90 deg. 

  

AIR Ensemble 

This effect applies fluid, shimmering modulation 
effects to the audio signal. 

Parameter Value Range Default Value 

Rate 0.01 – 10.0 Hz 1.00 Hz 

Depth 0.00 – 24.00 ms 6.00 ms 

Width 0–100% 100% 

Mix 0–100% (dry–wet) 75% 

Mod. Delay 0.00 – 24.00 ms 0.00 ms 

Mod. Shimmer 0–100% 50% 

 

AIR Flanger 
This effect applies a short, modulating delay to the 
audio signal. 

Parameter Value Range Default Value 

Rate 0.02 – 10.00 Hz 0.40 Hz 

Depth 0–100% 50% 

Feedback 0–100% 50% 

Mix 0–100% (dry–wet) 50% 

Headroom -20.0 – 0.0 dB FS -10.0 dB FS 
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AIR Fuzz Wah 

This is a multi-effect that combines transistor-like distortion and wah. 

Tab Parameter Value Range Default Value 

Fuzz-Wah Mix 0–100% (dry–wet) 100% 

 Order Fuzz>Wah, Wah>Fuzz Fuzz>Wah 

 Fuzz Mix 0–100% (dry–wet) 100% 

 Wah Mix 0–100% (dry–wet) 100% 

 Fuzz Drive 0 – 40 dB 20 dB 

 Fuzz Tone 1.00 – 10.0 kHz 3.16 kHz 

 Fuzz Output -Inf – 0.0 dB 0.0 dB 

 Fuzz Enable Off, On Off 

 Wah Pedal 0–100% 50% 

 Wah Filter Mode Lowpass, Bandpass, Highpass  Bandpass 

 Min. Freq. 50.0 Hz – 4.00 kHz 428 Hz 

 Max Freq. 50.0 Hz – 4.00 kHz 2.07 kHz 

 Min. Resonance 0–100% 55% 

 Max Resonance 0–100% 33% 

 Wah Enable Off, On On 

Modulation Mode LFO, Env LFO 

 Rate 
LFO 
Env 

 
8/4 – 16 
0–100% 

 
4T 
75% 

 Depth -100 – 0 – 100% 0% 

 

AIR Half Speed 

This effect can quickly create half-speed versions from any 
input material. Filter the processed audio using the built-in 
high pass and low pass filter to create dramatic transitions, 
and use the fade in and fade out parameters to create 
synchronized transitions between dry and effected audio.  

Parameter Value Range Default Value 

 Start, Stop  

Loop Length 1/16 – 4 Bars 1 Bar 

Mode *1.5, *2, *4 *2 

Mix 0–100% 100% 

Loop Fade 1.00 – 200 ms 4.90 ms 

Fade In Hard, Soft, 1/16–4 
Bars Hard 

 Fade Out Hard, Soft, 1/16–4 
Bars 

Hard 

 HPF Off, 20.0 Hz – 20.0 
kHz 

Off 

 LPF 20.0 Hz – 19.9 kHz, 
Off 

Off 

 Band Off, On Off 
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AIR Multi-Chorus 
This effect applies a thick, complex chorus effect to your 
audio signal. 

Parameter Value Range Default Value 

Rate 0.01 – 10.0 Hz 1.00 Hz 

Depth 0.00 – 24.00 ms 6.00 ms 

Voices 3, 4, 6 4 

Mix 0–100% (dry–wet) 50% 

Chorus Low 
Cut 

20.0 Hz – 1.00 kHz 20.0 Hz 

Chorus Width 0–100% 100% 

 Mod Wave Sine, Tri Tri 

 Mod Delay 0.00 – 24.00 ms 6.0 ms 

 

AIR Phaser 

This effect applies a phaser to your audio signal, for that 
wonderful "wooshy," "squishy" sound. 

Parameter Value Range Default Value 

Rate 0.10 – 10.00 Hz 1.00 Hz 

Depth 0–100% 50% 

Feedback 0–100% 0% 

Mix 0–100% (dry–wet) 50% 

Phaser Model Vibe, Stone, Ninety, 
Tron,  

Ninety 

Offset 

Phase 
Rate 

 

-180 – +180 deg. 
25–400% 

 
0 deg. 
100% 

 Type Phase, Rate Phase 

 

AIR Pitch Shifter 

This effect alters the pitch of the audio signal and can be 
adjusted based on the source or style of the signal. 

Parameter Value Range Default Value 

Mode Vocal, Bass, Beats, 
Chords, Textures 

Vocal 

Shift -24.0 – 0 – 24.0 0.0 

Mix 0–100% 100% 

 

AIR Stereo Width 

This effect creates a wider stereo presence in an audio 
signal.  

Parameter Value Range Default Value 

Width 0–200% 100% 

Delay 0.0 – 8.0 ms 0.0 ms 

Level Trim -Inf – 0.0 – +12.0 dB 0.0 dB 

Pan Trim L100 – <C> – R100 <C> 

High 0–200% 100% 

Mid 0–200% 100% 

 Low 0–200% 100% 
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AIR Stutter 

This effect creates mind-blowing glitch effects using a 
wide range of volume, pan and pitch stutter effects. 

Parameter Value Range Default Value 

Intervals 1/64 – ¼ 1/16 

Sync Off, On On 

Steps 2–64 5 

Step Length 0–100% 100% 

Freeze Off, On Off 

Decay 50.0 ms – 100 s 6.99 s 

 Volume -12.0 – 0.0 – 6.0 dB -1.2 dB 

 Mix 0–100% 100% 

 Pan Mod 0–100% 50% 

 Pitch Mod -100 – 0 – +100% 0% 

 

Auto Wah 

This effect is a low-pass filter modulated by an envelope that 
yields a classic funky “wah-wah”- like sound. The envelope 
is triggered by the incoming signal’s amplitude. The amount 
of the envelope on the cutoff frequency is user-definable. 

Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 100 

Resonance 0–100 75 

Attack 0–100 30 

Release 0–100 30 

Center 0–100 50 

Sensitivity 0–100 50 

 

Autopan Sync 

This effect uses an LFO (tempo-synced to your project) to 
move the incoming signal back and forth across the stereo 
field, creating a rotary effect. 

Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 100 

Rate 8 bars – 1/32 1/4 

 

Autopan 

This effect uses an LFO to move the incoming signal back 
and forth across the stereo field, creating a rotary effect. 

Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 100 

Rate 0–100 10 

 

Chorus 2-Voice 
This effect uses an LFO to modulate the pitch and a delay of 
the input signal, which are then added to the dry signal. In 
small amounts, this creates the illusion of multiple voices 
playing at once. Turn up the Feedback and Amount for 
more pronounced “shimmering” and “watery” sounds. 

Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 100 

Delay 0–100 20 

Amount 0–100 80 

Width 0–100 80 

Feedback 0–100 50 

Rate 0–100 10 
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Chorus 4-Voice 
This effect is the same as Chorus 2-Voice, but adds 
additional voices for more pronounced modulation. 

Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 100 

Delay 0–100 20 

Amount 0–100 80 

Width 0–100 80 

Feedback 0–100 50 

Rate 0–100 10 

 

Flanger Sync 
This effect is the same as Flanger, but syncs to your project 
tempo. 

Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 100 

Rate 8 bars – 1/16 triplets 1/4 

Feedback -100 – 100 0 

Delay 0–100 20 

Width 0–100 80 

 

Flanger 
A flanger is a modulated delay to emulate the sound created 
when running two analog tape machines in parallel with a 
slight time misalignment. Slow Rate settings can produce a 
“whooshing” jet engine sound, while faster rates result in 
more of a “warble.” 

Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 100 

Rate 0–100 10 

Feedback -100 – 100  0 

Delay 0–100 20 

Width 0–100 80 

 

Phaser 1 

This effect applies multiple ganged all-pass filters to create 
“notches,” or sharp spikes, in the frequency spectrum. The 
frequencies of these all-pass filters are usually modulated 
by an LFO to create a sweeping sound.  

Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 100 

Rate 0–100 10 

 

 

Phaser 2 

This effect is a variation on Phaser 1. Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 100 

Rate 0–100 10 

 

Phaser Sync 

This effect is similar to Phaser 1/Phaser 2, but the LFO is 
synced to the project tempo. 

Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 100 

Rate 1 bar – 1/16 triplets 1/4 
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Tremolo Sync 

This effect uses an LFO (synced to project tempo) to 
increase and decrease the volume of the signal. Depending 
on the LFO shape, this can produce a smooth wave effect 
(sine wave) or a stuttering “on-off” effect (square wave). 

Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 100 

Rate 1 bar – 1/16 triplets 1/4 

Sine to Square 0–100 (sine–square) 0 

 

Tremolo 

This effect is the same as Tremolo sync, but the LFO is 
not synced to project tempo.  

Parameter Value Range Default Value 

Dry/Wet 0–100 (dry–wet) 100 

Rate 0–100 10 

Sine to Square 0–100 (sine–square) 0 

 

 

Vocal 
 

Options: AIR Vocal Doubler, AIR Vocal Harmonizer, AIR Vocal Tuner 

 

AIR Vocal Doubler 

This effect creates realistic vocal doubles to add width 
or thickness to a vocal line. 

Parameter Value Range Default Value 

Voices 1–8 4 

Stereo Spread 0–100% 70% 

Lead Volume -Inf – +6.0 dB 0.0 dB 

Doubler Volume -Inf – +6.0 dB 0.0 dB 

Pitch +/- 0–250% +/- 38% 

Pitch Speed 0–100% 75% 

 Timing 0–800 ms 63 ms 
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AIR Vocal Harmonizer 

This effect can create up to four-part realistic vocal 
harmonies and complex doubling effects. Each vocal part 
has its own level, delay, formant, mode, and interval 
parameters.  

Parameter Value Range Default Value 

Key A–G# C 

Scale Major, Minor, Harm 
Minor, Melo Minor, 
Dorian, Phrygian, 
Lydian, Mixo, 
Locrian, Chromatic, 
Penta, Maj Triad, 
Min Triad, Root 

Major 

Lead Volume -Inf – 0.0 dB 0.0 dB 

Harmony Volume -Inf – 0.0 dB -2.5 dB 

Timing 0–100% 42% 

Tuning 0–100% 14% 

 Smooth 5–200 ms 8 ms 

 Voice Range Very Low, Low, Mid, 
High, Very High 

Mid 

 Root Mode Split A–G# E 

 Reference 420.0–460.0 Hz 440.0 Hz 

 Delay Sync Off, On On 

 Harmony 1–4 Off, On 1 On 

 

AIR Vocal Tuner 

This effect applies pitch correction for natural sounding or 
hard-tuned vocal effects. 

Parameter Value Range Default Value 

Detection Unworried, Default, 
Selective, Picky, 
Blind 

Default 

Voice Range Very Low, Low, Mid, 
High, Very High 

Mid 

Key A–G# A 

Scale Major, Minor, Harm 
Minor, Melo Minor, 
Dorian, Phrygian, 
Lydian, Mixo, 
Locrian, Chromatic, 
Penta, Maj Triad, 
Min Triad, Root 

Minor 

Retune Time 1–1000 ms 32 ms 

Reference 420.0–460.0 Hz 440.0 Hz 
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Plugins 
 

AIR Bassline 
 

The AIR Bassline plugin emulates the sound of classic mono synths, with a contemporary twist. Bassline also comes 
packaged with four integrated AIR effects (Chorus, Delay, Compressor and Hype), as well as two built-in distortion 
algorithms (Overdrive and Clip). 
 

 
 

Parameter Description Value Range 

Oscillator Waveform Continuously variable waveshape for the oscillator. Saw Octave, Saw, 
Square, Sine 

 Sub-Octave Amount of sub-octave oscillator. 0–100% 

 Fifth Amount of fifth-oscillator. 0–100% 

 Start Phase Position of the waveform when a note is triggered. Free, 0 degr., 180 degr. 

 Glide Time Amount of time to slide from the pitch of one note to 
the next note played. 

10.0 ms – 2.00 s 

 Boost Boosts the signal of the oscillator. 0.0 dB – 48.0 dB 

 Boost Freq. Center frequency of the boost. * 1.0 – * 240.0 

 Boost Envelope Amount of effect of the envelope on the Boost section. 

Adjust Gain to control the amount of boost. 

Adjust Frequency to control the center frequency of the 
boost. 

Gain 100–0%, Off, 
Frequency 0–100% 

Filter LP Cutoff Cutoff frequency for the low-pass filter. 20.0 Hz – 20.0 kHz 

 Reso Resonance of the filter. 0–100% 

 Filter Env Envelope of the filter.  

At negative values, decreases the cutoff value based on 
the decay value.  

At positive values, increases the cutoff value based on 
the decay value. 

-100% – 0 – 100% 

 HP Cutoff Cutoff frequency for the high-pass filter. 10.0 Hz – 500 Hz 
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AIR Bassline (continued) 
 

Parameter Description Value Range 

Envelope Amp Attack Length of time for the note to reach full volume. 100–0% Soft to 0–
100% Hard 

 Amp Decay Length of time for the note to reach the sustained volume. 0–100% 

 Filter Decay Length of time for the filter to reset after being released. 0–100% 

 Pitch Mod Amount of pitch modulation applied to the envelope. 0–100% 

Velocity Amp Control The amount of effect velocity has on amplitude control. 0–100% 

 Filter Control The amount of effect velocity has on filter control. 0–100% 

 Boost Control The amount of effect velocity has on boost control. 0–100% 

 Env Retrigger Sets whether the envelope will retrigger when a note is played 
while another note is being held. 

Off, On 

Volume  Sets the volume level. -Inf dB – +6.0 dB 

Drive Drive Type Choose one of two drive algorithms.  Overdrive, Clip 

 Drive Amount Amount of drive applied. 0–100% 

Bend 
Range 

 Number of semitones up or down controlled by MIDI pitch 
bend messages. 

0–12 

Chorus Rate Modulation speed of the chorus effect. 20.0 Hz – 20.0 kHz 

 Depth Modulation depth of the chorus effect. 0–100% 

 Mix Wet/dry amount of the chorus effect. -100% – 0 – 100% 

 On/Off Enables or disables the effect. Off, On 

Delay Time Length of time of the delayed signal.  

  When Sync is set to Free: 1 ms – 2.00 s 

  When Sync is set to Sync: 1/32 – 8/4 

 Sync Sync the Delay Time to the Global Tempo or set to Free to 
adjust Time by milliseconds.  

Free, Sync 

 Mix Wet/dry amount of the delay effect. 0–100% 

 Feedback Amount of signal fed back into the delay line. 0–100% 

 Damp Center frequency of where the delay signal will be dampened. 1.00 – 20.0 kHz 

 Reso Amount of resonance of the feedback signal. 0–100% 

 Reso Freq Center frequency for feedback resonance. 100 Hz – 10.0 kHz 

 Ratio Reduces the delay Time in either the Left or Right stereo 
field. This is useful for creating offset, panned delays. 

L 50:100,  
R 50:100 

 HPF Center frequency for delay signal high-pass filter. 20.0 Hz – 1.0 kHz 

 Width Stereo width of delay signal. Higher values give wider stereo 
separation. 

0–100% 

 On/Off Enables or disables the effect. Off, On 
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AIR Bassline (continued) 
 

 

 

Parameter Description Value Range 

Compressor Threshold Signal level after which the compressor will be applied. 0.0 – -60. dB 

 Ratio Amount of compression applied. 1.0:1 – 100.0:1 

 Output Amount of additional output gain for the compressed 
signal. 

0.0 – +30.0 dB 

 Mix Wet/dry mix of the compressor effect. 0–100% 

 Knee How gradually the compressor reacts as the threshold 
is reached.  

Lower values apply a "soft" knee (compression is 
applied more slowly as signal approaches the 
threshold), and higher values apply a "hard" knee 
(compression is immediately applied when the 
threshold is reached). 

0–100% 

 Attack Length of time to apply the compression. 100 us – 300 ms 

 Release Length of time for compressed signal to return to 
original level. 

10 ms – 4.00 s 

 On/Off Enables or disables the effect. Off, On 

Hype High Dampens or maximizes high end frequencies. -100 – 0 – +100% 

 Low Dampens or maximizes low end frequencies. -100 – 0 – +100% 

 On/Off Enables or disables the effect. Off, On 
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AIR Electric 
 

The AIR Electric plugin emulates the sound of classic electric pianos. Dedicated Pickup, Envelope, Bell and Noise 
parameter sections provide a huge amount of flexibility to configure the timbre of the electric piano sound. Electric 
also includes five AIR effects: Tremolo, Tube Distortion, Chorus, Delay and Spring Reverb. 

 

 

 

To enable or disable any sound or effect, press the circle in the upper-right corner of each section. 

 

Parameter Description Value Range 

Pickup Type Type of pickup emulated. Pickup, 0–100% 
Electro-Static,  
0–100% Electro-
Magnetic 

 Height Height of the pickup to the tines. 0.0 – 5.0 mm 

 Distance Distance of the pickup to the tines. 0.1 – 10.0 mm 

 Clip Amount of clipping applied to the signal. 0–100% 

 Keytrack Ties the pickup parameters to the pitch being played. 

At higher values, the Distance is increased as the 
pitch is increased. 

0–100% 

Envelope Attack Length of time for the note to reach full volume. 100–0% Hard,  
0–100% Soft 

 Decay Length of time for the note to reach the sustained 
volume. 

100 ms – 20.0 s 

 Release Length of time for the note to become silent after 
being released. 

100 ms – 5.0 s 

 Peak Length Length of time full volume is held before decaying. 3–50 ms 

 Keytrack Ties the envelope parameters to the pitch being 
played. 

At higher values, the envelope time is decreased as 
the pitch is increased. 

0–100% 
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AIR Electric (continued) 
 

Parameter Description Value Range 

Bell Tune Pitch of the bell sound, in semitones above the root 
pitch. 

0–60 semitones 

 Dry/PU Mix of Dry versus Pickup signal for the bell sound. -100% – 0% – +100% 

 Volume Level of the bell sound. -Inf dB – +6.0 dB 

 Tune Keytrack Ties the tuning of the bell sound to the pitch being 
played. 

0–100% 

 Decay How long it takes for the bell sound to dissipate 100 ms – 7.0 s 

 Keytrack Ties the amount of bell sound to the pitch being 
played. 

At negative values, the bell sound is increased as the 
pitch increases. 

At positive values, the bell sound is increased as the 
pitch decreases. 

-100% – 0% – +100% 

Noise Freq Center frequency of the noise effect 200 Hz – 16.0 kHz 

 Random Amount of randomization applied to the noise effect 0–100% 

 Mix Level of noise effect present -Inf dB – +6.0 dB 

 Attack Length of time for the noise effect to reach full level 1–50 ms 

 Decay Length of time for the noise effect to dissipate 100 ms – 3.00 s 

 Keytrack Ties the Freq to the pitch being played. 0–100% 

Polyphony Number of voices available. 1–16 Voices 

Level Overall level of the plugin. -Inf dB – +6.0 dB 

Velo Level Adjusts how much incoming velocity is applied. 0–100% 

Velo Tone Ties the incoming velocity to tone. 

At higher values, increased velocity increases tone 
brightness. 

0–100% 

Velo Attack Ties the incoming velocity to the attack envelope.  

At higher values, lower velocities feature longer 
attack times. 

0–100% 

Tremolo Rate Modulation speed of the effect.  

  When Sync is set to Free: 0.25 – 13.00 Hz 

  When Sync is set to Sync: 8/4 – 1/16 

 Sync Sync the Tremolo Rate to the Global Tempo or let it 
run Free. 

Free, Sync 

 Mode Select Pan for stereo field modulation, or Tremolo 
for amplitude modulation. 

Pan, Tremolo 

 Depth Amount of modulation applied. 0–100% 
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AIR Electric (continued) 
 

Parameter Description Value Range 

Tube Drive Amount of drive applied. 0–100% 

 Headroom Amount of gain reduction between the clean signal 
and the driven signal. 

-30.0 – 0.0 dB 

 Saturation Amount of saturation applied. 0–100% 

 Output Output level of the tube driven signal. -20.0 – 0.0 – +20.0 dB 

Chorus Rate Modulation speed of the effect. 0.40 – 3.20 Hz 

 Depth Amount of pitch modulation of the effect. 0–100% 

 Mix Wet/dry amount of the chorus effect. 0–100% 

Delay Time Amount of time between the dry signal and the 
delayed signal. 

 

  When Sync is set to Free: 1 ms – 2.00 s 

  When Sync is set to Sync: 1/32 – 8/4 

 Sync Sync the Delay Time to the Global Tempo or set to 
Free to adjust Time by milliseconds. 

Free, Sync 

 Mix Wet/dry amount of the delay effect. 0–100% 

 Feedback Amount of signal fed back into the delay line. 0–100% 

 Damp Center frequency of where the delay signal will be 
dampened. 

1.00 – 20.0 kHz 

 Reso Amount of resonance of the feedback signal. 0–100% 

 Reso Freq Center frequency for feedback resonance. 100 Hz – 10.0 kHz 

 Ratio Reduces the delay Time in either the Left or Right 
stereo field. This is useful for creating offset, panned 
delays. 

L 50:100, R 50:100 

 HPF Center frequency for delay signal high-pass filter. 20.0 Hz – 1.0 kHz 

 Width Stereo width of delay signal. Higher values give wider 
stereo separation. 

0–100% 

Spring Reverb Pre-Delay Length of time between dry signal and reverberated 
signal. 

0 ms – 250 ms 

 Time Length of reverb tail. 1.0 – 10.0 s 

 Mix Wet/dry amount of the reverb effect. 0–100% 

 Diffusion Rate of increasing density of reverb reflections.  

At lower settings, the sound of individual reflections is 
more present.  

At higher settings, reflections are more uniform. 

0–100% 

 Width Stereo width of reverb signal. Higher values give wider 
stereo separation. 

0–100% 

 Low Cut Center frequency for reverb signal low-cut filter. 20.0 Hz – 1.00 kHz 
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AIR TubeSynth 
 

The AIR TubeSynth plugin emulates the sound of classic vintage analog polysynths. TubeSynth is based on the 
highly acclaimed AIR Vacuum Pro desktop synth plugin and also includes 5 integrated AIR effects. 
 

 
 
 

Parameter Description Value Range 

Oscillator 1 Octave Coarse tuning of the oscillator by octaves. 

The Wide setting provides additional Fine tuning 
controls. 

Wide, 32', 16', 8', 4', 2' 

 Fine Fine tuning of the oscillator by semitones.  

  When Octave is set to Wide: -70.00 – 0.00 – +70.00 

  When Octave is set to 32'–2': -12.00 – 0.00 – +12.00 

 Shape Waveshape of Oscillator 1 (continuously variable) Triangle, Saw, Square, Pulse 

 F-EnvShape Amount of Filter Envelope output subtracted from 
or added to the value defined by the Osc 1 Shape 
parameter. 

-100 – 0 – +100% 

 Quad Enables or disables four-voice emulation for the 
oscillator. 

Off, On 

 Detune Adjusts tuning of the additional Quad voices. 0–100% 

Oscillator 2 Octave Coarse tuning of the oscillator by octaves, all the 
way down to LFO speed. 

LFO, 32', 16', 8', 4', 2' 

 Fine Fine tuning of the oscillator.  

  When Octave is set to LFO: 0.01 – 20.00 Hz 

  When Octave is set to 32'–2': -12.00 – 0.00 – +12.00 
semitones 

 Shape Waveshape of Oscillator 2 (continuously variable) Noise, Saw, Square, Pulse 

 F-EnvShape Amount of Filter Envelope output subtracted from 
or added to the value defined by the Osc 2 Shape 
parameter. 

-100 – 0 – +100% 

 Sync Enables or disables syncing of Oscillator 2 to 
Oscillator 1. 

Off, On 

 Micro Detune Additional detuning of Oscillator 2. 0–100% 

 Phase Position of the waveshape when the sound is 
triggered. 

0 – 360 degrees 

Sub Oscillator Shape Waveshape of the sub oscillator. Triangle, Saw, Square, Pulse 



  

 
266 

 

 

AIR TubeSynth (continued) 
 

Parameter Description Value Range 

Osc 2 EQ Gain Amount of gain applied to the selected Frequency. -48 – 0 – +48 dB 

 Frequency Center frequency for the equalization band. 25–10,000 Hz 

 Drive Amount of drive added to the EQ signal. 0–100% 

 Keytrack Ties the EQ settings to the pitch being played 0–100% 

Mixer Osc 1 Level of Oscillator 1. 0–100% 

 Osc 2 Level of Oscillator 2. 0–100% 

 Sub Osc Level of the Sub Oscillator. 0–100% 

 Ring Mod Level of Ring Modulation effect. 0–100% 

 Drive Level of Drive effect. 0–100% 

LP Filter Cutoff Center frequency of the low-pass filter cutoff. 0–100% 

 Reso Amount of resonance of the low-pass filter. 0–100% 

 Slope Amount of attenuation applied above the cutoff 
frequency. 

0–24 dB/oct 

 Saturation Amount of saturation applied to the low-pass filter. 0–100% 

 Env Percentage of the envelope output subtracted from or 
added to the LP Filter Cutoff. 

-100 – 0 – +100% 

 Keytrack Ties the LP Filter Cutoff to the pitch being played. 0–100% 

Filter Envelope Attack Length of time for the filter to reach full level. 1.00 ms – 100 s 

 Decay Length of time for the filter to reach sustain level. 1.00 ms – 100 s 

 Sustain Length of time for the filter to hold sustain level. 0–100% 

 Release Length of time for the filter to dissipate when released. 1.00 ms – 100 s 

Amp Envelope Attack Length of time for the note to reach full level. 1.00 ms – 100 s 

 Decay Length of time for the note to reach sustain level. 1.00 ms – 100 s 

 Sustain Length of time for the note to hold sustain level. 0–100% 

 Release Length of time for the note to dissipate when released. 1.00 ms – 100 s 

Envelope 3 Start Level Initial velocity level of the envelope. 0–100% 

 Start Time Length of time for the envelope to start. 0–5000 ms 

 Slope Hold Amount of Envelope subtracted from or added to the 
Destination when a note is held. 

-100 – 0 – +100% 

 Slope Rel Amount of Envelope subtracted from or added to the 
Destination when a note is released. 

-100 – 0 – +100% 

 Destination Where the envelope will be applied to. Off, Pitch, Osc 2 
Pitch, LFO 1/2 Rate, 
Osc1 Quad Det., Osc 
1/2 Shape, Osc 1/2 
Level, Ring Level 
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AIR TubeSynth (continued) 

 

 
 

Parameter Description Value Range 

LFO 1/LFO 2 Shape Waveshape of the low-frequency oscillator. Sine, Square. Saw 
Up, Saw Down, 
Pump, S&H, Drift 

 Destination Where the low-frequency oscillator is sent.  

  LFO1: Off, Pitch, Filter, 
Level, Pan 

  LFO2: Pitch, Osc 1/2 Shape, 
Osc 1/2 Pitch, LPF, 
Quad Detune, Osc 
EQ Freq, Osc 2 EQ 
Gain, Ring Level 

 Rate Speed of modulation.  

  When Sync is Off: 0.01 – 20.00 Hz 

  When Sync is On: 8/4 – 1/32 

 Depth Amount of modulation applied. 0–100% 

 Fade Apply a fade-in or fade-out of the LFO signal. 0.00 – 20.00 s out, 
No fade, 
0.00 – 20.00 s in 

 Sync Sync the LFO Rate to the Global Tempo or turn Off  
to adjust Rate by Hertz. 

Off, On 

Modulation Source Where the modulation signal is sent from. Filter Env, Amp Env, 
Osc 1, Osc 2 

 Destination Where the modulated signal is received. Pitch, Osc 1/2 Shape, 
Osc 1/2 Pitch, LPF, 
Quad Detune, Osc 
EQ Freq, Osc 2 EQ 
Gain, Ring Level 

 Depth Amount of modulation applied. 0–100% 
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AIR TubeSynth (continued) 
 

Parameter Description Value Range 

Controller Destinations   

 Velocity 1 Send Velocity data to one of the following control 
destinations.  

Amp, Cutoff, Osc1 
Shape, Osc2 Shape, 
Osc1&2 Shape 

 Depth Amount of modulation applied. 0–100% 

 Velocity 2 Send Velocity data to one of the following control 
destinations. 

Amp, Cutoff, Osc1 
Shape, Osc2 Shape, 
Osc1&2 Shape 

 Depth Amount of modulation applied. 0–100% 

 Modwheel Send Modwheel data to one of the following control 
destinations. 

Amp, Cutoff, Osc1 
Shape, Osc2 Shape, 
Osc1&2 Shape 

 Depth Amount of modulation applied. -100 – 0 – 100% 

 Aftertouch Send Aftertouch data to one of the following control 
destinations. 

LFO 1 Depth, Cutoff, 
Osc1 Shape, Osc2 
Shape, Osc1&2 Shape 

 Depth Amount of modulation applied. -100 – 0 – 100% 

Setup Polyphony Number of allowable voices, and how voices are 
triggered. 

Legato, Retrigger, 2, 3, 4 

 Bend Range Number of semitones up or down controlled by MIDI 
pitch bend messages 

2–12 (semitones) 

 Glide Time Amount of time to slide from the pitch of one note to 
the next note played. 

1.00 ms – 100 s 

 Glide All Enables or disables pitch gliding for all triggered 
notes, not just legato notes. 

Off, On 

 Detune Amount of detuning applied. This setting is only 
applied when Doubling is enabled. 

0–100% 

 Doubling Enables or disables voice doubling. Off, On 

Output Shape Amount of signal sent to a Tube Drive. 0–100% 

 Width Stereo width of the audio signal. Higher values give 
wider stereo separation. 

0–100% 

 Level Overall output volume of the plugin. -Inf dB – +12.0 dB 
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AIR TubeSynth (continued) 
 

 
 

Parameter  Description Value Range 

Chorus Rate Modulation speed of the effect. 0.01 – 10.0 Hz 

 Delay Length of time the wet signal is offset from the dry signal. 0.00 – 24.00 ms 

 Voices Number of voices used in the chorus effect. 3, 4, 6 

 LFO Wave Waveshape of the low-frequency oscillator for the chorus effect. Tri, Sine 

 Depth Amount of pitch modulation of the effect. 0.00 – 24.00 ms 

 Width Stereo width of the chorus effect. Higher values give wider 
stereo separation. 

0–100% 

 Lo Cut Center frequency for the chorus low-cut filter. 20.0 Hz – 1.0 kHz 

 Mix Wet/dry amount of the chorus effect. 0–100% 

Delay Time Length of time between the dry signal and the delayed signal.  

  When Sync is set to Free: 1 ms – 2.00 s 

  When Sync is set to Sync: 1/32 – 8/4 

 Sync Enable to sync the Delay Time to the Global Tempo, disable to 
set the Time in milliseconds. 

Off, On 

 Feedback Amount of delay signal fed back into the delay line. 0–100% 

 Mix Wet/dry amount of the delay effect. 0–100% 

 Damp Center frequency of where the delayed signal will be 
dampened. 

1.00 – 20.0 kHz 

 Reso Amount of resonance of the feedback signal 0–100% 

 Reso Freq Center frequency for feedback resonance. 100 Hz – 10.0 kHz 

 Ratio Reduces the delay Time in either the Left or Right stereo field. 
This is useful for creating offset, panned delays. 

L 100:50, R 50:100 

 HPF Center frequency for delay signal high-pass filter. 20.0 Hz – 1.0 kHz 

 Width Stereo width of delay signal. Higher values give wider stereo 
separation. 

0–100% 
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AIR TubeSynth (continued) 
 

Parameter Description Value Range 

Reverb Mode Type of reverb applied. Hall, Stadium, Room, 
Abstract 

 Time Length of reverb tail. 0.4 s – +Inf s 

 Lo Cut Center frequency for the reverb low-pass filter. 1 – 1000 Hz 

 Hi Cut Center frequency for the reverb high-pass filter. 1.0 – 20.0 kHz 

 Mix Wet/dry mix of the reverb effect. 0–100% 

Compressor Threshold Signal level after which the compressor will be applied. 0.0 – -60. dB 

 Output Amount of additional output gain for the compressed 
signal. 

0.0 – +30.0 dB 

 Mix Wet/dry mix of the compressor effect. 0–100% 

 Ratio Amount of compression applied. 1.0:1 – 100.0:1 

 Knee How gradually the compressor reacts as the threshold is 
reached.  

Lower values apply a "soft" knee (compression is applied 
more slowly as signal approaches the threshold), and 
higher values apply a "hard" knee (compression is 
immediately applied when the threshold is reached). 

0–100% 

 Attack Length of time to apply the compression. 100 us – 300 ms 

 Release Length of time for compressed signal to return to original 
level. 

10 ms – 4.00 s 

Hype High Dampens or maximizes high end frequencies. -100 – 0 – +100% 

 Low Dampens or maximizes low end frequencies. -100 – 0 – +100% 
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AIR Hype 
 
The AIR Hype plugin is a modern style dual-oscillator synthesizer that 
includes a wide variety of built-in effects for endless combinations of 
sound, as well as convenient macro controls for lightning-fast 
adjustments. 

 

 

Macro 

Use this tab to adjust the macro settings for the plugin. You can access 
the Effect on/off switches in all tabs. 
 

Parameter Description Value Range 

Macros These six macro controls are unique to each 
preset. 

Varies 

Cutoff Amount of filter cutoff applied. 0–100% 

Reso Amount of filter resonance applied.  0–100% 

Mod Amount of modulation effect applied. 0–100% 

Distortion Amount of distortion effect applied. 0–100% 

Delay Amount of delay effect applied. 0–100% 

Reverb Amount of reverb effect applied. 0–100% 

Pumper Amount of pumper effect applied. 0–100% 

Volume Main output volume. -inf – +6.0 dB 
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AIR Hype (continued) 
 

Filter / Amp 

Use this tab to adjust the filter and amplitude envelope settings. 
 
 
 
 
 
 
 
 

Parameter Description Value Range 

Filter Cutoff Cutoff frequency for the filter. 0–100% 

 Reso Amount of resonance of the filter. 0–100% 

Filter Envelope Attack Length of time for the filter to reach full level. 0–100% 

 Decay Length of time for the filter to reach sustain 
level. 

0–100% 

 Sustain Length of time for the filter to hold sustain level. 0–100% 

 Release Length of time for the filter to dissipate when 
released. 

0–100% 

 Envelope 
Depth 

Amount of Filter Envelope added to the filter 
cutoff. 

0–100% 

 Envelope 
Velocity 

Amount of effect the note velocity has on the 
filter envelope. 

0–100% 

Amp Spike Applies additional velocity to the amplitude 
attack. 

0–100% 

 Spike Decay Length of time for the Spike to decay. 0–100% 

Amp Envelope Attack Length of time for the note to reach full level. 0–100% 

 Decay Length of time for the note to reach sustain 
level. 

0–100% 

 Sustain Length of time for the note to hold sustain level. 0–100% 

 Release Length of time for the note to dissipate when 
released. 

0–100% 

 Fade Amount added to the envelope sustain level. 0–100% 

 Velocity Amount of effect the note velocity has on the 
amplitude envelope. 

0–100% 
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AIR Hype (continued) 
 

Effects 1 

Use this tab to adjust the settings for the Low-Frequency Oscillator 
and Modulation, Distortion and Hype effects. 
 
 
 
 
 
 
 
 

Parameter Description Value Range 

LFO Rate Speed of the low frequency oscillator.  

  When Sync is set to 1st Note, Each Note, or Off: 0.03 – 30.00 Hz 

  When Sync is set to Temp+Note or Tempo+Beat: 8/4 – 1/64 

 Sync Enables or disables LFO sync, and sets how it is 
synced when enabled. 

Off, 1st Note, Each Note, 
Tempo+Note, Tempo+Beat 

 Depth Amount of LFO modulation applied. 0–100% 

Mod Rate Speed of modulation. 0.05 – 20.00 Hz 

 Adjust Length of time the wet signal is offset from the dry 
signal. 

0.0 – 24.0 ms 

 Depth Amount of modulation applied. 0–100% 

 Mix Wet/dry mix of the modulation effect. 0–100% 

Distortion Drive Amount of drive applied. 0–100% 

 Bias Emulates amount of voltage sent to a tube power-
amp. 

-100 – 0 – 100% 

 Output Output level of the distorted signal. 0–100% 

 Mix Wet/dry mix of the distortion effect. 0–100% 

Hype Low Dampens or maximizes low end frequencies. -12.0 – +12.0 dB 

 Lo-Mid Dampens or maximizes low-mid frequencies. -20.0 – +20.0 dB 

 Hi-Mid Dampens or maximizes high-mid frequencies. -20.0 – +20.0 dB 

 High Dampens or maximizes high end frequencies. -12.0 – +12.0 dB 
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AIR Hype (continued) 
 

Effects 2 

Use this tab to adjust the settings for the Delay, Reverb, Compressor, 
Pumper and Limiter effects. 
 
 
 
 
 
 
 
 
 
 
 

Parameter Description Value Range 

Delay Time Amount of time between the dry signal and the 
delayed signal. 

1/16 – 16/4 

 Feedback Amount of signal fed back into the delay line. 0–100% 

 Freq Adjusts the filter cutoff frequency of the delayed 
signal. 

100 – 16000 Hz 

 Mix Wet/dry amount of the delay effect. 0–100% 

 L/R Reduces the delay Time in either the Left or 
Right stereo field. This is useful for creating 
offset, panned delays. 

L 50:100 – R 100:50 

Reverb Pre-Delay Length of time between dry signal and 
reverberated signal. 

0.0 – 250.0 ms 

 Time Length of reverb tail. 0.3 – 60.0 s 

 Mix Wet/dry amount of the reverb effect. 0–100% 

Compressor Threshold Signal level after which the compressor will be 
applied. 

-30.0 – +10.0 dB 

 Ratio Amount of compression applied. 1.0:1 – 20.0:1 

 Attack Length of time to apply the compression. 0–100% 

 Output Amount of additional output gain for the 
compressed signal. 

-20.0 – +20.0 dB 

Pumper Rate Speed of the pumper effect. Bar, 1/2 – 1/32T 

 Depth Amount of signal attenuation by the effect. 0–100% 

 Release Amount of time to release the effect. 0–100% 

Limiter Drive Amount of drive added after the limiter effect. 0.0 – 30.0 dB 
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AIR Hype (continued) 
 

Setup 

Use this tab to adjust the plugin setup parameters. 
 
 
 
 
 
 

Parameter Description Value Range 

Setup Transpose Transposition of the plugin, in semitones. -36 – +36 

 Tune Fine tuning of the plugin, in cents. -100 – +100 

 Glide Time Amount of time to slide from the pitch of one note to 
the next note played. 

0 ms – 32 s 

 Glide Mode Enables or disables pitch gliding for all triggered 
notes or legato notes. 

Off, Legato, All 

 Mode Sets the plugin to polyphonic or monophonic Poly, Mono 

 Del-Rev Level of the delay and reverb signals. -inf – +6.0 dB 

 Volume Overall level of the plugin. -inf – +6.0 dB 

MIDI Control    

Mod Wheel Destination Send Mod Wheel data to one of the following control 
destinations. 

Pitch, Cutoff, Reso, Amp, 
Pan 

 Depth Amount of modulation applied.  

  When Destination is set to Pitch: -12.0 – +12.0 

  When Destination is set to Cutoff, Reso, Amp or Pan: -100 – 0 – 100% 

 LFO Ties the modulation to the Control LFO. Off, On 

Aftertouch Destination Send Aftertouch data to one of the following control 
destinations. 

Pitch, Cutoff, Reso, Amp, 
Pan 

 Depth Amount of modulation applied. 0–100% 

  When Destination is set to Pitch: -12.0 – +12.0 

  When Destination is set to Cutoff, Reso, Amp or Pan: -100 – 0 – 100% 

 LFO Ties the modulation to the Control LFO. Off, On 

Control LFO Sync Enables or disables Control LFO sync, and sets how 
the Control LFO is synced when enabled. 

Off, First Note, Each 
Note, Tempo + Note, 
Tempo + Beat 

 Rate Speed of modulation of the Control LFO.  

  When Sync is set to First Note or Each Note: 0.03 – 30.00 Hz 

  When Sync is set to BPM & Note or BPM & Beat: 8/4 – 1/64 

 Shape Waveshape of the Control LFO. Sine, Triangle, Sawtooth, 
Square, S&H Random, 
S&H Alternate, Random 
Drift, Slow Drift 
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AIR Mellotron 
 
The AIR Mellotron plugin is a software recreation of the classic 
tape keyboard, including reproductions of the original tape 
samples in both clean and dirty versions.  

 
 
Model 

Use this tab to adjust the settings for the tape model. 
 

Parameter Description Value Range 

Sample Select the tape loop sample. 8 Voice Choir, Boys 
Choir, Flute, Violins 1, 
Violins 2, Violin 

Clean Enables or disables a cleaner Off, On 

Formant Decreases or increases the harmonic resonance of 
the formant frequency. 

-12 – 0 – +12 

Age Amount of sound degradation applied. 0–100% 

Smpl Start Starting point of the tape loop sample. 0–100% 

Cutoff Amount of filter cutoff applied. 0–100% 

Attack Length of time for the sound to reach full level. 0 ms – 32 s 

Release Length of time for the sound to dissipate when the 
note is released. 

0 ms – 32 s 

Vel > Amp The amount of effect velocity has on amplitude 
control. 

0–100% 

MW Vib Amount of vibrato applied from the mod wheel. 0–100% 

AT Vib Amount of vibrato applied from aftertouch. 0–100% 

Vib Speed Modulation speed of the vibrato effect. 0.03 – 30.00 Hz 

Key On Enables or disables key action noise on note on. Off, On 

Key Off Enables or disables key action noise on note off. Off, On 

On Vol Amount of key-on noise. 0–100% 

Off Vol Amount of key-off noise. 0–100% 

Smpl Poly Number of voices available. 1–40 

Level Overall level of the plugin. 0–100% 
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AIR Mellotron (continued) 
 
Flavor / Compressor / EQ 

Use this tab to adjust the settings for the flavor, compressor and 
EQ effects. Each effect can be turned on and off by using the 
buttons on the right side.  
 
 
 
 
 
 

Parameter  Description Value Range 

Flavor  Use the button in the upper-right corner to enable 
or disable the flavor effect. 

Off, On 

 Timbre Selects an emulation type to color the sound. Varies 

 Timbre Depth Amount of timbre emulation applied to the sound. 0–100% 

 Flutter Amount of speed fluctuation of the sound playback. 0–100% 

 Vinyl Distortion Amount of vinyl distortion noise applied to the 
signal. 

0–100% 

 Vinyl Noise Amount of vinyl noise such as clicks and pops 
applied to the signal. 

0–100% 

Compressor  Use the button in the upper-right corner to enable or 
disable the compression effect.  

Off, On 

 Threshold Signal level after which the compressor will be applied. -30.0 – 0.0 – +10.0 dB 

 Ratio Amount of compression applied. 1.0:1 – 20.0:1 

 Attack Length of time to apply the compression. 0–100% 

 Makeup Amount of additional output gain for the compressed 
signal. 

-20.0 – 0.0 – +20.0 dB 

EQ  Use the button in the upper-right corner to enable or 
disable the EQ effect. 

Off, On 

 Low Amount of attenuation or boost applied to the low 
frequency band. 

-12 – 0 – +12 dB 

 Low Mid Amount of attenuation or boost applied to the low-mid 
frequency band. 

-20 – 0 – +20 dB 

 High Mid Amount of attenuation or boost applied to the high-
mid frequency band. 

-20 – 0 – +20 dB 

 High Amount of attenuation or boost applied to the high 
frequency band. 

-12 – 0 – +12 dB 
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AIR Mellotron (continued) 
 
Delay / Spring Reverb 

Use this tab to adjust the settings for the delay and spring reverb 
effects. Each effect can be turned on and off by using the buttons 
on the right side.  
 
 
 
 
 
 

Parameter  Description Value Range 

Delay  Use the button in the upper-right corner to enable or 
disable delay. 

Off, On 

 Time Amount of time between the dry signal and the 
delayed signal. 

1/16 – 16/4 

 L/R Ratio Reduces the delay Time in either the Left or Right 
stereo field. This is useful for creating offset, panned 
delays. 

50:100 – 100:100 – 
100:50 

 Feedback Amount of signal fed back into the delay line. 0–100% 

 Mix Wet/dry amount of the delay effect. 0–100% 

 Reso LP Freq Low pass frequency for feedback resonance. 100 – 16000 Hz 

 Reso Bell Freq Center frequency for feedback resonance. 100 – 16000 Hz 

 Reso Bell Gain Amount of gain applied to the resonant frequency. 0–100% 

Spring Reverb  Use the button in the upper-right corner to enable or 
disable the spring reverb effect. 

Off, On 

 Pre-Delay Length of time between dry signal and reverberated 
signal. 

0 – 250 ms 

 Time Length of reverb tail. 1.00 – 10.00 s 

 Low Cut Center frequency for reverb signal low-cut filter. 20 – 1000 Hz 

 Diffusion Rate of increasing density of reverb reflections.  
At lower settings, the sound of individual reflections is 
more present.  
At higher settings, reflections are more uniform. 

0–100% 

 Width Stereo width of reverb signal. Higher values give wider 
stereo separation. 

0–100% 

 Mix Wet/dry amount of the reverb effect. 0–100% 
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AIR Solina 
 
The AIR Solina plugin is a software recreation of the classic string 
synthesizer. 

 

  

Ensemble 

Use this tab to adjust the voice and ensemble settings. 
 
 

Parameter Description Value Range 

Voice Click each button to enable or disable the selected 
voice. 

Contra Bass, Cello, Viola, 
Violin, Trumpet, Horn 

Voice Volume Volume of the selected voice. -Inf – 0 – +12 

Voice Panning Stereo panning of the selected voice.  L64 – C – R64 

Voice Octave Octave adjustment for the selected voice.  -2, -1, 0 (Contra Bass) 
0, +1, +2 (Violin) 
-1, 0, +1 (All others) 

Ensemble Enables or disables the ensemble effect. Off, On 

Bass Volume Adjusts the volume of the bass voices. 0–100 

Dual When enabled, both bass and upper voices will play 
on every key, regardless of the octave. When 
disabled, the voices will be split so that the bass 
voices play on lower octaves and the upper voices 
play on higher octaves.  

Off, On 

Upper Volume Adjusts the volume of the upper voices. 0–100 

Level Overall level of the plugin. 0–100% 
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AIR Solina (continued) 
 

Sound 

Use this tab to adjust additional settings for the plugin sound. 
 
 
 
 
 
 
 
 
 
 
 

Parameter Description Value Range 

Crescendo Length of time for the sound to reach full volume. 0 ms – 32 s 

Sustain Length of time for the sound to remain playing after 
the key is released.  

0 ms – 32 s 

Formant Decreases or increases resonant frequencies to 
adjust the timbre of the sound. 

-12 – 0 – +12 

Filter Adjusts the low-pass filter frequency. 0–100% 

Age Amount of detuning and drift applied. 0–100% 

Velocity to Amp The amount of effect velocity has on amplitude 
control. 

0–100% 

MW Vibrato Amount of vibrato applied from the mod wheel. 0–100% 

AT Vibrato Amount of vibrato applied from aftertouch. 0–100% 

Vibrato Speed Modulation speed of the vibrato effect. 1.00–30.00 Hz 

Sample Poly Number of voices available. 1–50 
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AIR Solina (continued) 
 

Flavor 

Use this tab to adjust the settings for the flavor and vinyl effects. 
 
 
 
 
 
 
 
 
 

Parameter  Description Value Range 

Flavor  Enables or disables the flavor effect. Off, On 

 Timbre Selects an emulation type to color the sound. Varies 

 Timbre Depth Amount of timbre emulation applied to the sound. 0–100% 

 Vinyl 
Distortion 

Amount of vinyl distortion noise applied to the signal. 0–100% 

 Vinyl Noise Amount of vinyl noise such as clicks and pops applied to 
the signal. 

0–100% 

 Flutter Amount of speed fluctuation of the sound playback. 0–100% 

 Monofy Reduces the stereo spread. 0–100% 
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AIR Solina (continued) 
 

Chorus / EQ 

Use this tab to adjust the settings for the chorus and EQ effects. 
Use the buttons on the right side to enable or disable each effect.  

 
 
 
 
 
 
 
 
 
 
 
 

Parameter  Description Value Range 

Chorus Rate Modulation speed of the chorus effect. 0.05 – 20 Hz 

 Depth Modulation depth of the chorus effect. 0–100% 

 Tone Decreases or increases the brightness of the chorus 
effect. 

-100 – 0 – +100% 

 Mix Wet/dry amount of the chorus effect. 0–100% 

EQ Low Amount of attenuation or boost applied to the low 
frequency band. 

-12 – 0 – +12 dB 

 Low Mid Amount of attenuation or boost applied to the low-mid 
frequency band. 

-20 – 0 – +20 dB 

 High Mid Amount of attenuation or boost applied to the high-mid 
frequency band. 

-20 – 0 – +20 dB 

 High Amount of attenuation or boost applied to the high 
frequency band. 

-12 – 0 – +12 dB 
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AIR Solina (continued) 
 

Delay / Spring Reverb 

Use this tab to adjust the settings for the delay and spring reverb 
effects. Use the buttons on the right side to enable or disable each 
effect.  

 

 

 
 
 

Parameter  Description Value Range 

Delay Time Amount of time between the dry signal and the delayed 
signal. 

1/16 – 16/4 

 L/R Ratio Reduces the delay Time in either the Left or Right stereo 
field. This is useful for creating offset, panned delays. 

50:100 – 100:100 – 
100:50 

 Feedback Amount of signal fed back into the delay line. 0–100% 

 LP Freq Low pass frequency for feedback resonance. 100 – 16000 Hz 

 Bell Freq Center frequency for feedback resonance. 100 – 16000 Hz 

 Bell Gain Amount of gain applied to the resonant frequency. 0–100% 

 Mix Wet/dry amount of the delay effect. 0–100% 

Spring Reverb Pre-Delay Length of time between dry signal and reverberated 
signal. 

0 – 250 ms 

 Time Length of reverb tail. 1.00 – 10.00 s 

 Low Cut Center frequency for reverb signal low-cut filter. 20 – 1000 Hz 

 Diffusion Rate of increasing density of reverb reflections.  

At lower settings, the sound of individual reflections is 
more present.  

At higher settings, reflections are more uniform. 

0–100% 

 Width Stereo width of reverb signal. Higher values give wider 
stereo separation. 

0–100% 

 Mix Wet/dry amount of the reverb effect. 0–100% 
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WayOutWare Odyssey 
 
The WayOutWare Odyssey plugin is a software recreation of the 
classic analog synthesizer that captures the character and nuance 
of the original Odyssey using WayOutWare’s experience and 
expertise in circuit modeling and signal processing.  

 

VCO 1/2 

Use this tab to adjust the settings for the voltage-controlled 
oscillators. 
 

Parameter Description Value Range 

LFO/Audio  When set to Audio, standard pitches will be 
produced as indicated by the Oct, Semi and CT 
values for the Frequency setting. 

When set to LFO, the VCO will be controlled by an 
LFO and may be used for modulating VCO2. 

LFO, Audio 

Frequency  Determines the pitch adjustment for the oscillator. 
The total frequency range depends on the 
LFO/Audio setting, and is shown at the bottom of 
this section. 

0.174 – 1478.852 Hz 

 Coarse Coarse pitch adjustment.  -0.200 – 6.333 V 

 Fine Fine pitch adjustment. 0.000 – 0.875 V 

VCO 1 FM  Source 1 
Waveform 

Type of frequency modulation waveform applied 
by the LFO. 

LFO Sine, LFO Square 

 Depth 1 Depth of frequency modulation.  0.0–100.0% 

 Source 2 Determines the frequency modulation source.  S/H, ADSR 

 Depth 2 Depth of Source 2 modulation.  0.0–100.0% 

VCO 1 Pulse 
Width 

Width Width of pulse width modulation. 50.0–90.0% 

Mod Depth of pulse width modulation. 0.0–100.0% 

 Source Determines the pulse width modulation source. LFO Sine, ADSR 

Sync  Determines whether VCO 2 is synced with the 
frequency of VCO 1. When disabled, you can use 
both VCOs to produce separate pitches.  

Off, On 

Frequency  Pitch adjustment for the oscillator. 8.706 – 1478.852 Hz 

 Coarse Coarse pitch adjustment.  -0.200 – 6.333 V 

 Fine Fine pitch adjustment. 0.000 – 0.875 V 

VCO 2 FM  Source 1 Type of modulation source. When S/H Mixer or 
Pedal is selected, the modulation can be 
controlled by the Sample and Hold mixer or by an 
optional external expression pedal. 

LFO Sine, S/H Mixer or 
Pedal 

 Depth 1 Depth of Source 1 modulation. 0.0–100.0% 

 Source 2 Type of modulation source.  S/H, ADSR 

 Depth 2 Depth of Source 2 modulation. 0.0–100.0% 

VCO 2 Pulse 
Width 

Width Width of pulse width modulation. 50.0–90.0% 

Mod Depth of pulse width modulation. 0.0–100.0% 

 Source Type of source for pulse width modulation. LFO Sine, ADSR 
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WayOutWare Odyssey (continued) 
 

Mod/Env 

Use this tab to adjust the settings for the low frequency oscillator, 
sample and hold generator, and envelope generator. 
 
 
 
 
 
 
 

Parameter Description Value Range 

LFO LFO Tempo 
Sync 

Determines whether LFO speed is free floating 
or synced to project tempo. 

Off, On 

 LFO Speed Speed of the low frequency oscillator.  
When Sync is Off: 
When Sync is On: 

 
0.0925 – 20.0000 Hz 
4/4 – 1/64 beats 

Sample/Hold Trigger Determines the source signal for triggering the 
Sample and Hold mixer, either the Low 
Frequency Oscillator or the pitched Keyboard 
output. 

LFO Trigger, Kybd Trigger 

 Source 1 Selects the VCO-1 waveform or pulse width 
modulation as Sample and Hold input. 

Saw, Pulse 

 Source 2 Selects a noise generator or the VCO-2 pulse 
width modulation as Sample and Hold input. 

Noise, Pulse 

 VCO-1 Level of the VCO-1 input. 0.0–100.0% 

 Depth Level of the noise or VCO-2 input. 0.0–100.0% 

 Lag Adjusts the smoothing of the Sample and Hold 
output voltage.  

0.0–100.0% 

AR Attack Attack time of the AR envelope generator. 0.003 – 10.000 seconds 

 Release Release time of the AR envelope generator. 0.003 – 10.000 seconds 

 Trigger Source Determines the input source sent to the AR 
envelope generator. 
When set to KYBD Gate, the envelope 
generator is triggered by key input. 
When set to LFO Repeat, the envelope 
generator is trigger by the LFO pulse wave. 

KYBD Gate, LFO Repeat 

ADSR Attack Attack time of the ADSR envelope generator. 0.003 – 10.000 seconds 

 Decay Decay time of the ADSR envelope generator. 0.003 – 10.000 seconds 

 Sustain Sustain time of the ADSR envelope generator. 0.000 – 10.000 V 

 Release Release time of the ADSR envelope generator. 0.003 – 10.000 seconds 

 Trigger Source Type of input to trigger the envelope generator.  KYBD Gate, LFO Repeat 

 Repeat When Trigger Source is set to LFO Repeat, 
select KYBD Repeat for the LFO to trigger only 
when a key is pressed, or select Auto Repeat 
for the LFO to trigger automatically without key 
input.   

KYBD Repeat, Auto Repeat 
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WayOutWare Odyssey (continued) 
 

Mix/Filter 

Use this tab to adjust the audio mixing and routing, as well as 
adjust the voltage controlled filter, high-pass filter, and voltage 
controlled amplitude. 
 
 
 
 

Parameter Description Value Range 

VCF VCF Cutoff Cutoff frequency of the filter.  0.680 – 10.645 V, or 
16.02 - 16012.70 Hz 

 VCF Res Resonance of the filter. 0.000 – 0.800 Q 

Audio Mixer Noise/Ring 
Mod 

Select the noise generator or ring modulation 
input for the mixer. 

Noise, Ring Mod 

 Noise/Ring 
Mod Level 

Level of the noise generator or ring modulation 
into the mixer. 

0.0–100.0% 

 VCO-1 Input Select the VCO-1 input type for the mixer. Saw, Pulse 

 VCO-1 Level Level of VCO-1 into the mixer. 0.0–100.0% 

 VCO-2 Input Select the VCO-2 input type for the mixer. Saw, Pulse 

 VCO-2 Level Level of VCO-2 into the mixer.  0.0–100.0% 

VC Filter VCO-1 Filter 
Modulation 
Source 

Set the input source for VCO-1 filter 
modulation. 
Select KYBD CV to use key input as the 
source. 
Select S/H Mixer or Pedal to use the Sample 
and Hold generator or optional external pedal. 

KYBD CV, S/H Mixer or 
Pedal 

 CV Modulation 
Level 

Level of VCO-1 filter modulation. 0.0–100.0% 

 VCO-2 Filter 
Modulation 
Source 

Set the input source for VCO-2 filter 
modulation. 

S/H, LFO Sine 

 CV Modulation 
Level 

Level of VCO-2 filter modulation.  0.0–100.0% 

HP Filter Filter 
Modulation 
Source 

Select which envelope generator to use as a 
filter modulation source. 

ADSR, AR 

 CV Filter 
Modulation 
Level 

Amount of envelope filter modulation applied to 
the VC Filter.  

0.0–100.0% 

 HPF Cutoff Cutoff frequency of the high-pass filter.  0.680 – 10.645 V, or 
16.02 - 16012.70 Hz 

VC Amp Mod Source Select which envelope generator to use as an 
amplitude modulation source. 

ADSR, AR 

 Mod Amount of envelope modulation applied to the 
output signal. 

0.0–100.0% 

 VCA Gain Amount of gain applied to the VC Amp. 0.0–100.0% 



  

 
287 

 

 

WayOutWare Odyssey (continued) 
 

Echo 
Use this tab to adjust the settings for the tape echo effect.  
 
 
 
 
 
 

Parameter Description Value Range 

Delay  Use the switch in the bottom-left corner to enable or 
disable the delay effect. 

Off, On 

 Sync Enable to sync the Echo Time to the Global Tempo, or 
disable to adjust the Echo Time by milliseconds. 

Off, On 

 Sustain Length of time that the echo continues playing. 0.0–100.0% 

 Echo Mix Adjusts the wet/dry amount between the original sound 
and the echo. 

100% Synth – 50/50% 
– 100% Echo 

 Echo Time Amount of time between the dry signal and the delayed 
signal. Use the slider or the Echo Time field to change the 
value. 

When Sync is Off: 
When Sync is On: 

0.02 – 5.00 seconds 
1/64 – 4/4 
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WayOutWare Odyssey (continued) 
 
 
Settings  

Use this tab to adjust general settings such as voice count, 
portamento and performance parameters. 
 
 
 
 

Parameter Description Value Range 

Voice Count  Number of voices available. When set to Duo, each VCO 
controls a separate note. 

Duo, 2–4 

Portamento  Length of time to slide between notes.  0.000 – 1.500 seconds 

 Exp Pedal Enables or disables the use of an expression pedal to 
control portamento. 

Off, On 

 Footswitch Enable or disables the use of a footswitch to activate 
portamento.  

Off, On 

Transpose  Amount of transposition applied to the keyboard. -2, 0, +2 octaves 

Noise  Type of noise used for the noise generator.  White, Pink 

Performance 
Velocity 
Depth 

MW Vib LFO Amount of vibrato LFO applied by the mod wheel. 0.0–100.0% 

 MW PWM Amount of pulse width modulation applied by the mod 
wheel. 

0.0–100.0% 

 KYBD Filter Amount that the filter is tied to the pitch being played. 0.0–100.0% 

 KYBD Amp Amount that the amplitude is tied to the pitch being 
played. 

0.0–100.0% 
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AIR DrumSynth 
 

The AIR DrumSynth plugins emulate the sound of classic drum machines and feature multiple synthesis types, 
advanced modeling and carefully crafted, built-in effects to create powerful contemporary drum sounds. 

 

 
 

Drum Sound 

Use this section to adjust the basic settings for the drum sound. You can also use the knobs on this tab to 
quickly adjust up to eight parameters specifically chosen for each sound.  

 

Parameter  Description Value Range 

Model  Type of drum sound emulated. Varies 

One-Shot  Allows the drum sound to play entirely when triggered 
or only for how long the note length is set. 

Enabled, Disabled 

Velocity  Amount of incoming Velocity applied. When set to 0, 
all notes will sound as if Full Level. 

0–100% 

Velocity 2  Amount of additional Velocity envelope that can be 
used to control a parameter. 

-100 – 0 – +100% 

 Target Select the Parameter where the Velocity 2 information 
is sent. 

Param 1–8 

Gain  Volume level of the drum sound. -Inf, -68.0 – 0 – +12.0 dB 

Parameter 
Knobs 

 Each drum sound has up to eight associated 
parameters that can be used to further shape the 
sound. The available parameters vary based on the 
type of drum sound selected. Use the knobs to adjust 
the selected parameter. 

Varies 

 

Transient 

Use this section to adjust the settings for the Transient effect. 

 

Parameter Description Value Range 

Attack Decreases or increases the amount of transient attack applied 
to the signal. 

-100 – 0 – +100% 

Shape Adjusts the shape of the processed transient. 0–100% 

Sustain Percentage of sustain envelope subtracted from or added to 
the transient effect. 

-100 – 0 – +100% 
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AIR DrumSynth (continued) 
 
 

Distortion 

Use this section to adjust the settings for the Distortion effect. 

 

Parameter Description Value Range 

Pre-Shape Increases or decreases the high-end tone of the incoming 
audio signal pre-distortion. 

-100 – 0 – +100% 

Drive Amount of drive applied. 0–60 dB 

Threshold Signal level after which the distortion will be applied. -20.0–0.0 dB FS 

High Cut Center frequency of the distortion signal high-cut filter. 1.00–20.0 kHz 

Mix Wet/dry amount of the distortion effect. 0–100% 

 

 

EQ 

Use this section to adjust the settings for the EQ effect. 

 

Parameter Description Value Range 

High Freq Center frequency for the High EQ band. 1.20 – 20.0 kHz 

High Gain Amount of gain applied to the High EQ band. Cut, -12.0 – 0 – +12.0 dB 

High Mid Freq Center frequency for the High Mid EQ band. 120 Hz – 16.0 kHz 

High Mid Q Width of the High Mid EQ band. 0.40–10.00 

High Mid Gain Amount of gain applied to the High Mid EQ band. -18.0 – 0 – +18.0 dB 

Low Mid Freq Center frequency for the Low Mid EQ band. 40.0 Hz – 8.00 kHz 

Low Mid Q Width of the Low Mid EQ band. 0.40–10.00 

Low Mid Gain Amount of gain applied to the Low Mid EQ band. -18.0 – 0 – +18.0 dB 

Low Freq Center frequency for the Low EQ band. 20.0 Hz – 1.00 kHz 

Low Gain Amount of gain applied to the Low EQ band. Cut, -12.0 – 0 – +12.0 dB 

 
 
 

Compressor 

Use this section to adjust the settings for the Compressor effect. 

 

Parameter Description Value Range 

Ratio Amount of compression applied. 1.0:1 – 100.0:1 

Attack Length of time to apply the compression. 100 us – 300 ms 

Threshold Signal level after which the compressor will be applied. -60.0–0.0 dB 

Output Amount of additional output gain for the compressed signal. 0.0–30.0 dB 
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AIR DrumSynth (continued) 
 
 
At the right end of each DrumSynth single plugin, you can quickly enable or disable the built-in effects (Transient, 
Distortion, EQ and Compressor) by tapping the Trans, Dist, EQ and Comp buttons, as well as adjust the overall 
Volume of the plugin by using the Volume slider. 

 

 

 

 

You can also use the DrumSynth:Multi plugin to access all DrumSynth sounds from one plugin, which includes 
additional dedicated effects and mixing controls. 

 

DrumSynth 1–8 / Trans/Dist/EQ/Comp 

Use the first eight sections in the Multi to control the same Drum Sound parameters as the individual DrumSynth 
plugins.  

Use the Del, Diff and Rev knobs to adjust the level of the Send FX for each drum sound. 

You can enable or disable the built-in effects (Transient, Distortion, EQ and Compressor) by tapping the 
Trans, Dist, EQ and Comp buttons for each DrumSynth. 

Use the FX sections to control the same parameters as the Transient, Distortion, EQ and Compressor effects 
in the individual DrumSynth plugins.  

 

Mixer 

Use this section to adjust the volume, panning, muting and soloing for 
each drum. 

Click the 1–8 icons to mute or unmute the selected drum. 

Click the S icon to solo the selected drum. 

Click and drag the pan slider to adjust the drum panning.  

Click and drag the volume slider to adjust the drum volume. 
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AIR DrumSynth (continued) 
 
 

Send FX 

Use this section to adjust the parameters for the Delay, Diffuser and 
Reverb effects. Tap the Del, Diff and Rev buttons at the top of the 
section to enable or disable the selected send effect. 

 
  
 
 
 
 
 
 
 

Parameter Description Value Range 

Delay Time Length of time between the dry signal and the 
delayed signal. 

1/32 – 8/4 

 Ratio Reduces the delay Time in either the Left or 
Right stereo field. This is useful for creating 
offset, panned delays. 

L 100:50, R 50:100 

 Feedback Amount of delay signal fed back into the 
delay line. 

0–100% 

 Filter Freq Sets the center frequency of the filtered delay 
signal. 

1.00 – 20.0 kHz 

 Reso Amount of resonance of the feedback signal. 0–100% 

 Reso Freq Center frequency for feedback resonance. 100 Hz – 10.0 kHz 

Diffuser Delay Delay time between the dry signal and the 
diffused signal. 

1/64 – 4/4 

 Feedback Amount of diffused signal sent back into the 
delay line. 

0–100% 

 Diffusion Rate of increasing density of reverb 
reflections. 
At lower settings, the sound of individual 
reflections is more present. 
At higher settings, reflections are more 
uniform. 

0–100% 

 Bright Adjusts the high-end tone of the diffused 
signal. 

0–100% 

Reverb Mode Type of reverb applied. Hall, Stadium, Room, 
Abstract 

 Time Length of reverb tail. 0.4 s – +Inf s 

 Low Cut Center frequency for the reverb low-pass 
filter. 

1 – 1000 Hz 

 High Cut Center frequency for the reverb high-pass 
filter. 

1.00 – 20.0 kHz 
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Trademarks & Licenses 
 

Akai Professional and MPC are trademarks of inMusic Brands, Inc., registered in the U.S. and other countries. 

Ableton and the Ableton Logo are trademarks of Ableton AG. 

ASIO, VST, and VST3 are trademarks of Steinberg Media Technologies GmbH. 

MPC 3 software incorporates élastique Pro V3 by zplane.development. 

MPC 3 software incorporates STEMS PRO V1 by zplane.development. 

Apple and macOS are trademarks of Apple Inc., registered in the U.S. and other countries. 

SD and SDHC are registered trademarks of SD-3C, LLC. 

Windows is a registered trademark of Microsoft Corporation in the United States and other countries. 

All other product names, company names, trademarks, or trade names are those of their respective owners. 
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Addenda 
 
MPC Pro Pack 
 

The MPC Pro Pack is included for all MPC Live III and MPC XL users and can be purchased as an upgrade for all 
other Gen 1 MPC standalone hardware running MPC v3.6 or later. 

To purchase the MPC Pro Pack, visit thempcstore.com / akaipro.com. You can unlock the MPC Pro Pack on 
up to three supported devices.  

To unlock the MPC Pro Pack, use the Activations tab of the Preferences. 

 

Clip Launch 
 

The MPC Pro Pack brings the Akai Force clip launching feature set to MPC software for the first time.  

 

To activate clip workflow: 

1. First, make sure you have activated and installed the MPC Pro Pack, and specifically the Clip Launch feature 
set. See the earlier section of this chapter to learn how to do so.  

2. In the Preferences menu, navigate to the Project Defaults tab and set the Use Clip Workflow button to ON. 

3. Turning Clip Workflow on and off requires you to close and reopen the MPC 3 software. When turning on or off, 
you will be prompted to save any unsaved changes to your current project.  

4. Once the MPC 3 software has been restarted, you may use the new clip workflow features, described below.  

 

When Clip Workflow is activated, you will have access to three additional MPC modes for working with clips on 
connected MPC hardware: 

• Clip Matrix Mode 

• Navigate Mode 

• Clip Editor Mode 

 

Within MPC software. a new Clip section in the Inspector will be available.  

Click the > or ∨ next to the Clip field to collapse or expand this section. 

Click the Clip field or down arrow () to select a clip or the linear 
Arrangement. Selecting an unused clip will prompt the New Clip options in 
the Grid Editor. 

Use the Clip Name field to enter a name for the clip. If left blank, this will 
automatically be named with the current Track Name, appended by the 
Clip number. 

Use the Length field to set the length of the clip in bars. 

Use the Time Sig fields to set the time signature of the clip. The first 
number sets the number of beats per bar (1–16), and the second number 
sets the note value of each beat (4, 8, 16, 32). 

Click Create New Clip to create the clip. 

Double-click the Clip field to rename the clip. 

Click the play icon to begin playback of the selected clip.  

http://thempcstore.com
http://akaipro.com


  

 
295 

 

 

Click the small menu icon (≡) to select or deselect which items are shown in 
this section.  

Start: the first bar of the clip 

End: the last bar of the clip 

Loop: determines whether or not clip playback will loop 

Loop Start: the first bar of the clip loop 

Loop End: the last bar of the clip loop 

Launch Q: the launch quantization value of the clip 

Launch: the clip launch behavior setting 

Legato: the Legato mode setting 

Note: The above options can only be edited when a filled clip slot is 
selected. 

Time Signature: the number of beats per bar, and the note value of each 
beat. When Arrangement is selected, this also adjusts the Time Sig value 
in the Sequence section. When a filled clip slot is selected, this adjusts the 
Time Signature for the selected clip only. 

 

Right-click the Clip Name field to open the Clip Settings window. 

Use the Name field to rename the clip. 

Use the Color field to determine the color of the clip. Select As Track to align the clip color with the track 
color, or choose an alternate color. 

Use the Launch Quantization field to set the quantization amount for launching the clip. Select Global to 
use the current Time Correct value, or select an alternate value. Select Off for no quantization. 

Use the Launch Mode field to determine clip launch behavior. Select Toggle for the clip to start or stop with 
each successive press. Select Trigger for the clip to start at the beginning with each press. 

Check the Legato box to enable Legato mode. When enabled, launching the clip will pick up playback from 
the same position of the previously playing clip, depending on the launch quantization value. For example, if 
launch quantization is set to 1 bar, launching a legato clip at Bar 1, Beat 2 of another playing clip will cause 
the legato clip to begin playing at Bar 2, Beat 1. If legato is off, the clip would begin playing from the start. 

Click the -/+ buttons to move to the previous or next clip. 

Click Close to close the Clip Settings window. 
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Advanced CV Tracks 
 

The MPC Pro Pack includes powerful enhancements to CV tracks, offering a comprehensive set of modulators and 
utilities that greatly enhance control over external CV-enabled devices. 

 

 

 

Use the dropdown menu to select a CV output destination. 

Use the Out knob to set the CV output. 

Use the Depth knob to apply additional modulation depth to the output. 

 

The LFO section provides control for the Low Frequency Oscillator, a periodic waveform with an adjustable 
frequency and shape which can be used for modulation purposes. 

Click the 1–4 icons to toggle between the four available LFOs. 

Click the Shape menu to select the LFO waveform type: Ramp Up, Ramp Down, Triangle, Sine, Square, 
Random 1, Random 2. 

Use the Trigger field to determine how the LFO phase resets. Select Free Running for the LFO to run 
continuously without resetting. Select Play Start to reset the LFO at the start of the sequence. Select Note On to 
reset the LFO each time a note is triggered in the CV track’s grid.  

Use the Rate knob to determine the LFO frequency. At lower values, it might take some time for the LFO to 
complete a cycle, while higher values will come closer to audible range. 

Use the Sync knob to synchronize the LFO’s rate with the MPC sequence tempo. You can select one of several 
time divisions (a . indicates a dotted note; a T indicates a triplet-based time division). When None is selected, 
Sync is off, and the frequency is determined by the Rate knob. 

Use the Depth knob to set the overall amount of modulation applied by the LFO. At lower values, the modulation 
is more subtle, and at higher values it is more extreme. 

 

The Ramp section lets you create rising or falling modulation signals. 

Click the 1–2 icons to toggle between the two available ramps. 

Use the Time field to adjust the length of the ramp. 

Use the Shape field to adjust the curve of the ramp. Positive values rise or fall more quickly, while negative 
values rise or fall more slowly. 
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The Env (Envelope) section lets you create a variable control signal that can be used, for instance, to modulate the 
filter, amplitude, or pitch settings of a sound over a given period of time. 

Click the 1–4 icons to toggle between the four available envelopes. 

Use the Mode field to set how the envelope is triggered. Select Note On to restart the envelope with each Note 
On message. Select Loop to continuously cycle the envelope. Select One Shot to play through the envelope 
once.  

Use the Sync field to synchronize the envelope to the MPC sequence for precise timing control. 

Use the Delay, Attack, Hold, Decay, Sustain, and Release fields or click and drag the “handles” of each 
envelope to shape the envelope or time-variant modulation output. See the Anatomy of an Envelope section to 
learn about the envelope parameters. 

Use the Depth knob to set the overall amount and direction in which the envelope is applied.   

 

Use the Offsets knobs to adjust voltage levels to modulate external gear.  

 

 

 

The Stepper section lets you create a step sequence for CV control. 

Use the Steps field to set the length of the sequence. 

Use the Speed field to set how quickly the sequence is played. 

Use the Speed Sync field to synchronize the speed with the MPC sequence tempo. You can select one of several 
time divisions (a . indicates a dotted note; a T indicates a triplet-based time division). When set to None, Sync is 
off,  and the sequence timing is determined by the Speed field. 

Click and drag the step handles to set step values. 

Click and drag the smoothing values, below the step number, to apply additional smoothing to each step. 

 

The Clock Divider section divides the incoming clock to allow for slower modulation rates. 

 

The Step section allows you to set Step lengths for modulation purposes. 

 

The Matrix section allows you to Sum or Multiply two modulation sources and sum or multiply them for complex 
signals. 
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MPC Pro Pack Plugins 
 

AIR Visual EQ4 

 

AIR Visual EQ4 is a highly versatile EQ plugin providing four bands of equalization, with a spectrum analyzer that 
gives clear visual feedback of the audio you want to process. 

 

 

 

Parameter Description Value Range 

Band Tap the power button next to each band to turn it on or off. Off, On 

Freq Center frequency of the EQ band. 20.0 Hz – 20.00 kHz 

Gain When Type is set to LowShelf, Peak, or HighShelf, this 
adjusts the output level of the EQ band. 

-30.0 – 0.0 – +30.0 dB 

Q Width of the EQ band. 0.10–18.00 

Type Shape of the selected EQ band. LowShelf, LowPass, 
HighPass, BandPass, Notch, 
Peak, HighShelf 

Gain Output level of the post-EQ audio. -inf – 0.0 – +12.0 dB 

 

 



  

 
299 

 

 

AIR Utility 

 

The AIR Utility plugin provides basic gain, mono/stereo, and phase utilities in a single plugin. 

 

 

 

Parameter  Description Value Range 

Input    

 Left Phase Click to invert the phase of the left stereo channel. Off, On 

 Right Phase Click to invert the phase of the right stereo channel. Off, On 

 Mode Click the drop-down menu to adjust the Stereo processing 
mode.  

• L: Left channel only 
• L+R (-3dB): Summed left and right channels, with a -3 

dB pad. 
• L+R (-6dB): Summed left and right channels, with a -6 

dB pad. 
• L-R (+3dB): Inter-channel difference, with a -3 dB pad. 
• L-R (+6dB): Inter-channel difference, with a -6 dB pad. 
• R: Right channel only 
• Stereo: Standard stereo image 
• Swapped: Reverses the left and right stereo channels 

See Description 

 Mono Converts a Stereo signal to Mono. This is only available 
when Type is set to L-R (+3dB), L-R (+6dB), Stereo, or 
Swapped. 

Off, On 

 Mid-Side Enables Mid-Side encoding, where the Left + Right 
channel sum is centered in the stereo image, and the Left - 
Right channel difference is panned to each side. This is 
only available when Type is set to Stereo or Swapped. 

Off, On 

 Width Adjusts the stereo width of the input signal. Higher values 
give wider stereo separation. 

0–200% 

 Bass Mono Enables converting the low frequency audio signal to 
mono. 

Off, On 

 Bass Mono 
Frequency 

Center frequency of the low-pass filter used for the Bass 
Mono function. 

50 – 500 Hz 

 Bass Mono 
Audition 

Click the headphones icon to isolate the low frequencies, 
useful when adjusting the Bass Mono Frequency. 

Off, On 
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Parameter  Description Value Range 

Output    

 Mute Mutes the outgoing audio. Off, On 

 DC Offset Applies a high-pass filter to remove extreme low 
frequencies that may cause audio issues.  

Off, On 

 Gain Adjust the output level of the processed signal.  -inf – 0.0 – 25.0 dB 

 Pan Adjust the stereo panning of the output signal.  L (100:0) – C (0:0) – R 
(0:100) 
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AIR Reverb Pro 

 

AIR Reverb Pro delivers realistic, dynamic reverbs suitable for a variety of sound design tasks, from subtle room 
reverbs to rich, expansive modulated tails. 

 

 

 

Parameter Description Value Range 

Input Width Adjusts the spread of the incoming audio signal in the 
stereo field. A setting of 0% means the incoming audio will 
be processed in mono. A setting of 100% means the 
incoming audio will be processed as a full stereo image.  

0–100% 

Room Size Size of the simulated room which helps determine the 
reverberation length.  

XXXS, XXS, XS, S, M, L, XL, 
XXL, XXXL 

Output Width Adjusts the spread of the outgoing processed audio signal 
in the stereo field. A setting of 0% means the audio will be 
output in mono. A setting of 100% produces an open, 
panned stereo image. 

0–100% 

Pre-Delay Length of time between dry signal and reverberated signal. 

Tap the music note icon to enable or disable Sync. 

 

 When Sync is Off: 0–250 ms 

 When Sync is On: 0, 1/32, 1/16T, 1/32D, 1/16, 
1/8T, 1/16D, 1/8, 1/4T, 1/8D, 
1/4,  

Decay Rate at which the reverberation decays after the original 
direct signal stops. 

0–100% 

Mix Wet/dry amount of the reverb effect. 0–100% 

Balance Mix between the Early Reflections signal and Tail signal. 0–100% 
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Parameter  Description Value Range 

Early 
Reflections 

 Click Early Reflections to open the following 
controls. 

 

 Type Simulated physical environment used for 
modeling the early reflections. 
• Off: No early reflections. 
• Booth: Simulates a vocal recording booth. 
• Club: Simulates a small, clear, natural-

sounding club ambience. 
• Room: Simulates the center of a small room 

without many reflections. 
• Small Chamber: Simulates a bright, small-

sized room. 
• Medium Chamber: Simulates a bright, 

medium-sized room. 
• Large Chamber: Simulates a bright, large-

sized room. 
• Small Studio: Simulates a small, live, empty 

room. 
• Large Studio: Simulates a large, live, empty 

room. 
• Scoring Stage: Simulates a scoring stage in 

a medium-sized hall. 
• Philharmonic: Simulates the space and 

ambience of a large, symphonic, concert hall. 
• Concert Hall: Simulates the space and 

ambience of a large concert hall. 
• Church: Simulates a medium-sized space 

with natural, clear-sounding reflections. 
• Opera House: Simulates the space and 

ambience of an opera house. 
• Vintage 1: Simulates a vintage digital reverb 

effect. 
• Vintage 2: Simulates a vintage digital reverb 

effect. 

See Description 

 Input – Direct Incoming audio level of the unprocessed signal 
into the Early Reflection. 

-inf – 0.0 dB 

 Input – Pre-Delay Incoming audio level of the Pre-Delay processed 
signal into the Early Reflection. 

-inf – 0.0 dB 

 Scale – Size  Adjusts the size of the early reflection reverb. You 
can also click and drag the cube to adjust the 
size.  

-50.0 – 400.00% 
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Parameter  Description Value Range 

Tail  Click Tail to open the following controls.   

 Tail – Distance  Adjusts the distance that sound travels for 
reflections during the tail. The higher the distance, 
the more you can hear distinct reflections in the 
tail.  

0–100% 

 Tail – Density  Adjusts the rate at which the sound density of the 
reverb tail increases over time. Higher Density 
settings create a smoother reverberated sound. 
Lower settings result in more fluttery echo. 

0–100% 

 Input – Direct  Incoming audio level of the unprocessed signal 
into the Tail. 

-inf – 0.0 dB 

 Input – Pre-Delay Incoming audio level of the Pre-Delay processed 
signal into the Tail. 

-inf – 0.0 dB 

 Input – Early 
Reflections 

Incoming audio level of the Early Reflections 
processed signal into the Tail.  

-inf – 0.0 dB 

 Damping – Low  Center frequency at which low-frequency 
damping is applied to the Tail signal. 

10–2000 Hz 

 Damping – Early  Center frequency at which high-frequency 
damping is applied to the early Tail 
reverberations. 

500–30000 Hz 

 Damping – Late Center frequency at which high-frequency 
damping is applied to the late Tail reverberations. 

500–30000 Hz 

 Mod Click the switch in the upper-right corner of this 
section to enable modulation. 

Off, On 

 Mod – Depth Amount of modulation applied to the Tail 
processed signal 

0–100% 

 Mod – Rate  Speed of modulation applied to the Tail 
processed signal.  

0–100% 
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Parameter  Description Value Range 

EQ  Click EQ to open the EQ and Dynamics 
controls. 

 

 EQ On/Off Click the switch next to the EQ heading to turn 
it on or off. 

Off, On 

 Low Cut  Center frequency of the low cut filter. 10.0 Hz – 1.00 kHz 

 Low Freq  Center frequency of the low EQ band. 20.0 Hz – 1.00 kHz 

 Low Gain Level of the low EQ band. -15.0 – 0.0 – +15.0 dB 

 Mid Freq Center frequency of the mid EQ band. 40.0 Hz – 16.0 kHz 

 Mid Gain Level of the mid EQ band. -15.0 – 0.0 – +15.0 dB 

 Mid Q Width of the mid EQ band. 0.50–10.00 

 High Mid Freq Center frequency of the mid EQ band. 40.0 Hz – 16.0 kHz 

 High Mid Gain Level of the mid EQ band. -15.0 – 0.0 – +15.0 dB 

 High Mid Q Width of the mid EQ band. 0.50–10.00 

 High Freq Center frequency of the high EQ band. 2.00 – 20.0 kHz 

 High Gain Level of the high EQ band. -15.0 – 0.0 – +15.0 dB 

 High Cut Center frequency of the high cut filter. 200 Hz – 20.0 kHz 

 Compressor Click the switch next to the Compressor 
heading to turn it on or off. 

Off, On 

 Compressor Threshold Volume level at which compression will be 
applied. 

-40.0 – 0.0 dB 

 Compressor Gain Adjusts the output level of the compressed 
signal. 

0.00–30.00 
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AIR Fabric Select 

 

Perform 
 

 

 

All settings in this view except Delay On/Off and Reverb On/Off are available in all other plugin views. 
 

Parameter Description Value Range 

Main Vol Overall level of the plugin. -inf – 0.0 – +6.0 dB 

Layer 1/2 Enable or disable the layer. Off, On 

Volume Level of the layer. -inf – 0.0 – +12.0 dB 

Layer 1/2 Category Sound category of the layer.  Varies 

Layer 1/2 Preset Preset sound within the selected category. Varies 

Cutoff Filter cutoff frequency of the layer. -100 --- 0 --- +100% 

Reso Amount of resonance/emphasis of the filter cutoff 
point for the layer.  

-100 --- 0 --- +100% 

Attack Amount of amplitude attack reduced from or added 
to the sound.  

-100 --- 0 --- +100% 

Release Amount of amplitude release reduced from or added 
to the sound.  

-100 --- 0 --- +100% 

Formant Decreases or increases resonant frequencies to 
adjust the timbre of the sound. 

-100 --- 0 --- +100% 

Sample Start Starting point of the sample. -100 --- 0 --- +100% 

Delay Enable or disable the delay effect. Off, On 

Delay Mix Wet/dry amount of the delay effect. 0–100% 

Reverb Enable or disable the reverb effect.  Off, On 

Reverb Mix Wet/dry amount of the reverb effect. 0–100% 
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Layers 
 

 

 

Layer Controls 
 

 

 

Parameter Description Value Range 

Layer 1/2  Click the power button to enable or disable 
the selected layer. 

Off, On 

 Sample Start Starting point of the selected sample. 0–100% 

 Key Low Set the lowest key for the layer key range. C-2 – G8 

 Key High Set the highest key for the layer key range. C-2 – G8 

 Undamped Keys Set the starting note above which all notes 
are undamped.  

Off, >D5, >E5, >F5 

 Octave Coarse tuning of the layer in octaves.  -4 – 0 – +4 

 Semi Transposition of the layer in semitones. -12 – 0 – +12 

 Cents Fine tuning of the layer in cents. -50.0 – 0.0 – +50.0 

 Formant Decreases or increases resonant frequencies 
to adjust the timbre of the sound. 

-12 – 0 – +12 
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Amp 
 

Parameter Description Value Range 

Vol Level of the layer. -inf – 0.0 – +12.0 dB 

Spike Applies additional velocity to the amplitude 
attack. 

0–100% 

Spike Length Length of time for the Spike to decay. 0–100% 

Pan Stereo panning of the layer. L64 --- C --- R64 

Pan Keytrack Ties the stereo panning to the pitch being 
played. 
At negative values, the lower notes will be 
stereo right, and higher notes stereo left. 
At positive values, lower notes will be stereo 
left, and higher notes stereo right.  

-100 – 0 – +100% 

Pan Alternate Alternate successive notes between stereo 
left and right.  

-100 – 0 – +100% 

 
 

Filter 
 

 

 

Parameter Description Value Range 

Mode Type of filter applied. Off, Lowpass 24dB, Lowpass 
12 dB, Band 18, Band 12, 
High 12, Peak EQ, Presence, 
Damper,  

Cutoff Cutoff frequency of the filter. 0–100% 

Reso Resonance of the filter. 0–100% 

Env Depth Envelope depth of the filter.  
At negative values, decreases the cutoff value 
based on the decay value.  
At positive values, increases the cutoff value 
based on the decay value. 

-100% – 0 – +100% 

Keytrack Ties the envelope parameters to the pitch being 
played. 
At higher values, the envelope time is 
decreased as the pitch is increased. 

0–100% 

Velocity The amount of effect velocity has on filter 
control. 

-100% – 0 – +100% 
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Envelopes 
 

Click the Amp Env, Filter Env, or Pitch Env buttons to view the selected envelope.  

Click the Edit button to view and edit the selected envelope parameters. You can also click and drag the envelope 
points directly. 

 

  

 

Parameter Description Value Range 

Amp 
Envelope 

Attack Length of time for the sound to reach full 
level. 

0 ms – 32 s 

 Decay Length of time for the note to reach sustain 
level. 

0 ms – 32 s 

 Sustain Level of the sound while the note is held. 0–100% 

 Release Length of time for the note to dissipate when 
released. 

0 ms – 32 s 

 Fade Level decrease or increase to the envelope 
sustain level. 

-100 – 0 – +100% 

 Velocity Amount of effect the note velocity has on the 
amplitude envelope. 

-100 – 0 – +100% 

 Vel > Att The amount of effect velocity has on the 
amplitude attack. 

-100 – 0 – +100% 
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Envelopes (continued) 

 

  

 

Parameter Description Value Range 

Filter 
Envelope 

Attack Length of time for the filter to reach full level. 0 ms – 32 s 

 Decay Length of time for the filter to reach sustain 
level. 

0 ms – 32 s 

 Sustain Level of the filter while the note is held. 0–100% 

 Release Length of time for the filter to dissipate when 
released. 

0 ms – 32 s 

 Fade Level decrease or increase to the envelope 
sustain level. 

-100 – 0 – +100% 

 Velocity Amount of effect the note velocity has on the 
filter envelope. 

-100 – 0 – +100% 

 Vel > Att The amount of effect velocity has on the filter 
attack. 

-100 – 0 – +100% 
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Envelopes (continued) 

 

   

 

Parameter Description Value Range 

Pitch 
Envelope 

Level 1 Pitch level (relative to the Env Depth) at the 
start of the note. 

-100 – 0 – +100% 

 Delay Length of time to reach Level 2. 0 ms – 32 s 

 Level 2 Pitch level (relative to the Env Depth) at the 
start of the note. 

-100 – 0 – +100% 

 Attack Length of time between Levels 2 and 3. 0 ms – 32 s 

 Level 3 Pitch level (relative to the Env Depth) at the 
start of the note. 

-100 – 0 – +100% 

 Decay Length of time for the note to reach sustain 
level after the Attack. 

0 ms – 32 s 

 Sustain Pitch level (relative to the Env Depth) as the 
note is held. 

-100 – 0 – +100% 

 Release Length of time for the note to dissipate when 
released. 

0 ms – 32 s 

 Level 5 Pitch level (relative to the Env Depth) when 
the note is released. 

-100 – 0 – +100% 

 Env Depth Sets the range of pitch adjustment in 
semitones. 

-12.00 – 0.00 – +12.00 
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LFO 
 

 

 

Parameter Description Value Range 

Mode Waveshape of the low frequency oscillator.  Off, Constant, Sine, Triangle, 
Sawtooth, Square, S+H 
Random, S+H Alternate, 
Random Drift, Slow Drift 

Sync Disable or enable and select how the LFO is 
synced to the global tempo. 

Off, First Note, Each Note, 
BPM & Note, BPM & Beat 

Destination Where the low frequency oscillator is applied.  Pitch, Cutoff, Reso, Amp, 
Pan,  

Rate Speed of the low frequency oscillator.  

 When Sync is set to Off, First Note or Each Note: 0.03 – 30.00 Hz 

 When Sync is set to BPM & Note or BPM & Beat: 8/4 – 1/64 

Depth Amount of LFO modulation applied. -100 – 0 – +100% 

Fade Level decrease or increase to the LFO level. -100 – 0 – +100% 
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Percussion 
 

 

 

Parameter Description Value Range 

Percussion  Click the power button to enable or disable 
percussion sample. 

Off, On 

 Sample Select the percussion sample used. Varies 

 Trigger Selects when the percussion sample is 
triggered. 

Note-On, Note-Off 

 Octave Adjust pitch of the percussion sample. -4 – 0 – +4 

 Cutoff Cutoff frequency of the percussion sample. 0–100% 

 Decay Length of time for the percussion sample to 
decay. 

0.0 ms – 32.0 s 

 Release Length of time for the percussion sample to 
become silent after being released. 

0.0 ms – 32.0 s 

 Volume Level of the percussion sample. -inf – 0.0 – +12.0 dB 
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Effects 
 

 

 

Parameter  Description Value Range 

Chorus  Use the button in the upper-left corner to enable or 
disable the chorus effect. 

Off, On 

 Rate Modulation speed of the chorus effect. 0.05 – 20.00 Hz 

 Mix Wet/dry amount of the chorus effect. 0–100% 

Tremolo  Use the button in the upper-left corner of this section 
to enable or disable the tremolo effect. 

Off, On 

 Rate Modulation speed of the effect. 0.05 – 20.00 Hz 

 Shape Adjusts the modulation waveshape. -100 – 0 – +100% 

 Stereo Degree of stereo spread of the effect. 0–360 deg. 

 Modwheel Enable or disable tremolo control by the modwheel. Off, On 

 Depth Modulation depth of the tremolo effect. 0–100% 

Phaser  Use the button in the upper-left corner to enable or 
disable the phaser effect. 

Off, On 

 Rate Modulation speed of the effect. 0.05 – 20.00 Hz 

 Depth Amount of modulation applied. 0–100% 

 Feedback Amount of phaser signal fed back into the phaser 
circuit. 

0–100% 

 Stereo Degree of stereo spread of the effect. 0–360 deg. 

 Center Center frequency of the phaser filter.  0–100% 

 Mix Wet/dry mix of the phaser effect. 0–100% 
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Effects (continued) 

 

Parameter  Description Value Range 

Flavor  Use the button in the upper-left corner of this 
section to enable or disable the flavor effect. 

Off, On 

 Timbre Selects an emulation type to color the sound. Varies 

 Timbre Depth Amount of timbre emulation applied to the sound. 0–100% 

 Vinyl Distortion Amount of vinyl distortion noise applied to the 
signal. 

0–100% 

 Vinyl Noise Amount of vinyl noise such as clicks and pops 
applied to the signal. 

0–100% 

 Flutter Amount of speed fluctuation of the sound playback. 0–100% 

 Monofy Reduces the stereo spread of the sound to mono. 0–100% 

EQ  Use the button in the upper-left corner of this 
section to enable or disable the EQ effect. 

Off, On 

 Low Amount of attenuation or boost applied to the low 
frequency band. 

-12 – 0 – +12 dB 

 Low Mid Amount of attenuation or boost applied to the low-
mid frequency band. 

-20 – 0 – +20 dB 

 High Mid Amount of attenuation or boost applied to the high-
mid frequency band. 

-20 – 0 – +20 dB 

 High Amount of attenuation or boost applied to the high 
frequency band. 

-12 – 0 – +12 dB 

Amp | Cab  Use the button in the upper-left corner to enable or 
disable the amp/cab effect. 

Off, On 

 Cab Model Type of amplifier simulated. D.I., Brit, 1x8”, 1x12”, 
2x10”, 2x12”, 4x10”, 
4x12”, 1x15” Bass, 4x10” 
Bass, Radio 

 Drive Amount of overdrive applied to the amp signal. 0–100% 

 Soft Clip Amount of softening applied to the clipped signal to 
decrease high-frequency harmonics and add 
warmth. 

0–100% 

 Mono/Stereo Determines whether the simulation is mono or 
stereo. 

Mono, Stereo 

 High Amount of high-range tone reduction or boost. -100 – 0 – +100% 

 Mid Amount of mid-range tone reduction or boost. -100 – 0 – +100% 

 Bass Amount of bass-range tone reduction or boost. -100 – 0 – +100% 

 Volume Output level of the amp signal. -12.0 – 0.0 – +12.0 dB 
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Effects (continued) 

 

Parameter  Description Value Range 

Compressor  Use the button in the upper-left corner of this 
section to enable or disable the compressor. 

 

 Threshold Signal level after which the compression will be 
applied. 

-30.0 – 0.0 – +10.0 dB 

 Ratio Amount of compression applied. 1.0:1 – 20.0:1 

 Attack Length of time to apply the compression. 0–100% 

 Makeup Amount of additional output gain for the 
compressed signal. 

-20.0 – 0 – +20.0 dB 

Delay  Use the button in the upper-left corner of this 
section to enable or disable delay. 

Off, On 

 Time Amount of time between the dry signal and the 
delayed signal. 

1/16 – 16/4 

 L/R Ratio Reduces the delay Time in either the Left or 
Right stereo field. This is useful for creating 
offset, panned delays. 

50:100 – 100:100 – 100:50 

 Feedback Amount of signal fed back into the delay line. 0–100% 

 Reso LP Freq Low pass frequency for feedback resonance. 100 – 16000 Hz 

 Reso Bell Freq Center frequency for feedback resonance. 100 – 16000 Hz 

 Reso Bell Gain Amount of gain applied to the resonant 
frequency. 

0–100% 

 Mix Wet/dry amount of the delay effect. 0–100% 

Reverb  Use the button in the upper-left corner of this 
section to enable or disable reverb. 

Off, On 

 Pre-Delay Length of time between dry signal and 
reverberated signal. 

0 – 250 ms 

 Time Length of reverb tail. 0.3 – 60.00 s 

 Size Size of the reverberation environment.  0–100% 

 Shape Shape of the reverberation environment, which 
will alter the density of reverb reflections.  
At lower settings, the sound of individual 
reflections is more present. 
At higher settings, reflections are more uniform. 

0–100% 

 Damp Amount of frequency dampening applied to the 
reverberated signal. 

100–0% 

 HPF Freq Center frequency for reverb signal high-pass 
filter. 

0 – 2000 Hz 

 Bright Amount of high frequency decay.  -100–0% 

 Mix Wet/dry amount of the reverb effect. 0–100% 
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Settings 
 

 

 

Parameter Description Value Range 

Global Transpose Transposition of the plugin, in semitones. -36 – 0 – +36 

 Tune Fine tuning of the plugin, in cents. -100 – 0 – +100 

 Pitch Bend 
Range 

Number of semitones up or down controlled by MIDI 
pitch bend messages. 

0–24 (semitones) 

 Polyphony Number of allowable voices, and how voices are 
triggered. 

Dynamic Poly, Legato, 
Retrigger, 2–6 Notes 

 Glide Mode Enables or disables pitch gliding for all triggered 
notes or legato notes. 

Off, Legato, All 

 Glide Time Amount of time to slide from the pitch of one note to 
the next note played. 

0.0 ms – 32.0 s 

Modwheel Destination Send Mod Wheel data to one of the following control 
destinations. 

Pitch, Cutoff, Reso, 
Amp, Pan 

 Depth Amount of modulation applied.  

  When Destination is set to Pitch: -12.0 – +12.0 

  When Destination is set to Cutoff, Reso, Amp or Pan: -100 – 0 – 100% 

 LFO Ties the modulation to the Control LFO. Off, On 

Aftertouch Destination Send Aftertouch data to one of the following control 
destinations. 

Pitch, Cutoff, Reso, 
Amp, Pan 

 Depth Amount of modulation applied. 0–100% 

  When Destination is set to Pitch: -12.0 – +12.0 

  When Destination is set to Cutoff, Reso, Amp or Pan: -100 – 0 – 100% 

 LFO Ties the modulation to the Control LFO. Off, On 
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Settings (continued) 

 

Parameter Description Value Range 

Expression Destination Send Expression data to one of the following control 
destinations. 

Pitch, Cutoff, Reso, 
Amp, Pan 

 Depth Amount of modulation applied. 0–100% 

  When Destination is set to Pitch: -12.0 – +12.0 

  When Destination is set to Cutoff, Reso, Amp or Pan: -100 – 0 – 100% 

 LFO Ties the modulation to the Control LFO. Off, On 

Footswitch 1 Destination Send Footswitch 1 data to one of the following 
control destinations. 

Pitch, Cutoff, Reso, 
Amp, Pan 

 Depth Amount of modulation applied. 0–100% 

  When Destination is set to Pitch: -12.0 – +12.0 

  When Destination is set to Cutoff, Reso, Amp or Pan: -100 – 0 – 100% 

 LFO Ties the modulation to the Control LFO. Off, On 

Control LFO Shape Waveshape of the Control LFO. Sine, Triangle, 
Sawtooth, Square, S&H 
Random, S&H 
Alternate, Random 
Drift, Slow Drift 

 Rate Speed of the low frequency oscillator.  

  When Sync is Off: 0.03 – 30.00 Hz 

  When Sync is On: 8/4 – 1/64 

 Sync Enables or disables Control LFO sync, and sets how 
the Control LFO is synced when enabled. 

Off, First Note, Each 
Note, BPM & Note, 
BPM & Beat 
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